# Table of Contents

Foreword .......................... 0

## Part 1 Introduction to AquaChem
1 Installing AquaChem ................................................................. 1
2 Uninstalling AquaChem ............................................................ 2
3 In-Program Help .................................................................... 3
4 On-Line Help ........................................................................ 3
5 Starting AquaChem ............................................................... 3
6 AquaChem Interface Layout .................................................... 5
7 AquaChem Toolbar .................................................................. 14

## Part 2 Getting Started
1 Creating a New Database ......................................................... 16
   Importing Data ..................................................................... 19
   Assigning Symbols ............................................................... 23
2 Creating Plots ......................................................................... 28
   Plot Options ......................................................................... 28
   Printing Plots ....................................................................... 28
   Exporting Plots as Graphics File .......................................... 28
3 Creating Reports ..................................................................... 36
   Parameters tab ..................................................................... 36
   Saving Reports ..................................................................... 36
   Printing Reports .................................................................. 36

## Part 3 AquaChem Menu Commands
1 File Menu ............................................................................ 42
   New .................................................................................... 42
   Open .................................................................................. 42
   Close .................................................................................. 42
   Save Database ...................................................................... 46
   Save as Template .................................................................. 46
   Import ................................................................................ 46
   Sample/Stations ................................................................. 46
   Time Series Data ................................................................. 42
   Export ................................................................................ 42
   Image ............................................................................... 42
   ESRI Shapefile .................................................................... 63
   Data ................................................................................... 42
   MODFLOW ......................................................................... 67
   KML File ............................................................................ 68
   PDF File ............................................................................. 42
   Print ................................................................................... 42
   Template Designer ................................................................ 72
   Template Designer Interface ............................................. 42
   Template Designer Controls .............................................. 42

© 2017 Waterloo Hydrogeologic.
Creating New Templates - Example........................................................................................................ 42

Database ................................................................................................................................................ 42
  Aliases .................................................................................................................................................. 42
  Calculations ....................................................................................................................................... 42
  Chemicals Master Table ..................................................................................................................... 42
  Database Parameters .......................................................................................................................... 42
  Database Info ..................................................................................................................................... 42
  General ................................................................................................................................................ 42
  Holding Times Configuration .............................................................................................................. 42
  Parameter Groups ............................................................................................................................... 42
  PHREEQC ........................................................................................................................................... 42
  Plots .................................................................................................................................................... 42
  QC Metadata ....................................................................................................................................... 42
  Ranges ................................................................................................................................................ 42
  Standards - Configure ....................................................................................................................... 42
  Standards - Import .............................................................................................................................. 42
  Thermometers .................................................................................................................................... 42

Exit ....................................................................................................................................................... 42

2 Edit Menu .......................................................................................................................................... 121
  Cut ...................................................................................................................................................... 121
  Copy .................................................................................................................................................... 121
  Paste .................................................................................................................................................. 121
  Replace ............................................................................................................................................... 121
  Find .................................................................................................................................................... 121

3 View Menu ....................................................................................................................................... 128
  Table View ....................................................................................................................................... 128
  Edit ..................................................................................................................................................... 128
  Default ............................................................................................................................................... 128
  Contaminants .................................................................................................................................... 128
  Options ............................................................................................................................................... 128
  Options - Active List .......................................................................................................................... 128
  Options - Sample Details .................................................................................................................... 128
  Options - Table View ........................................................................................................................ 128
  Options - Plots .................................................................................................................................. 128
  Options - Reports .............................................................................................................................. 128

4 Filter Menu ....................................................................................................................................... 135
  Show All ............................................................................................................................................ 135
  Omit All ............................................................................................................................................. 135
  Show only selected ............................................................................................................................. 135
  Omit selected .................................................................................................................................... 135
  Invert Selection .................................................................................................................................. 135
  Select Associated Samples/Stations ................................................................................................. 135
  Open Selection .................................................................................................................................. 135
  Save Selection .................................................................................................................................. 135

5 Stations/Samples Menu ..................................................................................................................... 137
  New ................................................................................................................................................... 137
  Clone .................................................................................................................................................. 137
  Edit .................................................................................................................................................... 137
  Delete ................................................................................................................................................. 137
  Assign Symbol ................................................................................................................................. 137
  Creating New Symbols ...................................................................................................................... 137
  Auto Generate Symbols .................................................................................................................... 137
  Assign Station ................................................................................................................................... 137

© 2017 Waterloo Hydrogeologic.
# Contents

- **Representative On / Off** ................................................................. 137
- **Goto next Selected (CTRL+S)** .......................................................... 137

6 **Plots Menu** ......................................................................................... 148

- **New** .................................................................................................. 148
- **Open Configuration** .......................................................................... 148
- **Save Configuration** .......................................................................... 148
- **Close All Plots** ................................................................................ 148
- **List of Plots** .................................................................................... 148
- **Define Symbol or Line** ................................................................. 148
- **Show Sample Data** ......................................................................... 148
- **Identify Plot Data** ........................................................................... 148
  - None .................................................................................................. 148
  - Selected Plot .................................................................................. 148
  - All plots .......................................................................................... 148

7 **Reports Menu** .................................................................................... 152

- **Data Summary** .................................................................................. 152
- **Compare Sample** ............................................................................ 152
- **Mix Samples** .................................................................................. 152
- **Water Quality Standards** ............................................................... 152
- **Hardness Dependent Standards** ..................................................... 152
- **Rock Source Deduction** ............................................................... 152
- **Statistics** .......................................................................................... 152
  - Summary Statistics ........................................................................ 152
  - Correlation Matrix ......................................................................... 152
  - Trend Analysis ............................................................................... 152
  - Outlier Tests .................................................................................... 152
- **Sample Summary** ........................................................................... 152
- **Report Designer** ............................................................................. 152

8 **Tools Menu** ........................................................................................ 153

- **Calculators** ...................................................................................... 153
  - Aggregate Samples ......................................................................... 153
  - Aquachem Function ...................................................................... 153
  - Calculate facies ............................................................................ 153
  - Corrosion and Scaling ................................................................. 153
  - Decay Calculator ............................................................................ 153
  - Find Missing Major Ion ................................................................ 153
  - Formula Weight Calculator ........................................................ 153
  - Oxygen solubility ......................................................................... 153
  - Volume Concentration Converter .............................................. 153
  - Retardation ..................................................................................... 153
  - Special Conversions ..................................................................... 153
  - Species Converter ....................................................................... 153
  - Unit Calculator .............................................................................. 153
  - UTM Conversion ........................................................................... 153
- **QA/QC** ............................................................................................. 153
  - Compare Duplicates ....................................................................... 153
  - Highlight Duplicates .................................................................... 153
  - Highlight Outliers ........................................................................ 153
  - Holding Times ................................................................................ 153
  - Manage Duplicates ....................................................................... 153
  - Method Detection Limit ............................................................... 153
  - Reliability Check .......................................................................... 153
  - Total/Dissolved Comparison ....................................................... 153

© 2017 Waterloo Hydrogeologic.
Look Up Tables ................................................................. 153
Degradation Rates ............................................................. 153
PHREEQC Phases ............................................................... 153
Periodic Table ................................................................. 153
Water Standards ............................................................... 153
Time Series ........................................................................ 153
Browse Database ............................................................... 153
Modeling ........................................................................... 153
Calculate Saturation Indices and Activities ......................... 153
Calculate pH ...................................................................... 153
Calculate Eh ...................................................................... 153
Alk > HCO3, CO3................................................................. 153
Equilibrate with Minerals ................................................... 153
PHREEQC (Basic) .............................................................. 153
PHREEQC (Advanced) ....................................................... 153
Generate PHT3D Input ....................................................... 153
9 Window Menu .................................................................. 156
Tile Vertical ......................................................................... 156
Tile Horizontal ................................................................. 156
Cascade ............................................................................. 156
Arrange Icons ..................................................................... 156
Help Menu .......................................................................... 157
Contents ............................................................................. 157
Index .................................................................................. 157
About ................................................................................. 157
Part 4 Plots .......................................................................... 158
Common Plot Features ......................................................... 158
Title Dialogue ...................................................................... 158
Plot Title ............................................................................. 158
Position .............................................................................. 158
Alignment ........................................................................... 158
Shift From Axis ................................................................... 158
Symbols Dialogue ............................................................... 158
Show frame ......................................................................... 158
Edit frame .......................................................................... 158
Scaled Symbol Size frame .................................................. 158
Legend dialogue ................................................................. 158
Contents frame .................................................................... 158
Frame frame ........................................................................ 158
Line Dialogue ....................................................................... 158
Equation tab ........................................................................ 158
Line Properties tab ............................................................ 158
Format dialogue ................................................................. 158
Axis .................................................................................... 158
Minimum/Maximum ........................................................... 158
Labelled Ticks ..................................................................... 158
Label Angle ......................................................................... 158
Minor Ticks ......................................................................... 158
Format ............................................................................... 158
Title .................................................................................... 158
Log Scale ............................................................................. 158
Labels dialogue ................................................................. 158

© 2017 Waterloo Hydrogeologic.
## Part 5 Reports

1. Excel Time Series ................................................................. 223
2. Common Report Features .................................................. 230
3. Data Summary .................................................................... 232
4. Compare Sample .............................................................. 233
5. Mix Samples ...................................................................... 236
6. Water Quality Standards ................................................... 238
### Part 6 Tools

<table>
<thead>
<tr>
<th>Tool</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculators and Converters</td>
<td>289</td>
</tr>
<tr>
<td>QA/QC</td>
<td>303</td>
</tr>
<tr>
<td>LookUp Tables</td>
<td>310</td>
</tr>
<tr>
<td>Modeling</td>
<td>312</td>
</tr>
<tr>
<td>Calculate Saturation Indices and Activities</td>
<td>314</td>
</tr>
<tr>
<td>Calculate pH</td>
<td>317</td>
</tr>
<tr>
<td>Calculate Eh</td>
<td>318</td>
</tr>
<tr>
<td>Equilibrate with Minerals</td>
<td>319</td>
</tr>
<tr>
<td>PHREEQC (Basic)</td>
<td>321</td>
</tr>
<tr>
<td>PHREEQC (Advanced)</td>
<td>323</td>
</tr>
<tr>
<td>PHREEQC Interactive</td>
<td>323</td>
</tr>
<tr>
<td>PHREEQC for Windows</td>
<td>324</td>
</tr>
<tr>
<td>Generate PHT3D Input</td>
<td>326</td>
</tr>
</tbody>
</table>

### Part 7 Geochemical Modeling with PHREEQC (Basic)

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>AquaChem Interface to PHREEQC</td>
<td>338</td>
</tr>
<tr>
<td>Preferences for PHREEQC</td>
<td>338</td>
</tr>
<tr>
<td>The PHREEQC Thermodynamic Database Link</td>
<td>338</td>
</tr>
<tr>
<td>PHREEQC Window Layout</td>
<td>340</td>
</tr>
<tr>
<td>General</td>
<td>340</td>
</tr>
<tr>
<td>Surface Complexation</td>
<td>340</td>
</tr>
<tr>
<td>Exchange Capacity</td>
<td>340</td>
</tr>
<tr>
<td>Mineral Assemblage</td>
<td>340</td>
</tr>
<tr>
<td>General</td>
<td>340</td>
</tr>
<tr>
<td>Reaction Temperature</td>
<td>340</td>
</tr>
<tr>
<td>Output</td>
<td>340</td>
</tr>
<tr>
<td>Save Options</td>
<td>340</td>
</tr>
<tr>
<td>Creating PHREEQC Input Files</td>
<td>347</td>
</tr>
<tr>
<td>Simulation - Steps</td>
<td>347</td>
</tr>
<tr>
<td>Add Initial Conditions</td>
<td>347</td>
</tr>
<tr>
<td>Forward Modeling</td>
<td>347</td>
</tr>
<tr>
<td>Equilibrium Phases</td>
<td>348</td>
</tr>
<tr>
<td>Exchange Assemblage</td>
<td>347</td>
</tr>
<tr>
<td>Gas Phase Assemblage</td>
<td>352</td>
</tr>
<tr>
<td>Adding Solutions</td>
<td>353</td>
</tr>
<tr>
<td>Using Samples from your AquaChem Database</td>
<td>347</td>
</tr>
</tbody>
</table>

© 2017 Waterloo Hydrogeologic.
<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding Pure Water</td>
<td>347</td>
</tr>
<tr>
<td>Solution Properties</td>
<td>347</td>
</tr>
<tr>
<td>General</td>
<td>347</td>
</tr>
<tr>
<td>Concentrations</td>
<td>347</td>
</tr>
<tr>
<td>Surface Assemblage</td>
<td>357</td>
</tr>
<tr>
<td>Mix Solutions</td>
<td>359</td>
</tr>
<tr>
<td>Reactions</td>
<td>359</td>
</tr>
<tr>
<td>Running PHREEQC Simulation</td>
<td>363</td>
</tr>
<tr>
<td>Part 8 Appendices</td>
<td>364</td>
</tr>
<tr>
<td>1 Appendix A: Troubleshooting and FAQ</td>
<td>364</td>
</tr>
<tr>
<td>2 Appendix B: Using HydroGeo Analyst and AquaChem Together</td>
<td>365</td>
</tr>
<tr>
<td>3 Appendix C: Trend Analysis Tests</td>
<td>367</td>
</tr>
<tr>
<td>Linear Regression</td>
<td>367</td>
</tr>
<tr>
<td>Mann-Kendall Test</td>
<td>369</td>
</tr>
<tr>
<td>Sen’s Test</td>
<td>367</td>
</tr>
<tr>
<td>4 Appendix D: Calculating Alert Levels</td>
<td>373</td>
</tr>
<tr>
<td>5 Appendix E: References</td>
<td>375</td>
</tr>
<tr>
<td>Index</td>
<td>378</td>
</tr>
</tbody>
</table>
1 Introduction to AquaChem

AquaChem is a software package developed specifically for graphical and numerical analysis and modeling of water quality data. It features a fully customizable database of physical and chemical parameters and provides a comprehensive selection of analysis tools, calculations, and graphs for interpreting water quality data.

AquaChem's data analysis capabilities cover a wide range of functionalities and calculations including unit conversions, charge balances, sample comparison and mixing, statistical summaries, trend analyses, and much more. AquaChem also comprises a customizable database of water quality standards with up to three different action levels for each parameter. Any samples exceeding the selected standard are automatically highlighted with the appropriate action level color for easily identifying and qualifying potential problems.

These powerful analytical capabilities are complemented by a comprehensive selection of commonly used plotting techniques to represent the chemical characteristics of water quality data. The plot types available in AquaChem include:

- Correlation plots: X-Y Scatter, Ludwig-Langelier, Wilcox, Depth Profile
- Summary plots: Box and Whisker (Grouped, Multiple Parameters, Multiple Stations, Time), Frequency Histogram, Quantile, Detection summary, Meteoric Water Line, Stacked Bars
- Multiple parameter plots: Piper, Durov, Temary, Schoeller
- Time-Series plots (multiple parameters, multiple stations, statistical)
- Geothermometer and Giggenbach plot
- Detection summary plot
- Probability plots
- Single sample plots: Radial, Stiff, and Pie
- Thematic Map plots: Bubble, Pie, Radial and Stiff plots at sample locations

Each of these plots provides a specific interpretation of the many complex interactions between the groundwater and aquifer materials, and identifies important data trends and groupings.

In addition, AquaChem features a built-in link to the popular geochemical modeling program PHREEQC for calculating equilibrium concentrations (or activities) of chemical species in solution and saturation indices of solid phases in equilibrium with a solution. For more advanced simulations, you may link to the USGS programs PHREEQCI or PHREEQC for Windows, and use your AquaChem samples as input solutions for these modeling utilities.

Once you start using AquaChem, you will see that it is truly one of the most powerful tools available for interpretation, analysis and modeling of any water quality data set.

1.1 Installing AquaChem

System Requirements
AquaChem requires the following minimum hardware configuration:

Supported Operating Systems:
- Windows 7 Professional, Enterprise or Ultimate
- Windows Vista Business, Ultimate or Enterprise

Note: Home and Starter Versions are not supported.
Introduction to AquaChem

Processor: Pentium 4, 32-bit or 64-bit  
Hard Disk: 250 MB  
RAM: 2GB (or more Recommended)  
Networking Hardware: Network Card (required for soft-key licensing)

The AquaChem installation package requires the following software configuration:
- Microsoft .NET Framework: 4.0 or higher

Note: If you do not have MS Access (or have a later version) please install the free Access Runtime Engine

Installation

For more detailed instructions on installing and licensing AquaChem please see the Online Instructions

PHREEQC-I Installation

The USGS's PHREEQC-Interactive program is a graphical interface for preparing and running complex geochemical modeling scenarios. AquaChem has a built-in link to the PHREEQC-Interactive program that is capable of launching this program with all selected samples already formatted as modelling input. The PHREEQC-I must be installed separately; the installation file is available on your CD-ROM under the PHREEQC directory. Once installed, the PHREEQCI executable must be registered in the Aquachem preferences. It can then be launched from AquaChem (Tools / Modeling / PHREEQC (Advanced) and the input file will automatically be initialized with the chemical composition of the samples that are highlighted in the AquaChem sample list.

PHREEQC for Windows Installation

AquaChem also supports a link to the PHREEQC for Windows program. This program is an alternative graphical interface that also allows for preparing and running advanced geochemical simulations.

If you wish to install and use the PHREEQC for Windows program, this can be downloaded from the USGS website:

1.2 Uninstalling AquaChem

There may be instances where you will need to uninstall (remove) AquaChem from your system (i.e. if the software is to be transferred to another computer, or you need to reinstall on the current computer).

To uninstall AquaChem:
- Locate the Add/Remove Programs option in your Windows’ Control Panel.
- Select AquaChem as the program to be removed and follow the on-screen instructions.
- Once you are finished, re-boot your system to ensure all system files are updated.
1.3 In-Program Help

To view the In-Program help, select Help / Contents. Some AquaChem windows and dialogs contain buttons, which load the appropriate help section for the current active component. The AquaChem Help window is divided into three main areas:

- A Navigation Frame on the left displays the Contents, Index, Search, and Favorites tabs.
- A Toolbar across the top displays a set of buttons to help navigate through the Help system.
- A Topic Frame on the right displays the actual Help topics included in the On-Line Help.

The tabs in the Navigation Frame provide the core navigational features as described below.

**Contents**
The Contents tab displays the headings in the “Table of Contents” in the form of an expandable/collapsible tree. Closed book icons represent Table of Contents headings that have sub-headings.

**Index**
The Index tab displays the list of Help topics. You can scroll to find the index entry you want, or you can type in the first few letters of the keyword in the text box, and the index will scroll automatically as you type. Double-click an index entry to display the corresponding Help topic. Alternately, you may select an index entry and then click the Display button to open the Help topic.

**Search**
The Search tab is used to search the On-Line Help documents for a word or phrase of interest. Simply type the search word(s) or phrase(s), then press Enter or click the Display button.

**Favorites**
You can add frequently accessed Help topics to a personal list of favorites, which is displayed in the Favorites tab. Once you have added a topic to your list of favorites, you can access the topic by double-clicking it. Click Add to add the currently displayed topic to your favorites list. Select a favorite and then click Remove to delete a topic from your favorites list.

1.4 On-Line Help

You can also find the AquaChem help on-line:

http://www.novametrixgm.com/help/aquachem/

This online version of the Help can be updated more regularly than the help within the program, so check it out for the latest updates to the documentation!

1.5 Starting AquaChem

To start AquaChem, you must have the program installed on your computer. If you have not yet installed AquaChem, please refer to the section on Installing AquaChem.
Otherwise start AquaChem by double-clicking on the desktop icon or by accessing Waterloo Hydrogeologic Software/Aquachem from your Start / All Programs menu.

Upon starting AquaChem, the following Open Database dialogue will be displayed prompting you to select a valid AquaChem database.

Select the Demo.aqc file to open the demonstration database; to open a different database, browse to the appropriate folder. Otherwise, to create a new database click [Cancel] in this dialogue and select File > New from the main menu.

Opening Old Projects
You may open an .AQC file from previous versions of AquaChem. To open a project from v.5.0 or higher, use the File > Open command. You will be prompted with an Open Database dialogue. Browse to the folder which contains your database and press [Open]. The following message will appear.
If you select [Yes], the AquaChem database will be opened with a screen layout as shown on the next page, or if you select [No] then the option of opening the old project sets will be canceled.

1.6 AquaChem Interface Layout

After opening an AquaChem project file, a screen layout similar to the following figure will appear.

Main Menu Bar

Main Toolbar

Active Samples/ Stations Window

Parent Window

Parent Window is the main AquaChem window which houses all other windows.
Main Menu Bar contains specific menus for graphs and dataset. Depending upon the currently selected window, each window has a distinct set of menu options. A detailed description of each main menu option associated with various windows is provided in AquaChem Menu Commands.

Main Toolbar contains specific tool buttons for different options. A detailed description of each main toolbar item is provided in following section AquaChem Toolbar.

Active Samples/Stations Window will always appear when you open an AquaChem database and will remain on-screen as long as the project database is open (i.e. the Active Samples/Stations window cannot be closed unless the project database is closed). This window displays the list of samples and stations in the currently selected database. Two further windows can be accessed through the Active Samples/Stations tab to display and manipulate the dataset:
- Sample Details Window contains details for the selected sample.
- Station Details Window contains details for the selected station.

The following remaining 'Child' windows are used to display and manipulate the data which can be accessed through the main menu commands:
- Table View available under View menu allows you to view and edit the data in the database as a table.
- Template Designer available under the File menu contains options for designing print templates for plots and reports.
- Reports loads pre-defined data analysis reports, or user-designed reports. The Report Designer available under the Reports contains options for designing data reports.
- Tools loads several tools for data analysis and interpretation. Modeling > PHREEQC available under the Tools loads the interface for the PHREEQC modeling utility, and provides direct links to the graphical user interfaces for PHREEQC-I and PHREEQC for Windows.

AquaChem follows most standard Windows interface conventions. Each window can be minimized to the bottom of the Parent window and re-opened as needed. Likewise, window sizes can be adjusted by dragging and releasing the corners of the window frame. Windows can be arranged (as shown below for example) on the Parent window using the Windows > Tile Horizontal or Tile Vertical command which are available from the main menu.
The following section summarizes the features of each of the main AquaChem windows.

**Active Samples/Stations Window**

AquaChem follows a database hierarchy of stations followed by samples. This means that each sample must have a corresponding station. When you create a new sample, a corresponding station must be assigned to it.

The Active Sample/Stations window contains summarized information about every active sample and station in the database; the fields in this window are read-only which means that fields in this window cannot be edited. This window contains two tabs: Stations and Samples. Clicking on these tabs displays the following windows.
The first column in these windows will always contain an ID value; each sample and station in your database will have a unique database ID value. This allows AquaChem to manage the data and perform internal calculations.

**NOTE:** The internal database ID value cannot be edited, nor can this column be removed from the active list. This ID value is automatically created when you create a new sample or station.

In addition to the ID column, there will be columns containing sample or station description parameters. These columns can be modified and the sorting options can be modified as well. For more details on sorting the active list, please see the View > Options - Active List section in Chapter 3.

The bottom of the Active Sample/Stations window contains the following three buttons:

- The **[Sort]** button will load the sort options for the active list. This will allow you to change which parameters appear in the active list and their order.
- The **[New]** button will create a new sample or station, depending on which mode is active (i.e. which tab is selected).
- The **[Delete]** button will delete the selected sample or station.

In order to edit the data for a specific sample or station, you need to open the Sample Details or Station Details window. These windows are explained in greater detail in the following sections.

The following shortcuts can be used to reach quickly a specific record without the more time consuming Find operation. Click in the column holding the field you want to search. Then press the first character of the searched expression on the keyboard. The program will jump to the first expression starting with the respective character. Alternatively, you may press Ctrl-F and type in the text string you want to search for. After pressing the [OK] button, the program will jump to the first matching record having a matching field.
If the Find function returned several records in a long list, these records may be scrolled through without hiding the unselected records. To do so, press Ctrl-S on your keyboard. This will initially take you to the first selected record, while pressing it again will scroll through all highlighted records sequentially.

Sample Details Window
The Sample Details window is a read/write window, which means data can be entered, saved, and read from this window. Individual samples can be viewed and edited using this window. To load this window for one of the samples in your active list, you can:
- select a sample from the active list and double-click the left mouse button on it; OR
- select a sample from the active list and press the <Enter> key on your keyboard; OR
- select a sample from the active list and click Sample > Edit from the main menu; OR
- right-click the sample from the active list and select [Edit].

An example of the Sample Details window is shown below:
To enter data in the Sample Details window, simply double-click in the desired field and type in the appropriate information. Alternatively, data can be imported into your database using the Import feature (see the File > Import section for more details).

The Sample Details window is separated into two frames: the top frame includes general details on the sample (Sample and Station tabs), and the bottom frame contains the Measured, Calculated, Modeled, and Description tabs.

Data can be entered for the Sample tab at the top of this window, and in the Measured and Description tabs in the bottom half of this window. Under the Measured Parameters tab, you will see the label Parameter Group with a corresponding combo box. This allows you to
select different groups of Measured Parameters, and focus on just desired groups (for example you may want to view just Anions or Cations). The Show analyzed values only group will hide all parameters for which there is no data recorded, and display only those samples which have measured values. Parameter groups can be created and edited in the File > Database screen using the parameter group tab dialogue.

For Sample, Station or Measured Parameter you may also right-mouse click on a grid cell in order to view the Parameter Details. The Parameter Details window displays all the meta data available for the selected parameter including description, formula weight, and the CAS Registry number.

The Calculated tab contains function values based on measured data from the current sample. These entries cannot be edited (this data is read-only). However you may define which of the available AquaChem functions should be displayed and what unit is to be displayed (e.g. for hardness) on this tab using the Sample Detail Options.

The data in the Modeled tab is obtained from PHREEQC simulations (as such, there will be no values for Modeled Parameters when you enter or import data into your database). There are two ways in which you can copy PHREEQC results into the Modeled tab:

[1] Click the PHREEQC button at the bottom of the window, and PHREEQC will calculate the Saturation Indices for the available Modeled Parameters in the database. This will be done only for the current sample;

[2] Select multiple samples in the Active Samples list, and use the menu option Tools > Modeling > Calculate Sat. Indices and Activities.

The scroll buttons at the bottom of the Sample Details Window can be used to scroll through the Sample Details for other samples:

The order of these buttons (from left to right) is as follows:
- First sample - loads the sample details for the first sample in your active list.
- Previous sample - loads the sample details for the previous sample in your active list.
- Next sample - loads the sample details for the next sample in your active list.
- Last sample - loads the sample details for the last sample in your active list.

The first field in the Sample Details window is the Station ID. As mentioned earlier, every sample must have a station assigned to it. To assign a station to a sample, click once in this field then click the button which will appear near the right side of this field. Alternatively, you may click Samples > Assign Station from the main menu. This will load a list of available stations, similar to the dialogue shown to the right side. From this dialogue, you may select a station directly from the list; or if you have a long list of stations, the Find feature at the top of this window can be helpful. Simply enter the Station ID or any other parameter from the station you are looking for into the Find field, and press the Find icon to run a search for this expression. If this expression might be found in
several fields of the station table then you might want to choose a category from the combo box beside this field in order to narrow down the fields which are searched by the query. Once you have located the desired station for this sample, press the [Assign] button at the bottom of this dialogue and this will return you to the Sample Details window. When you are finished in the Sample Details window, press the [Save] button at the bottom to save new data and/or changes to your database. Once you are finished, press [Close] to return to the Active List. The data under the Station tab is read-only, and as such cannot be edited. The Station tab contains information on the station which corresponds to the current sample. To edit the station parameters, open the Station Details Window as described in the next section. Note that in the Sample Details section, fields with a defined length of greater than 100 characters will appear as a multiline field to make long texts, such as comments, readable. Also, the text fields in the Sample Details section may contain hyperlinks or file names. Double clicking such a field will open the respective file or link. It may be useful to link the original laboratory data files or PDF files from which the data was extracted to respective samples. Even if the information contained in this file is not actually included in the AquaChem database, is then easily accessible.

**Station Details Window**
The Station Details window is a read/write window, which means data can be entered, saved, and read from this window. Individual stations can be created, edited, or viewed using this window.

To load this window for one of the stations in your active list, you can:
- select the station from the active list, then double-click the left mouse button on it; OR
- select the station from the active list, then press the <Enter> key on your keyboard; OR
- select the station from the active list and click Station > Edit from the main menu; OR
- right-click on the station from the active list and select [Edit].

An example of the Station Details window is shown below.

![Station Details Window](image)

To enter data in the Station Details window, simply double-click in the desired field and type in the appropriate information. Alternatively, data can be imported into your database using the Import feature (see the File > Import section for more details). To save new data and/or changes to the database for this station, press the [Save] button at the bottom of this window. Once you are finished, press [Close] to return to the active list. The scroll buttons at the bottom of this window are similar to the Sample Details window; these buttons can be used to scroll through the details for other stations in your active list.
Note that in the sample detail section, fields with a defined length of greater 100 will appear as a multiline field to make long texts such as comments readable. Also, the text fields in the sample detail section may contain hyperlinks or file names. When double clicking such a field, the respective file or link will be opened. Useful information to link to a station record may include an image of the station or a geological log.

1.5.4 Plots Window
AquaChem provides a comprehensive selection of plotting techniques commonly used for aqueous geochemical data analysis and interpretation. Each of these plot types can be used to graphically represent information for all samples in the Active Samples List, or for selected samples only.

To create a new plot:
Ensure the Samples tab is the current active window.
Select Plots > New from the main menu.
Choose the desired plot type from the list in this menu.
Modify the plot options or click [OK] to accept the defaults.
This will create a Plot window displaying the selected plot for all or selected samples in the Active Samples List.
An example below shows a plot window containing a Piper plot:

![Piper Plot](image)

Any samples selected in the Active List will be highlighted on the Piper plot. Shapes and sizes of the symbols can be modified and the plot options can be adjusted to show just the selected samples, or all the current active samples available in your database. In certain plots the data points may be labeled.

It is important to remember that the data plotted on all open plots are directly linked to the database samples. Any changes to the data are immediately reflected in each of the open graphs. Clicking a data point on the graph will highlight the corresponding sample in the Active samples list window (the corresponding data point in all other open plot windows will also be highlighted). This can be effective for identifying outlier points on the plot. Similarly, selecting a sample in the active list will highlight the corresponding data point on all open
graphs. Changing the number of samples in the active list automatically updates ALL open plots.
For more details on the various Plots and their respective options, please refer to Chapter 4: Plots.

Table View
The Table View window is loaded when you select View > Table View from the main menu. You can then load any of the previously created table views, or use the Create option to design a new Table (spreadsheet) View.
For more details on the Table View options, please see the View > Table View section in Chapter 3.

Reports Window
A Report window provides reported and/or calculated information for a selected sample, group of samples, or all active samples in the database. The reports can be produced by selecting a sample from the active list and then selecting one of the report types from the Reports Menu option.
The text reports can be edited, printed, or saved to a .TXT, .CSV or .XLS file. AquaChem generates several types of reports. Using the Report Designer, you can create and customize your own reports, to display whatever data and/or calculations you desire.
For more details, please refer to Chapter 5: Reports.

Tools
AquaChem provides you with the following pre-defined data analysis tools:
AquaChem Function
Decay Calculator
Find Missing Major Ion
Formula Weight Calculator
Volume Concentration Converter
Special Conversions
Species Converter
Unit Conversions
Calculate facies
Corrosion and Scaling
Oxygen solubility
There are also QA/QC checks, Look Up Tables, and options for the linking to the PHREEQC interface available under the Tools Menu. As well, there is a feature that allows you to create an input file for PHT3D modeling engine using the data entered in the database.
For more details, please refer to Chapter 6: Tools.

PHREEQC Interface
AquaChem includes a direct link to the USGS modeling program PHREEQC (version 2.12). You may also run the USGS graphical user interfaces (PHREEQCI or PHREEQC for Windows), giving access to more advanced options which are not available through the AquaChem interface.
For more details on PHREEQC and modelling, please refer to Chapter 7.

1.7 AquaChem Toolbar
This section describes each of the items in the AquaChem toolbar. Most toolbar buttons are context sensitive and react according to the active AquaChem window or dialogue. If there are
no options available for the selected window or dialogue, the toolbar icons may become grey and inactive.

The AquaChem toolbar is shown below.

For a short description of each item in the toolbar, place your mouse pointer over an icon and a hint will pop-up. The function of each toolbar item is described below:

- New button creates a new database (only available if no other database is open)
- Open button opens a database (only available if no other database is open)
- Save button saves the current database file
- Print button prints a plot, table, or a report
- Copy button copies currently selected data, or copies a plot to the Windows Clipboard
- Cut button cuts currently selected data
- Paste button pastes currently copied (or cut) data
- Edit button edits selected sample/station
- Create button creates new sample/station
- Delete button deletes selected sample/station
- Find button finds samples/stations
- Options button loads the options for sample/station list, Table View options, Report, or Plot window
- Show all button shows all samples/stations in the active list
- Omit all button hides all samples/stations in the active list
- Show only selected button hides all samples/stations in the list that have not been selected
- Omit selected button hides all selected samples/stations in the active list
- Zoom out/Zoom in buttons are used to change the zoom extent in the Map and other XY plots
- Identify button identifies sample data used on the selected plot(s)
2 Getting Started

This chapter is designed to serve as a 'quick-start' reference guide for those interested in getting started quickly using the most common features of AquaChem. You will follow a sample set of instructions, using the same data set that was used for the Demo database.

To begin, this chapter has been divided into sections for your convenience - feel free to read through the entire chapter, or jump directly to a section of interest.

Creating a New Database
- Importing Data
- Assigning Symbols
Creating Plots
- Plot Options
- Printing Plots
- Exporting Plots as Graphics File
Creating Reports
- Saving Reports
- Printing Reports

2.1 Creating a New Database

When you first load AquaChem, an Open Database dialogue will appear. You have the option of loading an existing project, or creating a new project.

To create a new project, press Cancel when this dialogue appears.

After pressing Cancel, you will see a blank AquaChem window indicating there is no database loaded.

To create a new database:
Select File / New from the main menu. A New Database dialogue will appear as shown below.
Browse to the appropriate folder
Type in the name of the new database, and click Save. (For this demonstration, the file will be called Sample.aqc).
You will then see the following New Database confirmation dialogue.

Below the New Database Name field, in the Template field, you must specify a database template file to use for the creation of your database. If you are a new user to AquaChem, it is recommended that you use the Template_Basic.TPL file as the starting template for your database (the default). After becoming more experienced with the program, you can create new templates and use these for future databases.
Click OK once you are finished entering the database (.AQC) and template (.TPL) name.
NOTE: It is recommended that database filenames contain a combination of letters and numbers only. The filename and directory path should NOT contain spaces, accents, or other special characters.

AquaChem will then automatically create a blank database file using the associated database template file containing the data structure for each record in the database. A blank database is shown below:

At this point you can begin to enter your sample data into the database. You have two options for data entry:

- Data can be entered manually or
- Data can be imported from file(s)

If you enter your data manually, be sure to first create a minimum of one station, so that you have a pre-existing station to assign to your samples.

The most convenient option for large data sets is to import the data from a text file; this will be demonstrated in the next section.

If the data is imported, the station data can be imported the same time as the sample data or separately.

Before proceeding with the import option, you should ensure that your source file containing your water analysis data is properly formatted. For your convenience, an Excel template is provided with AquaChem, which includes the most common Sample and Station parameters. This file is called template_2010.XLS and can be found in the root AquaChem installation.
folder. If you wish, you may use this file for your data set. Simply enter your data, then Save the Excel file under a new name and then import your data to an AquaChem database.

2.1.1 Importing Data

To import sample data into your AquaChem database, please follow these steps:

- Select File / Import / Samples/Stations from the main menu
- Select button beside the File field to locate the source file
- Browse to the ImportData.xls (located in the Programs Files\AquaChem directory) and select Open

By default the Format selected is Samples as Rows - and for this demonstration, the Samples as Rows mode will be used.

The remaining import options can be left as is.

Select Next.
In the next dialogue, AquaChem requires you to match the fields in your file to the required AquaChem parameter fields. For the ImportData.xls file, the column headings have already been prepared such that they precisely match up with the required AquaChem field headings. Therefore, there is no need to do manual matching. However, if there are blank fields in the AquaChem column, then this indicates that the parameter names in the file are not identical to the AquaChem parameter names, and the fields could not be identified. For example, if the file contained the parameter name ‘pH', you must match this up to the AquaChem parameter pH_field or pH_lab (whichever is appropriate).

If necessary, please refer to the Import section in Chapter 3 for more details on matching parameters during the import.

Select Next.

The next dialogue contains a list of the AquaChem parameters which were not matched up to parameters in the source file. This dialogue allows you to enter constant values for these parameters (optional). For example, if all of the imported samples belong to the same project or the same location and this information is not included in the source data file, you may fill the respective fields during this step of the import. To skip this step, leave these fields blank.
For this example we do not need to map anything.

Select Next.

The data will being importing. You will then see the following warning prompt:
This option allows you to automatically create one symbol for each unique station in the imported source file. These symbols will be created in the Station symbol group. This is a very helpful feature, which can aid in plotting your sample data later on.

Select No to pass on this feature.

The last dialogue in the import options, contains a summary of the import routine and gives you the opportunity to use the [Save] button to save the import settings. Please check that all of your samples, stations, and parameters have been successfully imported.

Select Close.

After successfully importing the data, you will return to the main database window showing your active Samples and Stations. For this data set, there should be 4 stations, with 7 samples taken from each station location, for a total of 28 samples.
The next section will go through assigning symbols for your data.

### 2.1.2 Assigning Symbols

The next step to building a new AquaChem project is to assign symbols to your samples. By default, a new database will include several symbol groups - for example a Default symbol group with just one symbol assigned to each sample, and a Station symbol group, with a unique symbol for each unique station in the database; the station symbols are automatically assigned to the appropriate corresponding samples. You may create new symbol groups, or add symbols to one of the existing symbol groups.

For this demonstration, you will add symbols to the Default group. Follow the instructions below to create new symbols.

Select Plots from the main menu and then select Define Symbol or Line and ensure the Default symbol group is selected.

Select the button and a new field will be added to the list of symbols:

Type: MW-1 in the new line that is added

You will now add three more symbols:
Select + button
type: MW-3 (for the new symbol)

Select + button
type: OW-2 (for the new symbol)

Select + button
type: OW-4 (for the new symbol)

Once you are finished, you should have five symbols listed for the Default symbol group, as seen in the figure below.

Next you need to define the necessary symbol properties:

Select Symbol #2 (MW-1) from the list
Select Edit button
The Default Symbols dialog will appear on your screen.
Simply click on the desired new symbol shape.

Choose a Color for the new symbol. To access the color options press the button beside the Color field, and select a color from the list of available colors. This will be the line color - you also need to select a fill color.

Choose a Size for the symbol; the font sizes are available from the combo box beside Size. (Recommended size is 12pt.)

Select Close button, once you are finished.

Repeat these steps for the three other new symbols that were created to match the selections as shown below.
Once you are finished creating the symbols and defining the symbol properties,

Select Apply
Select Close

In your active samples list, you are ready to assign these symbols to the samples.
Select the first seven samples in your sample list. To do so, click on the first sample, hold down your left mouse button, and drag your mouse down to the 7th sample.
Select Assign Symbol from the main menu under Samples.

The Assign Symbol dialogue will list the available Symbol group names and the corresponding symbol, as defined earlier.
Select the second symbol 02 - MW-1.
Select Assign.

You will now assign symbols to the next group of samples.

Activate the Sample list and select the samples from the MW-3 Station- samples 8 to 14.
Select the third symbol 03 - MW-3.
Select Assign

Repeat these steps to assign symbols to the remaining samples for stations OW-2 and OW-4.
Close the Assign Symbol dialogue by clicking the [Close] button when you are done.

Once you are finished, each of your samples should have a corresponding symbol which relates to the location of that sample. In the active list of samples, there is a column heading
Symbol which indicates the Symbol group that is assigned to each sample. You should see Symbols 2, 3, 4, and 5 in your sample list, as shown below.

The samples are now ready to be plotted.

### 2.2 Creating Plots

AquaChem allows you to plot your sample data numerous different plot types. For this exercise, you will create a simple Piper plot which distinctly shows the four different sample groups. For more details on the AquaChem plots and the plot options, please refer to Chapter 4.

In the Sample Lists,
Highlight all samples in the list, by selecting the first sample in the list and dragging the mouse down the list while holding the left-mouse button.
Select Plots from the main menu, then select New and then Piper

A Piper Plot Options dialogue will appear with default plot settings. The following section describes some of the generic plot options.
To create the plot using the default plot options, click [OK].
The plot should be created similar to the one shown below:
You can modify the plot options by right-clicking on the plot to load the Plot options dialogue. If you are satisfied with your plot, proceed to the next section titled Printing Plots.

**Plot Options**

There are many common graphical features and options for each plot. When you select any of the graph types to plot (for example Piper plot), a plot options dialogue will appear with default settings for all of the necessary parameters and settings. For most plot types, the Plot Options dialogue contains links to the following dialogues: Parameters, Title, Symbols, Label, Axis, and Legend (not all dialogue options are present on the Piper plot options dialogue. For more information, see Chapter 4)
The main Plot Options dialogue contains information on the parameters/series used in the plot and provides the link buttons to access various dialogues described below, which are used to customize the plot.

**Title Dialogue** - contains options for Plot Title font size, Position, and Alignment.

**Symbols Dialogue** - contains options for symbols used in the plot, Visibility, Scaled Symbol Size options, etc.

**Legend Dialogue** - contains options for displaying a Plot Legend, Legend Title, and display features.

**Labels Dialogue** - contains options for data point labeling and positioning.

**Axis Dialogue** - contains options to customize the axes.

**Line Dialogue** - contains options to add and customize lines on the plot.

### Printing Plots
Once you have prepared the desired plot(s), you are ready to print.

Select File from the main menu and select Print, or click the Print icon in the tool bar.

You should then see a Print Options window, as seen below.
The Print Options allow you to choose which plots will be printed, their position, size, and which plot template will be used.

A list of Available Plots will appear in the upper-left corner of this window. This list represents the plots which are currently open in AquaChem. Select the plots you want to print by placing a check mark in the box beside the appropriate plot name. The piper plot is already selected by default.

If you have generated several plots you have the option to order them by station by select this check box under the list of available plots.

The plot will be automatically sized to fit the page layout. If the default page settings are not suitable, you can manually change the position of each plot using the options provided in the Axis tab (Length and Origin).

If you want to display plots on several pages proceed as follows:

Enter the number of plots per page.

You will be asked to confirm the number of rows and columns on your page. For example, if you wish to display 8 plots and you enter 2 rows and 2 column, the plots will be distributed on 2 pages.
Next, you can select the page layout by choosing a print template. The print template will allow you to enter information on the page footer such as project information, sample information, and company information.

Under the Page Layout options (on the left side of the window), you will see the default template setting is US-Letter-Portrait. Select from the combo box to see all available templates.

You can see a list of plot descriptors in the Page Layout dialogue. They are linked to the fields on the report and you can see the changes made as soon as you leave the field you were typing in:

Next, you will fill in the project specific plot description fields under the Page Layout options. Press the <Enter> key after each entry:
DESCRIPTION:
type: Piper plot of samples collected from 1992 to 1998
PROJECT:
type: Sample Project
PROJ #:
type: 2010-1
CLIENT:
type: Client’s name.
DATE:
type: Current date
NOTE: The logo shown in the bottom of the page can be easily replaced with your own company logo. This is done using the Template Designer option, which can be accessed by clicking the button beside the Template combo box. This option is not explored in this exercise. For more information, please refer to Template Designer section in Chapter 3.

Next, if you have added a legend to your plot, you can add this legend to the printed page, and position it on the page.
Select the Legend tab (below the list of Available Plots, and beside the Axis tab).
Select Visible (click once in the check box) to activate the legend for the Piper Plot.
The Piper plot legend will appear in the upper-left corner of the page. To move the legend,
Select X-Axis field and enter a value of 15.
Select Y-Axis field and enter a value of 25.

If you have loaded the plot successfully, your display should be similar to the one shown below:
Select the Print button (in the lower left corner) to send the plot to a printer.
Select Close button to close the print options window and return to the AquaChem active samples list.

Exporting Plots as Graphics File
Upon returning to the main AquaChem window, you will see that the active sample list window is open, and you should still have the Piper Plot window open. In addition to printing the Piper plot, you will now save this plot as a graphics file so that it may be inserted into an external report.

Select the Piper plot window to make this the active window
Select File from the main menu, and then choose Export, and finally, Image.

You will then be prompted to enter a filename for the plot. Browse to the desired folder on your computer, then enter a name for the file. For this demonstration, you will save the file in the AquaChem folder.

**type: Piper as the filename for the plot**
Select Save

The plot will be saved as a .WMF (Windows MetaFile) graphics file. This file can be opened using most conventional graphics editors, or the file can be directly inserted into a word processor application.
2.3 Creating Reports

AquaChem allows you to choose from 9 data analysis reports and perform 6 different statistical tests on your data. For this demonstration, you will briefly examine the generic Report options and create a Statistics Report. The Summary Statistics report provides a statistical summary of selected parameters for all active samples in your database. For more details on Reports, please refer to Chapter 5.

To create a Summary Statistics report for all samples in the active list:

Select Reports from the main menu and then choose Statistics, and finally Summary Statistics.

A dialogue will load that will allow you to customize your Summary Statistics report. This dialogue contains four tabs: Parameters, Statistics, Options, and Data.

Parameters tab
The first tab that loads will allow you to specify which parameters you wish to use in your Summary Statistics report.
For this example, you will add benzene, Sum of Anions and Sum of Cations to the list of parameters.

Select button
Select Measured Values from the combo box.
Select Benzene from the list of parameters.
Click the Select button
Select Calculated Values from the combo box at the top of the dialogue.
Select Sum of Anions from the list.
Click on the Select button
Select Sum of Cations from the list.
Click on the Select button
Select Close

If you wish to add more parameters, you can do so in the manner described above.
To remove a parameter from the list,
Select the parameter to be removed
Select the button
Once all parameters are selected, you can chose what statistics to perform.
Select the Statistics tab.

Statistics tab
The Statistics tab allows you to select the summary statistics that will be performed on the data for the parameters you selected in the previous tab.
For this example, leave the statistics that are selected by default, however if you wish to add more statistics you can do so in the same manner as adding parameters. Selecting certain statistics will require you to enter additional information. For example, when selecting the Quantile statistic (QUANT), you will need to enter the percentage of the quantile. When you are finished, move on to the Options tab.

Options tab
This tab allows you to select the output orientation (parameters as rows/statistics as columns or parameters as columns/statistics as rows) as well as providing you with the option to Break by symbol. If this option is selected, the summary report will be generated for every group of samples that bear the same symbol, i.e. every station in this example.
For this example, check the box beside Break by symbol and move on to the Data tab. This will create separate statistics for all samples assigned to the same symbol.

**Data tab**
The Data tab provides a preview of the data that will be used for the summary statistics report.
Select OK button.

The Statistics report window should be shown on your display, similar to the one below.

The minimum, maximum, arithmetic mean, as well as other values of interest will be calculated for the selected database parameters.
Once you are finished, you can Save or Print your report.

**Saving Reports**

Reports can be printed or saved to multiple file formats. The supported file formats are .XLS, .TXT, and .CSV.

**NOTE:** The pre-defined reports in AquaChem can be saved as .XLS, .TXT, and .CSV. The user-defined reports (e.g. Sample Summary Report created using the Report Designer) can be saved as .HTM or .RTF format.

To save the report,

- Select the Save button at the bottom of the report window
- Type: a filename for the report
- Select the file type
- Select the Save button

**Printing Reports**

To print any of the reports,

- Select the Print button at the bottom of the Report window; or
- Select File from the main menu and then select Print, while the report window is active.

The Report will then be sent to your default Windows printer, or you may select another printer.

- Select the Close button located at the bottom of the Reports window, to close the window and return to the main AquaChem window.
3 AquaChem Menu Commands

This chapter describes each of the items on the AquaChem menu bar. Similar to the AquaChem Toolbar, the menu is context sensitive and main menu items are available only when the active list window is the currently selected window. In addition, menu items will become grey and inactive if there are no available for the current mode.

In this chapter, you will find information on:
File Menu.
Edit Menu
View Menu
Filter Menu
Stations/Samples Menu
Plots Menu
Reports Menu
Tools Menu
Window Menu
Help Menu

Following the menu items, you will find a section on the AquaChem database, which covers the database options that are available for your AquaChem project. The following sections explain the menu commands in detail.

3.1 File Menu

3.1.1 New
The New option is only available when no other database is open. In order to activate this option, you must first close any database files which may be open.
The New command creates a new empty database based on a database template. The template is an empty database that contains all necessary data tables, parameters, settings, etc., but does not contain sample or station data. When you create a new database, the database template is copied to the specified filename and location. Choosing a database as a template simply means that you will find the same Sample/Station Parameters and Settings in the database as there are in the selected template.

You will find two default database templates under My Documents/AquaChem folder: Template_BasicTPL is normally used to create a new database file. Template_AdvancedTPL is for more advanced users

AquaChem lets you save and use any valid AquaChem database as a template.

Creating a New Database
Follow the steps below to create a new AquaChem database file:
Start AquaChem and press Cancel when prompted to open a database. (Or if you already have AquaChem opened, close the current open database by selecting File / Close).
Select New from the File menu, and the New Database dialogue will appear as shown below.
Browse to the appropriate folder. The default folder is under My Documents / AquaChem. Type in the name of the new database, and click [Save]. You will then see the following New Database dialogue.

Below the database filename, you must specify a Database Template to use for the creation of your database. By default, AquaChem will use the Template_Basic.TPL file which is included with your installation. This template contains the same data structure as the demo database. When you first start using AquaChem, this will be the only database template file available, and in most cases this template file should be adequate. If you have other database templates available, click the button to browse and select a .TPL file to be used for your project.

Once you are finished entering the .database (.AQC) and template (.TPL) name, press [OK].
**NOTE:** Database filenames should be a combination of letters and numbers only. The filename and directory path should NOT contain spaces, accents, or other special characters.

AquaChem will then automatically create a blank database file (with .AQC extension) using the associated database template file containing the data structure for each record in the database. An example is shown below:

If you use the Template_Basic.TPL file, then your data structure may contain some parameters which do not apply to your data set, while others, which you might need, may be
missing. Use the File / Preferences / Database Parameters options to modify the available parameters in the template. These options are explained later in this chapter.

Open
The Open command opens an existing AquaChem database. When you select this command, the following dialogue should appear:

You may open an .AQC file from AquaChem v.4.0 or later. AquaChem no longer supports direct opening of projects from version 3.7 or earlier. To retrieve data from such a project, it has to be exported to a text, MS Access, or MS Excel file and then imported into a new AquaChem database.

NOTE: You may open a database which resides on a network computer. However, only one user should access a database at a time. If you have created you database with a previous AquaChem version modifications will be applied to your file during opening. You will be informed a backup copy of the original database is created.

After you have selected the desired database, click Open to load the file into AquaChem. You may also open a database by picking the file from the recent file list, under the File menu.

The Open database option is only available when no other database is open. In order to activate the Open command, you may need to first select File / Close to close the opened database.

Close
The File / Close command will close the current database. This will allow you to open other databases, or create a new database.

**Save Database**
Saves the database, or allows you to save the database under a different name and directory. The database file is saved with the extension .AQC.

**Save as Template**
This option allows you to save the current database settings to a database template (.TPL) file. This new template can be used when creating future databases having the same structure and settings as the currently loaded database.

The Template_Basic.TPL file is used only in the initial step to create a database. Similar to a word template which you use to create a new word document, the document is completely independent of the template after the document is created. After the database is created, the Template file is no longer needed. You may add, remove, or change parameters and properties; all properties are stored in the .AQC database itself. If you want that new databases use identical settings as your current database, Do not delete or rename the Template_Basic.TPL file, since it is the default database template.

The Save as Template command is only available when a database is open, and the Active List window is active.

**Import**

**Sample/Stations**
The import option allows you to import Sample and Station data into your AquaChem database. This option is only available when the sample/stations list window is the active window. The Import routine is separated into four simple steps. When you select File > Import from the main menu, the following dialogue will appear:
The source data file must be a text file with the data separated by a tab, semicolon, or comma (extension .TXT, .PRN, or .CSV), an MSExcel file (extension .XLS), or an MSAccess 2000 database table or view. When using a character other than a tab (e.g. a comma or semicolon), ensure that this character does not exist in any of the text fields in the file. To load the data file, simply press the button beside the File field.

The file format is specified beside the Format field. Use the combo box (as shown below) to select the appropriate file format.

The source data file may have the following formats:
- **Samples as Rows** - each new row represents a new sample, parameters are listed in columns.
- **Samples as Columns** - each new column is a new sample, parameters are listed in rows. The only constraint of this format is that one row has to contain the StationID information for the station for which the sample was collected.

- **One analyzed value for each Row** - each new row contains new measured values. The minimum information that has to be provided in each row is as follows: SampleID (being unique for each Sample), StationID, Parameter name, value, unit (where valid units are: mg/l, ug/l, ng/l). Typically, this format will thus contain further columns with analysis metadata such as MDL (method detection limit), method used for the measurement (Protocol), Precision of measurement, etc. These meta parameters are, however, not required in the import file.

- **Station Data only** - import just the Station Description fields, such as X, Y, Z, Location, Station Name, Well depth, etc. This can be useful if your source data for stations and measurements is kept in separate files. It is then recommended that you import the station data before analysis results. If you select this option, each station must be in a separate row.

- **NWIS Stations** - import station data from the National Water Information System (NWIS) file format (*.txt).

- **NWIS WQ** - import water quality data from the National Water Information System (NWIS) file format (*.txt). Note: Be sure to import the corresponding stations before importing WQ data.

- **PHREEQC Output** - import PHREEQC output data as AquaChem samples. For more information on importing PHREEQC output data, please refer to "Importing PHREEQC Output".

**Note**: NWIS (http://nwis.waterdata.usgs.gov/nwis/) is a large network covering the United States of American, and provides access to water-resources data collected at approximately 1.5 million sites in all 50 States, the District of Columbia, and Puerto Rico.

**Note**: Depending on the format, the first row (or column) must contain headers. Optionally, the subsequent rows may contain the unit or the CAS registry number allowing a more accurate matching of the database and import parameters.

The next step in the Import Options dialogue is to specify the row at which to start importing. This option allows you to exclude the first row(s) if it contains header and/or unit data.

AquaChem also provides you the option to identify and match CAS Registry numbers (Chemical Abstract Services). If this option is enabled, AquaChem will use the CAS Registry number rather than the parameter name to match parameters from the import file to the database. In order to use this feature, specify the row (or column) of the import file that contains the CAS registry number using the up/down arrows. Also, the registry number must be specified in the AquaChem database parameters.
This feature is useful if the import file contains many organic contaminants, which often are named and spelled differently, resulting in an unreliable match between the database and import file when using names only. The CAS Registry number is unique for any registered chemical substances and therefore all parameter matches are effectively realized. It must be noted, however, that the CAS numbers exist only for chemical parameters. Parameters such as TDS, pH, BOD, etc., do not have CAS numbers. If you do not have CAS numbers in your file, then leave this box unchecked.

The import routine has an option to Check for existing Samples; this will allow you to add data to already existing samples in your database. When this option is enabled, AquaChem will check for existing SampleIDs in your project database, and if an identical SampleID is found in the database, the import data will be written to the corresponding sample. If the import field includes data which is already in the database, the data in the database is automatically overwritten. This feature is useful, if data for the same dataset has been analyzed by different labs and must be imported from different source files. If the Add all imported records as new samples option is enabled, every record in the import file will create a new sample in the database, regardless if an identical SampleID exists or not. Please note that this may lead to duplicate samples being created in your project database.

Example
To import a data file into your AquaChem database, please follow these steps:

**Hint:** Before proceeding with the import option, you should ensure that your source file containing your water analysis data is properly formatted. For your convenience, an Excel template is provided with AquaChem, which includes some of the most common sample and station parameters. This file is called Import_Template.XLS and can be found in your AquaChem installation folder. If you wish, you may use this file for your data set. Simply enter your data, save the Excel file under a new name and proceed with the import options.

Or, you may use the ImportData.xls file as a guide; this file is also included in your AquaChem installation folder.

**Step 1: Data Source File**
Select File / Import from the main menu.

Press the button beside the File field to locate the source file.
Browse to the appropriate folder to locate your source file then click [Open]. Note: If your source file is an Access Database (*.mdb) file, you will be prompted to select the appropriate table or query that contains the source data.

Your filename should now appear in the File field, and a preview of the file should appear in the lower section of the dialogue.

Select the import Format for the source file (Samples as Rows or Samples as Columns, etc.). For this demonstration, the Samples as Rows mode will be used.
Select the row from which to start importing.
Enable or Disable the option to Match CAS #s.
Choose the import option to replace or append the existing samples.
Once you have entered the necessary details in the first import options dialogue, press the Next button to proceed.

**Step 2: Match Parameters**

The next step in the Import data options is to Match Parameters. The Match Parameters frame contains a table listing the Column numbers, the Source text file headers, the Units in the text file, and corresponding AquaChem parameter Internal Key values, as shown in the following Import Options dialogue.
There is also an option to apply a multiplication Factor to the incoming data set. A multiplication factor is needed if the species for the same parameter do not correspond. For example, if Silica is expressed in the import file as mg/L Si and as mg/L SiO2 in the database. In order to calculate the transformation factor for the respective species you may use the Species Converter, available in the Tools menu.

In this dialogue, you are required to match up the data in the source file to the appropriate AquaChem parameter labels. If there are blank fields in the AquaChem column, this means that no match parameter was found in the database. This may be due to the lack of this parameter in the database, or that the parameter is spelled differently in the Source file. If the cell stays empty, the respective parameter will not be imported. For example, if your text file had the parameter name Conductivity, you must match this up to the AquaChem parameter Internal Key name Cond. Blank fields indicate that AquaChem has not found a matching parameter in the database. If a matching parameter should exist but might be spelled differently than in the data source, you may select it using the steps below:
Double-click in the grid cell under the Aquachem column and a combo box will appear listing all of the available parameters in your AquaChem database.

Select the appropriate parameter to match to the import Source File column. This will correctly link the parameters in the source file to the parameter names in the AquaChem database template.

If the parameter to be imported is not included in the database, it may be created prior to importing. Select <create> from the available list. An AquaChem database parameter will be created for every Import parameter that has been mapped to <create> when you click the [Next] button. You will be prompted to enter the required information for each parameter to be created in such way.

Repeat this step for each parameter in your source file which has not been correctly mapped to an AquaChem database parameter.

**Hint:** If the field names in the file are identical to the field names in the AquaChem database template file, the parameters will be mapped automatically to the AquaChem column. Therefore, if you format your source file correctly prior to importing, you can save some time in this step.

AquaChem allows you to import concentrations in the units which may be different from the ones specified for this parameter in the database. These values will be converted to the units used in the database during the import. Unless otherwise specified, the units used for that parameter will be identical to those specified in the database parameters options (under File / Preferences). To change the default units, double-click in the corresponding grid cell under the Units column and you will see a selection of available units (g/L, meq/L, mg/L, mmol/L, mol, ppm,
umol/L, ug/L). Select the desired unit, and repeat this for other parameters as needed. The values will be converted into the project units.

Once you have mapped all units and parameters, press the Next button to proceed. If you have at least one Import parameter mapped to <create>, the following dialogue will load:

![Create Field Dialogue](image)

Fill in the appropriate data and click [OK]. Make sure you select the appropriate parameter type using the Type combo box at the top of the dialogue. You may later edit these options later on in File>Preferences>Database Parameters. Click [Select] to copy predefined information (CAS number, formula) from a list of predefined parameters. The most important value that needs to be provided is the parameter name. Other values can be specified after the import. If more than one parameter was mapped to <create>, AquaChem will present a new dialogue for each parameter, which was marked with the <Create> flag.

Once the last parameter was created, the dialogue will close and you will move to the next step of the Import routine.

If the data does not appear to be correct, press the <Previous button to return to the previous step.

**Step 3: Unmapped Fields**
The next dialogue contains a list of the AquaChem parameters which were not matched up to parameters in the source file (ie. Unmapped Fields).
This dialogue allows you to enter constant values. For example, if all of the imported samples belong to the same project or to the same location, but this information is not included in the data, you may fill the respective fields automatically with the specified value during this step of the import. For example, you may read the data from a file called MW-1.xls indicating that all samples were taken from well MW-1. In this case, you would enter "MW-1" as a constant value for location. To skip this step, leave these fields blank.

To proceed to the last step in the import routine, press the [Next>] button. To return to the previous step, press the [<Previous] button.

Upon proceeding, you will then see the following prompt:

This option allows you to automatically create one symbol for each unique station in the Station symbol group and assigns this symbol to the appropriate samples.

Select Yes to accept this feature, or No to ignore this option.

**Step 4: Result Screen**
The last dialogue in the Import options is a summary of the results of the data import.
The Result Screen dialogue shows the Number of new Samples and Stations that were successfully imported, and the Number of parameters that were successfully mapped and imported.

Before closing the import routine you can save your import settings by clicking the [Save] button. This option allows you to save the import settings (file format, mapped parameters, units, factors, and constant values) for future use. When you click the [Save] button you will be prompted with a Save Import Configuration dialogue as shown on the right hand side. Simply enter a name for the import configuration, click [OK] and then [Close]. After successfully importing the data, you will return to the main database window showing your active samples and stations. This concludes the necessary steps for importing data.

Once you are finished, press the [Close] button.

**Importing PHREEQC Output**

AquaChem can import files in PHREEQC selected output format. This is useful if you generated a number of simulations for example by mixing two samples in different proportions and you wish to save the simulations as AquaChem samples so that you can use the program’s plotting and reporting capabilities to analyze the results. Prior to this import, the database must include at least one stations, and all parameters in the PHREEQC output file must exist in the database parameters within AquaChem. To confirm that the required database fields exist in the database, or to add fields to the database, navigate to the Database settings by selecting File > Preferences from the main menu, and then selecting the Database Parameters option.
To import the PHREEQC output file, follow the steps below:

Selecting the Data Source
From the main menu, select File / Import / PHREEQC Output
The Import Options dialog box will appear on your screen.

Click the [...] button located beside the File field, and select the desired PHREEQC output source file.
From the Format combo box, select the PHREEQC Output option.
Select which row to start importing data from

Choose to add the imported records as new samples, or overwrite existing samples in the database using the appropriate radio button.
Click the Next button.
Assign Station & Map Fields
The following dialog will appear on your screen:
Click the [...] button, and select the associated station from the list of stations.
Type a comment describing the simulation results (optional)
Under the Import tab, using the horizontal scroll bar, scroll across to the far right of the preview table. In the far right column, labeled "Select", select the desired samples to include in the import. You can use the combo box located below the table to make automatic selections from the table, e.g., Select All, Select Solutions only, etc.

Click the Map Fields tab. Map the PHREEQC output fields to the appropriate fields in the AquaChem database. Note: AquaChem will automatically map fields that have the same parameter name.
Click the Next button

Viewing Import Results
The data will then be imported. Once finished, the results screen will appear displaying the number of samples imported (shown below).
Click the Close button to close the Import dialog.

**Time Series Data**
AquaChem allows you to import non-chemical time series data, i.e., water levels, precipitation, evaporation, etc., from Microsoft Excel spreadsheets (.XLS).
(Please be aware that *.xlsx file formats are not currently supported).
Once imported, the time series data can be plotted independently and compared with chemical data on time series plots.
To import non-chemical time series data, select File / Import / Time Series Data, from the AquaChem main menu.
The following dialog will appear on your screen:
Selecting the Source File
Select the [...] button beside the File field to specify the desired source file. A preview of the data will show in the Preview Data table below. Please consider the following when importing time series data:

The source file must contain the following columns: Legend, Date, and Value.
- The Legend column contains a descriptive label for each row which will be used for showing on plot legends, e.g., Precipitation, Water Levels, and for distinguishing groups of data within the same time series table.
- The Date column contains the date for each measurement in MM/DD/YYYY format.
- The Value column contains the measurements of an attribute, e.g., precipitation, water levels etc.

Each column in the source data should have a header row, e.g., Legend, Date, Value. Any rows that contains a blank value for one of the above columns will not be imported. Click the [Next] button to proceed to the next step in the import process.

Matching Columns
Specify a Series Name by selecting the green plus and a brief description of the time series data. Please note that the Series Name will be used to identify the time series when plotting the data on a time series plot. It is recommend that you create a new table for any distinct data type, such as water levels, participation, pumping etc.
The next step involves mapping the fields in the source data to the required fields in the AquaChem database, and assigning the appropriate data type to each field.

Under the Match column, select the appropriate destination field for each field in the source data. You must specify a field for Value, Date and Legend. For example, the date field in the source data should be matched with the Date field, and the measurement field should be matched with Value field. The Legend field should be assigned to a column in the source data that contains a descriptive label, e.g., Water Level. This label will be displayed on the time series plot legend.

**Note:** Each time series may only have one Value field (measured attribute). Additional attributes must be imported as a separate time series.

Once the fields have been mapped, select the Next> button.

The Results dialog will appear, displaying the number of imported records. Click the Close button to complete the import process.

The imported time series can now be viewed in AquaChem by selecting Tools > Lookup Tables > Time Series from the main menu.

For information on showing time series data on time series plots, please refer to "Time Series (Multiple Parameters)".

**Page Template**
This import option allows you to import Report Page Templates from other AquaChem projects. First specify the AquaChem project file (*.aqc) you want to import a Page Template from. Then select from the list of Page Templates which layouts you wish to import (you can select more than one) and choose the Select button.

![Import Layout](image)

You will find the imported Page Templates in the Template Designer.

**Plot Layout**
This import option allows you to import Plot configurations from other AquaChem projects. First specify the AquaChem project file (*.aqc) you want to import a Plot Layout from. Then select from the list of Plot Layouts which you wish to import (you can select more than one) and choose the Select button.

**Export**
The Export option allows you to export the data or plots for use in other applications such as Visual MODFLOW and Hydro GeoAnalyst. The Export command is only available when the Active List window or a graph window is currently active.

**Image**
When any graph window is active, the File / Export / Image option is available. Clicking this option will load the following dialogue:
You have the option of saving the image in .WMF (Windows metafile) format.

**ESRI Shapefile**

This option is available only when you have the Active Samples list or a Map plot active and it allows you to export the data as an ESRI shape file (.SHP).

If the Active Samples list active, selecting this option will load the following dialogue:
Use the button to add parameters to export (X and Y coordinates are selected by default and cannot be removed).

To create the destination file, click the button beside Filename field. The following dialogue will load:
Type in the name of the destination file that you wish to create and click [Save]. You will be returned to the previous dialogue and the File name field will now be filled with the appropriate address.

Click [Export] to export this point theme shapefile. The values for all specified parameters will be included for every point in the attribute table.

If a Map plot is active, selecting the File / Export / ESRI Shapefile option will produce a point or a polygon theme shapefile depending on the currently active symbol type. If the map shows a plain symbol, scaled symbol or a pie plot, then a point theme will be created holding all the chemistry per point in the attribute table. For example, for a pie plot - all parameters; for a plain symbol - just StationID. If the map plot shows a Stiff or Radial diagram per sampling point, then the respective diagrams are exported as polygons, along with the current symbol label, and the data attributes. Since these polygons are defined in map coordinates, you should optimize the symbol size in AquaChem according to the final map scale in Hydro Geo Analyst or ArcView.

Type in the name of the destination file and click [Save] to export the file.

**Data**

This menu item is available when the Active Samples list or a plot is active.

To export your sample/station data, select File>Export>Data while the Active Samples list is active. The following dialogue will load:
Data may be exported in 2 formats: Samples as rows and One parameter per row. These options are available under the Options tab. The One parameter per row format means that for each parameter the stationid, sampleid, value, unit, analysis comments, precision, MDL will be exported. This allows you to export the complete information into an export file. However this format is less convenient if data is to be used for plotting, statistics, etc. In the case of the standard One parameter per row format, only the concentration value for each measurement result will be written to the export file.

By default, all the parameters are selected and will be exported. To remove parameters from the export, highlight the parameter you wish to remove and click the button.

To add parameters to the list, click the button and select from the parameters list that loads.

You may choose the parameter names or the parameter labels to be used as headers in the destination file. Parameter labels are a good choice if you wish to create a table or a presentation. Parameter names should be considered if the exported table should be reimported back into a different AquaChem database, as the parameter names will match automatically.

Click the button beside the File name field to create the destination file. The destination file can be of type .PRN, .TXT, .CSV, and .XLS. You may view a Preview of the exported data under the Preview tab. Once you are finished, click the [Export] button to generate the file.
You may also export data that was used to generate a specific plot. This feature is useful if you wish to use this data in another plotting program. To export plot data, select the plot you wish to export the data for and then select File>Export>Data. Once a window containing the pertinent data loads, you have a choice of printing the data or saving it as a .TXT, .CSV, or a .XLS file.

**MODFLOW**

The Export / MODFLOW option will export your current sample and station data to a space-delimited text file. The data can then be used for the input (concentration observation well data) of a Visual MODFLOW groundwater model.

To export the data:
Select File / Export / MODFLOW from the main menu.

Click the button beside To File to generate the destination file. This file can be a .TXT, .CSV, or .XLS file.

Select the Type of data to export. The default is Single Station/Parameter, however you may choose Multiple Stations/Concentrations as well. See below for a more extensive description of the second option.

Select the Start Date
Select the Target Time Unit
Select the Station to export
Select the parameter to export
Click Export to export the file

Each line in the generated file will have a time measurement and an observed concentration for a single parameter. The start date is used to calculate the time for the first observation.

**NOTE:** The Export button will become active only after the necessary options have been specified.

If you choose Multiple Stations / Concentrations format, then the dialogue shown below will appear:
Select the Start Date
Select the Target Time Unit
Select the stations you wish to export by checking the boxes beside them
Select the parameters you wish to export by checking the boxes beside them
This format is only practical if a Depth parameter value is available in your database. After selecting all desired information, the observation name is concatenated with the station code and depth in the resulting destination file.
Once you have specified the necessary settings, click the [Export] button to proceed and generate the export file. Press the [Close] button to close this dialogue and return to the main AquaChem window.

**KML File**
This option allows you to export Station coordinates and associated parameter data to .KML file, a file format supported by various geobrowsers, such as Google Earth. When a KML file is imported into Google Earth, each station is projected on a 3D globe as a single point symbol. Associated sample data may be viewed in a pop-up information box for each station.

**Note**: .KML format requires station locations in geographic coordinates, e.g., latitude and longitude. Therefore, if your station coordinates are currently expressed in a projected coordinates system (e.g., UTM), you must convert them to geographic coordinates (e.g., Lat/Long). This can be easily done using the AquaChem UTM conversion tool (see "UTM Conversion".)

To export data to KML file format, select File > Export > KML File from the main menu. The Export to KML File dialog will appear on your screen.
The Export to KML file dialog consists of three tabs:

1. **Data**
   Select the [...] button located beside the Filename field. The Export Data dialog box will appear, where you can specify the desired destination folder and file name for the .KML file. Use the + button to add parameters to the .KML file. When selected, the Parameters dialog box will load, where you can select one or more parameters in the AquaChem database. Please note, Coord_Long, Coord_Lat and Station ID are required parameters, and are selected by default. These parameters cannot be removed. If you wish to export sample data, be sure to add the Sample ID parameter.

2. **Options**
   The Options tab provides several export options for displaying data in Google Earth.
Choose the desired station symbology from the Map Symbol combo box. When the KML file is opened in Google Earth, each station will be displayed on the map using the specified symbol.

The Symbol Size text box allows you to specify the size of the Map Symbol, when displayed in Google Earth. Enter a value between 1 (smallest) and 10 (largest). Please note, the map symbols can be further customized using various options provided by Google Earth itself.

The Show Label allows you to enable or disable station labels. If this checkbox is empty, by default station names will not be displayed as labels in Google Earth. If this checkbox is "checked", a station name label will appear beside each station.

3. Preview
The Preview tab provides a preview the data that will be exported to the KML file. The data displayed in the Preview tab is read-only.
Once you have selected the desired parameters, and set the appropriate options, click the Export button to generate the .KML file. Upon exporting, you will be prompted to open the file in Google Earth. If you have Google Earth installed, click the Yes button to open the .KML file. If you do not have Google Earth, click the No button. The file can be imported into manually into Google Earth by selecting File > Open from the Google Earth main menu.

PDF File
This option allows you to export Plot reports to PDF file format.

Note: This option is only available when the Print Options window is shown on your screen.

To export to PDF file format:
Create the desired plots (Plots / New), or open a saved plot configuration (Plots / Open Configuration).
Select File / Print, from the main menu.

The Print Options window will appear on your screen. Configure the plot report as desired using the available options.
With the Print Options window open, select File / Export / PDF file from the main menu. The Export to PDF file dialog will appear on your screen. Specify the destination folder and the desired file name, and then click the Save button. Please note that you must have a version of Adobe Acrobat reader installed in order to view exported PDF documents.

Print
The Print command will load the print options for the current AquaChem window or dialogue.

The print icon in the toolbar serves the same purpose. The Print option is only available when one of the following windows is active:
- Plots
- Tables (Spreadsheet View), or
- Reports

Please refer to Printing and Exporting Plots section for more details.

**Template Designer**

Use the Template Designer to customize the pre-defined printing templates shipped with the AquaChem demo database, or to create new ones.

**Template Designer Interface**

When you select Template Designer from the File menu, the following window will appear:

1. Available Templates in the upper-left corner containing the Template Name and a combo box listing the available templates.
2. Template Details is located immediately below the Template Name field. This includes the controls and tools for designing templates, such as:
   - Lines,
   - Fields,
   - Labels
   - Graphics, and
   - Margins

The Template Designer dialogue has three main components:
1. Available Templates in the upper-left corner containing the Template Name and a combo box listing the available templates.
2. Template Details is located immediately below the Template Name field. This includes the controls and tools for designing templates, such as:
   - Lines,
   - Fields,
   - Labels
   - Graphics, and
   - Margins
3. Preview Window on the right side of the dialogue, containing a preview of the Template as content is added or modified.

The options in the Template Designer allow you to:
- Select the page size, orientation, and margins
- Draw lines and borders
- Define and position text block descriptors
- Position user-entry fields
- Add headers and footers, and
- Position and size bitmap graphics for a company logo
- Adjust the margins of the plot display area

The following section provides more details on the functionality of the template designer.

**Template Designer Controls**
The main controls and tools for the Template Designer are on the left side of the main dialogue (as shown in the figure below).

At the top of this frame, you will see a list of the available templates; you can select a different template from the combo box. AquaChem includes the following pre-defined templates:
- US Letter - Portrait
- US Letter - Landscape
- A4 - Portrait
- A4 - Landscape

In the Template Designer dialogue:
- Click the button to add a new item to the template.
- Click the button to delete the currently highlighted item.

Note that the buttons are common to each tab. For example, if you are in the Lines tab and you press the button, a new border line will be added. You can then proceed to enter the appropriate properties for this line in the fields below.

The button in the Template Designer dialogue will load a Template Name dialogue as shown below. It displays the full list of templates currently available and will allow you to create and name new templates.
In the Template Name dialogue:
Click + button to create a new template
Click - button to remove an existing template

To rename a template simply place your mouse cursor in the appropriate field, then enter a new text label. Once you are finished in this dialogue press [OK]. When positioning a line, field, or graphics, the X, Y page coordinates displayed in the lower left section of the main Template Designer dialogue can be helpful. These coordinates correspond to your mouse cursor location and can help you in the placement of the start and end points.

The [Duplicate] button will duplicate the currently selected template. The duplicate template will be named Copy of TemplateName, and the duplicate template will have the same layout and characteristics as the originally selected template. If it is your first time creating or customizing a Print Template, it may be easier to modify a duplicate copy of an existing template, than to start from the beginning. Please note that each Template must have a unique name.

**NOTE:** Although you have the option of modifying the default template designs, it is strongly advised that you either duplicate the selected template, or create a new blank template. This avoids damaging or losing the original template designs and ensures you will always have a standard set of default Print Templates.

When you press the [Page Setup] button, the following Page Setup dialogue will appear:
In this dialogue, in the upper Paper section you can define paper Size and Source.

In the lower Orientation section, you can define paper orientation and page Margins for the template. The page margins will correspond to the location of the page border. The page dimensions inside the margins will be used to automatically locate and size the selected plots.

You can also access your standard Windows Printer options by pressing Printer button. Once you are finished, press [OK] to return to the previous dialogue.

**Creating New Templates - Example**

The following section describes the options of the Template Designer, and how it can be used to build and customize your own templates. The brief instructions below tell you how to create a basic printing template, and how to customize this to your own preferences.

Click button to load the list of Templates.

Click button to create a new template.

Enter a name for the new template (e.g. "Sample-Letter" for these instructions).

Press [Close].

Choose this template from the combo box.

You will then see a new blank Print Template in the preview window. By default, all new templates include a border and default page settings.

**Creating Lines**
The first tab in the template designer dialogue is Lines. This tab allows you to create the Print Template form by drawing lines indicating the borders of the template Title Blocks. Each line has a Name, Width, starting coordinates (X1, Y1), and ending coordinates (X2, Y2). The coordinates units are in cm. The coordinates are measured from the origin, which is the bottom left corner of the page.

In the Border frame you can show/hide the page border using the check-box, as well as set the border width.

To create a new Line:
Click + button and a new Line will be created with the name new Line#. Double-click in the Name field and enter a unique name for the new line (e.g. Line2).
Enter a line Width 0.2.
Enter the desired start and end coordinates for the new line (X1, Y1 represents the starting point of the line, and X2, Y2 represents the end point of the line). The bottom-left corner of the Preview Window serves as the origin for the Template designer.

To edit an existing line, select the line from the list and enter the new coordinates. For example, if you want to start a line at a point located 1.5 cm from the bottom of the page and 1.5 cm from the left side of the page, you would enter a line with X1 = 1.5 and Y1 = 1.5 (cm). Remember that you can always use the mouse pointer to check the page coordinates, as shown on the left side of this dialogue.

If you want to enter line locations to coincide with margin locations, enter the following items for the X or Y coordinate:
Enter "L" to have a line coordinate equal to the left margin location.
Enter "R" to have a line coordinate equal to the right margin location.
Enter "T" to have a line coordinate equal to the top margin location.
Enter "B" to have a line coordinate equal to the bottom margin location.

This is useful if you want the lines to automatically adjust as the page margins change. An example is shown below.

In this example, a line would be located at a height of 4 cm from the bottom of the page (Y1 and Y2 = 4) and the line would extend from the left page margin (X1 = L) to the right page margin (X2 = R) as shown below.
NOTE: To allow for quick recognition, the selected line, field or label is colored in red in the preview window. This will help you to quickly choose the starting and end points.

To remove existing lines, select the line then press the button. The template designer settings will automatically be saved to the database; as such there is no [Save] button required in this dialogue.

Creating Fields
The next two tabs in the template designer are Fields and Labels. These provide options for adding text to the template. The fields tab is used to create, position and label the Text fields. Beside each field, there will be a corresponding label.
The Text fields are the items which will show up when you load the template into the print preview window. They will be blank and prompt you to enter the specific details.

To create a new Field:

Click the button and a new Field will be created with the name new Field#. Enter a unique name for the field.

Enter the appropriate page coordinates for the field (the position refers to the page coordinate location for the bottom-left corner of the field). Remember to leave room for the Label which will typically be placed to the LEFT of the field.

Select an appropriate font for the field.

Click once in this field, and you should see a button will appear. Press this button to access the font options for this field.

To modify an existing field, select this item from the combo box, and make the desired changes to the position, text value and/or font. The button can be used to remove existing fields from the template.

The next step is to create a Label for the Text Field. As mentioned above, the Label is commonly positioned immediately to the left of the Field, using the same Y-coordinates. Therefore, take note of the Y-coordinates for the field(s) you just created, so they can be used for the corresponding label.

Creating Labels

The fixed text Labels are hardcoded into the template; this means that this item will always show up once the template has been selected, and will be Read-Only in the print options window. Beside each label, there is a Field entry, which receives the actual text entry for the printout when the template is loaded (information is entered into the fields in the print preview window).

For example, a label item would be Date; beside the date, there would be a Date field. When the template is loaded into the print options window, you will be prompted to enter a date in the Date field, which corresponds to the plot or report(s) which has been selected for printing. AquaChem allows you to specify multiple labels at any location on the page. These labels generally contain static project information such as Client, Project number, and Date.
The Labels tab allows you to create, position and customize the Labels on the template. At the top of this dialogue, there are defaults for a Header and Footer for the template. The header position (Left, Center, or Right) can be adjusted along with the font (press the button to access the font options for the Header or Footer). If you do not want a header or footer, simply leave this field blank. In the lines below, you will see the list of labels.

To create a new label:

Click button and a new Label will be created with the name new Text#. Enter a unique name for the label. Enter the appropriate page coordinates for the label. \((X1, Y1)\) refers to the page position for the bottom-left corner of the label. It is common to position the label to the left of the corresponding field. If necessary, use the preview window as a guide.

Select an appropriate font for the label. Click once in this field, and you should see a button appear. Press this button to access the font options for this label. To modify an existing Label, select the item from the combo box, and make the desired changes to the position, text value and/or font. The button can be used to remove existing Labels from the template.

Creating Graphics

The Graphics tab in the template designer dialogue allows you to import graphics (\(.BMP\), \(.GIF\), or \(.JPG\)) into the template design.
You may set the position of the image on the page and specify the size as it will appear on the page. Each of the default Print Templates has been designed to accommodate an imported bitmap image of your company logo or your client's logo (or any image). AquaChem supports common graphics files .BMP, .GIF, and .JPG.

**Please Note** - if you find that your logo seems to disappear after several pages of a multi page report this is likely due to a limitation in the amount of information that can be stored in a document from the reporting component. To resolve the problem we recommend using a smaller sized logo (lower resolution) as the images take the most amount of space.

To import a new bitmap image file:

Click button and a new Graphics entry will be created with the name new Picture#. Enter a Name for the new graphics. Click once in the File field and a button should appear. Click this button to browse the bitmap image file (filename.BMP) and then to import the image click [Open].

Enter the position coordinates of the bitmap (the position of the bitmap refers to the X-Y page coordinates for the top-left corner of the bitmap image). Enter the Width and Height of the selected bitmap file. The dimensions of the bitmap image refers to the Width and Height of the bitmap image as it will appear on the page. The bitmap image will be automatically re-sized (e.g. stretched or compressed) to fit the dimensions.

You may also use the navigation and reduce/enlarge buttons to change the position and size of the label.

To modify an existing bitmap file, select the graphics from the combo box, and make the desired changes to the position, name, or dimensions. The button can be used to remove existing bitmap logos from the list.

**Adjusting Plot area Margins**

The Margins tab in the template designer dialogue allows you to define the area that may be used for placing plots automatically. For example, if the template includes figure information at the bottom of the page, setting a margin of 5 or 6 cm will prevent the automatic plot placement from using this area and the plots will not overlap with these template elements. This is done by simply entering the distance (cm) form each side of the page you would like the display area to be confined to in the appropriate field (Top, Bottom, Left, and Right).

You can also turn the page border on or off using the Show check box and set the width of the page border line by entering an appropriate value (mm) in the Width field.
Preferences

The Preferences dialogue loads the general user preferences and database options for AquaChem. These can be accessed only when the sample/station list is active. Several preferences and options are available and a detailed description for each of these are provided in the following section.

**NOTE**: If your database does not include some of the required parameters or if some of the required parameters are not properly mapped in the Alias section, then the applicable function(s) requiring these parameters will contain null values or erroneous information.

At the bottom of this dialogue, you will see two buttons:

- **Save** - The Save button will save any changes you make to your database.
- **Close** - The Close button will close the dialogue, and return you to the main AquaChem window.

Aliases

This option allows you to adjust the parameters which are used for some of the internal calculations in AquaChem. Some parameter names have been hardwired to AquaChem for these calculations. For example, in order to calculate the hardness given by the sum of Ca and Mg, AquaChem must know if these parameters are called Ca or CALCIUM in the database.
Mandatory aliases which require to have an assigned parameter are highlighted in yellow. Aliases that have a white background may stay unmatched, however, certain functionalities may not be available. e.g. if the 18O and Deuterium aliases are not defined, the meteoric waterline plot and isotope related calculations will not be active, even if the respective parameters exist in the database.

For most purposes, it is recommended not to modify the original parameter names. However if you must rename a mandatory parameter, this section gives you the opportunity to map the database field to the parameter name in the database. An important alias is the "Measured Alkalinity". Often carbonate species are measured in the field as alkalinity and expressed in mg/l CaCO3. If this is the case, then the respective parameter must be matched to the Measured Alkalinity alias. After that, the electroneutrality calculation will be based on alkalinity rather than HCO3 and CO3 concentrations. Alkalinity may be plotted on Piper diagrams and PHREEQC will use this parameter when modeling the aqueous species distribution. After setting the measured alkalinity alias, make sure you return to the respective parameter and select the appropriate unit, as alkalinity units (mg/l CaCO3, french degrees, german degrees, meq/L), differ from all other concentration units (mg/l, mmol/l etc.).

When you are dealing with very alkaline water samples and your data contains measured hydroxide concentrations, make sure that the "Hydroxide" alias is matched to the respective parameter since it is used for the alkalinity calculation.

Once you are finished in the Aliases tab, press [Save] to save any changes and [Close] to return to the main menu.

Calculations
The Calculations option allows you to set the equation coefficients and parameters that are used in the isotope and geothermal gradient calculations. It also provides information on the various calculations that are performed by AquaChem.

**Isotopes**

In the Isotopes option, you may define coefficients for several functions for the isotopic calculations. With the exception of the meteoric water line, all equations have a highly regional character. If you want to make temperature or precipitation estimations, please find the respective coefficients for your study area. There are also parameters for \(^{18}\text{O}\) (Oxygen 18) and \(^2\text{H}\) (deuterium) equations: meteoric waterline, altitude-isotope and altitude-mean annual temperature relations. All of these functions are derived empirically. The coefficients for the isotope-altitude and the isotope-temperature functions are regional and should be used only in the area of calibration. Indicate the area of application of these functions in the field provided.

**Geothermal Gradient**

The Geothermal Gradient is used for a simple subsurface temperature estimation. These options allow you to specify which values are used to calculate the temperature at a given depth. The geothermal gradient is used in the geothermometer plot. It allows the user to estimate the subsurface temperature of waters produced by a borehole if the depth of the inflow zone is known. This temperature is then compared to geothermometer temperatures for the respective sample.

The formula for the Geothermal Gradient calculation is as follows:

\[
\text{subsurface temperature } [T(z)] = \text{Average surface temperature} + \text{geothermal gradient} \times \text{depth (km)}.
\]

The geothermal gradient may vary regionally; it is approximately 33 °C/km in most environments. Any changes made to the Geothermal gradient equation should be registered with AquaChem by pressing the [Save] button prior to closing the Database options dialogue.

**Water Type (major ion definition)**

First you may choose between a long or short name for water facies calculation. For the long version of the water type, the water type expression is calculated as follows:

- All concentrations are converted to meq/L.
- Values are then transformed from meq/L to meq%.
- All parameters which are below a certain limit (10% by default) are removed.
- The remaining ions are considered Major ions. These ions are ordered according to their percentage. Cations are ordered first, followed by the anions.
- The result is the WaterType string (e.g. Ca-Mg-HCO\(_3\)).

The threshold for determining if an ion is major is normally 10%; however in some countries 12.5% is more common. the higher the threshold, the smaller number of parameters that may exceed this threshold is. Usually, only major ions (Na, Ca, Mg, HCO\(_3\), Cl, SO\(_4\)) will have a concentration that allows them to exceed the defined threshold. If you want to make sure, that other important elements such as potassium or nitrate appears in the water type expression, then you can achieve this by lowering the threshold value.

The second (short) way of calculating the water type consists of simply listing the most frequent cation and the most frequent anion, which results in one of the following combinations for most natural waters: Ca-HCO\(_3\), Ca-Cl, Ca-SO\(_4\), Na-Cl, Na-SO\(_4\), Na-HCO\(_3\).
The Redox Water Type option allows you to determine the water type based on the redox category of the sample. There are four redox categories (shown in the table below).

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>strongly oxidized</td>
<td>contains oxygen, nitrate and sulfate, but no iron</td>
</tr>
<tr>
<td>B</td>
<td>weakly oxidized</td>
<td>contains nitrate and sulfate, but no oxygen or iron</td>
</tr>
<tr>
<td>C</td>
<td>weakly reduced</td>
<td>contains sulfate and iron, but no oxygen or nitrate</td>
</tr>
<tr>
<td>D</td>
<td>strongly reduced</td>
<td>contains iron and may contain hydrogen sulfide or methane, contains no oxygen or nitrate, sulfate reduced to some degree.</td>
</tr>
<tr>
<td>X</td>
<td>redox conflict</td>
<td>Sample contains a redox conflict, e.g., if hydrogen sulfide (strongly reduced) and oxygen (highly oxidized) are found in the same sample.</td>
</tr>
</tbody>
</table>

The Redox Category (water type) is determined by the following algorithm:

The water type is displayed in the Sample Details window as a distinct parameter.

**NOTE:** The Water Type parameter cannot be edited; it is read-only. Also when changing the type of water type expression or when changing the threshold value for major ions, you must recalculate the water type expressions for all samples using the Tools>Calculators>Calculate Facies menu item.

**Functions**

The Functions frame lists all of the internal calculations performed by AquaChem, with reference information for each calculation provided in the fields below. All of the active functions (as indicated by a checkmark) will be available as database parameters which can be included in statistical comparisons and for plotting data. In this dialogue, you may select which calculations should appear in the function lists. For example, if you never use the enthalpy calculation, you may deactivate it here. In addition, you may define the default units for some of the functions.

The calculated values are displayed in the Sample Details window, under the Calculated tab:
The functions such as hardness, ion balance, etc. are hardwired to AquaChem; as such, it is not possible to change the parameters involved in these calculations. You may however, edit the name of the function or activate/deactivate a function. Deactivated functions will not appear in the list of functions within AquaChem. For functions that can be expressed in different units (e.g. hardness as °f, °g, mg/L CaCO3) you may specify the default unit.

To edit the name of the function, press View > Options when the Sample Details window is active, and edit the options under the Functions tab.

AquaChem includes a number of common calculations for determining common geochemical parameters. Each of the available calculations (functions) is explained below.

**Calculated Alkalinity**
Acid neutralizing capacity. Generally equal to the concentration of 2CO3- + HCO3- + OH- - H+.

**Calculated Density**
Calculated density based on the partial molal ionic volumes. This value is calculated as follows:
where
\[ v = \sum (n_i \cdot v_i) \]

where
- \( v \) is the molar volume:
- \( n_i \) is the concentration in mmol/l of ion i and
- \( v_i \) is the partial molar volume at 25°C

Partial molal ionic volume coefficients are from Owen and Brinkley, 1941 and for more details, see Hounslow, 1995, p. 58

**Calculated TDS (Total Dissolved Solids)**

TDS is a measure of the evaporation residue at a given temperature. It can also be thought of as the mass of all ions. It is important to note that the calculated TDS is only an approximation and it is always better to have a measured value. TDS is calculated as follows:

First the sum in mg/L of Na+K+Mg+Ca+Cl+SO4 is calculated. Then AquaChem checks if (Ca+Mg-SO4) > (HCO3+CO3). This is done because TDS is not simply the sum of ions but the weight of residue you would expect if you evaporate the entire sample. In waters that contain an excess carbon (Ca+Mg-SO4) < (HCO3+CO3) you may not add all carbon to the residue since bicarbonate will partly outgas as CO2 during evaporation. Only the quantity of HCO3 which can be precipitated as calcite and dolomite is added to the estimate of the TDS. SO4 is deduced from Ca+Mg because gypsum is built first and the Ca that is used up by this process cannot be used any more to build calcite. If (Ca+Mg-SO4) > (HCO3+CO3) then all HCO3 and CO3 can be added to the TDS because there is enough Ca+Mg to build calcite and dolomite.

**Total Hardness**

The sum of ions that can precipitate from water as calcite or dolomite. Generally, the sum of Ca and Mg, expressed in meq/L or mg CaCO3/L, or in degrees.

100 mg CaCO3/L = 1 mmol Ca2+/L = 2 meq Ca2+/L

The Degrees equivalents are as follows:
- 1 German Degree = 17.8 mg CaCO3/l
- 1 French Degree = 10 mg CaCO3/l

**Non Carbonate (Permanent) Hardness:**

Parts of Ca and Mg in excess of HCO3.

**Carbonate (Temporary) Hardness:**

Parts of Ca and Mg which are balanced by HCO3 and thus can precipitate as CaCO3.

**Residual Sodium Carbonate (RSC)**

The RSC has the following equation: RSC=(CO3-+HCO3-)-(Ca2++Mg+2)

It is similar to the SAR in that it expresses the sodium content in relation with Mg and Ca. This value may appear in some water quality reports although it is not frequently used. If the RSC < 1.25 the water is considered safe If the RSC > 2.5 the water is not appropriate for irrigation.

**Langelier Saturation Index (LSI)**

The Langelier index is a popular way of expressing the equilibrium state of a solution in respect to calcite.
Index between -0.5 and +0.5: the water is balanced
Index < -0.5: the water is Corrosive.
Index > +0.5: the water is scale forming.

\[ \text{LSI} = \text{pH} - \text{pHs} \]

where \( \text{pH} \) is the measured pH and \( \text{pHs} \) is the pH where the water sample would be in equilibrium. The \( \text{pHs} \) is estimated from temperature, alkalinity, hardness and total dissolved values.

\[ \text{pHs} = (9.3 + a + b) - (c + d) \]

\[ a = \log((\text{TDS}) - 1) / 10 \]

\[ b = -13.12 \times \log(\text{temp} + 273.15) + 34.55 \]

\[ c = \log(\text{Ca as CaCO3}) - 0.4 \]

\[ d = \log(\text{Alkalinity}) \]

**NOTE:** LSI is only an approximation of the real saturation state. Whenever possible you should use the PHREEQC modeled saturation index of calcite or dolomite in your studies.

**Ryznar Stability Index (RSI)**

The Ryznar stability index (RSI) attempts to correlate an empirical database of scale thickness observed in municipal water systems to the water chemistry. Like the LSI, the RSI has its basis in the concept of saturation level. Ryznar attempted to quantify the relationship between calcium carbonate saturation state and scale formation. The Ryznar index takes the form:

\[ \text{RSI} = 2(\text{pHs}) - \text{pH} \]

The empirical correlation of the Ryznar stability index can be summarized as follows:

- \( \text{RSI} \ll 6 \) the scale tendency increases as the index decreases.
- \( \text{RSI} \gg 7 \) the calcium carbonate formation probably does not lead to a protective corrosion inhibitor film.
- \( \text{RSI} \gg 8 \) mild steel corrosion becomes an increasing problem.

**ElectroNeutrality**

\( \frac{(\text{Cations} - \text{Anions})}{(\text{Cations} + \text{Anions})} \), expressed as a percent. The Electro Neutrality is a common quality control method.

**Sum of Anions:**

Sum of all measured anions for the sample, in meq/l.

**Sum of Cations:**

Sum of all measured cations for the sample, in meq/l.

**Sum Ions:**

Sum of all ions in your sample. This can be expressed in mmol/l, meq/l, mg/L.

**SAR (Sodium Adsorption Ratio)**

The sodium adsorption ratio is an important water quality criterion for irrigation waters. It is used in the Wilcox plot.

\[
\text{SAR} = \frac{N_a}{\left(\frac{Ca + Mg}{2}\right)^{0.5}}
\]
NOTE: The concentrations used in the formula are in meq/L.

MH (Magnesium Hazard)
Magnesium is considered to be harmful for plants, but the effect is reduced by the presence of calcium. Magnesium Hazard was proposed by Szabolcs and Darab (1964).

\[ MH = \frac{Mg}{(Ca + Mg)} \times 100 \]

Units are in meq/l. MH > 50 is considered to be harmful for irrigation water.

NOTE: The Concentrations used in the formula are in meq/L.

Calculated TOC
This function calculates the total carbon within all organic species. Carbon from inorganic species such as HCO3, CO3, CO2 is not included.

Calculated TOX
Calculated total organic halogens. Sum of all halogens (e.g. Cl-, Br-, I-, etc.) present in ug/L, mg/L or g/L in all organic parameters (thus, Cl from Cl- or Cl2 is excluded).

\( z(18O) \)
Average infiltration height as a function of oxygen 18 isotopic composition. Coefficients are valid only for a very limited zone, and must be established for your area of interest using empirical data.

\( T(18O) \)
Average temperature of infiltration zone as a function of oxygen 18, isotopic composition. Coefficients are valid only for a very limited zone, and must be established using empirical data.

\( T(2H) \)
Average temperature of infiltration zone as a function of deuterium. Coefficients are valid only for a very limited zone.

\( z(2H) \)
Average infiltration height as a function of deuterium. Coefficients are valid only for a very limited zone.

Temperature (Z)
Estimated Temperature for a given depth and geothermal gradient.

Temp > H H2O (l)
Enthalpy of liquid water as a function of temperature (t). This is a polynomial function:

\[ Temp = \text{enth(water)} = a(1) + a(2) * t + a(3) * t^2 + a(4) * t^3 + a(5) * t^4 + a(6) * t^5 + a(7) * t^{-1} + a(8) * t^{-2} + a(9) * \log_{10}(t) \]

where
\( a(1) = 418.84 \)
\( a(2) = 10.286 \)
a(3) = -0.05092
a(4) = 0.00026309
a(5) = -0.00000069303
a(6) = 0.0000000074566
a(7) = -1209.8
a(8) = 11.99
a(9) = -353.76


**Temp > H H2O (v)**
Enthalpy of water vapor as a function of temperature. This is a polynomial function:

\[
\text{Temp} = \text{enth(water vapor)} = a(1) + a(2) \cdot t + a(3) \cdot t^2 + a(4) \cdot t^3 + a(5) \cdot t^4 + a(6) \cdot t^5 + a(7) \cdot t^{-1} + a(8) \cdot t^{-2} + a(9) \cdot \log_{10}(t)
\]

where
a(1) = 2035
a(2) = -5.0499
a(3) = 0.057399
a(4) = -0.00030426
a(5) = 0.00000079095
a(6) = -0.0000000086968
a(7) = 1342.4
a(8) = -13.298
a(9) = 396.29

For more details please refer: Fournier & Potter, 1972:

**SiO2 > H H2O (l)**
Enthalpy of liquid water as a function of dissolved silica. This is a polynomial function:

\[
\text{enth} = a(1) + a(2) \cdot \text{SiO2} + a(3) \cdot \text{SiO2}^2 + a(4) \cdot \text{SiO2}^3 + a(5) \cdot \log_{10}(\text{SiO2})
\]

where
a(1) = -42.198
a(2) = 0.28831
a(3) = -0.00036686
a(4) = 0.0000031665
a(5) = 77.034

For more details please refer: Fournier & Potter, 1972:

**SiO2 > H H2O (v)**
Enthalpy of water vapor as a function of dissolved silica. This is a polynomial function:

\[
\text{enth} = a(1) + a(2) \cdot \text{SiO2} + a(3) \cdot \text{SiO2}^2 + a(4) \cdot \text{SiO2}^3 + a(5) \cdot \log_{10}(\text{SiO2})
\]

where
a(1) = -3.5532
a(2) = 0.146
a(3) = -0.0004927
a(4) = 0.000012305
a(5) = -0.000000049421
Exceeds_Solubility
Returns "true" (-1) if solubility is exceeded and the solution is above the specified solubility.

Exceeds_NO
Returns "true" (-1) if natural occurrence is exceeded by one of the measured concentrations. The natural occurrence range can be defined in the database screen on the range tab.

Season
Returns the season number for the sample (i.e. 1=Spring, 2=Summer, 3=Fall, 4=Winter - based on Northern Hemisphere seasons).
Spring: 21/3 - 20/6
Summer 21/6 - 20/9
Fall 21/9 - 20/12
Winter 21/12 - 20/3

NOTE: this is a convenient way to find and select all samples that were sampled in the same season but in different years.

On the southern hemisphere as defined in the preferences screen: 1=Fall, 2 equal Winter, 3=spring, 4=Summer

Month
Returns the month for the sample (i.e. 1=January, 2=February, etc.). Again, using this function in the find screen might be convenient to select data for calculating month based statistics over several years.

Year
Returns the year for the sample.
Once you are finished in the Calculations section, press [Save] to save the changes and [Close] to return to the main menu.

The calculated parameters are treated by AquaChem as regular database parameters with respect to plotting, searches, or statistical calculations. However, in order for the built-in calculations to work, their corresponding database parameters must be included in the database. For example, the database must include Ca and Mg in order to calculate hardness, and both of these parameters must be identified with an Internal Name of 'Ca' and 'Mg' respectively.

Chemicals Master Table
This option allows you to maintain the chemicals master table, which is stored within the Aquachem database file. This table is an extensive list of predefined chemicals, which may be used as templates to create new parameters in the AquaChem project files. You may manually add new parameters, delete parameters, or change fields in existing parameters.

Importing Parameters
The import file typically contains dozens of chemicals that need to be created manually in your database before the respective values can be imported. Often these files have the "one value per row" format as shown below. In this format it is very tedious to extract individual parameter names. The [Import] button allows you to automate the extraction of these
parameters and adds them to the chemicals master table and/or the current database parameters. After pressing the [Import] button you will see the following screen:

First, you need to specify the import file by pressing the button. The grid below will be filled with the file contents. On the Match columns tab you have to match the import file columns to the respective column in the chemicals master table. The CAS number and the parameter name are mandatory.
Press the [Load] button to proceed. This will extract all distinct parameter names found in the specified column and switches the display to the parameters tab. The Parameters tab should now contain the list of extracted parameters as shown below. Each record is preceded by a checkbox, indicating whether this parameter will be imported in the following import procedure.

Press the [Check] button in order to test the parameters for entries having different names but the same registry number. This may be due to a typo in the parameter name, in which case the parameter should be discarded. This can occur as well because of having the same parameter measured in two different ways, e.g. filtered and unfiltered. You might want to add such parameters to the database parameters, but not to the Chemicals Master Tables, which should contain one record per CAS registry number only. The system prompts you when encountering duplicate registry numbers and unchecks the records, if you decide to discard it. Once the parameter check is ended, the Import tab is shown.

This final tab lets you specify if the parameters should be imported to the Chemicals Master Table only or in parallel to the current project database parameters as well. We recommend to import parameters to the Chemicals Master Table only. Then review and complete the
parameters with missing formula weight and formula information. Finally, go back to the Parameters and add new parameters from the updated Chemicals Master Table.

Press the [Import] button to start the import procedure. Note that you will have to confirm the import of parameters where an identical CAS registry number already exists in the target table. If a parameter is to be imported having the same name as a parameter already existing in the target table, this parameter will be simply ignored. At the end of the import process the number of successfully created parameters in the target table will be displayed on the Import tab.

**Database Parameters**

The Database Parameters option allows you to modify the data structure of the current AquaChem database project by adding or deleting parameter fields from each of the four parameter categories. This option can also be used to modify the attributes of each parameter (e.g. Display label, Internal name, Molecular weight, Charge, Units, etc.) or to change to order in which the parameters are displayed in the Sample Details window.

In an AquaChem database there are several categories of parameters:

- Station Description Parameters
- Sample Description Parameters
- Measured Parameters
- Analysis Metadata, and
- Modeled Parameters

Mandatory parameters are highlighted in yellow. A detailed description of each parameter category follows below:

**Station Description Parameters**

These are parameters which contain general information about the station. This data is entered once for every individual station. The station can then be assigned to a single sample or multiple samples. Typical parameters for the stations are: station name, ID, location, area, X,Y coordinates, elevation, and well depth. Station Description parameter values can be text or numbers. An AquaChem database may contain a maximum of 255 Station Description parameters.

**Sample Description Parameters**

These are parameters which contain general information about the sample. This category typically includes alphanumeric or data types such as sample ID, sampling date, sampling personnel, etc. Sample Description parameter values can be text or numbers. An AquaChem database may contain a maximum of 255 Sample Description parameters.

**Measured Parameters**

These are parameters that are either measured at a sampling location (in the field) or derived from a laboratory analysis of a water sample taken from that location. These parameters will contain numerical values for your sample (e.g. concentrations for cations, anions, organic contaminants, pH, TDS, etc.). For these parameters, you may enter a comment for every analyzed value as well as an acceptable Range. An AquaChem database may contain unlimited number of Measured parameters.

**Analysis Metadata**

In AquaChem, each measurement may be further described with meta data fields. The initial database includes the most commonly used fields: Method detection limit, Protocol (Method), outlier flag, solubility, and comment. Depending on your field of activity you might
want to add meta data fields such as the Practical Quantification Limit (PQL) or the information whether this element has been filtered after sampling. AquaChem allows you to add an unlimited number of meta data fields to the measurement table. Meta data information is only visible in the Sample Detail screen where each parameter appears as an additional column behind the measured value. Note that you have to set the respective to Visible using the Sample Detail Option screen.

**Modeled Parameters**
AquaChem provides an integrated graphical interface for geochemical modeling using PHREEQC where the data for each sample in the database can be used as input data for the PHREEQC simulations. Modeled Parameter values are calculated by PHREEQC during a simulation and read back to the database.

The Modeled Parameters are very similar to numerical parameters, however you may not add comments, description, or define Ranges. Modeled Parameters appear in a separate tab in the Sample Details window.
For more details on the Modeled Parameters and PHREEQC modeling, please refer to Chapter Tools section, and Geochemical Modeling with PHREEQC (Basic) section.

**Database Parameters**
For each Parameter category, you will see a list of parameters belonging to that category appearing on the left side; on the right side, you will see the description and details for each parameter, as shown below:

At the bottom of the Parameters list, you will see several buttons. The function of each button (in order from left to right) is as follows:
Move to top: moves a parameter to the top of the list
Move up: move the parameter up
Move down: move the parameter down
Move to bottom: move the parameter to the bottom of the list
Sort alphabetically: sorts parameter list alphabetically
Add new parameter: adds a new parameter
Delete parameter: deletes the selected parameter(s)

Each parameter has a corresponding name, label, and info, so that it can be easily identified in the database, and incorporated in to plots, calculations, and modelling with PHREEQC. Below is a list of the required fields for the various parameter types.

Sample Description Parameters and Station Description Parameters require the following Parameter Details:
- Internal Key
- Form Label
- Description
- Type

One of the new features of AquaChem is the ability to modify the type of the existing parameters for the station and the sample table. Depending on the Type of a parameter, different details need to be provided:

Type Integer, Long, Single, Double:
- Unit
- Format

Type Text:
- Length
- List of Values (optional)

Type Memo:
- Length

Type Boolean and Date:
- No additional parameter details

A Measured Parameter requires the following Parameter Details:
- Internal Key
- Form Label
- Description
- Formula
• Formula Weight (g/Mol)
• Solubility
• Valence
• CAS Registry Number
• Unit
• Format

A Modeled Parameter requires the following Parameter Details:
• Internal Key
• Form Label
• Description
• Formula
• Formula Weight (g/Mol)
• Valence
• Unit
• Format

NOTE: It is not necessary to have values entered for each field for each parameter. However for reports and plots, it is recommended that you enter as much information as possible.

The following is a brief summary of each of these Parameter Details:

Internal Key - this is the internal name defined when the parameter is first created; once a parameter has been created, the internal key cannot be changed.

Form Label Display - label assigned to the parameter so that it can be distinguished in the Sample/Station Details window, and other AquaChem windows and dialogues.

Description Brief - description of the parameter. This information is entered only in this location, and is designed to provide the user with a quick reference. (This field may remain blank if desired).

Length - set the character length of the field

Formula - Chemical formula for the parameter.

List of Values - allows you to create a unique pick list for this parameter. To edit the list of values, click the button in the List of Values field. When editing the respective parameter in the sample or station window, only the predefined values can be selected from a combo box.

Formula Weight - Formula weight for the measured parameter. For many measured parameters, there is an option to calculate the formula weight (select a measured parameter then you will see a Calculate FMW button appearing below this dialogue. Press this button and AquaChem will automatically calculate the weight of the parameter, provided the formula is entered and available in the database).

Solubility - set the solubility for the measured parameter.

Valence - positive or negative charge (if applicable).

CAS Registry - for measured parameters, if you know the CAS (Chemical Number Abstracts Service) Registry number, you can enter it in this field. Otherwise, you may leave this field blank.

Unit - allows you to select the units that will be applied for the selected parameter (mg/L, meq/L, etc.). For all other parameters without a formula, an editable list of units is displayed. To access this list, simply click in the field beside Unit and press the button to load the list of available units. Note that when changing the unit for a parameter and the database already contains data, existing values are not changed automatically. This change has to be done manually using the Edit > Replace option after saving the database configuration. E.g. when changing the unit for copper from mg/L to ug/l, all copper values have to be multiplied by a factor of 1000.
**Format** - displays the format for a numerical parameter. This field determines how many decimal places will appear for a numerical parameter. To change the display format, simply click in the field beside Format and press the button to load the Format options dialogue. You can then increase/decrease the number of Decimal places using the up/down buttons or select the Auto or Scientific format for the parameter.

**Type** - set the parameter data type. There are nine data types in the AquaChem database:
- Boolean
- Integer
- Long
- Single
- Double
- Date
- Text
- Memo

The numeric parameter fields do not accept text values such as "ND" or "NA" and will return a value of zero for any such text entry. However, AquaChem does accept "greater than" and "less than" values (e.g. <0.01). In addition, AquaChem allows you to recognize or ignore the "greater than" and "less than" values on graphs (see the File > Preference, and browse to the Censored Data tab to edit these options).

The next section will describe how to add new parameters to your database, and create new parameters.

**Adding/Creating New Parameters**
If you are adding a Station Description or Sample Description parameter to your database, follow the steps below:
Select File / Preferences from the main menu (if you have not already done so) and go to the Database Parameters tab.
Select the Station Description or Sample Description parameter category from the combo box.
Press the button and a New Database Parameter dialogue will appear.

In this dialogue type in the name of your new parameter. This name will be used as the Internal Key, Form Label, and Description for the parameter.
Click [OK] and this will return you to the list of parameters.
Proceed to fill in the required Parameter Details for this parameter.

If you are adding a Measured Parameter, then follow the steps below:
Select the Measured Parameters category from the combo box in the upper left corner of the dialogue.
Press the button and you will see a Parameter List dialogue:
Choose a parameter from the list of available parameters; to add multiple parameters, press the <Ctrl> key (on your keyboard) while you select multiple parameters from the source list. You may use the Find option to run a query for a parameter name to see if it is available in the AquaChem chemical database. Use the combo box above the parameters list to choose from the various measured parameter categories available in AquaChem (Inorganic, Organic, VOC's, etc.).

Press the [Select] button and the parameter(s) will be added to your database.

If the parameter that you want to add is NOT available in this list, then:

Click the button (in the lower-left corner of the dialogue) and a New Database Parameter dialogue (as shown to the right) will appear.

Type in the name of your new parameter (this may be a formula or full chemical name). This name will be used as the Internal Key, Form Label, and Description for the new parameter.

Click [OK] and you will return to the Database options dialogue.

Proceed to fill in the required Parameter Details for this parameter.

If you are adding a Modeled Parameter, follow the steps below:

Select the Modeled Parameters category from the combo box.
Press the + button and you will see a PHREEQC Parameters dialogue (as shown on the right-hand side). Choose a parameter from the list of available parameters. To add multiple parameters, press the <Ctrl> key (on your keyboard) while you select multiple parameters from the source list. You may use the Find option to run a query for a parameter name to see if it is available in the AquaChem chemical database. Use the combo box at the top of this dialogue to choose from the various parameter categories available in AquaChem (Activities, Saturation Indices). Press the [Select] button and the parameter(s) will be added to your template.

If the parameter that you want to add is NOT available in this list, then:

Click the + button and a New Database Parameter dialogue will appear.

Type in the name of your new parameter. It is important that the name for new modeled parameter matches the names used in the PHREEQC thermodynamic database for phases (minerals) or species. When selected from the list, this will ensure that the names are matched successfully. This name will be used as the Internal Key, Form Label, and Description for the new parameter. Click [OK] and you will return to the Database options dialogue. Proceed to fill in the required Parameter Details for this parameter.

**NOTE**: Parameter names should contain numbers and letters only; do not use any other characters, and/or spaces in the parameter names.

Upon returning to the Parameter list, you must then enter the remaining required parameter details including the description, units, formula, format etc. All measured chemical parameters should have a formula weight specified. If you do not know the molecular weight of a chemical parameter, press the Calculate FMW button below the parameter details and AquaChem will read the formula from the field and insert an appropriate molecular weight according to the Periodic Table of Elements. Cations and Anions must be accompanied by their Valence (positive or negative charge).

The Format field is set to Auto by default. To choose a new display format for a parameter, click once in the Format field, and then press the button and you will see the following dialogue:
The Format options allow you to specify the number of Decimal places for measured parameters, and specify if the value will be in Scientific or whole number format. If Auto is selected, then AquaChem will determine the optimal number of decimal places for that parameter. This may result in a "hiding" of a 0 after a decimal place (for example, 7.10 may be displayed as 7.1). To correct this, disable the Auto option, and increase the number of decimals to the desired amount. Once you are finished, press [OK] to accept changes or [Close] to return to the previous dialogue.

Deleting Parameters
To remove a parameter from your database, simply select one or several parameters from the parameters list on the left side of the dialogue and click the button.

Exporting Parameters
On various occasions, it will be useful to save all parameters and respective settings to a file for documentation or review purpose. This may be accomplished by pressing the Export button below the parameter details grid. The information may be saved to in text or Excel format.

Update Parameters
The central Aquachem.mdb database holds a master table including hundreds of organic and inorganic chemicals. This is the list you may choose from when adding new parameters to the database. If a parameter has been created manually and the entry misses the formula or formula weight, you may use the Update button to copy the missing information from the chemicals master table to your database parameter. Note that for this the CAS registry number must be filled, since it is internally used for matching parameters. Also, if the parameter does not exist in the Master chemical table, the update process will not return any results.

Mandatory Parameters
AquaChem has several parameters which are required for EVERY database, and therefore cannot be deleted from the database. These parameters are needed by various plots, reports, and calculations. Mandatory parameters are highlighted in yellow and when selected, the [Delete] button becomes disabled. The following is a list of mandatory parameters for an AquaChem database.

Mandatory Sample Description Parameters:
- Sample_Date
- SampleID
- WaterType

Mandatory Station Description Parameters:
- StationID
- X
- Y

Mandatory Measured Parameters:
- Ca
- HCO3
- SAMPLE_DEPTH
Once you have made changes to the Parameters in your database structure, press [Save] to accept these changes.

**Parameter Statistics**
The Parameter Statistics frame allows you to view parameter statistics, e.g., Min, Max, Avg and Count, while browsing the parameters in the parameters list.

**Database Info**
This options gives you some basic information about your database including the template it is based on and size. As well as when is was created, modified and last accessed.

The Compress button will compress your database. Your project database file size may become large if you have a large number of samples, and are continuously deleting samples. Compressing the database will compact and repair your database, and may make the file size more manageable. AquaChem will create a backup copy of the uncompressed database file, with the file extension .SAV. Should you encounter problems with the new compressed file, simply delete this, and restore the previous file by renaming the .SAV file with the extension .AQC.

The AquaChem project database files are saved in a Microsoft Access 2000 relational database format. The projects are saved with a unique file extension (.AQC). This is done for two reasons:
1. This prevents any confusion or possible corruption of the file if it were to be accidentally opened in MS Access, and critical changes were made to the data structure or even to the data itself; and
2. This ensures that only AquaChem projects are opened in AquaChem, and that non-supported files that (that could potentially result in corruption or data loss) are not opened.

However, it is still possible to view/edit an AquaChem database file using MS Access. Simply launch MS Access and open this database file, using the File Open command.

**NOTE**: It is recommended that you first make a back-up of your database file, before modifying it in the MSAccess environment.

An AquaChem database may contain an unlimited number of samples, depending on the number of parameters it uses and the amount of memory available on your PC. Working with too many samples can slow some operations even though you are only working with a portion of the database. Therefore, working with several databases containing less than 5,000 samples may be more efficient than using one large database.

**General**
Use the Project Location combo box to select the hemisphere for your project site. Depending on the hemisphere, the seasons may be reversed. The seasons are counted beginning with Spring (March 21 to June 20), in the Northern Hemisphere and Fall in the Southern Hemisphere.
To view which season returns which number, consult the Calculations tab of the Database.
In the Interface Colors dialogue, you can specify the AquaChem main program window Background color. Simply click on the button and a standard windows Color options dialogue will load allowing you to choose another color.

Use the Document Root field to specify the path to the folder, containing documents that are referenced from AquaChem records. Sample or station text fields may contain filenames or internet addresses. For filenames, you may indicate the full filename including the path or only the filename. In latter case, this file must be reside in the documents root folder. This is convenient, if the documents have to be moved to a different location. Since all reference files reside in the root folder, only the document_root parameter has to be changed to indicate the new location. If the files are specified including the full file path, then all records referencing the moved files must be updated.

Additionally you have an option to automatically open the last AquaChem project when you Startup the program.

**Holding Times Configuration**
This option allows you to configure the tables and fields used to run a holding times analysis.

**Parameter Groups**
The Parameter Groups options allow you to sort measured numerical parameters into groups, providing a quick and easy view of specific sample data accessible in the Sample Details window.
For your convenience, AquaChem comes with the following pre-defined parameter groups:

- Show analyzed values only (hides all parameters for which there are no assigned measurement values)
- Anions (e.g., Cl-, F-, SO42- etc.)
- Cations (e.g., Ca2+, Na+, K+, Mg2+, etc.),
- Gas (O2, CO2, NO2, etc.)
- Isotopes (18O, 2H, 14C, etc.)
- Organic Chemicals (BTEX, Vinyl Chloride, etc.)
- Overview (pH, TDS, Cond, Major ions)

By selecting a parameter group from the combo box, you can view which parameters belong in a selected group; one parameter may belong to multiple parameter groups. To add/remove parameters from a parameter group, simply select the parameter from either the full list on the left side, or the group list on the right side, and press the move button to move the parameters accordingly.

You may also create new parameter groups, and add any combination of measured parameters to this new group.

To create a new parameter group:

Press the button beside the list of Parameter Groups:
In the Parameter Groups dialogue that appears, press the button to add a new item. Double click on this label and type in a name for this new group. (To delete existing parameter groups, select an item then press the button.)

Once you are finished press [OK]. Select this new parameter group from the combo box listing the available groups.

Use the button to move parameters from the master list into this group. To move several parameters press the <Ctrl> key while you select multiple parameters from the source list, then press button. To remove parameters from the parameter group, select the target parameter and press the button.

Once you are finished in the parameter groups dialogue, press [Save] to save the changes and [Close] to return to the main menu of AquaChem. The parameter groups can now be accessed in the Sample Details window. To do so, open the details for any sample and you should see the following window:
In the Measured parameters tab, beside the Parameter Group label, there is a combo box listing the available parameter groups for the database (indicated by the arrow). Simply choose one of the groups from this list, and AquaChem will display only the data for the predefined parameters in that group.

**PHREEQC**

This option allows you to specify PHREEQC related files. You must specify the locations of the PHREEQC Thermodynamic Database (phreeqc.dat) and the PHREEQC Executable (phreeqc.exe) files. These files are required for running PHREEQC simulations.

Press button beside the Thermodynamic Database field and select the path and filename from the PHREEQC Thermodynamic Database dialogue. From this dialogue, select either phreeqc.dat, Wateq4f.dat, Pitzer.dat, Minteq.dat or Minteq.v4.dat. These files are installed under My Documents \ AquaChem \ PHREEQC.

In the PHREEQC Executable field select the path and filename for the phreeqc.exe file. This is the batch file version of PHREEQC included in your AquaChem Program folder.

Finally, specify the path and filename for the USGS graphical user interface (PHREEQCI or PHREEQC for Windows) executable, if this component is installed. To change the directories for these files, press the button beside each directory path, and specify the new file/folder location.
By default, all PHREEQC input and output files will be saved in your AquaChem installation folder (default is Program Files\AquaChem).

PHREEQC-I or PHREEQC for Windows is required for Advanced PHREEQC Simulations. To check for an updated version of the Graphical User Interfaces we provide a button to go to the USGS Website.

Once you are finished, click [Save] then [Close]. You are now ready to run PHREEQC.

**Plots**

The Preferences dialogue contains settings for Plots which is used for the settings in the Plots and Symbols.

**Active Plots**

The upper left frame of this dialogue lists the Active Plots. This allows you to activate / deactivate the plots. Deactivated plots will not appear in the Plots menu (main toolbar). This allows you to hide plots which are never used from the menu. Active Plots are indicated by the presence of a checkmark beside the plot. By default, all plots are active.
Symbol Font
In the upper right frame of this dialogue you will see options for the Symbol Font. AquaChem provides two options for showing symbols on plots and graphs: Geometric Markers and True type fonts. If the Geometric Markers option is selected, you will be able to select from a variety of geometric shapes when defining plot symbols. If the True type fonts option is selected, AquaChem will use "True type fonts" for symbols on plots and graphs. As such, there is an unlimited number of symbols that you can use for your project database.

The default font selection is WHI_Symbol. To choose another font type, press the button.

**NOTE**: The symbols can be defined for samples through the Plots > Define Symbol or Line dialogue.

Plot Title Options
This frame includes settings for the automatic plot titling option. When a new Pie, Radial, or Stiff plot is created with your samples, the plots will automatically be titled with the descriptive fields (parameters) listed here. You can specify which parameters you would like to be utilized when using the automatic title option.

To do so, click the or button to add or remove parameters. To change existing fields, simply double click in the field and choose a new parameter from the combo box. The parameter order can be arranged using the up and down buttons. Once you are satisfied with the parameters, you must specify a Field Separator. This will be the character that separates the parameters in the title of the plot. You can use any character as the field separator, however the most common are a space, hyphen, comma, or a semi-colon.

Based on these preferences, all new Pie, Radial and Stiff plots will be titled with the unique descriptive parameters for the individual sample. Using these parameters above, you can see an example of a Pie Plot which is created with the automatic title option.
The title of the Pie plot uses Sample_Date (8/15/1992), SampleID (MW-1-92), and Location (Waterloo), separated by a comma.

The Plots tab also allows you to choose in which color the selected samples are highlighted when a symbol is clicked. For example, if you use red often as symbol color, you may want to select a different highlight color in order to distinguish which symbols are selected and which ones are not.

QC Metadata
This option allows you to specify settings for several QC analysis options.
**Non Detects**

Data generated from chemical analysis may fall below the method detection limit (MDL) of the analytical procedure. These measurements are generally described as nondetects, (rather than as zero or not present) and the appropriate limit of detection is usually reported. In cases where measurement data are described as not detected, the concentration of the chemical is unknown although it lies somewhere between zero and detection limit. Data that includes both detected and non-detected results are called censored data in the statistical literature. (Office of Environmental Information, U.S. Environmental Protection Agency, 2000).

In AquaChem database the non detects are entered with a "<" sign. This tab allows you to specify settings for handling censored data in plots and calculation.

In this dialogue, you are presented with options for displaying non detects in plots and all calculations except the Summary Statistics as mentioned above. AquaChem allows you to enter and store approximate measured values using the less than (<) symbols. These options require you to specify whether these approximate values will be ignored or included in the plots.

If you choose to Ignore non detect with graphics or calculations, they will be treated as null entries.

If you choose Don't ignore non detect results, you may specify by which factors <> these values are multiplied for the use in plots or calculations. For example, if 2.0 and 0.5 are specified, a value of >10 will be taken as 20, and a value of <10 will be taken as 5.

**Duplicates**

This option allows you to specify a code to be used to assign to the Primary Sample when a duplicate sample has been found.
QC Flags
As documented in the US EPA Guidance on Environmental Data Verification and Data Validation (http://www.epa.gov/quality/qs-docs/g8-final.pdf):
The goals of data validation are to evaluate whether the data quality goals established during the project planning phase have been achieved, to ensure that all project requirements are met, to determine the impact on data quality of those that were not met, and to document the results of the data validation and, if performed, the focused data validation.

A common way to document the results of data validation is by assigning QC Flags to the results. This option within AquaChem allows you to specify the Field to be used to populate the flags generated from running a Method Detection Limit Analysis. As well as which flags to be used. Several flags are included but you are able to create your own as well.

You will find different flags depending on whether you used the Basic or Advanced template when creating your project.
The Flags that are included are a summary of qualifiers we have commonly encounter and are described below. As mentioned previously you are free to adjust them as you see fit.

U = The analyte was analyzed for but not detected above the reported estimated quantitation limit.
J = The analyte was positively identified, the associated numerical value is the approximate concentration of the analyte in the sample:
J+ = likely to have a high bias,
J- = likely to have a low bias.
UJ = The analyte was analyzed for but not detected. The associated value is an estimate.
R = The sample results are rejected due to serious deficiencies in the ability to analyze the sample and meet quality-control criteria. Presence or absence cannot be verified.
X- = The result was rejected because of an extremely low value
X+ = The result was rejected because of an extremely high value

Ranges
Ranges are similar to the drinking water standards; they allow you to define qualitative and quantitative intervals for any parameter. An example for Conductivity (cond) is shown in the dialogue above, and detailed below:
Conductivity (uS/cm)
100-1000 natural aquifer range
<250 low salinity (C1)
250-750 medium salinity (C2)
750-2250 high salinity (C3)
>2250 very high salinity (C4)

Data can be marked as a "Natural Occurrence" using the provided check-box. If a natural occurrence range is defined for a parameter, the reliability check tool will later be able to detect all concentrations outside this interval. The natural for a parameter occurrence depends strongly of the type of water you are analyzing. It will be very different whether you are working on surface water, ground water or sea water. Please review the values included in the startup database and adjust them to whatever value is applicable in your study area.
Ranges can be useful for interpreting stable isotope data: S, N, C, Sr, He. Isotopes reflect the signature of their source. If the ranges of every potential source is given, an analyzed value can be easily attributed to one of the sources.

To add a new Range item:
Choose the desired parameter from the combo box at the top of this dialogue.
Press the button to add a new item.
Enter the desired Label (descriptive name or text).
Enter the corresponding Minimum and Maximum values.
Check the Natural Occurrence box if needed.
Press [Save] to save the changes and [Close] to return to the main menu.

To view the range options for a sample, load a Sample Details Window and then right-mouse click on the parameter name. A dialogue titled Parameter Details appears, showing all the information about this parameter including the ranges.

The Range information should appear in the lower section of this dialogue. Once you are finished in this dialogue, press [Save] to save the changes and [Close] to return to the main menu.

**Standards - Configure**
With this option you can specify the set of Water Quality Standards to be used for the current database in AquaChem. Multiple standards and levels can be set to active, allowing you to check values against a mix of levels, e.g. ODWS and PWQO, or USEPA and WHO. Values exceeding the respective water quality standards will be highlighted using a color code when displaying the data. You may change the color that should be associated with every level of exceedence by double-clicking on the color for respective level.

Values can also be compared to a percentage of a standard by specifying a percentage (0 - 1) under the Fraction column for one of the active water quality standards.

The data for each Water Quality Standard is specified in the Database dialogue which can be accessed through File > Database > Water Quality Standards. There, you may edit existing values for the standards for each parameter. You can also create your own set of Water Quality Standards and import or manually enter values for these new standards.
Guideline exceedences can be viewed in the sample details table. However, when multiple guidelines are active, there is no legend to find out what exceedences a highlighted cell indicates.

To view all the guideline exceedences for a parameter in the sample details table, simply click on the highlighted cell, and then right-click to display the Parameter Details dialog (shown below).
All the active guidelines that are exceeded are displayed at the bottom of the dialog, as indicated in the image above.

Standards - Import

The options in this dialogue allow you to view and modify water quality standard levels, and create or import new sets of standards. These standards are used in the data analysis reports, table views, and individual sample details. Measured parameters which exceed these...
pre-defined levels are highlighted in predefined colors depending upon the specified preferences. This allows you to quickly identify sample exceedances and water samples which may be harmful to humans and the environment.

To view the available standards, simply choose a standard from the combo box beside the Water Quality Standard field. To view a guideline level for the selected guideline, simply choose a level from the combo box beside the Level field.

Standards can be modified by simply editing the existing values beside each parameter in the grid, or importing a complete set of standards from a file (*.txt or *.xls). For each parameter in the database you may define up to three guideline levels.

To view the properties of a Water Quality Standard, press the button beside the Standard name, at the top of this dialogue. You should then see the following dialogue:

```
In this dialogue, you may view and/or modify the Standard Name, Reference, and Year Approved. It is useful to provide a URL to the original standard so that you can check from time to time whether there have been changes made to the standard. The Levels frame lists the defined guideline levels and their corresponding colors. You can add a new level by clicking the button.

You can have an unlimited number of levels for the selected guideline. However, in most cases, two levels will be adequate (Tolerated level, Guideline level). Simply add the number of levels appropriate for the guideline. You may then assign a name to each level (Tolerated level, Guideline level, cleanup level etc.). You can call the first level MCL (applicable in U.S.), or you can name this MAC (applicable in Canada). Simply type in the new name in the appropriate field. Similarly, for Level 2 and Level 3 you may enter your own labels.

For your convenience, several commonly used Water Quality Standards are included with AquaChem:
```
- U.S. Environmental Protection Agency (US EPA) - National Primary Drinking Water Regulations (EPA 816-F-02-013, July 2002).
- Canadian Council of Ministers of the Environment (CCME) - Canadian Environmental Quality Guidelines - 2002 including AO, IMAC, and MAC
- Health Canada - Guidelines for Canadian Drinking Water Quality - 2004 including AO, IMAC, and MAC

For more details on these standards, please see the website links below:
CCME: http://www.ccme.ca/publications/can_guidelines.html
US EPA http://www.epa.gov/safewater/mcl.html

To create a new water quality standard, follow the steps below:
If you have not already done so, open the File / Preferences dialog, and select the Standards - Import option.
Press the [ ] button (in the upper right corner) to access the Water Quality Standards properties dialogue, as shown below.

Click the [New] button to create a new standard
A blank Water Quality Standards dialog will load (shown above). Here you can:
- Enter the name for this new set of standards
- Enter a reference for the new set of standards
- Enter a URL for the set of standards
- Enter the year that the standards were approved
- Enter guideline levels for the new set of standards (see above for more information)
- Once finished, click the [Close] button.

Under the Water Quality Standards tab, select the new standards from the Water Quality Standards combo box (shown in the image below). Below that, select a guideline level from the Level combobox.

There are two ways to enter parameters and assign guideline levels: the values can be entered manually or the data can be imported from a file. Either way, data is entered for one guideline at a time.

Adding Data Manually

To manually add guideline levels, simply click on the button. A new field will be added to the grey grid, where you can manually enter the following data:

<table>
<thead>
<tr>
<th>Type</th>
<th>User specified acronym that allows to group parameters, e.g., in chemicals (C), microbial (M) and radionuclide (R) parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter*</td>
<td>Parameter name in guideline</td>
</tr>
<tr>
<td>CAS#</td>
<td>CAS registry number (for simplified parameter matching)</td>
</tr>
<tr>
<td>Unit</td>
<td>Original parameter unit. This may differ from AquaChem's internal unit. The value used in AquaChem may need to be converted.</td>
</tr>
<tr>
<td>Standard*</td>
<td>Maximum value or interval for guideline</td>
</tr>
</tbody>
</table>
Comme | A comment
--- | ---
Year | The year when the standard was introduced or revised

*Mandatory Fields*

**Importing a Guideline Level**

For importing guidelines, an excel file (or text file) must be created for every guideline level, e.g., MCL, MCL goal, etc. The column structure in the excel file must exactly match the column format below, however all columns may be empty except the parameter and standard (Upper Limit) column.

<table>
<thead>
<tr>
<th>Type</th>
<th>Parameter</th>
<th>CAS</th>
<th>Unit</th>
<th>Lower Limit</th>
<th>Upper Limit</th>
<th>Comment</th>
<th>Year</th>
</tr>
</thead>
</table>

It is recommended that the parameter names in your file are identical to the respective parameter names (the Internal Key name) in the AquaChem database template. If the parameter names are different, AquaChem will not recognize the data for these parameters when you attempt to import them, and you will need to match the fields manually. Optionally, the standard to be imported may contain the CAS registry number per substance, allowing to match this unique code against the CAS registry numbers for the database parameters resulting in a more efficient detection of parameters.

**NOTE:** Do not include headers in the text file. The first line in your text file should be the first available parameter for which you have a guideline level.

To import the water quality standards using a text or excel file:

Click the **Import** button beside the Import water quality standards from File field for the filename. The following dialogue will then appear:
Locate the source file on your computer, then click [Open].

After you load the file, the dialogue will be refreshed.

The grid is divided into two sections: grey fields and white fields. The grey fields represent the original (raw) water quality standard data that was imported. The adjacent white cells represent the matched AquaChem parameters and the corresponding standard levels. The standard values may be adjusted for differences in units between AquaChem and the original source file.

AquaChem will attempt to identify matching parameters in the database either by using the CAS number if available, or the parameter name. You should carefully scan the list and verify if all the parameters have been identified, e.g. the original name in the guideline may say "Total Dissolved Solids" while the database parameter may say TDS. This will not be discovered by AquaChem and you must select the corresponding AquaChem parameter.

To manually assign an AquaChem parameter to a standard record, simply click the cell and select a parameter from the combobox (shown below)
If the original standard is expressed in mg/l but AquaChem uses ug/l for the same parameter, a conversion factor of 1000 is automatically applied for the value used in AquaChem to check for exceedances. However, for some parameters such as Nitrate and Silica, the parameters may be expressed in different formulas, e.g., nitrate originally as N and AquaChem may express nitrate as NO3. In these cases, a conversion factor must be calculated manually and applied to the standard in AquaChem. For example, if the original standard for nitrate as N is 10, then the standard in AquaChem for nitrate as NO3 is 44.2. You can use the species converter to calculate the conversion factor.

To use this new standard, you must select this in the Standards - Configure option. Once you are finished in this dialogue, press [Save] to save the changes and [Close] to return to the main menu.

**Thermometers**
The Thermometers options allow you to modify existing Geothermometers or to create new ones. Geothermometers are used to estimate the original subsurface reservoir temperature of ascending groundwater which underwent conductive cooling during its ascent. They reflect the temperature dependence of most rock-water reactions. The reactants, which remain dissolved during the journey to the surface, are ideally proportional to their original aquifer temperatures. For example SO2 (Quartz or Chalcedony dissolution or Na/K for albitisation). The original reference and the temperature range for which the thermometer is valid (most thermometers only work above 100 °C) and can be viewed and edited in this dialogue.

Geothermometers are generally derived from the Van't Hoff equation and have the form:

\[ T(°C) = \left( \frac{a}{b + \log(K)} \right) + 273 \]

where

- \( a \) and \( b \) are constants describing a straight line in the 1000/T-log(K) plot, and
- \( K \) depends on the reaction used for the geothermometer (SiO2 for all SiO2 thermometers, Na/K for the Na/K thermometer, etc.)

Since thermometers are usually developed from empirical data, different coefficient values are found in the literature. AquaChem includes a compilation of most currently used geothermometers as shown in the figure above. The equations for each of the thermometers are stored in the project database file and can be customized and modified. Each thermometer record includes the formula's coefficients, the reference (author and year), and the range within which the formula was calibrated.
The Thermometers tab contains a list of available geothermometers that can be plotted on a geothermometers plot. If a thermometer is enabled (checked) it will be available for the geothermometers plot. If it is disabled (not checked) it will not be available for the geothermometers plot.

There are several fields for each thermometer:
- The Short Name refers to the list name of the selected geothermometer.
- The Label refers to the reference name of the geothermometer.
- The Reference refers to the author and year of the original publication.
- The Range refers to the temperature range within which the thermometer is supposed to provide reliable data. This normally corresponds to the range of the calibration data.
- The Type refers to the thermometer class.

Creating a New Geothermometer
You may add published thermometers from literature or create your own thermometer if the formula structure corresponds to one of the pre-defined thermometers provided by AquaChem. For example, to create a new Na/K thermometer:
Select an existing Na/K geothermometer,
Click the button to create a new Na/K geothermometer (new thermometer will be added to the bottom of the list).
Select the new geothermometer Type.
Enter a new Short Name, Label, Reference, Range, and Type.
Replace the formula parameters from the original geothermometer with the parameters from the new geothermometer.
Press the [Save] button to save the changes to the database.
This new thermometer is automatically included in thermometer calculations and can be visualized as a Geothermometer Plot.

Exit
The Exit command will exit AquaChem. Ensure that all changes are saved to your database before exiting the program.

3.2 Edit Menu

The Edit menu provides access to commonly used Windows tools such as Cut, Copy, and Paste. The Cut, Copy, and Paste commands are not available when the active list window is the active window; these options are only available when you are viewing or editing data for a sample or a station.

Cut
Cuts selected data from the field and places it on the Windows Clipboard.

Copy
Copies the selected data or plot to the Windows Clipboard.

Paste
Pastes data from the Windows clipboard into the selected field. In order to paste numerical values into a sample details field, the field must be active, which is indicated by a flashing cursor in the field. Simply double-click in the appropriate field to activate it and it will be ready to accept data from the clipboard.

Replace
The Replace command allows you to replace data for an individual parameter with a new value for all active samples in the database or to multiply all existing values by a specified factor.

Simply choose the method you wish to apply and the parameter you wish to apply this change to from the combo box beside Parameter. Then enter the value to replace or multiply by in the field beside the method combo box. Once you are finished, click [Apply]. A warning message similar to the one shown below will appear:

Choose [Yes] to proceed or [No] to cancel the operation.

The Multiply by method may be useful for correcting import errors. E.g. the X coordinates can be multiplied by 1000 in order to convert the inadvertently imported km values into meters. Note that this method can also be used to bulk edit analysis meta information such as Protocol or Method Detection Limit. For example if you know that in all imported samples, the detection limit of mercury is 1 ng and the method 245.1 was used for analysis, the replace feature is the fastest way for updating this information. Alternatively this information has to be entered manually in the sample detail screen, if it was not included in the import data source.

Find

The Find dialogue allows you to create queries of the samples or stations in the AquaChem database.
You may run a Simple, Result meta data, Complex Search, Find Exceedances, Find Maxima, or SQL Query search. Each query type is discussed below.

The records which satisfy the defined search criteria will then be highlighted in your active list. You can now use the filter options in the active list to reduce the list of samples or stations to the highlighted records or to remove highlighted records from this list.

**Simple**
A simple search allows you to specify one criterion based on Station, Sample, or Measured values. All records matching the search criteria will be selected (highlighted) in the active list window after the search operation is completed. This feature is very useful for filtering the active list to include only those samples or stations which meet a specific criteria.

To run a Simple Search:
Enter a parameter in the Parameter field, or click button to select a parameter from the list.
Select the desired Operator (<, >, =, LIKE). Searches for strings that use the = operator return exact matches, whereas searches that use the LIKE operator return matches that contain the substring you have specified in the Value text field. Searches for character strings are not case sensitive.
Enter the corresponding parameter Value. (The units for the parameter value will be read from the Database options for the selected parameter.)
Press [Apply].

**Result meta data**
A meta data search allows you to search for result meta data, e.g. all samples where the method detection limit of mercury is above a given value. An example of useful meta information is also whether the results originates from a filtered or unfiltered sample. The meta data search allows you to quickly search for all samples having calcium concentration results from filtered samples. When you select Result meta data search, the following fields will be presented:

The set-up for the meta data search is very similar to that of a simple search, with the exception of the extra field, Metadata field, which allows you to select the appropriate meta data.

To run the Result meta data search:
From the Type combo box select Result meta data search
Select the desired Parameter, Metadata, and the Operator
Enter the corresponding Value
Click [Apply]

**Complex Search**

A complex search allows you to specify multiple criteria based on Station, Sample, Measured, Calculated, Thermometer, and Modeled values.

When you select Complex Search the following dialogue will appear:

This option allows for a more advanced search of your database. It allows you to combine queries with logical operators, select the unit for each concentration parameter and to search on function results as well. (e.g. Find all samples where Cl < 50 AND Hardness > 100).

To run a Complex Search:
From the top of the Find dialogue, select the Complex Search option
Enter a search string (Parameter, Operator, and Value)
Press the [Add to Criteria] button
This will cause the search string to be moved to the lower half of this dialogue. You can now add an additional search string.
Press [Apply] after you entered the desired search strings, to run the query.

The Logical field is a combo box containing `AND' and `OR'. These logical operators are used to link multiple search criteria. This field is only available after you have entered at least one search criterion. The Parameter field is used to specify a database parameter on which to
base the query. Below the Operator field, there is a combo box listing the available comparison operators (>, >=, <, <=, <>, LIKE, NOT LIKE). In the Value field, enter a parameter value for the Find criteria. The Units field is used to select a unit system for searches based on chemical parameters or their ratios. This may be useful in the following example: you are searching for samples where concentration of sodium exceeds that of chloride, indicating a sodium source other than halite. The concentrations may be stored in mg/l in the database, but you may specify a search for a Na/Cl ratio > 1 expressed in mmol/l.

The [Add to Criteria] button is used to transfer the specified search criteria to the Search Criterion list box. You can also type the query expression directly into the Search Criterion text field if you are familiar with the format. The and buttons allow you to add or remove search strings directly and to form the search criteria frame.

Under the Options, you must specify the query options for the Advanced Search:
Clear current selection before query: this will cause the current search query to be cleared, and run a fresh new query.
Add hits to current selection: the samples that were highlighted from a previous query will remain so.
The Select Representative Samples Only option will find only samples that fulfill the current query and are marked as representative in the Sample Details window. This might be useful when comparing samples for different sites and you only want to see a few representative samples per site on plots, reports, etc.

You can assign a representative sample for each site when entering the data in the Sample Details window using Sample > Representative > On or checking the Sample is representative of this site check box in Sample Details window. If you use the Select Representative Samples Only option, only the samples which are representative of each site, and which satisfy the search criterion are returned.

Below are a few examples of the Search Criterion and Search Results:
Date > 01/01/1960 Returns all records sampled after January 1st, 1960.
Location = Baden Returns all records with location "Baden".
Location LIKE Baden Returns all records with location containing the substring "Baden" (e.g. Baden, Badenweiler, Badentown, etc.)
Na/Cl>1 Returns all records with excess Na with respect to Cl (choose units of mmol/L when using ion ratios).

NOTE: The Find selection is context sensitive: if the Samples tab is active in the main list, the find will allow you to build and run a Find operation on samples; if the Stations tab is active, the find will be applied to stations.

NOTE: AquaChem allows you to save simple or complex queries for easy recall in the future using the [Save] button. Saved queries can be retrieved either within the find screen (select from combo box) or in the sample list by selecting it in the Filter combo box.

Find Exceedances
A Find Exceedances query allows you to find samples with a parameter that exceeds a specified water standard. When you select Find exceedances from the Type combo box, the following fields will be presented.
To run a Find Exceedances search:
From the Type combo box select Find Exceedances
Select the desired water standard from the Standard combo box (See "Water Standards" on page 173 for information on how to add water standards).
Select the desired parameter from the Parameter combo box.
The corresponding standard value for the selected parameter will display in the Standard text box.
Click the [Apply] button to perform the search.
All records matching the criteria will be selected (highlighted) in the active list window after the search operation is completed.

Find Maxima
The Find Maxima/Minima query allows you to find samples with the highest or lowest values of a selected parameter in all samples or just one station.

To run a Find Maxima search:
From the Type combo box, select Find Maxima.
Select the desired parameter from the Parameter combo box.
Select the desired mode: Min or Max. If you select Min, AquaChem will locate the sample with the lowest value for the selected parameter. If you select Max, AquaChem will locate the sample with the highest value for the selected parameter. Choose the group of samples with which to perform the query. Choose All Samples to locate the minima/maxima from all samples in the database. Choose the Per Station to find to locate the minima/maxima for each station in the database. Click the [Apply] button. All records matching the criteria will be selected (highlighted) in the active list window after the search operation is completed.

**SQL Query**
The SQL Query option allows you to query the AquaChem database using SQL syntax. This options requires that you have an understanding of SQL statements as well as good knowledge of the dataset.

```
select * from d_sample where WATERTYPE = "CaSO4-HC03"
```

To run a SQL Query:
Type the desired SQL statement in the white space (as shown in the image above). Click the Apply button. The query results will be displayed in a separate window, called SQL Query (shown below).
The query results can be refined further by using the Find field in the top left corner of the window. The contents of the window may be copied to the clipboard or sent to a printer by right-clicking on the table, and selecting the desired option.

**Find within Distance**
The Find within Distance command can be found from the main menu under Edit > Find within Distance. This command is only available when the Stations tab is selected in the active window. Entering a specified distance (metres) in the dialog box of the Find within Distance window and clicking OK will select all stations in the active window within the specified distance.

### 3.3 View Menu

**Table View**
Aquachem allows you to view and edit data in a tabular spreadsheet-like format containing all samples currently displayed in the Active sample list. This is a convenient method of handling a series of data or comparing selected parameter values for multiple samples. To create a spreadsheet view of the database, select Table View from the View menu. You can then use the Create option to create your own template, view the Default table view, or any customized table view.

**Edit**
When you select the Edit option, a Table View Settings dialogue will appear (as shown below) listing the parameters that will be included in the columns of the spreadsheet.
The Parameters dialogue tab can be used to select only those parameters you are interested in viewing/editing in a spreadsheet format. At the top of this dialogue, in the Settings field, you will see the name of the current table. In the lower half of the Table View settings dialogue, you will see the list of parameters as they will appear in the table. The order of the parameters can be changed by using the top, up, down, and bottom arrow buttons.

Parameters can be added or removed from the table view. To add a parameter, Click the button in the Table View settings dialogue and a Parameters dialogue will appear.
Select the Parameter category by pressing the button. Choose parameter(s) from the list that appears. Press the [Select] button. Press [Close] to return to the previous dialogue. To delete a parameter(s), simply select parameter(s) from this list and press the button.

The Unit for the table view can also be changed, along with the column (Col Title) or row titles and the number of digits used to display the results. Limiting the number of digits is useful when displaying function or ratio results. Once you are satisfied with the Table view, press the [Save] button at the bottom of this dialogue. Alternatively, you may save the table view settings under a new name. To do so, press the [Save As] button at the bottom of this dialogue, and this will load the Save Settings dialogue as shown below.

In this dialogue, enter a Name and an optional Description for the new Table View you have created and press [Save] to return to the Table View settings dialogue. Saved settings can now be retrieved from the Settings combo box of the Table View Settings dialogue. In addition, this new Table View will now appear under the AquaChem View > Table View menu below the Default table view.

The Options tab allows you to further customize the report.
The Format may be set to Samples as Rows (standard) or Samples as Columns; the latter gives a better overview if the spreadsheet contains many parameters, but only a few samples. In the Highlight Exceedances combo box you may define whether and how values exceeding the currently active water standard will be highlighted. The selection includes using a bold font for the exceeding values or marking the cell with background color showing which level of the standard has been offended. The legend for those colors is shown at the bottom of the screen. The Show Standard option allows you to include the standards values below the row or column of parameter names. Note that all levels of the standards will be shown for multi level standards, e.g. MCL (Maximum Contaminant Level), MCLG (MCL Goal), AO (Aesthetic objective). You can define the code that displays for both non-detect values and not analyzed values, using the Non Detect Code and Not analyzed code text boxes, respectively. In the Show Statistics grid, the user may define statistical values that will be added below the last sample row or column. All summary statistics functions may be used.

Typically the minimum, maximum, mean, percentile, etc., functions are useful in this context. To add statistical functions,

Press the button
Select one or several functions from the statistical functions
Press the [Select] button in the screen shown below
Back in the spreadsheet option tab, you may change the default column or row title for the statistics function using the title column in the screen shown above. For percentiles, you must define the fraction of percentile in the value column that should be calculated, e.g. enter 0.25 for a quartile or 0.5 for the median.

Once you are finished, click [OK] to load the Table View window.

In this dialogue, the colored cells indicate sample exceedences, as defined by the currently selected Water Quality Standards (WHO, CCME or US EPA). Samples which exceed the guidelines will be shaded with the appropriate color, as defined in the File>Preferences>Standards - Configure. At the top of the table view, an water quality standards table is displayed.

You may edit the data in this window as needed; simply edit the required cells with new values. New data will be automatically saved to the database.
NOTE: You may not edit a cell displaying a station parameter. The reason for this is that the station parameters are not entered for each sample; instead each sample has a reference to the station table. Editing a station would edit this station in all samples where it is referenced. If you need to reference a different station for a sample, use the Assign Station option when you are in the Sample Details window (Sample > Assign Station). If you need to assign a station that does not yet exist in the database, create a new station using the Station > New command. You also may not edit values in the cells that are assigned formulas, e.g. a ratio of one parameter to another or the calculated electroneutrality, hardness, sum of cations, etc.

You may print the table view by pressing the [Print] button at the bottom of the window, or select Print from the main menu. Select File > Save from the main menu to save the table view; the file may be saved in .TXT, .CSV, or .XLS format. To return to the main AquaChem window, press [Close].

Default - the Default command will load a default Table View with default parameter settings.
Contaminants - the Contaminants command will load a Table View with common contaminants.

Options

The Options command will load the options dialogue for the current AquaChem window. There are options available for the various AquaChem windows. The options will be different for a plot, table view, active list, and the Sample Details window. Each of these is explained below.

The same function is performed by the Options icon on the toolbar.

Options - Active List
The active sample/station list can contain any sample/station description parameter from your database. To edit the parameters in the active list, select Options from the View menu (alternatively you can press the [Sort] button at the bottom of the active list window).

This dialogue allows you to add/remove the parameters which appear in the active list of samples or stations, or adjust their position using the up/down buttons. To add a new item click the button; to remove an existing item, click the button. Note that for performance reasons only sample and station parameters can be included in these lists. Additionally you can change the existing parameters. To do so, double-click on a parameter and select a new parameter from the combo box.

The Col title column contains the display names for each field. This column is editable, allowing you to modify the display titles of each field.
The Sort Order column allows you to specify the sort options for your active list. The active list will be ordered based on the assigned sort number given to each field. For example, in the image above, the list will be sorted by Station_ID and then by Sample_Date and Sample_ID.

To move fields in this dialogue, use the or buttons.
When you are finished press the [Close] button at the bottom of the dialogue to apply the changes to the active list.

**NOTE:** The active samples list and the active stations list each has its own sorting options. To access the sorting options for the Active Stations list, ensure the Stations tab is selected in the active list when you select View > Options.

**Options - Sample Details**
When a Sample Details window is active, click Options from the View menu to access the Sample Details Options dialogue as shown on the right.

Under the Analysis tab, you can edit the settings of the Sample Details window, specifically the Measured parameters tab. Fields can be turned on or off, by selecting Yes/No from the relevant combo box. You may also select the alternative units, a default parameter group, and enable/disable guideline exceedences (to activate or deactivate this option). You may show or hide the following columns:

- Comment: allows you to add a comment for each measured value (e.g. any difficulties encountered while measuring a particular parameter)
- Standard: select a level within the current water standard to be displayed with every measured result
- Protocol: protocol used for sample measurement
- MDL: method detection limit
- Precision: precision of measurement
- Outlier: outlier check-box (data considered outliers will no be shown on plots or included in calculations)
- Alternative unit: displays an alternate unit (e.g. meq/L when a value is expressed in mg/L)
- Alternative unit format: the conversion process from one unit to another may generate many decimal places. Use this field to set how many decimal places you want to appear

Default parameter group: the parameter group that is loaded by default (parameter groups may be defined in File>Database>Parameter Groups)
Highlight exceedences: choose whether or not to highlight guideline exceedences
If one or all of these parameters are not needed, you may hide the respective columns from the Sample Details window.
Under the Functions tab (shown on the right) you may edit the settings of the calculations which appear under the Calculated tab in the Sample Details window. These options allow you to control the appearance of the Calculated fields. The names of the Calculated parameters can be edited under the Title column. The units and number of decimal places for the Calculated values can also be adjusted. The order of the calculated parameters can be arranged using the and arrows.

Functions can also be added or removed using the and buttons respectively. Once you are finished, press the [OK] button to return to the Sample Details window.

For more details on the Calculations performed by AquaChem, please see the section Calculations.

Options - Table View
If you select View > Options while a Table View window is open, this will load the Table View Settings dialogue for defining the view of the selected Table (i.e. available parameters, table layout, etc.).

Options - Plots
If you select View > Options while a Plot window is open, this will load the Plot Options dialogue for that plot type.

Options - Reports
If you select Options from the View menu, while a Report window is open, this will load the Report Options dialogue for that specific Report type.

3.4 Filter Menu
The options under the Filter menu allow you to temporarily "hide" samples, and work with only a few samples or a subset of your database. Omitted samples will be excluded from any plots, tables, reports, or calculations. These options allow you to store several projects in the same database, but focus on specific sites or locations, and produce site-specific plots and reports.
NOTE: The Filter options apply to both the Stations and the Samples. For example, when a station is temporarily omitted, all samples associated with that station will also be temporarily omitted from the active list.

Show All
Using this command restores all the samples or stations to your active list, e.g. any samples that you omit can be reinstated into the active list by choosing Show All (Ctrl-A) option from the Filter menu.

Omit All
This option hides all samples or stations that are currently listed.

Show only selected
This option allows you to display only the selected sample(s) or station(s). All non-selected records will be hidden from the active list. When selecting samples/stations in the active list with the mouse, remember that AquaChem supports the standard Windows selection functions: press <Shift> or <Ctrl> to select multiple records.

Omit selected
This option hides the selected sample(s) or station(s) from the active list. These samples or stations are not deleted; they are simply not shown in the active list window, so that you may work with a subset of the database.

Invert Selection
Use this command to select all records that are not selected, and de-select all records that are currently selected.

Select Associated Samples/Stations
Use this command to select all samples which are associated with a station(s) or vice versa. For example, if you are in Stations mode and you want to locate all samples which are associated with a selected station, simply click Filter > Select Associated Samples then switch to the Samples tab and those samples which are associated with that station will be highlighted. This command can be applied to multiple stations or samples. Use the <Shift> or <Ctrl> keys on your keyboard to select multiple records.

Open Selection
This command allows you to retrieve a previously saved data selection:

In the Open Selection dialogue, select a previously saved selection from the list and press [OK]. All records belonging to the selection file will then be highlighted in the active list.
If you want to work exclusively with the samples from the selection file, select Show Only selected after opening the selection file. Selections can also be retrieved from the active list as shown below:

![Sample List - 28 Active Samples]

**Save Selection**
The Save Selection command saves the list of currently selected samples or stations to your database. In the Save Selection dialogue enter the name of the file. This file can be opened in later sessions to work with the same subset of the database.

3.5 **Stations/Samples Menu**

This menu is automatically updated to reflect the current context (sample or station) of the records list in AquaChem. If the Samples tab is selected in your list, or if you have a Sample Details window active, then this menu item will show as Samples. If the Stations tab is selected in your list, or if you have a Station Details window active, then this menu item will show as Stations. Each of the Stations/Samples menu item is explained below.

**New**
This item allows you to create a new sample or a new station. When you select Stations > New, you will see the a Station Details window:
To add station data, click with your mouse in the input fields and type in the required data. Use the <Enter> key to accept the value and advance to the cell below. Click the [Save] button at the bottom of the details window to add the new record to your database.

When you select Samples > New, you will see a blank Sample Details window:
NOTE: You must have at least one pre-defined station in your database before creating a new sample. Therefore, when you create a new database, you must first create a minimum of one station; then you may create a new sample and Assign this station to this new sample.

To add sample data, click with your mouse in the input fields and type in the required data. Click the [Save] button at the bottom of the details window to add the new record to your database.

**Clone**
Creates a duplicate sample or station. In this procedure only the potentially common data among different samples (such as sampling data, station, etc.) are copied. Cloning samples can be an efficient way of creating multiple samples belonging to the same sampling event.

**Edit**
Opens the Sample/Station Details window for the selected sample or station.
Delete
Deletes the selected sample or station.

Assign Symbol
The Assign Symbol option allows you to assign symbols to your samples. This option is only available when you are in Samples mode.
To assign symbols to samples:

Select the desired sample(s) in your active list
From the main menu, select Samples > Assign Symbol.
The Assign Symbol dialogue will appear, and provide a list of the available symbol names and the corresponding symbols.

Choose one symbol from this list and click the [Assign] button. This symbol will then be assigned to the selected sample(s).
To return to the active list of samples press [Close].

To edit the symbol options, select Plots / Define Symbol or Line and the following dialogue will appear.
In this dialogue, you can create symbols and symbol groups, and define the symbol characteristics. The upper portion of this dialogue contains the Symbol Group and the symbols belonging to this group. You can create multiple symbol groups for your samples. For example, you may want to assign symbols based on site, however you may also want to assign symbols based on geology, aquifer body or another variables. To do this, simply create a new symbol group, define the symbols, and assign these symbols to the samples. However, only one symbol group may be plotted at a time. Samples that have not been assigned any symbol of the current symbol group are automatically assigned Symbol 1 of the Default group.

**Symbols Tab**

There are two default symbol groups included with every new AquaChem database: Default and Station. The Default symbol group includes one symbol, called Default. The Station symbol group includes one symbol for each unique station ID that is created in your database. Each time a new station is created in your database, a corresponding symbol will be created in the Station symbol group; the symbol name will be identical to the Station ID.

To create new symbol groups, click the button beside the combo box below the Symbol Group combo box:

The Symbol Groups dialogue will appear as shown below:
Click \( + \) button to create a new symbol group and then enter a name for the new symbol group.

Click \( - \) button to delete existing symbol groups.
Click [OK] to return to the previous dialogue.

The Symbol Name on Legend frame lists the available symbols, their name and status, for the corresponding symbol group.

To add or remove symbols from a symbol group:
Click \( + \) button to add a symbol to the group.
Click on the delete button \( - \) to delete the selected symbol.

The symbols with a check mark beside them are active; as a result, the samples associated with these symbols will be displayed on the open plots. To remove a group of sample data points from all of the open graphs, simply click on the appropriate check box to de-activate the corresponding symbols. The following buttons also appear in this dialogue:

- [Select All] To activate all symbols, press the [Select All] button.
- [Unselect All] To deactivate all symbols, press the [Unselect All] button. To move symbols in this list, use the up/down arrow buttons.
- To move the symbol up or down on the list.
- To sort the symbols alphabetically.
- To edit the selected symbol (see "Editing Symbols").
- To save the current symbol configuration.
Editing Symbols
When the Edit Symbol button is selected, the following dialog will appear on your screen (ensure you select a symbol from the list before selecting the edit button).

Under the Symbol tab you will see different shapes of the symbols. The Color and Size of the symbol can be modified and Symbol Previewed as it will appear on the plots. AquaChem is capable of using geometric markers (default) or "True type fonts" for symbols on plots and graphs. The symbol type can be changed in the Preferences dialog.

Under the Connecting Line tab you can select Style, Width and Color. Each symbol is associated with a particular line style. This line style, the width of the line, and the line color can be customized for each symbol. The Style field displays a selection of six line styles, a line width, and a line color that can be displayed in the Depth Profile Plot, Schoeller graph and the Time Series graph to connect associated data points. Line styles other than solid can only be applied if the line width does not exceed 0.3 mm.

Click [Apply] to save changes you made to the symbols. To return to the main AquaChem window, press the [Close] button.

Options Tab
The Show only symbols present in record list option allows you to hide symbols, which are not used by any of the active samples. This can be useful when, for example, your project includes tens of stations but you would like to have quick access to the three stations you are currently working with.

The Identify Samples option is used to highlight the samples in the active list that are associated with the selected symbol.

Creating New Symbols
Follow the instructions below to create a new symbol:
Select a Symbol Group from the combo box at the top of this dialogue

Press the button and a new field will be added to the list of symbols
Enter a name for the new symbol
Then press the <Enter> key (on your keyboard) to accept the new name
Click the Edit button to edit the selected symbol
Choose a symbol character from the list of available symbols
Choose a Color for the new symbol. To access the color options, press the button beside the color field, and select a color from the Color palette.
Choose a Size for the symbol. A list of font sizes can be accessed by clicking the button from the combo box.
Click the [Close] button
Press [Apply] to create the symbol
Press [Close] and return to your sample list
Now use the Samples > Assign Symbol option to assign this symbol to the desired samples.
If done successfully, the active samples window will display a column listing the symbol number which is assigned to each sample.

**Auto Generate Symbols**

AquaChem includes a convenient feature that allows you to automatically create symbols based on station database parameters. For example, your station data contains a parameter
"Geology" and ten distinct geology terms have been assigned to the stations within the current project. Instead of searching for all different geology terms and adding a symbol for each one, you may use the Auto feature to create these items. Press the [Auto] button in the Define Symbol or Line dialogue to load this option. Typically, parameters that should later be used as symbol labels should be defined as list of values (pick list) in order to guarantee consistent spelling.

**NOTE:** The auto generate symbols option is not available for the Default symbol group. You must first create a new symbol group in order to activate the [Auto] button and to use this option.

In the Auto Generate Symbols dialogue, you will be prompted to choose a parameter for which symbols will be automatically generated. The available parameters are all Sample and Station description parameters and measured parameters as defined in your database template.

Numeric and text parameters will be handled differently. If you choose a parameter of type text, e.g. Geology, the grid below the selection box will be filled with all geology expression that could be retrieved from the current data set. You may edit or remove expressions that are not required or add new geology expressions. Note that for new expressions, a symbol will be created, but no samples will be initially assigned to this symbol.

After selecting a numeric parameter (any station, sample or measured parameter) the grid below the selection box will be filled with 5 classes dividing the range in which the selected parameter is represented in the database into regular intervals. You may remove, edit and add any intervals and edit the interval legend.
A unique symbol character will be generated for each symbol group, and will use the default font size of 12 and default color black. Select the desired field and click [OK] to return to the Define Symbol or Line dialogue, where you will see the new symbols which were automatically generated. You now have the option of modifying these new symbols (i.e. the shape, color, name, size, etc.).

The new symbols are automatically assigned to the samples in your database; the symbols will be assigned to the matching parameter for that sample. For example, if you automatically generate symbol groups based on Location, AquaChem will search your database for all instances of the Location parameter, and create a symbol for each unique entry for Location. For numeric parameter, each sample will be assigned to the symbol, where the sample parameter lies between minimum and maximum value specified for this symbol.

**Assign Station**

The Assign Station option allows you to assign a station to the selected sample. This menu item is only available when a Sample Details window is active.

When you select Samples > Assign Station from the main menu, a Station List dialogue (as shown here) will appear with a list of the available stations in your database.
From this dialogue, you may select a station directly from the list; or if you have a large list of stations, the Find feature at the top of this window can be helpful. Once you have located the desired station for this sample, press the [Assign] button at the bottom of this dialogue and this will return you to the Sample Details window.

**Representative On / Off**
This option defines the Representative samples flag for the selected sample(s). A representative sample is indicated by the presence of a check mark in the Active Samples window as shown below.
This feature is convenient when handling a large dataset consisting of many samples from multiple stations. By marking manually one or several samples per station as representative, you may later filter these samples much more quickly when creating plots comparing all stations, where the selection of all samples would make the plot confusing.

When you perform a search or calculation, you may choose to use only samples in the active list which are representative of each site.
To enable this option, choose Sample > Representative > On.
To disable this option, select Sample > Representative > Off (or manually remove the check mark in the Sample Details window).
NOTE: The Representative menu item is only available when you are in the samples mode.

**Goto next Selected (CTRL+S)**
Use this menu item to navigate highlighted records in the sample or station tables.

### 3.6 Plots Menu

The following section provides a brief summary of the commands in the Plots menu. For more details on the AquaChem plots and the plot options, please refer to the Plots Chapter.
New
This item allows you to create a new plot.

Open Configuration
Opens a previously saved plot configuration.

Save Configuration
Saves the current set of plots and their settings to the current AquaChem database.

Close All Plots
Closes all plot windows.

List of Plots
Loads the List of Plots window. The List of Plots contains a list of all opened plots, and allows you to make changes to multiple plots simultaneously. For example, you may have generated time series plots for each station in your project. Using the list of plots, you can quickly adjust the axis extents, change fonts and symbols, etc. for all opened plots, simultaneously.

To make changes to multiple plots in the plots list, highlight the desired plots by holding the SHIFT key on your keyboard, and selecting each plot.

Select one of the buttons in the Options frame to load the associated options. You may change settings for the X-axis, Y-axis, Y2-axis (if applicable) plot Title and plot Legend. You may also show/hide the Plot grid. For more information on these plots options, please refer to "Common Plot Features".

Once the desired changes have been made, click the Refresh button to apply the changes to the highlighted plots.

You may also select from the following commands:
- Close All Plots - closes the highlighted plots
- Minimize Plots - minimize the highlighted plots
- Restore Plots - displays any of the highlighted plots that have been minimized.
- Refresh All Plots - applies changes made in the options to all highlighted plots.
- Clone Plot - to make a duplicate copy of the highlighted plot.

You may also select from the following order by options:
- Plot Title then Y axis Title
- Y axis Title then Plot Title

You may use the green up and down arrows to order the plots. This information is saved within your plot configuration so when recreating plots you can save time.

**Define Symbol or Line**
Loads the Define Symbol or Line dialogue for defining symbol and line properties as they appear in the plots and graphs. For more details on this dialogue, please refer to the sections Assign Symbol, Creating New Symbols, and Auto Generate Symbols above.

**Show Sample Data**
If this option is selected, AquaChem will display a window with the data for the selected sample. Simply click on a sample point from the plot and the Info data dialogue will appear. Each time you click on a new sample point, the new data is loaded into dialogue. An example is shown below.

**NOTE:** You may need to re-arrange the positions of your windows in order to see the sample data dialogue.
Identify Plot Data
The Identify option allows you to link the plotted data to the samples in the active list. This allows you to click on a point in the graph and view the corresponding sample in the active list. This is useful when you have a large number of samples plotted on one plot, and you want to identify outliers.

There are three options available for selecting and identifying points on a plot: None, Selected Plot, and All Plots. The default mode to identify points is on All Plots; this means that all data points on all plots are linked to the database. These three options are described below:

None
If you click on a plot, no samples will be highlighted. The data points on the graphs are not linked to the database which means that samples are not identified. When you have several open graphs and a large database with many samples, it may be convenient to have no link between the graphs and the database in order to increase the speed of the various AquaChem operations.

Selected Plot
Only the data points in the active graph are linked to the database. The plotted point is activated (turns red color by default) and is selected in the sample list. This mode is useful if you are working with a large data set and want to focus on just one graph.

All Plots
The sampling point of the corresponding sample is activated on all plot windows and on the sample list. If you are working with several graphs, you can simultaneously identify a sample.
in all plots by clicking near a point in any of the plots, or by clicking on a sample in the active list. The sample will become selected in the active list, and the corresponding data points will be highlighted in red (by default) in all the open plot windows. If the Table view is open, the records will be identified here as well.

3.7 Reports Menu

The Reports allow you to create a summary of your data from your AquaChem database. AquaChem generates seven pre-defined reports and also allows you to create your own report templates.

These reports are all generated in a separate Report window in a spreadsheet view. The reports can be printed `as is' using the [Print] button on the lower-left corner of the window or saved using the [Save] button.

The following is a brief summary of the options under the Reports menu. For more details on Reports, please refer to the Reports Chapter.

Data Summary
The Data Summary report allows you to generate a summary report for the AquaChem database and all stations and samples currently displayed in the Active Stations/Samples list.

Compare Sample
The Compare Sample report allows you to compare a sample in your database to another sample or multiple samples. The Compare Sample report uses a linear regression algorithm to generate the Correlation coefficient and the Euclidean distance between a selected sample and all other active samples. Samples having a chemical composition similar to the selected sample will have a correlation close to 1 and a small euclidean distance. Samples having similar chemistry, but being diluted with respect to each other will have correlation close to 1, but a large euclidean distance. Samples with little similarity will have a correlation coefficient close to 0.

Mix Samples
The Mix Samples report generates solution concentrations resulting from the step-wise mixing of specified proportions of two selected samples from the project database.

Water Quality Standards
The Water Quality Standards report provides a summary of parameters exceeding the established Water Quality Standards for the selected sample. The selected samples are compared to the pre-defined Water Quality Standards as specified in the Preferences in the File menu.

Hardness Dependent Standards
The United States Environmental Protection Agency (EPA) has established standards for metals where toxicity is a function of hardness. The water quality criteria for metals can be expressed as "total recoverable" or "dissolved" for acute and chronic concentrations. The total recoverable also includes the sorbed concentration on particles. Acute standards offer protection from toxic effects from chemical concentrations during a shorter term exposure. Chronic standards offer protection from toxic effects from a chemical during long-term exposure.
EPA Freshwater standards are mainly used for hardness dependent standards, however similar standards can be found in different countries. The demo_basic database provided with AquaChem only includes the EPA Freshwater Standards, however you may create your own standards.

**Rock Source Deduction**  
This report allows you to determine with what kind of minerals the water sample has been in contact with during its subsurface journey. The results are based on ion ratios and total dissolved solids found in the sample. If results do not meet expectations, they should be confirmed with more a detailed study based on multiple samples, aquifer mineralogy analysis, modeling, and plots.

**Statistics**  
The Statistics submenu provides several statistical analyses you may wish to perform on your data.  
- **Summary Statistics** - Generates the summary statistics such as Minimum, Maximum, Mean, and Percentiles for all samples available in the project.  
- **Correlation Matrix** - Generates a correlation matrix for a specified number of sample parameters that are common to all active samples. A linear regression routine calculates the regression coefficient (r), and the slope and intercept of the regression line.  
- **Trend Analysis** - Calculates the trend for a selected parameter using linear regression, Sen's test, or Mann-Kendall test.  
- **Outlier Tests** - Uses Dixon's (extreme value) test, Discordance test, Rosner's test, and Walsh's test to determine whether there are any outliers for a specified parameter in the dataset.

**Sample Summary**  
The Sample Summary report provides a general overview of a sample including major ions, hydrochemical facies (e.g. Na-Cl), calculated hardness, ion balance, ion ratios, etc.

**Report Designer**  
The Report Designer allows you to customize your own reports based on a single sample. The user defined reports may contain any parameter, ratio of parameters or function values. It is also possible to add a template and create a print ready output for your report. For more information refer to Chapter 5: Reports.

### 3.8 Tools Menu

The Tools menu provides access to the data analysis tools, including converters, calculators, and access to the PHREEQC modeling interface. The following is a brief summary of the options under the Tools menu. For more details on Tools, please refer to the Tools Chapter.

**Calculators**  
When you access the Calculator option from the Tools menu, you will find the following options:

- **Aggregate Samples** - This tool allows you to create a new sample based on a number of selected samples, which are aggregated using various algorithms such as minimum, maximum, median, geometric mean, etc.
- **Aquachem Function** - The Aquachem Function is a complement to the Calculated parameters tab available in the Sample Details window. It allows you to calculate any
function in any available unit quickly and easily, based on the selected sample. The calculations in the Sample Details window are fixed and typically contain only the most commonly used calculations. However, if you want to use some of the other calculations the Aquachem Function dialogue provides these options.

- **Calculate facies** - This command calculates the Watertype expression for all highlighted samples.

- **Corrosion and Scaling** - This tool estimates a samples tendency for scaling or corrosion

- **Decay Calculator** - This tool allows you to calculate the degradation of a species by a first order reaction:

\[
\frac{dC_A}{dt} = -C_A
\]

You may choose to calculate:
- Concentration after a specified amount of time
- Time to reach a specified concentration
- Estimate half life from given measurement concentration values

Aquachem includes half-lives for more than 300 species, for physical phases including air, soil, groundwater and surface water. These half-lives are taken from the following reference:

- **Find Missing Major Ion** - This tool helps you to fill in data for missing cations or anions, using the charge balance and existing measured values for other ions for the sample.

- **Formula Weight Calculator** - This tool helps you to calculate the formula weight based on a user-defined formula.

- **Oxygen solubility** - This command allows to calculate the theoretic solubility of oxygen based on the temperature and elevations of using the American Society of Civil Engineers' formula.

- **Volume Concentration Converter** - This converter is used for samples with measured organic chemicals. It allows you to convert measured concentrations in ppm by volume (ppmV), to mg/m3 at a specified temperature.

- **Retardation** - This tool allows you to calculate the retardation coefficient by entering your porosity, organic content and the Kd (distribution coefficient).

- **Special Conversions** - This tool provides conversions for non-linear geochemical calculations. E.g. Conductivity<>Resistivity, pe<>Eh, etc.

- **Species Converter** - This tool allows you to convert any species into a different form. This is useful to express a measured amount of a parameter as a different aqueous species in mg/L. For example, you may convert Nitrogen as NO3 into Nitrogen as N or vice versa.

- **Unit Calculator** - This tool performs basic unit conversions for length, time, volume, density, mass, etc.

- **UTM Conversion** - This function allows you to calculate geographic coordinates from projected (UTM) coordinates, and vice versa, for stations in your database.

**QA/QC**

- **Compare Duplicates** - this report allows you to compare any two records with matching DuplicateIDs and determine where they differ for each concentration result.

- **Highlight Duplicates** - select this option in order to highlight all samples marked as duplicates. Aquachem considers a sample as duplicate, if the Duplicate_ID value of the sample description is not empty.

- **Highlight Outliers** - selecting this option will load a dialogue in which you can choose a parameter. Clicking OK in that dialogue will highlight all samples in the Active Samples list that have the outlier flag selected for the parameter value.
- **Holding Times** - this tool allows you to calculate Holding Times for selected parameters. You must specify which fields contain the date and time used for calculating the holding time under File>Preferences>Holding Times Configuration.
- **Manage Duplicates** - this tool allows you to find and mark duplicate samples by assigning duplicate codes.
- **Method Detection Limit** - this tool allows you to check your samples against Method Detection Limits which are configured by selecting File>Preferences>Database Parameters.
- **Reliability Check** - the Reliability Check report allows you to confirm the validity of the measured sample data. There are a number of tests provided in AquaChem which can provide insight into the reliability of your analysis.
- **Total/Dissolved Comparison** - this tool allows you to compare total (or unfiltered) and dissolved (or filtered) concentrations.

**Look Up Tables**
The Lookup Tables shows the tables that are defined in the File > Database > LookUp Tables dialogue. These tables allow you to quickly find information for use in AquaChem.
- **Degradation Rates** - This look up table provides a list of degradation rates for common organic chemicals.
- **PHREEQC Phases** - This look up table provides a list of commonly used minerals including formula and formula weights from the PHREEQC thermodynamic database. If no PHREEQC options are specified in the preferences, then this table will be empty.
- **Periodic Table** - This table provides information for the elements of the periodic table.
- **Water Standards** - This table contains all of the water quality standards and guidelines for the current database.
- **Time Series** - This allows you to select and view any table of time series data that you have imported.
- **Browse Database** - This allows you to browse through the entire AquaChem database and view any table.

**Modeling**
AquaChem has a built-in link to the PHREEQC geochemical modeling program, that is capable of creating one or more solutions from the water quality samples in your AquaChem database. The Modeling option under the Tools menu provides links to the various options for PHREEQC. The following is a brief introduction to the modeling features included with AquaChem. For more details, please see Chapter 6 and 7.

**Calculate Saturation Indices and Activities**
This command will run PHREEQC for the samples selected in your active list. PHREEQC will calculate saturation indices and activities for those parameters which are defined in your database (those parameters listed in the Modeled Parameters tab). The results will automatically be saved back to the Sample Details table, for the selected samples.

- **Calculate pH** - this allows you to calculate the pH for the selected samples. The simulation is based on the assumption that the solution is in equilibrium with a carbonate mineral. This utility may be used to estimate the pH, in the case where a measured pH value is not available. However, this is calculated based on the assumption that the groundwater sample in question flows in a carbonate aquifer and is in equilibrium in respect to calcite or another specified carbonate material.
- **Calculate Eh** - this allows you to calculate the Eh for the selected sample based on a redox couple. The Eh is calculated based on the redox speciation, using the Nernst Equation. Each Redox couple gives an individual Eh value which in cases of equilibrium conditions should be reasonable. This menu item launches PHREEQC to search for available redox couples and to calculate ph and Eh values for each couple.
• **Alk > HCO₃, CO₃** - Alkalinity is the measure of the total acid-neutralizing capacity of the water. Since most of the alkalinity in a natural groundwater is due to inorganic carbon species, it can be used to determine bicarbonate and carbonate concentrations. This utility allows to calculate the bicarbonate and carbonate concentration based on the total alkalinity and pH of a selected sample. For a given alkalinity, the bicarbonate/carbonate ratio increases with higher pH values and decreases under low pH conditions. When this option is selected, the following warning message will appear:

![Warning Message](image)

Click [Yes] to calculate the HCO₃ and CO₃ modelled values for the selected sample. Any existing HCO₃ and CO₃ values in the selected sample will be overwritten with the modeled results.

• **Equilibrate with Minerals** - this calculator allows to equilibrate a solution with one or several minerals and calculates the amount of mineral that is necessary to reach equilibrium. This equilibration can be combined with a partial evaporation of the sample to simulate the evaporation process. As a further option, a pump rate and duration can be specified and the program then calculates the total amount of solids, that will be precipitated or dissolved during this period.

• **PHREEQC (Basic)** - this allows you to create an input file for PHREEQC, and loads a graphic user interface to the most commonly used features of PHREEQC. The more advanced features (Inverse Modeling, Kinetics, and Advection/Transport) are not included in this option. To utilize these features, you may load one of the USGS’s full versions of graphical interfaces as explained below.

• **PHREEQC (Advanced)** - this will load an external window, containing one of the USGS’s PHREEQC interfaces (PHREEQC-Interactive or PHREEQC for Windows). This will allow you to use the full features of the PHREEQC modeling program, using your AquaChem samples as initial solutions.

**NOTE:** You must have one of the mentioned external graphical interfaces installed and configured in the PHREEQC section of the preferences in order to use this feature.

• **Generate PHT3D Input** - this option allows you to create PHT3D input files for use with PHT3D in Visual MODFLOW versions 4.2 or higher. For more information on this option, please refer to "Generate PHT3D Input".

### 3.9 Window Menu

Using this menu you can arrange the windows in AquaChem master window. Below the Arrange Icons option there is a list of all open windows, so you can easily navigate between them without shrinking them to arrange on a common screen.

- **Tile Vertical** - Arranges open windows one above the other.
- **Tile Horizontal** - Arranges open windows side by side.
- **Cascade** - Cascades open windows.
Arrange Icons - Organizes icons of minimized windows along the bottom of the parent window.

3.10 Help Menu

Contents - Displays the AquaChem On-line Help.
Index - Displays the Help index.
About - Displays the AquaChem version number and information on how to contact Waterloo Hydrogeologic

You can also find the AquaChem help online:

http://www.novametrixgm.com/help/aquachem/

This online version of the Help can be updated more regularly than the help within the program itself so check it out for the latest updates to the documentation!
When you select Plots from the main menu and then New, a sub menu will appear with a list of all the available plot types:

- Box and Whisker
- Depth Profile
- Detection Summary
- Durov Plot
- Geothermometer Plot
- Giggenbach Triangle
- Histogram
- Ludwig-Langelier Plot
- Map
- Meteoric Water Line (MWL) Plot
- Pie Chart
- Piper Diagram
- Probability Plot
- Quantile Plot
- Radial Plot
- Scatter Plot
- Schoeller Plot
- Stacked Bars (Distance) Plot
- Stacked Bars (Stations) Plot
- Stiff Plot
- Ternary Plot
- Time Series (Multiple Stations)
- Time Series Plots (Multiple Parameters)
- Time Series (Stacked Bars)
- Time Series (Statistics Summary)
- Wilcox Plot

AquaChem allows you to create multiple plots for the same data set and view these plots simultaneously within the Windows environment. Each of these plots is explained in greater detail later in this chapter. The following section describes some of the features that are common to all plots.

### 4.1 Common Plot Features

Although each graph type has unique characteristics, there are also many graphical features and options that are common for each one. When you select any of the graph types to plot, a Plot Options dialogue similar to the one below, will appear with default settings for the necessary parameters and plot settings.
After the plot has been created, there are two ways to access the Plot Options dialogue:

- Click View / Options from the main menu when a plot window is the active window; or
- Right-mouse click on the centre of the plot window.

The Plot Options dialogue is typically divided into two major parts: the Parameter/Series Options and Plot Options.

The Parameter/Series Options portion of the dialogue allows you to set up various parameters of the plot, while the Plot Options portion allows you to set up such plot features as the legend, symbols, title, and labels. Simply click the button to load the appropriate dialogue.

Parameters Dialogue - Contains information on the parameters/series used in the plot, axis labels and font options, axis titles and ranges, and toggles to turn the plot gridlines or axis ticks on/off.

Title Dialogue - Contains options for plot title, position, and font size.

Symbols Dialogue - Contains options for symbols used in the plot, proportional symbol options, etc.

Legend Dialogue - Contains options for displaying a plot legend, legend title, and display features.

Labels Dialogue - Contains options for displaying and customizing symbol labels.

Format (Axis) Dialogue - Contains options for customizing the axis values and appearance.
Annotations Dialogue - Contains the options for adding one or more text annotations onto your plot.

Each Options dialogue has the following buttons located at the bottom of the dialogue:
- The [Apply] button will apply the current plot settings to the selected plot type.
- The [OK] button will apply the current plot settings to the selected plot type and will close the plot options dialogue.
- The [Cancel] button closes the plot options dialogue.
- The [Set Default] button will save the current plot settings as defaults for that plot type. This includes plot parameters, grid lines, axes titles, legend appearance and symbol settings, but does not include plot titles. The default settings will be applied every time you create a NEW plot of that type, with the current database.

The Axes/Parameters dialogue has several buttons and functions which are common for most (but not all) plot types:
- The add button allows you to add new parameters to the plot. The add button will load the parameter list dialogue, and allow you to select a new parameter from the list of available parameters in your database. Simply choose the desired parameter, press the [Select] button and this parameter will be included in the plot. When you have chosen all needed parameters, click [Close] to return to the options. The button beside a required parameter performs the same function.
- The delete button will remove the selected parameter from the plot parameters list.
- The up-arrow button allows you to shift the selected parameter upwards in the list of parameters.
- The down-arrow button allows you to shift the selected parameter downwards in the list of parameters.

Title Dialogue
Clicking on the button beside Title launches the following dialogue:

In this window, you can enter a Plot Title and edit the title font by pressing the button. In addition, you can change the Position, and Alignment of the plot title.

- **Plot Title** - Defines the title of the selected graph type. Enter the plot title in the text field provided. If no text is entered, then no title will be plotted.
- **Position** - Defines the position of the plot title as either Above Plot or Below Plot.
- **Alignment** - Defines the alignment of the plot title as either Left justify, Centre justify, or Right justify in the plot window.
- **Shift From Axis** - Defines the vertical distance of the plot title above or below the plot.
**Automatic Plot Title Option**

AquaChem includes a useful utility which will allow you to automatically assign plot titles based on any station or sample description parameter, or a combination of these parameters. This is very practical especially when you are creating a large number of plots.

**NOTE:** This feature is applicable only to plot types that represent one distinct sample per plot (Pie, Radial and Stiff plots only).

To setup the Automatic Plot Title features, close all plot windows and ensure the sample list is the active window. Select File from the main menu, then Preferences. From this dialogue, choose the Plots tab and a window similar to the one shown below will appear.

![Preferences dialog](image)

Under the Plot Title Options section (in the lower-left corner), you can specify which parameters you would like to appear when using the automatic title option. Parameters can be arranged, and added/removed using the up, down, add, or remove buttons. Once you are satisfied with the parameters, you must specify a Field Separator. This will be the character that separates the parameters in the title of the plot. You can use any character as the field separator, however the most common are a hyphen, comma, or semi-colon.

Below you can see an example of the plot that uses the automatic titling feature with specified parameters:
NOTE: By default, all Pie, Radial, and Stiff plots will be titled automatically with the fields specified in the Preferences dialogue. To change the plot title after the plot has been created, simply type in a new plot title in the Plot Title field, and press [OK].

Symbols Dialogue
The options in the Symbols dialogue allow you to edit the symbol appearance settings.

Show frame
In this frame you find the following options:
- Show Symbol - show/hide symbols using this check-box
• Display selected samples only - display only the samples selected from the Samples List using this check-box (need to pre-select the samples)
• Show precision - show/hide precision bars using this check-box (Precision value must be entered for this particular parameter in the Sample Details window)
• Connecting lines - show/hide connecting lines using this check-box

Edit frame

Symbols - Click the button to open the Define Symbol or Line dialogue. In this dialogue, you can define the names and status of the symbol groups, the shape and color of the symbols, and the line-type and color of lines that appear in the plots (refer to the Define Symbol or Line section in Chapter 3 for a description of the symbol groups settings).

Labels - Click the button to open the Labels dialogue. In this dialogue you can specify the labels for each individual data point or for multiple data points at once. Select the text, font, and position for the label. For more detail see Labels dialogue section later in this chapter.

Scaled Symbol Size frame

Proportional to - This option allows you to scale the size of the plot symbols based on a user-defined parameter (TDS, pH, Cond, etc.). This allows you to represent an additional parameter on your plot. For example, in a scatter plot, you can display information on three parameters, instead of only two (X and Y). Once the parameter is selected, you can choose different units for this parameter.

Scaled from ... to ... Points - Defines the minimum and maximum radius of the scaled symbol size. The minimum symbol size will be plotted for the lower limit of the proportional parameter value, while the maximum symbol size will be plotted for the upper limit of the proportional parameter value. The minimum radius ensures that all symbols will be visible even if the proportional parameter value is zero.

Lower and Upper Limits - Defines the minimum/maximum value of the proportional parameter to use for plotting a proportional symbol size. The lower limit is the value below which the symbol size does not get any smaller; i.e. all samples with a proportional parameter value less than the lower limit, will use the smallest symbol point size; likewise for the upper limit. The purpose of the lower limit is simply to set a value below which the symbol sizes do not change.

If you want to exclude symbols from the plot based on a specified criteria, then you should create a query to filter out the undesirable samples.

Legend dialogue

Most plots have legend options, as shown below:
You can access these options either by clicking the button beside Legend in the Plot Options dialogue, or by right clicking on the plot legend itself.

Contents frame
Symbol Names - Show/hide symbol names using this check-box. When the legend is visible, the Symbol Names from the currently selected symbol group will be displayed on the plot. Use the font button below the options to edit the font of the symbol names as they appear in the legend.
Ignored symbols not present in plot - When this option is active, the plot will show only those symbols which are used in the current plot. For example if 10 symbols are active, but the current selection of samples only uses 2 of them, AquaChem will ignore those symbols that are not present in the plot and display just the 2 symbols in the legend.
Scaled Symbol Size/Color - This option is only active if you have symbol sizes plotted proportional to a parameter value, under the Symbols options. When this is activated, the legend will show a scale for the proportional symbol sizes.
Show Line Legend - Show/hide line legend using this check-box.
Columns - Specify the number of columns for displaying legend items

Frame frame
Visible - Show/hide box around the legend using this check-box.
Shadow - Show/hide the legend shadow effect using this check-box.

Line Dialogue
AquaChem allows you to put a calculated or user-defined regression line on your plot. For Time Series and Box and Whisker plots horizontal lines can also be added to represent line features such as Maximum Concentration Limit.
To create a new line click the in the upper right corner. The defined line follows the basic equation of $y=mx+b$ and once a new line is created you need to specify these constants for the line. There are two ways of doing so: calculate a linear regression trend or enter user defined values.

**Equation tab**

**Linear Regression frame** - This frame allows you to calculate the linear regression constants based on various selections:

- **All** - calculates linear regression using all available stations
- **Selected** - calculates linear regression using only selected series
- **Individual stations (names depend on the database)** - calculates linear regression based on one station

Once you've selected the data series, click the [Calculate] button to calculate the coefficients.

**NOTE:** The selection must include more than one point.

**Formula frame** - This frame allows you to enter custom values for the linear regression equation constants. If you used the Linear Regression frame to calculate values based on data points, these values will be displayed in this frame. If the Calculate feature was used, this frame will also display statistics of the calculations.

**Adding a Horizontal Line (Time Series and Box and Whisker plots)** - To add a horizontal line to a Time Series or Box and Whisker plot to represent a feature such as a Maximum Concentration Limit line, simply create a new line in the Lines dialog and edit the line name as you would like it to appear in the plot legend. Then in the Formula frame, enter the Y-axis value where you would like the line to be positioned in the b field of the $y=mx+b$ formula. The line can be included in the plot legend using the Legend dialogue.
Line Properties tab
Use this tab to customize the line appearance on the plot.

Style frame - Set the Style, Color, and Width of the line.

X-Axis Limits frame - Set the maximum and minimum X-value for the generated line. If left and right are set to Auto, the line will span the entire plot.

Format dialogue
This dialogue is only available in plots on X-Y style plots with linear axes.
**Axis** - This combo box allows you to switch between the available axes.

**Minimum/Maximum** - Allows you to customize the minimum and maximum axes values. AquaChem will determine a default minimum/maximum value based on all of the data plotted on the graph. If you enter a new value and you wish to return to automatic calculation, enter "A" in this field.

**Labeled Ticks** - Defines the interval value of the labeled ticks for the corresponding axis. AquaChem will determine a default value for the labeled ticks such that the plot will have 5 labeled ticks on the corresponding axis. If you enter a new value and you wish to return to automatic calculation, enter a value of "A" in this field.

**Label Angle** - Allows you to specify the angle to the axis at which the labels appear. Tilted tick labels are recommended for long labels which run the risk of overlapping on smaller plots.

**Minor Ticks** - Defines the number of minor ticks between each of the labeled ticks. The default value is 1. Only integer values are accepted.

**Format** - Sets the numeric format for the labels on the axes (e.g. Auto, 0, 0.0, 0.00, 0.0E+00, etc.). Beside Format, click button in the combo box to select from the list of available numeric formats.

**Title** - Defines the title of the corresponding axis. If a title field is left empty, a default title equal to the internal name of the parameter will be selected by AquaChem. If you want to omit one or both axes titles, type a space in the text field(s). Use the button to change the font.

**Log Scale** - Some plots allow you to show the plot data using a log scale for either the X or Y axis, or both. This allows you to normalize the data set, if there is a significant range in the data.

### Labels dialogue

Use this dialogue to set up the label display properties. This dialog is only available once the plot is created. All changes made to the labels are automatically updated in the plot.
In the grid at the top of the dialogue, select the samples for which you want to display a label. Click and drag the mouse pointer to select the stations in a continuous list, or hold down the Ctrl key to select individual samples. When the Labels dialogue is loaded, any samples that are currently selected on the plot (or in the Active List) will be highlighted for you.

**Parameter frame** - If you wish the labels to be displayed only for the selected samples, click the radio button beside Assign parameter result to selected samples only. Otherwise, leave the default setting of Assign parameter result to all samples. Use the combo box to select the parameter that will be used as the label. As soon as you do so, the labels will be displayed for selected (or all) samples.

**Edit Label frame** - You may use this frame to customize a particular label, or create a custom label for any sample. To do so, select a sample from the grid at the top of the dialogue. If this sample already has a parameter label, it will be displayed in the Label field. If this sample has no label assigned to it, the Label field will be blank.

**Label** - The label text is normally filled automatically from a database field. You may, however, edit this text or even enter all labels manually.

**Visible** - Use this check-box to display/hide the specified label for the selected sample(s).

**Connecting line to Symbol** - Use this check-box to display/hide a line connecting the symbol with the label. The connecting line is useful for densely placed symbols.

**Font** - Click the button to change the label font.

**Position frame** - Use the arrow buttons to position the labels. The label position is updated as soon as you click the arrow button.

**Annotations Dialogue**
This dialogue provides the options for adding text annotations onto your plots. This dialog is only available once the plot is created.

The green plus will add an annotation while the red x will delete an annotation. There are also options for an outline for the annotation box or whether to have the box transparent or filled white. Under the Text Entry portion of the dialogue you will find options for the alignment, font and font angle. The text is entered into the white box.

4.2 Plot Configurations

Once you have created the desired plot, or combination of several plots, the Save Configuration option under the Plots menu is enabled. This allows you to save the current configuration of open plots and their settings, to your database.

The configuration includes axis settings, selected samples, symbol settings, etc.

When you select Save configuration, the dialogue shown above will appear prompting you for a name for the Plot Configuration. Simply type in a name for the plot configuration.

Once you are finished, click [OK].
To recall a saved plot configuration in the future, use the Plots / Open Configuration option. Simply select the plot configuration you desire, then click [OK]. This will load the plot(s) and their settings. When a plot configuration is loaded, the sample selection used for this plot will also be reset in the Active List window. Aquachem allows for multiple plots configurations to be open concurrently. To remove any unwanted or outdated plot configurations, simply select the respective item from the list, and press the \(\times\) button. Once you are finished, click [Close].

## 4.3 Save, Show, and Identify Plot Data

### Show Sample Data

If this option is selected from the Plots menu, AquaChem will display a small dialogue with the data for the selected sample. Simply click on a sample point from the plot and the Info data dialogue will appear. Each time you click on a new sample point, the new data is loaded into dialogue. An example is shown below:

![Sample Data Dialogue Example](image)

**NOTE**: You may need to re-arrange the positions of your windows in order to see the Sample Data dialogue.

### Identify Plot Data
The Identify option allows you to link the plotted data to the samples in the active list. This allows you to click on a point in the graph and view the corresponding sample in the active list. This is useful when you have a large number of samples displayed on one plot, and you want to identify outliers.

**NOTE:** You may specify the color in which the symbol is highlighted on the plot in the Plots option under File>Preferences.

There are three options available for selecting and identifying points on a plot: None, Selected Plot, and All Plots. The default mode to identify points is on All Plots; this means that all data points on all plots are linked to the database. These three options are described below:

- **None** - If this option is selected, then no symbols will be highlighted on the plot when the samples are selected. The data points on the graphs are not linked to the database which means that samples are not identified. When you have several open graphs and a large database with many samples, it may be convenient to have no link between the graphs and the database in order to increase the speed of the various AquaChem operations.

- **Selected Plot** - Only the data points in the active graph are linked to the database. The chosen point is activated (highlighted) and selected in the sample list. This mode is useful if you are working with a large data set and want to focus on just one graph.

- **All plots** - The sampling point of the corresponding sample is activated on all plot windows and on the sample list. If you are working with several graphs, you can identify a sample in all plots as well as in the sample list by clicking near a point in any of the plots, or by clicking on a sample in the active list. The sample will become selected in the active list, and the corresponding data points will be highlighted in red in all the open plot windows.

### 4.4 Printing and Exporting Plots

Once you are satisfied with your plot(s) and their design, you have three options for producing output:

- The plot can be saved as a Windows Metafile (.WMF) and printed from an external application, or inserted into a report;
- The plot can be copied to the Windows clipboard and pasted into another supported application (ex. a graphics program, MSPaint, or a word processor);
- The plot can be printed as is, or can be incorporated into a Printing Template which can include project information, company details, and your company logo.

**Export as Metafile**

When you have any plot window open, you can save the plot as a Windows Metafile (graphics format) by selecting File from the main menu and then Export>Image. In the Save Plot As... dialogue that appears, enter a filename for this file and press [Save]. You can now open and manipulate this image using a graphics editor or insert this file into a report. When using this feature, each plot window must be saved individually as a metafile.
Copy Plot to Clipboard

To copy the selected plot to the windows clipboard, select Edit from the main menu and then Copy. If successful, a confirmation dialogue will appear. The plot can then pasted directly into another application such as a word processor or a graphics editor.

Printing

To print one or more of the on-screen plots, select File from the main menu and then Print, while the plots window is active. Alternatively, you can click the icon from the AquaChem toolbar. A Print Options window will appear, as shown in the figure below:
The Print Options window has the following components:

**Available Plots**: Contains the list of plots that were open when Print option was selected, and thus are available for printing.

**Plot Legends and Locations**: Lists the X and Y location of the plot and the legend (if available).

**Page Layout Options**: Lists the available plot templates and options for customizing the report.

**Print Preview Window**: Provides a preview of the printed page.

To print one or more plots, you must select the desired plot(s) from the list of the Available Plots by placing a check mark in the box beside the appropriate plot. The selected plot(s) will appear in the Print Preview window and will be automatically sized and arranged to fit the page.

To select a plot, click once on the plot list to activate it, and then click once in the box beside the plot name. A check mark will be added to the box and this plot should appear in the Print Preview window. To load additional plot(s), simply click once with your mouse in the box beside the plot name(s).

To remove a plot from the Print Preview window, simply click once in the box to remove the check mark beside the appropriate plot.

**Arranging the Plots**

The order of the plots can be easily modified using the arrow buttons below the list of plots. Selected plots can be moved up or down using these buttons. The position of each plot on the page can be modified in the Axis tab by entering a new X, Y origin; the size of each plot can be modified by entering a new X, Y length.
Clicking the [Auto] button will load the following dialogue:

![Auto Position Dialogue]

Editing the grid used to optimally position plots on the page. If needed, click the [Refresh] button at the bottom of the screen to update the print preview. Plots per page option allows you to spread the plots over several pages, as well as specify the number of plots to be arranged on each page.

**Print Preview Window**

The Print Preview window provides a "What You See Is What You Get" (WYSIWYG) preview of the printed page. The page magnification value can be adjusted using the magnifying glass above the preview window. This will enlarge or shrink the appearance of the page preview on your screen. The page coordinates (cm) for the mouse pointer location are located in the upper left corner of this window.

**Selecting a Print Template**

The Page Layout frame allows you to select from a list of pre-defined print templates which contain fields for descriptions of the plot(s), the project, client, and company information. In this frame there is also a **Plots per page** field. This allows the user to specify how many plots they would like to appear on each page when printing multiple plots. Plot arrangement and page layouts can be saved as templates at anytime by selecting **Save as Template** from the File menu.

AquaChem includes the following pre-defined print templates:

- US Letter - Portrait
- US Letter - Landscape
- A4 - Portrait
- A4 - Landscape

The default template selection is "None", meaning no print template is selected. If "None" is selected you have the option to enter a two line title at the top of the page plus a one line footer at the bottom of the page.

If the pre-defined print templates are not satisfactory for your needs, you can easily create your own customized print templates using the Template Designer option available by clicking the '...' button beside the template selection list. For a detailed description of this component, please refer to the Template Designer section in chapter 3.

If you select one of the pre-defined print templates, a list of available descriptor fields will appear and the Print Preview window will be updated to reflect the layout of the selected template. Fill in the project specific plot description fields under the Page Layout options. Depending on the template, you may enter information for: **CLIENT**, **PROJECT**, **PROJ #**, **DATE**, **DESCRIPTION**.
An example of the Print Preview window with Fields is shown below:

Once you have entered the descriptive information for the plot, press the [Refresh] button to refresh the print preview.

When you are satisfied with the print layout, simply click the [Print] button in the lower left corner of the window, select File > Print from the main menu, or click the icon.

Alternatively, you may select Edit > Copy from the main menu, and the plot, along with the print template, can be copied to the clipboard, and pasted into an external application.

To return to the main AquaChem window, click the [Close] button.

4.5 Plot Details

This section describes each of the AquaChem plots and the options available for each plot.

Box and Whisker
Depth Profile
Detection Summary
Durov Plot
Geothermometer Plot
Giggenbach Triangle
Histogram
Ludwig-Langelier Plot
The Box and Whisker plot displays a statistical summary of any measured database parameter(s). It is composed by a central box showing the spread of the bulk of the data (interquantile range) and the whiskers, showing the length of the tails.

The Box and Whisker plot can be displayed in four forms:

- Box and Whisker (Grouped)
- Box and Whisker (Multiple Parameters)
- Box and Whisker (Multiple Stations)
- Box and Whisker (Time)

**X-Axis frame**
When the Box and Whisker (Grouped) plot is used, samples are grouped by sample name, and each box is colored according to the current symbol configuration. This plot can be useful for comparing station box and whisker plots belonging to different domains/areas, e.g., upgradient/downgradient.
First, select the desired parameter from the top list of parameters, and then add one or more stations to the stations list. When the station box and whisker plots are created, they will be colored based on the current station symbol configuration. For more information on assigning station symbols, see "Assign Symbol".

An example of a Box and Whisker (Grouped) is shown below:
If you select Box and Whisker (Multiple Parameters) plot then select one or more stations group in the Series field, and then specify one or more parameters under the Parameters list. The options for this plot are shown below.
An example of the Box and Whisker (Multiple Parameters) plot is shown in the figure below.
If you select Box and Whisker (Multiple Stations) plot then you will see the Parameters and Series fields become reversed. You can highlight one or more parameters in the Parameter field and then enter one or more stations in the Station list. The options for this plot are shown below.
An example of the Box and Whisker (Multiple Stations) plot is shown in the figure below:
If you select Box and Whisker (Time), the analysis will be performed on all samples in the Sample List for one or more parameters. AquaChem can aggregate the samples by month, season or year. Note that the season and month group may include samples from different years and are particularly useful for seasonal analysis.
An example of the Box and Whisker (Time) plot is shown in the figure below:
Select the statistics to be displayed as whiskers using the Whiskers combo box.

Whereas the extent of the central box is standardized (25%, 75% quantiles), the extent of the whiskers is not. The whiskers combo box, therefore, lets you choose, which position of the tails of the underlying population should be used to displayed by the whiskers: Min/Max extent, 5/95% or 10/90% quantiles. If the whiskers are defined as a quantile value, then the minimum and maximum values can be added as a further information to the plot and will be shown as points above and below the whiskers.

Click the button beside Format to produce the Axis dialogue. Use this dialogue to customize the x-axis appearance.

**Y-Axis frame**

Unless all parameters you wish to plot are unitless, this frame allows you to select the display unit using the Unit combo box.

Click the button beside Format to load the Axis dialogue. Use this dialogue to customize the y-axis appearance and apply log transformation if necessary.

**Plot frame**

Click the button beside Title to load the Title dialogue.

Check the box beside Legend to enable the plot legend. Click the button to load the Legend dialogue and customize the display options.

Check the box beside Show Grid to display the gridlines.

Click the button beside Lines to load the Lines dialogue. In this plot the Line option may be used to draw a horizontal line representing the standard for the or one of the plotted parameters. This can be done manually by creating a line $y=mx+q$ where $m=0$ and $q$ equal to the standard for this parameter.

If the standard value is defined in the active water standard, then clicking on the [Standard] button will automatically create this line for you.
Fill Color/Pattern
Click the button beside Color to select the fill color for the box plot.
Click the button beside Pattern to choose the display pattern for the box plot.

Set Default button - the set default button will save your settings within the X-Axis frame, Y-Axis frame and Plot frame.

For more details on this plot, please refer to the article: Tukey J.W., 1977: Exploratory Data Analysis, Addison-Wesley, Reading, Massachusetts, USA. 1977, pp. 39-43.

4.5.2 Depth Profile

The Depth Profile plot displays the change in a parameter value as sample depth changes. An example of a Depth Profile plot and the corresponding Depth Profile Plot Settings dialogue is shown in the figure below.

The Depth Profile plot is similar to a borehole log. The plot displays the change of a measured parameter over a measured sampling depth. In order to create this plot, you must have an entry for the parameter Sample_Depth for one or more samples in your database. You may then plot the Depth (on the Y-Axis) against any measured parameter (on the X-Axis).

X-Axis and Y-Axis frames
Click the button beside the Parameter field in the X-Axis frame to select the parameter to be plotted on the x-axis. The parameter for the y-axis frame is Depth and cannot be changed. Select the units for the x-axis parameter using the Unit combo box in the X-Axis frame. The unit for the y-axis depends on the Depth parameter unit in the database and cannot be changed in this dialogue.
Click the button beside Format in the X-Axis and Y-Axis frames to access their respective settings dialogues.

Plot frame
4.5.3 Detection Summary

The Detection Summary plot is used to visualize the relative proportions of samples above the specified water quality standards. The plot shows a summary bar for every parameter specifying the percentage of values where the contaminant has not been detected, where it has been detected but is below the water quality standard and the percentage of samples exceeding the water quality standard. Below is the Detection Summary plot options and the corresponding plot:

On the left side of each detection summary bar you can see the number of samples that have a value for the parameter that this bar represents. The parameter name is listed on the right side of each detection summary bar. The X-axis lists cumulative percent values from 0 to 100. You can calculate the number of samples that exceed a particular standard (or are non-detects) by multiplying the percent "length" of the particular colored segment by the number of samples used to produce a particular detection summary bar.

NOTE: Parameter values that contain "<" symbol will be included in "below MDL" category.

Axis frame
Click the button beside the X-axis Format and Y-axis Format to load their respective options dialogues.

Parameters frame
Use this frame to select the parameters for which you wish to produce the detection summaries. Use the button to add parameters (select from the presented list), the button to delete parameters, and buttons to change the order in which they appear on the plot.

Plot frame
Click the button beside Title and Legend to access their respective dialogues. The Legend feature must be activated (checked) before the options dialogue can be loaded. Use the check box beside Show Grid to show/hide the gridlines. Use the check box beside Show number of samples to show/hide the number of samples displayed to the left of the detection summary plot.

**Fill colors frame**

Use this frame to customize the display colors for detection summary plot. Use the button to access the color selection dialogue.

### 4.5.4 Durov Plot

The trilinear Durov plot is based on the percentage of major ion milliequivalents. The Cations and Anions values are plotted on two separate triangular plots and the data points are projected onto a square grid at the base of each triangle. In addition, the Durov plot allows for the direct comparison of two other groundwater parameters, typically pH and the total dissolved solids (TDS). The Durov plot is an alternative to the Piper plot which is described later in this chapter.

Since the data points are projected along the base of the triangle, which lies perpendicular to the third axis in each triangle, information about the concentration of the vertex element (the third element) is lost in the square grid. Changing the orientation of parameters in both triangles may improve your ability to detect distinct groups.

An example of Durov plot and the corresponding Durov Plot Options dialogue is shown in the figure below.

![Durov Plot Options](image)

**Cations and Anions**

The Cations specify the parameters of the left triangle. Default settings are the major cations Na, Ca, and Mg, however any other parameter can be selected (e.g. gas composition, trace elements etc.). The Anions generally specify the parameters for the upper triangle. Default settings are the major anions Cl, SO4, and HCO3, however any other parameters can be selected. Note that measured Alkalinity is a valid anion parameter, provided the respective parameter is known by the system as being the Alkalinity. This may be done on the File>Database>Alias tab by assigning the respective parameter to the Measured Alkalinity. If
using the alkalinity in the anion triangle, change the respective displayed label field to HCO₃ + CO₃.

Data from poorly concentrated parameters can be multiplied by a common factor to prevent data point accumulation on a base line when plotting parameters with very different concentrations. Type the multiplication Factor in the field beside the parameter.

Both the Cations and Anions frames also contain a Label field for each parameter. This allows customization of the parameter labels on the plot diagram. For example the parameter ‘Ca’ can be edited in the Label field to displayed as ‘Calcium’.

**Plot**

Click the button beside Title, Symbols, Legend, and Labels to access their respective options dialogues.

The Legend and Labels features must be activated (checked) before the options dialogues can be loaded.

Check the boxes beside Labeled Ticks and Show Grid to display the tick values and grid lines on the plot.

Click the button to change the font of the Labeled Ticks and the Axis Titles.

Click the 1 Plot per Symbol option to create one Durov plot for each station.

**Right Plot frame**

The right plot is located to the right of the middle grid of the Durov plot. Choose which parameter to show on this plot by selecting the button located beside the Parameters field. You may also choose the desired Unit, and customize the appearance of the Axis.

**Bottom Plot**

The bottom plot is located below the middle grid of the Durov plot. Choose which parameter to show on this plot by selecting the button located beside the Parameters field. You may also choose the desired Unit, and customize the appearance of the Axis.

4.5.5 Geothermometer Plot

Geothermometer plots can be used to test the quality of geothermometer estimates for a given geological and hydrogeological situation. Different geothermometers can produce very different results when applied to the same water sample(s). Each geothermometer has a set of conditions which must exist for reasonable values to be calculated. For example, if the in-situ temperature was not sufficient to attain rock-water equilibrium, the aquifer composition may be different from the one assumed by the geothermometer. Using conventional geothermometer graphs (log K-1000/T plots), you can check the quality of the calculated temperature if you have in-situ temperature measurements. You should collect all analyses from the literature for which in-situ temperatures have been measured. Also note the aquifer lithology of the samples. When you start a geothermal study, search for references to samples which compare closely with the aquifer of the water you are studying, and check which geothermometer gives the most reliable estimates. This thermometer is likely to give the most reliable results for the water you are studying.

Geothermometer plots can be used to:
- Check the applicability of a thermometer on a set of samples.
- Search for the geothermometer for which you observe the best fit.
- Develop new chemical thermometers for parameters or parameter ratios which show linear behavior in this plot.
For a list of the available Geothermometers, please see the Thermometers options, in the File > Preferences.

The Geothermometer plots display most commonly used geothermometers. An example of a Geothermometer plot and the corresponding Geothermometer Plot Options dialogue is shown in the figure below.

The following section describes some of the features and options of the Geothermometer Plot that are not covered in the Common Plot Features section.

Geothermometers are generally expressed by the formula:

$$t(K^\circ) = \frac{1000 \cdot a}{b + \log(x)}$$

where, x is the SiO2 concentration or Na/K, etc., log (x) values plot on a straight line as a function of 1000/T.

The coefficients a and b are obtained empirically from deep borehole data with in situ temperature measurements.

**Axis frame**

Click the button beside X-axis format and Y-axis format to access their respective options dialogues.

**Plot frame**

Click the button beside Title, Legend, Symbols, Labels, and Lines to access their respective options dialogues. The Legend and Labels features must be activated (checked) before the dialogues can be loaded.

Use the Show Grid check box to show/hide the plot grid lines.

**Thermometer List**

Select (highlight) the thermometer to be used for the plot.

For more details on Geothermometers, please refer to the following article: Kharaka et al. 1989.
4.5.6 Giggenbach Triangle

The Giggenbach triangle provides a visual aid to determine the water-rock equilibrium. An example of the Giggenbach Triangle plot and the corresponding Giggenbach Triangle Options dialogue is shown in the figure below.

The Giggenbach Triangle (K-Mg-Na Triangle) representation allows you to verify the extent to which water-rock equilibrium has been attained.

The triangle is comprised of three zones:
- Immature waters (at the base);
- Partially equilibrated waters (in the middle); and
- Fully equilibrated waters (along the curve).

Depending on where the composition of a given sample lies within this triangle, you can estimate the extent of rock-water equilibrium. For mature waters falling near the upper curve, you can estimate the temperature as well.

Giggenbach Triangle frame
Enter the division factors for Na and K in the text fields provided. The default values for the plot are Na/1000 and K/100.
Use the Labeled Ticks check box to show/hide the tick values.
Click the button to modify font for the tick values and parameter labels.

Plot frame
Click the button beside Title, Symbols, Legend, and Labels to access their respective options dialogues. The Legend and Labels features must be activated (checked) before the options dialogues can be loaded.
Use the Show Grid check box to show/hide the plot grid lines.

For more details on the Giggenbach Triangle, please refer to the following article:

4.5.7  Histogram

Two of the oldest methods for summarizing data distributions are the frequency and histogram plots. Both the histogram and the frequency plot use the same basic principles to display the data: dividing the data range into units, counting the number of points within the units and displaying the data as the height within a bar graph. An example of a Histogram plot and the corresponding Histogram Plot Options dialogue is shown in the figure below.

You can easily identify a single sample in a multi-sample histogram plot by clicking on the sample in the Active Samples List. A red triangle will be displayed on the histogram, indicating the range interval of the selected sample (this is a unique feature of AquaChem and is not normally found in other histogram plotting software). Clicking on a bar on the graph will select all the samples in the Active List which are included within the interval range defined by the histogram bar you selected.

X-Axis frame

Use the button beside Parameter to select parameter to be plotted on the histogram. This field can also handle parameter ratios, sums, or differences (e.g. Na/Cl, Ca+Mg, Cl-SO4). Enter these parameter combinations into the parameter field manually. Unless the parameter you've chosen is unitless (e.g. pH), the Unit combo box will allow you to select the units for the parameter.

The Classes field defines the number of data classes (or intervals) into which the range of parameter values will be subdivided. Each data class will be represented by a single bar on the histogram. Type the number of classes (bars in the histogram) in the provided field.

Click the button beside Format to load the corresponding axis options dialogue.

Y-Axis frame

The number of samples within each data class is referred to as the frequency of occurrences. This can be expressed as either a percentage of the total number of samples (Percents), or as the number of samples within each data class (Number of hits). Select the desired option.

Click the button beside Format to load the corresponding axis options dialogue.
Plot frame
Click the button beside Title to load the title **options** dialogue. Check the box beside Show Grid to display the grid lines.

**Fill Color and Pattern frame**
The color and pattern of the bars in the graph can be modified using the options beside Color and Pattern. Simply press the button to access the various options.

4.5.8 Ludwig-Langelier Plot

The Ludwig-Langelier plot allows you to quickly see patterns and correlations between the major cations and anions for multiple samples. An example of the Ludwig-Langelier plot and the corresponding Ludwig-Langelier Plot Options dialogue is shown in the figure below.

The Ludwig-Langelier square plot is similar to the projection areas of the Piper and Durov plots. By convention, the sums of selected cations are plotted on the X-Axis and the sums of selected anions are plotted on the Y-Axis. Each axis ranges from 0 to 50 meq%.

Sample points are calculated as follows:

\[
\sum \text{anions} = \text{Cl} + \text{SO}_4 + \text{HCO}_3
\]

\[
\sum \text{cations} = \text{Ca} + \text{Mg} + \text{Na} + \text{K}
\]

\[
\%\text{Na} = 50 \frac{\text{Na}}{\sum\text{cat}}
\]

\[
\%\text{Cl} = 30 \frac{\text{Cl}}{\sum\text{an}}
\]
Suitable groupings of cations and anions are selected and plotted as percentages. Generally, this type of graph is used to plot \%Na+\%K against \%HCO3+\%SO4. In this plot, \%Ca+\%Mg and \%Cl are also fixed:

\%Ca+\%Mg = 50 - (\%Na+\%K)  
\%Cl = 50 - (\%HCO3 + \%SO4)

All major elements can be displayed in one plot with the Ludwig-Langelier plot, however like the Piper and Durov plots, the plot displays relative ratios rather than absolute concentrations.

**X-Axis and Y-Axis frames**

Click the button beside the Parameter field to select the first of the parameters. The remaining parameters must be added manually.

Click the button beside Format to load the axis options dialogue for the corresponding axis.

**Plot frame**

Click the button beside Title, Symbols, Legend, and Labels to load the corresponding dialogue. The Legend and Labels features must be activated (checked) before their options dialogues can be accessed.

Use the Show Grid check box to show/hide the plot grid lines.

### 4.5.9 Map

The Map plot reads the X, Y coordinates for the station location, and displays this on a blank grid or on a site map of your site. The Map plot can import and overlay an AutoCAD (.DXF) file, an ESRI shape (.SHP) file, or a common graphics (.BMP, .JPG, and .GIF) file as a basemap of the site or study region defining the major physical and geographical boundaries and geological characteristics.

The Map plots can be used to simply display the station locations throughout the study region, or to interpret spatial trends in the physical or chemical characteristics of each sample using proportional symbol sizes, or by plotting Pie, Radial or Stiff graphs at each sample location. The Radial and Stiff symbols may be exported to ESRI polygon shapefile format.

**NOTE:** You must have at least one station in your database with X and Y co-ordinates in order to create a Map plot. Also, station coordinates must be expressed in a projected coordinate system, and X and Y values must be positive.

When you choose a Map as the plot type, the following Map Plot Options dialogue will appear:
Axis tab

Axes frame - Click the button beside X-axis format and Y-axis format to access the corresponding dialogues.

Plot frame - Click the button beside Title, Legend, and Label to access their respective options dialogues. The Legend and Labels features must be activated (checked) before the options dialogue can be loaded. Use the Frame and Show Grid check boxes to show/hide the frame around the map and the plot grid lines.

Base Map frame - AquaChem allows you to load multiple maps in various file formats as the base map for the plot. You can load any of the following types of files: .DXF, .SHP, .BMP, .JPG, and .GIF. If the format of the file you wish to load is not listed above, use a graphics editor to convert it into one of the listed formats.

To add a basemap to your plot click the button. In the Base Map File dialogue that is loaded select the appropriate file type and navigate to the desired file. Click [Open] to load the map and the file name will appear in the Base Map frame as shown below.

If you loaded a .DXF or a .SHP file, the min X/max X and min Y/max Y coordinates are entered automatically. For the ESRI shape files you will also have the options of changing the line width and color.

For shape files, additional options will appear allowing you to specify line width and color.

NOTE: The images must be georeferenced in feet or meters (the units have to be the same as the station X-Y coordinates). AquaChem does not support Lat/Long coordinate system.
If you load a common graphics file (.BMP, .JPG, or .GIF), the program automatically assigns one meter (or foot) per pixel in the picture. This image has to be manually georeferenced.

Simply enter the new coordinates for 2 corner points of the map.

If you wish to change the source file for the currently highlighted map, click the button to load a new file.

You may load multiple maps into your map plot. Use the and buttons to change the order in which they appear in the plot and the check box beside the name to show/hide the respective map image.

**Symbols tab**
The Symbols tab in the Map Plot Options dialogue allows you to choose a symbol to represent the samples on the map plot.
Symbol frame
There are six symbol types to choose from:
- Plain Symbol
- Proportional Size
- Proportional Greyscale
- Pie Chart
- Radial Diagram
- Stiff Diagram

Depending on the type of symbol you choose, the lower preview frame will show different plot and the third tab (available only for Pie Chart, Radial Diagram, and Stiff Diagram) will present different options to customize the chart.

Plain Symbol
The Plain Symbol type will plot the symbol shapes, sizes and colors as they are defined for each sample group. Press the button beside the field to access the Define Symbol or Line dialogue for viewing or modifying the symbol settings for the database.

Proportional Size Symbols
The Proportional Size symbol type will plot the defined symbols at each sample location with a symbol size determined by the value of a selected parameter. The sample values for the proportional parameter will be used to determine the radius of the symbol at each sample location (e.g. samples containing higher values of the proportional parameter will have a larger symbol radius).
To change the proportional parameter, type in the internal name of the desired parameter in the Parameter field, or click the button and select another parameter from the list.

The Radius field is used to set the minimum and maximum symbol radius (in points). The minimum symbol radius corresponds to the Lower Limit value of the proportional parameter, while the maximum radius corresponds to the Upper Limit value. Use a non-zero minimum radius to plot symbols at sample locations containing very low values of the proportional parameter. The symbol radius at each sample location is determined using a linear interpolation between the Upper Limit value and the Lower Limit value.

**Proportional Greyscale**
This symbol type will display a Greyscale symbol at each sample location, with the scale determined by the value of a selected parameter. The sample values for the proportional parameter will be used to determine the greyscale color of the symbol at each sample location (e.g. samples containing higher values of the proportional parameter will have a darker greyscale). To change the proportional parameter, simply type in the Internal name of the desired parameter in the Parameter field, or click the button and select another parameter from the parameters list. Sample with values less than the Lower Limit value are assigned a white symbol color, while points with values equal to or greater than the Upper Limit value are assigned a black color fill.

**Sample Aggregation**
If you wish to display only one sample for every station in your project, this frame allows you to select the criteria according to which this sample will be chosen:

- Selected Samples only - only the samples currently selected in the Samples List will be displayed
- Representative samples only - only samples that are marked as Representative in the Samples List will be displayed
- Most recent sample per station - one sample with the latest date will be displayed for each station
- Oldest sample per station - one sample with the earliest date will be displayed for each station
- Smallest value - presents an option to choose a parameter based on the value of which one sample (with the smallest value) will be displayed
- Highest value - presents an option to choose a parameter based on the value of which one sample (with the largest value) will be displayed
• Closest to average - presents an option to choose a parameter based on the value of which one sample (with the value closest to the station mean) will be displayed

Preview frame
This frame is available only for Pie, Radial and Stiff Diagrams. It presents a generalized view of the chosen plot and the [Edit] button. Clicking on this button will move you to the third tab which, depending on the plot type you chose, will be one of the described below.

Pie Chart tab - This symbol type will display a Pie chart of the selected parameters at each sample location.

Parameters list - Click the button to add parameters to the pie chart and the button to delete them. Use the and buttons to change the order of the parameters.

Fill Style frame - Use the buttons beside Fill Color and Fill Pattern to specify these features.
Use the Units combo box to select the units for the parameters that require them.
Type in the symbol size in centimeters in the Symbol Size text box.

Inside Circle frame - If you wish, you can display one parameter as an inside circle of the pie plot. Click the button to select the parameter from the list and enter the Maximum Value for the parameter. The samples containing a Proportional parameter concentration equal or greater than the Maximum Value will have an inside circle with the maximum radius. The inside circles for samples with Proportional parameter concentrations less than the Maximum Value will have a proportionally smaller radius.
An example of a Map Plot with Pie charts as sample symbols is shown below.

Radial Diagram tab - This plot will display a Radial Diagram of the selected parameters at each sample location.
Parameters list - Click the button to add parameters to the radial diagram and the button to delete them. Use the and buttons to change the order of the parameters.

Axes frame - Set the Minimum and Maximum values for the axes. AquaChem will select the optimum values, however they may not be what you want. Select the units for the parameters using the Units combo box. Set the Symbol Size. This value is the radius of the symbols as they appear on the printed output. Depending on your monitor's resolution they may seem different on the screen. You may log-transform your data using the Log scale check box.

Fill Style frame - Use the buttons beside Fill Color and Fill Pattern to specify these features. Use the Units combo box to select the units for the parameters that require them. Type in the symbol size in centimeters in the Symbol Size text box.

Stiff Diagram tab - This plot will display a Stiff diagram of the selected parameters at each sample location.
Cations and Anions list - A Stiff diagram plots an equal number of cations and anions. Click the + button to add parameters to the Cation and Anion list and the - button to delete them. Use the \[\text{↓}\] and \[\text{↑}\] buttons to change the order of the parameters.

**NOTE**: You must have an equal number of Cations and Anions which is greater than zero to generate this plot.

The Maximum Concentration values will represent the uniform maximum value for each parameter. The minimum axis value is always zero.

The Symbol Size field contains the setting for the size of the Stiff diagrams plotted at each sample location.

The Fill Style (Fill Color and Fill Pattern) for each parameter can be modified by clicking on the target parameter, then choosing a new Color or the Pattern by clicking on \[\text{...}\] button beside Fill Color and Fill Pattern fields.

Once you have configured all options to your satisfaction, click [OK] to generate the plot. You can always access the options dialogue by right-clicking on the plot.

4.5.10  **Meteoric Water Line (MWL) Plot**
The Meteoric Water Line plot is the standard way to portray measurements of stable isotopes from water (18O and 2H). It consists of a scatter plot showing 18O on the X-axis and 2H on the y-axis. The meteoric water line is defined by the following equation:

\[ 2H = 8.2 \times 18O + 10.8 \]

Most precipitations and groundwaters fall closely on this line. In cases where the measurements are shifted from this line, the type of shifting provides important information regarding the process leading to the observed shift (e.g. rock water interaction, evaporation, mixing with seawater etc.).

**X-Axis and Y-Axis frames**

The Parameters and Units are selected automatically for this plot and cannot be changed. You can change the axis options by clicking on the button and loading the corresponding Axis dialogue.

**Plot frame**

Click the button beside Title, Symbol, Lines, Legend and Labels to access the corresponding options dialogues. The Legend and Labels features must be activated (checked) before the dialogues can be loaded. Use the Show Grid check box to show/hide the plot grid lines.

**NOTE**: this plot is only active if your database contains the parameters 18O and 2H and if these parameters are mapped in the Alias section.

### 4.5.11 Pie Chart

The Pie plot is a simple way of showing parameter portions in a sample. An example of the Pie plot and the corresponding Pie Plot Options dialogue is shown in the figure below.
When you choose the Pie chart, a plot will be created for every sample selected in the active sample list. Before using this option, ensure that only the samples you want to plot are selected.

You must create a generic pie plot for every sample before you can customize it for each individual one. To do so, in the initial options dialogue set up the general options for the Pie plot - parameters to be plotted, their color and pattern, etc. Once this is done, click [OK]. A pie plot will be created for every selected sample. Right click on any of the pie plots to launch the Pie Plot Options dialogue and use it to customize the plots for each sample.

Sample
At the top of the Pie Plot Options dialogue, there is a Sample field which identifies the active sample(s) associated with the plot options dialogue. If you have created several Pie charts, you can use the Sample field to select and modify the settings for each pie plot individually, or several at once as shown below.

To make changes to multiple plots simultaneously, simply select all of the samples you wish to edit in the list above (using your mouse), make the required plot changes then click [Apply]. This is useful for normalizing the axes scales, units, and general formats for each of the open Pie charts. If just one sample is highlighted and selected in this dialogue, then the changes will only be applied to this plotted sample.

Parameters frame
Parameters list - contains the parameters that will be plotted on the Pie chart. Existing parameters can be changed by selecting the parameter, and then typing in the name of the new parameter in the same field. New parameters can be added to the list by clicking the
button and selecting a parameter from the available list. The new parameter will then be added to the bottom of the list. Parameters can be removed from the list by selecting the parameter and clicking the button. The order of the parameters in the list can be adjusted using the and buttons.

**Fill Style frame** - The Fill Style allows you to edit the appearance of each pie slice in the plot. Select a parameter from the Parameters list, then select the Pattern and the Color you wish to assign to that slice of the pie chart. Repeat for the other parameters in the list.

**Unit frame** - Allows you to set display unit. The typical unit is meq/l which places cations in the upper part of the plot and anions in the lower part or vice versa, and permits a visual control of the electroneutrality.

**Inside Circle frame** - The Inside Circle is used to represent the concentration of a single parameter (or combination of parameters) that is not included in the Pie chart parameters. You can specify any chemical or physical parameter that reveals the most comprehensive information about the sample. For example, you may want to display the CO2 or SiO2 concentration for the selected sample. Type a valid parameter in the Proportional to field to create an inside circle on your pie chart. Type a Maximum Value in the next field below (or use the default value). If several pie charts are created, it is recommended that you choose 3 to 4 times the average value of the inside parameter as the maximum value. All values that are greater than or equal to the maximum value are displayed with the maximum diameter. The inside circle will have a radius between zero and the specified maximum radius (R).

R= Maximum radius for the internal circle
Value = value for this sample for the selected parameter.
Maximum Value: Maximum value above which, the full internal circle is drawn.
Inside Radius = (Value / Maximum Value) * (pR/2)

Unless the parameter you have selected is unitless, you must also specify the units using the Units combo box.

**Plot frame** - Click the button beside Title and Legend to load the corresponding options dialogues. Pie plots are titled automatically according to the settings in File>Preferences>Plots. The Legend feature must be activated (checked) before the settings dialogue can be accessed.

**Slice labels frame** - The Slice Label options will apply a label to each slice of the pie chart. You can choose from Parameter Name, Concentration, Percentages, or None for no label.

### 4.5.12 Piper Diagram

The Piper plot is useful for showing multiple samples and trends in major ions. An example of the Piper plot and the corresponding Piper Plot Options dialogue is shown in the figure below.
In the Piper plot, major ions are plotted as cation and anion percentages of milliequivalents in two base triangles. The total cations in meq/l, and the total anions in meq/l, are set equal to 100%. The data points in the two triangles are then projected onto the diamond grid. The projection reveals certain useful properties of the total ion relationships. Every sample is represented by three data points; one in each triangle and one in the projection diamond grid.

If your database stores carbonate species concentration as alkalinity, you may use the parameters for alkalinity instead of HCO3. To do this add CO3 to the field so that it displays HCO3+CO3.

The Piper plot allows comparisons of 6 parameters between a large number of samples. Like all trilinear plots, it does not portray absolute ion concentrations. The main purpose of Piper plots is to show clustering of samples.

Cations and Anions frames
The default parameter settings include the major cations (Na+K, Ca, and Mg) against the major anions (Cl, SO4 and HCO3+CO3); however, any other parameters, or combination of parameters, can be easily selected (e.g. gas composition, trace elements etc.)

The parameters can be modified by typing the Internal name of the parameters in the appropriate fields, or pressing the button and selecting another parameter from the available list. You may also multiply or divide the parameter concentrations by a factor if you need to compare elements which are systematically very different in concentration (e.g. comparing a trace element together with major ions). Finally, you may also enter parameter operators and functions (e.g. Na+K or Na/Cl); to do this, simply enter Na+K (for example) in the parameter field manually, and press [Apply]. However multiple parameters (e.g. Na, Cl) are not accepted.

Both the Cations and Anions frames also contain a Label field for each parameter. This allows customization of the parameter labels on the plot diagram. For example the parameter `Ca' can be edited in the Label field to displayed as 'Calcium'.

Plot frame
Use the link buttons in this frame to modify the options such as:
Title - to include a title and adjust its font, position, and alignment
Annotation - add annotation on the plot and adjust its font, and alignment
Legend - check this on to display a legend, and then adjust the font, number of columns, and display options
Symbols - adjust the symbol used, the size and color, option to display only the selected sample, option to scale symbols.

Please note - when you scale symbols - only the symbols on the Diamond of the Piper Plot will be scaled (not the individual triangles).

Labels - check this on to display labels, and then select the label its font, position etc.

Then there are some additional options including:
Labeled Ticks - these are the axis labels and provides options for changing the font, style, size etc.
Axis Titles - option to adjust the font, style, size of the Axis Title
Show Grid - option to turn the grid on or off
1 Plot per symbol - select this option to create one Piper plot for each symbol (e.g. station).

4.5.13 Probability Plot

Probability plots involve plotting quantiles of a data against the quantiles of the normal distribution. They are particularly useful for spotting irregularities within the data when compared to a specific distributional model, like the Normal. It is easy to determine whether departures from Normality are occurring more or less in the middle ranges of the data or in the extreme tails. Probability plots can also indicate the presence of possible outlier values or a different population that do not follow the basic pattern of the data and can show the presence of significant positive or negative skewness. The log scale transformation on the y-axis may be used to test whether a dataset that shows non normal behavior is simply normally distributed.

**X-Axis frame** - Use the button beside Format to set the Y-axis options.

**Y-Axis frame** - Select the parameter to plot by clicking the button and choosing from the parameter list. If the chosen parameter has units, a Units combo box will be presented in which you can select the desired units.

Use the button beside Format to set the X-axis options.

**Plot frame** - Use the button beside Title, Legend, Symbol and Lines to set their options. Check the box beside Show Grid to display the gridlines on the plot. Creating correlation lines may be useful to visually test whether data is distributed on a straight line, indicating a normal distribution of the underlying data set. if the y-axis is set to log scale, then the alignment of the data on a line indicates lognormal distribution.
4.5.14 Quantile Plot

The Quantile chart plots the ranked data from lowest to highest on the background of lines that denote 25% Quartile, Median, and 75% Quartile.

X-Axis frame - Use the button beside Format to set the Y-axis options.

Y-Axis frame - Select the parameter to plot by clicking the button and choosing from the parameter list. If the chosen parameter has units, a Units combo box will be presented in which you can select the desired units.

Use the button beside Format to set the X-axis options.

Plot frame - Use the button beside Title, Legend, and Symbol to set their options. Check the box beside Show Grid to display the gridlines on the plot.

4.5.15 Radial Plot

The Radial plot is used to compare multiple parameter values for a single sample and to compare the ratios of these values for many different samples. An example of the Radial plot and the corresponding Radial Plot Options dialogue is shown in the figure below.
Radial plots can be used to evaluate the change in water quality at a single location over a period of time, or they can be used to evaluate the change in water quality as the water passes through different geologic formations or different subsurface conditions. A plot will be created for every selected sample in the Active Samples List. Before using this option, ensure that only the samples you want to plot are selected.

**Sample**
The Sample field identifies the active sample(s) associated with the plot options dialogue. If you have several Radial plots open, you can use the Sample field to select and modify the settings for each one.

To make changes to multiple plots simultaneously, simply select all of the samples in the list above (using your mouse), make the required plot changes, then click [Apply]. This is useful for normalizing the axes scales, units, and general formats for each of the open Radial plots. The changes apply to most of the graph settings that affect the appearance of the Radial plot, with the exception of the plot title. If just one sample is highlighted and selected in this dialogue, then the plot options changes will only be applied to this plotted sample.

**Parameters frame**
The Parameters list contains the parameters that will be plotted on the Radial plot. A Radial plot requires a minimum of three parameters. Existing parameters can be changed by selecting the parameter, and then typing in the name of the new parameter in the same field.

New parameters can be added to the list by clicking the button and selecting a parameter from the available list. The new parameter will then be added to the bottom of the list. Parameters can be removed from the list by selecting the parameter and clicking the button. The order of the parameters in the list can be modified by selecting the parameter and using the or buttons to move the position of the selected parameter.

Use the Units combo box to choose the appropriate units.

**Axes frame**
Checking the Axes labels box will display the respective parameter labels at the outer ends of each axis.

Click the button beside Format to set the axes ticks options.
Filling options frame
Click the button beside Title to create a title for the plot. Whereas many of the options are modified in all plots when applied, the title will be created unique for the active plot, unless you have several plots selected.
Use the Grid (Circles) check box to show/hide the circular grid of the plot.
Use the button beside Color and Pattern to set these respective features.

4.5.16 Scatter Plot

X-Y Scatter plots are the most simple and popular approach to interpreting hydrochemical data. Scatter plot shows effects such as correlation of parameters or clustering of samples in a very intuitive manner. An example of the Scatter plot and the corresponding Scatter Plot Options dialogue is shown in the figure below.

X-Axis and Y-Axis frames
Click the button beside Parameter field to select the parameter to plot on the respective axis. Unless the chosen parameter is unitless, the Unit field will be enabled. Use this combo box to select the appropriate units for the chosen parameter.
Once you have defined the parameter options, click on the button beside Format to set the axis options.

Plot frame
Click the button beside Title, Legend, Symbol, Label, and Lines to customize their respective settings.

The Scatter plot is one of several plots in AquaChem for which you can add custom trend lines. To do so, click on the button besides Lines. Use the dialogues shown below to create and customize the trend line:
The Lines options allow you to perform a regression analysis on all the data, or on a specified group of data. You can calculate the equation of best fit for the line, and plot the line on the graph. You can also create your own line with your own equation and plot it on the graph as well.

For more information on how to create a line on the plot, please refer to "Line Dialogue".

This is one of the plots on which it is common to use precision bars. You can do so using the Symbols Dialogue described on of this chapter.

4.5.17 Schoeller Plot

Schoeller (1962) developed semi-logarithmic plots to represent major ion analyses in milliequivalents per liter and to demonstrate different hydrochemical water types on the same plot. The number of analyses that can be illustrated at one time is limited because of the lines. The plot has the advantage that, unlike trilinear plots, actual parameter concentrations are displayed. An example of the Schoeller plot and the corresponding Schoeller Plot Options is shown in the figure below.

X-Axis frame

Customize the list of parameters to be plotted. New parameters can be added to the list by clicking the button and selecting a parameter from the list of available parameters. The new parameter will then be added to the bottom of the list. Parameters can be removed from
the list by selecting the parameter and clicking the \( \times \) button. The order of the parameters in the list can be modified by selecting the parameter and using the \( \leftarrow \) or \( \rightarrow \) buttons to move the position of the selected parameter. Parameters can include ratios, sums, or differences (Na/Cl, Ca+Mg, Cl-SO4). Simply manually enter these operators in the parameter field.

Click the \( \text{Format} \) button beside Format to set the axis options.

**Y-Axis frame**

The y-axis for the Schoeller plot is concentration of the chosen parameters. The Unit combo-box will allow you to choose the appropriate units. If ions are portrayed in a Schoeller plot, then it is recommended to use the meq/l unit, since it allows to compare directly the ion ratios.

Click the \( \text{Format} \) button beside Format to set the axis options.

**Plot frame**

Click the \( \text{Title, Legend, and Symbols} \) button to customize their respective settings.

Check the Show Grid box to display the gridlines on the plot.

### 4.5.18 Stacked Bars (Distance) Plot

This plot option allows you to display stacked bars for multiple stations which are projected onto a line. Generally this is intended for only one sample per station. The x axis will display the distance between the stations to allow users you make spatial interpretations.

In the Options dialogue box you will find the list of samples you selected to be included in your plot. You can add or remove samples from this list with the green plus or red x respectively. You need to indicate the direction of the line that the samples will be projected onto.

### 4.5.19 Stacked Bars (Stations) Plot
This plot option allows you to select which stations you wish to plot stacked bars for. Generally this is intended for displaying one sample per station. Where the time series (Stacked Bars) option will display all samples for the selected station, this plot allows you to pick which sample you wish to plot for each station. This allows you to make cross station comparisons.

In the Options dialogue box you will find the list of samples you selected to be included in your plot. You can add or remove samples from this list with the green plus or red x respectively.

### 4.5.20 Stiff Plot

The Stiff plot belongs to the group of pattern plots (see Hem 1985, p. 175). It is constructed by plotting the milliequivalents per liter of three or more anions and three or more cations. Stiff plots can be used to evaluate the change in water quality at a single location over a period of time, or they can be used to evaluate the change in water quality as the water passes through different geologic formations or different subsurface conditions.

An example of the Stiff plot and the corresponding Stiff Plot Options dialogue is shown in the figure below.
A Stiff plot will be created for every selected sample in the active list. Before using this option, ensure that only the samples you want to plot are selected. The following section describes some of the features and options of the Stiff plot that are not covered in the Common Plot Features section.

**Sample**
The Sample field identifies the active sample(s) associated with the plot options dialogue. If you have several Stiff plots open, you can use the Sample field to select and modify the settings for each one.

To make changes to multiple plots simultaneously, simply select all of the samples in the list above, (using your mouse), make the required plot changes, then click [Apply]. This is useful for normalizing the axes scales, units, and general formats in each of the open Stiff plots.

**Parameters frame**
The Cations and Anions lists contain the parameters that will be plotted on the Stiff plot. Existing parameters can be changed by selecting the parameter, and then typing in the name of the new parameter in the same field.

New parameters can be added to the list by clicking the + button and selecting a parameter from the list of available parameters. The new parameter will then be added to the bottom of the list. Parameters can be removed from the list by selecting the parameter and clicking the - button. The order of the parameters in the list can be modified by selecting the parameter and using the ↑ or ↓ buttons to change the position of the selected parameter.

**NOTE:** The Stiff plot requires an equal number of cations and anions (i.e. typically three cations and three anions).

**Axis frame**
Set the Maximum concentration for the x-axis in meq/l.
Set the number of Ticks for the x-axis.
Use the Axes Labels and Show X-Axis check boxes to show/hide the respective features.
The font for the tick and axis labels can be changed by clicking the button.

**Plot frame**

Use the button beside Title and Legend to customize their settings.

**Fill Style frame**

Access the fill Pattern and the Color options by clicking the button.

### 4.5.21 Ternary Plot

Ternary plot is used to determine the relationship between the concentrations of three different parameters in multiple samples. An example of the Ternary plot and the corresponding Ternary Plot Options dialogue is shown in the figure below.

Like the Piper and Durov plots, the Ternary plot displays relative concentrations of each parameter with respect to the sum of the concentrations of each parameter. Each vertex of the Ternary plot represents a relative concentration of 100% for the parameter at the respective vertex, while the base represents a relative concentration of 0% for the parameter plotted at the opposite vertex.

**Parameters frame**

The parameters can be modified by typing the Internal name of the parameters in the appropriate fields, or pressing the button, and selecting another parameter from the dialogue that appears. You may also multiply the parameter concentrations by a factor if you need to compare elements which are systematically very different in concentration (e.g. comparing a trace element together with major ions). You may also enter parameter operators and functions (e.g. Na+K or Na/Cl); to do this, simply enter Na+K in the parameter field and press [Apply]. However multiple parameters (e.g. Na,Cl) are not accepted.

The Unit combo box will allow you to select the appropriate units (where applicable).

**Plot frame**

Click the button beside Title, Legend, Symbol, and Labels to customize their respective settings. Use the Show Grid check box to show/hide the plot gridlines.
4.5.22 Time Series Plots (Multiple Parameters)

The Time Series plot shows the evolution of a chemical or physical parameter for a given sampling point as a function of time. This plot is a standard technique for interpreting hydrochemical and hydrogeological processes and in particular temporal trends in natural waters.

Time Series (Multiple Parameters) plot is intended for one sampling station (or any other defined legend item, e.g. aquifer). The options dialogue for the Time Series (Multiple Parameters) plot appears below.

Choose a single Station (or other defined legend item) from the top of the dialogue box.

Parameter Properties frame

Parameters Tab - Choose the parameter(s) that you want plotted. Use the + and - buttons to add or remove parameters, and the and buttons to change the order of the parameters.
The Name of the parameter is automatically filled in, however you may manually change it under the Label column. Select the desired Y-axis under the Axis column (Y refers to the left Y axis, and Y2 refers to the right Y axis)

**Time Series Tab** - The time series tab allows you to select non-chemical time series data to show on the time series plot, e.g., precipitation, water levels etc. Please note that you must import the time series data into AquaChem database before you can show on the time series plot. For more information on importing time series data, please refer to "Import".

When the Time Series Tab is selected, click the button to load a time series dataset. The Parameters window will appear on your screen. From the Category combo box select the table in which the time series is saved. The available time series data series for the selected table will be displayed. Choose the desired time series and click the [Select] button. The Name of the parameter is automatically filled in, however you may manually change it under the Label column. Select the desired Y-axis under the Axis column (Y refers to the left Y axis, and Y2 refers to the right Y axis)

**Symbol frame** - Use the Visible check box to show/hide symbols.

Below the Visible check box is a preview of the symbol used to represent currently selected parameter on the plot. Click the button beside the preview to load the dialogue shown to the right. Use this dialogue to select the symbol style, size, and color (click on the field beside Color to produce the color selection dialogue). Click [OK] when satisfied with symbol settings. The symbols defined here will supersede the symbols defined under the Plots / Define Symbol or Line option.

**Line frame** - Use the Visible check box to show/hide the line connecting the symbols. Click the button beside the line preview to produce the dialogue shown on the right. Use this dialogue to set the style, color, and width for the line (click on the field beside Color to load the color selection dialogue). When you are satisfied with the line settings, click [OK].

**Axis frame** - Click the button beside Time-axis and Y-axis to customize their respective settings.

**Plot Frame** - Click the button beside Title, Legend, Symbol, and Label to customize their respective settings. The Legend and Label features must be activated (checked) before their dialogues can be accessed. Use the Show Grid check box to show gridlines on the plot. This is another plot where precision bars may be useful. For more information on how to add them, please refer to "Symbols Dialogue".

The figure below demonstrates a finished Time Series (Multiple Parameter) plot:
4.5.23 Time Series (Multiple Stations)

The Time Series plot shows the evolution of a chemical or physical parameter for a given sampling point as a function of time. This plot is a standard technique for interpreting hydrochemical and hydrogeological processes and in particular temporal trends in natural waters.

Time Series (Multiple Stations) is intended for one parameter.

The options dialogue for the Time Series (Multiple Stations) plot appears below.
Choose a single Parameter from the top of the dialogue box.

**Station Properties frame**
Choose the station(s) that you want plotted. Use the + and - buttons to add or remove stations, and the ↑ and ↓ buttons to change their order.
Use the Unit combo box to select the appropriate units.
The Name of the station is automatically filled in, however you may manually change it.

**Symbol frame**
Use the Visible check box to show/hide symbols.
Below the Visible check box is a preview of the symbol used to represent currently selected station on the plot. Click the ... button beside the preview to load the dialogue shown to the right. Use this dialogue to select the symbol style, size, and color (click on the field beside Color to produce the color selection dialogue). Click [OK] when satisfied with symbol settings.
The symbols defined here will supersede the symbols defined under the Plots / Define Symbol or Line option.
Line frame
Use the Visible check box to show/hide the line connecting the symbols.

Click the button beside the line preview to produce the dialogue shown on the right. Use this dialogue to set the style, color, and width for the line (click on the field beside Color to load the color selection dialogue). When you are satisfied with the line settings, click [OK].

Axis frame
Click the button beside Time-axis and Y-axis to customize their respective settings.

Plot Frame
Click the button beside Title, Legend, Symbol, and Label to customize their respective settings. The Legend and Label features must be activated (checked) before their dialogues can be accessed. Use the Show Grid check box to show gridlines on the plot.

Please refer to "Symbols Dialogue" for information on how to add precision bars.

A finished Time Series (Multiple Stations) plot is shown below:
4.5.24 Time Series (Stacked Bars)

The stacked bar chart allows you to display the chemical concentrations of samples as stacked bars. Major anion and cation bars can be stacked side-by-side to show the ion balance over time. Different heights for anion and cation bars can indicate an ion imbalance, and point out an issue in a particular sample.

An example of the Stacked Bar plot and the corresponding chart options are shown in the figure below.

Parameter Frame - By default, the major ions are listed in the parameter frame. However, you may add and remove parameters as desired using the `+` and `-` buttons. The Label column in the parameter list allows you to change the labels of each parameter for displaying on the plot legend, e.g., Na to Sodium.

Fill Style Frame - Specify the fill color and pattern of the stacked bar for the selected parameter.

Axis Frame - Click the [...] button to customize the X-axis and Y-axis settings. Use the Unit combo box to select the appropriate units.

Plot Frame - Click the [...] button beside Title and Legend to customize their respective settings. Use the Show Grid check box to show gridlines on the plot. Use the Cation/Anion Bars check box to show the cations and anions in two separate bars.

4.5.25 Time Series (Statistics Summary)

Time Series (Statistics Summary) plot is used to display a statistical summary over a specified time period as a bar chart. The options for the time period over which the data is to be aggregated include month or year. The following summary values per period can be displayed: as Min, Max, any Quantile and Standard Deviation.
Parameter - Select the parameter for which you wish to create the Time Bar plot, and specify the appropriate units.

Statistics frame - Select the Series, the values from which will be plotted. Select the time period by which to Aggregate the data. Select the Statistics to display on the plot. Minimum, Maximum, and Mean are selected by default. To change a statistic, click on the statistic you wish to change and choose a new one from the presented combo box. To add a new statistic, click the button; to delete an existing statistic, click the button.

Use the and buttons to change the order the statistic bars appear on the plot. Legend field shows the statistic label that will be displayed in the plot legend for the statistic currently selected. If you wish a different label to appear for this statistic, simply replace the default text with new text. Color field shows the color of the bar for the statistic currently selected in the Statistics list. To change the color, double-click on the field to load the color selection dialogue.

Axis frame - Click the button beside Time-axis format and Y-axis format to customize their respective settings.

Plot frame - Click the button beside Title, Legend, and Symbol to customize their respective settings. Use the Show Grid check box to show gridlines on the plot.

4.5.26 Wilcox Plot

A Wilcox plot can be used to quickly determine the viability of water for irrigation purposes. The Wilcox plot is also known as the U.S. Department of Agriculture diagram. An example of the Wilcox plot and the corresponding Wilcox Plot Options dialogue is shown in the figure below.
The Wilcox plot is a simple scatter plot of Sodium Hazard (SAR) on the Y-axis vs. Salinity Hazard (Cond) on the X-axis. The Conductivity (COND) is plotted by default in a log scale. These plot parameters are hardwired into AquaChem and cannot be changed. You must have values for the COND and SAR parameters in your database in order to use this plot.

**X-Axis and Y-Axis frames**

The Parameters are pre-selected and cannot be changed. Click the button to customize the x-axis and y-axis settings.

**Plot frame**

Click the button beside Title, Legend, Symbols, and Labels to customize their respective settings. The Legend and Labels features must be activated (checked) before their options dialogues can be accessed.

The Wilcox plot contains the following sections:
- Conductivity (us/cm)
  - C1: Low (0-249)
  - C2: Medium (250-749)
  - C3: High (750-2249)
  - C4: Very High (2250-5000)

The SAR values are divided into the following categories:
- S1: Low
- S2: Medium
- S3: High
- S4: Very High

The locations of the SAR lines are determined by the following equations:
- S1: Line equation: \( y = -1.5816 \times 10^{-3}x + 10.15816 \)
- S2: Line equation: \( y = -2.2959 \times 10^{-3}x + 18.22959 \)
- S3: Line equation: \( y = -3.0102 \times 10^{-3}x + 26.30102 \)
5 Reports

When you select Reports from the main menu, you are presented with several types of reports to aid in the presentation of your data. These reports are generated in a separate Report window as unformatted text. These reports can be printed 'as is' using the [Print] button located on the lower-left corner of the report window, or the information can be saved using the [Save] button.

The following pre-defined Reports are included with AquaChem:

- Data Summary
- Compare Sample
- Mix Samples
- Water Quality Standards
- Hardness Dependent Standards
- Rock Source Deduction
- Statistics
  - Summary Statistics
  - Correlation Matrix
  - Trend Analysis
  - Outlier tests

You can also design your own report templates, which allows you to produce reports on a wide variety of sample data and calculations. You can do so using the Report Designer component, which is explained later on in this chapter. AquaChem includes a Sample Summary Report, which was designed using the Report Designer.

5.1 Excel Time Series

The Excel Time Series Report allows you to send your selected samples and results to an Excel template that will automatically create Time Series charts.

The Excel Time Series Report will be based on the currently display samples so ensure you filter your list before running the report.

In the Excel Time Series Report dialog you need to select the parameters you wish to use from the list on the right hand side. You can select the parameters by selecting the parameter from the list of current project parameters and then selecting the green plus icon or by double clicking on the parameter. You will see the list of selected parameters on the left hand side.
After selecting your parameters you can preview the data you are about to export to Excel by selecting the Preview button.

Select the close button to close out of the Data Preview.

When you select the Export button you will be prompted to make the following selections in the Chart in Excel dialog.
The template selection allows you to select which Excel template you wish to use to export your data to. When you install AquaChem you will find several example templates installed (in your documents folder under AquaChem / Templates). These templates are only examples and you are encouraged to review them and edit them to suit your needs. Especially important to review the Data worksheet of the template - this is where you will see the list of parameters that the template will be expecting and that will be charted.

For example - let's take a look at the template called Example with 2 plots 2 parameters.xlsx.

On the Data worksheet you will see this template is set to expect the following parameters:
Ca
Mg
Cl
SO4

On the Time Series worksheet you will see this template is set to generate 2 plots - the top plot will use Ca and Mg values while the bottom plot will use the Cl and SO4 values.
As mentioned previously - you are encouraged to edit the templates to make them specific for your needs.

Let's select this template to export our data. Under the Required section we need to select the Series Grouping - this is going to be the Parameter (as we want to plot the previously selected parameters as a time series). By
default the Sample Date has already been selected - this will be used for the X-axis. And then you need to select the value - this will be used for the Y Axis.

Under the optional section you can specify a Chart Grouping - in this case select Station - this will then make one plot for each station. Additionally there is an option to make the non-detect values symbols smaller on the chart.

Once you have made all the selections hit the OK button and you will see the Chart Mappings dialog. Here you can see that Cl and SO4 will be on one chart while Ca and Mg will be on the other Chart.

Select OK again and you will be prompted to save your excel file. By default it will save to your Documents / AquaChem / Charts folder - however you can save it to where you would like.
Once you have provided a name and select Save your Excel spreadsheet will open. You will find several worksheets - one for the data and then one for each of the charts.
5.2 Common Report Features

Although each pre-defined report has unique characteristics, there are also a few buttons and options that are common for all reports. These buttons may be found below the Parameters list in the Report Options dialogue, or in the Report window itself.

The Mix Samples Report options dialogue is shown below:

The Parameters list is common to many reports dialogues. Below the Parameters list you will find the following buttons:

- The up arrow button allows you to move the selected parameter up in the report options dialogue.
- The down arrow button allows you to move the selected parameter down in the report options dialogue.
- The sort button allows you to sort the parameter list alphabetically.
- The delete button will remove the selected Parameter from the parameters list.
- The add button allows you to select a parameter from the list of available parameters and add new parameters to the Report. When you press the add button, the following dialogue will appear:
Simply choose the desired parameter and press the [Select] button, and this parameter will be included in the report. You can use the button to sort the parameter list alphabetically, allowing you to quickly locate a parameter. In addition, some reports allow you to choose from several parameter categories, which are available in the combo box at the top of the Parameters dialogue. Once you are finished, press the [Close] button to close this dialogue.

When the [Set Default] button is pressed, the current parameter settings will be used as the default parameter settings for all new reports for the selected report type.

The Select sample button loads your list of active samples, and allows you to select a sample for the Report. Double-click on the desired sample to load this into the Report options.

A generic report window is shown below:

In some Report windows, you will find the following buttons:

The scroll buttons allow you to generate a Report for other samples in your active list. These buttons can be found on the bottom of the Report window. The function of these buttons (in order from left to right) is as follows:
**First sample** - loads a Report for the first sample in your active list.

**Previous sample** - loads a Report for the previous sample in your active list.

**Next sample** - loads a Report for the next sample in your active list.

**Last sample** - loads a Report for the last sample in your active list.

The **Print** button will print the current report to the selected Windows printer.

The **Save** button will save the current report. The pre-defined reports in AquaChem can be saved as .TXT, .CSV, and .XLS. The customized reports (designed using the Report Designer) can be saved as .HTM or .RTF format.

The **Close** button will close the Report window.

Where applicable, you can access the Report options dialogue by selecting View from the main menu and then Options. This allows you to change the report settings (such as which parameters or samples to use).

The following section provides more details on each of the various pre-defined Reports available in AquaChem.

### 5.3 Data Summary

The Data Summary report allows you to generate a summary report for the AquaChem database and all stations currently displayed in the Active Samples list. The following information is shown on a data summary report:

- Database location path
- Database Template
- Active Stations
- Active Samples
- Number of Parameters
- Number of samples per station including the first sample and last sample dates.
- All analyzed parameters in the samples, including the units, results, %ND, MDL, Min and Max.
- Results per Station matrix showing the number of measurements for each parameter and station combination.
5.4 Compare Sample

The Compare Sample report allows you to compare parameters for one sample to other samples in your database. This allows you to quickly determine the similarities and differences between your samples. When you select Reports from the main menu and then Compare Sample, the following dialogue will appear:

Select the Save button to export the data to a .TXT, .CSV or .XLS file.
The top field in this dialogue "Compare this sample to all active samples" allows you to select a sample to be used in the report. Press the Select sample button at the right side of this field and Pick a Sample dialogue will open up (as shown below). It allows you to select a sample for the Report.

Double-click on the desired sample to load this into the Report options.

The Compare Sample report requires you to specify Parameters which will be used in the comparison analysis. To add new parameters, press the button and select a parameter from the available list. You may also include parameter ratios, sums or differences (e.g. Na/Cl, Ca+Mg, Cl-SO4) in the Parameters field; simply type these values in manually in the parameter field. To remove parameters from the list, press the button. The default parameter settings for this report can be changed by modifying the parameters field and pressing the [Set Default] button in the lower left corner of this dialogue.
There are two options to select the samples from the active list:
- Select samples with correlation coefficient > #
- Use selected samples only

The Select samples with correlation coefficient > # option allows you to enter a correlation coefficient (r) value, and AquaChem will highlight (select) those samples in the active list once the comparison is completed.

When the Use selected samples only option is enabled, the Report will use only those samples that are selected (highlighted) in the active samples list, as part of the analysis.

Once you have specified the required options, press [OK] and the report will be generated. An example is seen below:

![Compare Samples: MW-1-92](image)

The Compare Sample report uses a linear regression algorithm to generate the correlation coefficient and the Euclidean distance between a selected sample and all other active or selected samples. Samples having a chemical composition similar to the selected sample will have a correlation coefficient close to 1. The correlation coefficient is a function of ratios rather than absolute values. The difference in absolute concentrations is expressed by the Euclidean distance:

$$d_{ij} = \sqrt{\sum_{i=1}^{n} (x_{ik} - x_{jk})^2}.$$  

where $x_{ik}$ denotes the $k$th variable measured on sample $i$ and $x_{jk}$ is the $k$th variable measured on sample $j$. For each sample, $n$ variables are measured. The distance between sample $i$ and sample $j$ is $d_{ij}$. 

© 2017 Waterloo Hydrogeologic.
In the examples above, comparing Sample x to Sample y, the following conclusions can be made:
(A) high similarity
(B) high similarity but sample y is diluted with respect to sample x
(C) low similarity

5.5 Mix Samples

The Mix Samples Report generates solution concentrations resulting from the step-wise mixing of specified proportions of two selected samples from your database. When you select Reports from the main menu and then Mix Samples, the following dialogue will appear:

In the Select Solutions frame, press the button beside Mix and With fields to select a sample from the available solutions (samples) that are in your database. Each field contains a complete list of all active samples in your AquaChem database.
The Parameters list allows you to select the parameters that will be included in the mixing calculations. Typically you should select parameters that you know are common to each sample. (If you use parameters which are not common to both samples, then the report may not be successfully generated). To add a parameter to the list, press the button and select a parameter from the list. To remove a parameter, select the parameter then press the button. The default parameter settings for this report can be changed by modifying the parameters and pressing the [Set Default] button in the lower-left corner of the dialogue.

In the Mode frame there are two mixing options, the Simple Mixing mode and the Optimize mode. Each mode is described in detail below.

**Simple Mixing Mode**
When you select the Simple Mixing mode, AquaChem will mix the two selected samples in a step-wise process.

In the Simple Mixing frame, the Add field is the starting proportion \( m \) of Solution 1 in the mixture solution, while the to field is the final proportion \( n \) of Solution 1 in the mixture solution. The Number of Steps value is the number of uniform steps in which to get from \( m \) to \( n \) parts of Solution 1 in the mixture solution. Starting with \( m \) parts of Solution 1 and \( (1.0 - m) \) parts of Solution 2 in the mixture solution, AquaChem will begin uniformly decreasing the proportion of Solution 1 in the mixture solution while maintaining a total proportion value of 1.0. The final mixture solution has \( n \) parts of Solution 1 and \( (1.0 - n) \) parts of Solution 2.

The figure below shows the Sample Mixing Report, and the results of mixing two solutions.

<table>
<thead>
<tr>
<th>Solution 1</th>
<th>Solution 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percentage of solution 1 in target solution: 10% - 50%</td>
<td></td>
</tr>
<tr>
<td>Solution 1</td>
<td>Solution 2</td>
</tr>
<tr>
<td>1.0</td>
<td>0.0</td>
</tr>
<tr>
<td>0.10</td>
<td>0.90</td>
</tr>
<tr>
<td>0.20</td>
<td>0.80</td>
</tr>
<tr>
<td>0.30</td>
<td>0.70</td>
</tr>
<tr>
<td>0.40</td>
<td>0.60</td>
</tr>
<tr>
<td>0.50</td>
<td>0.50</td>
</tr>
<tr>
<td>0.0</td>
<td>1.0</td>
</tr>
<tr>
<td>Na</td>
<td>K</td>
</tr>
<tr>
<td>80.0</td>
<td>15.0</td>
</tr>
<tr>
<td>210.5</td>
<td>1.14</td>
</tr>
<tr>
<td>196.0</td>
<td>1.18</td>
</tr>
<tr>
<td>181.5</td>
<td>1.22</td>
</tr>
<tr>
<td>167.0</td>
<td>1.26</td>
</tr>
<tr>
<td>152.5</td>
<td>1.3</td>
</tr>
<tr>
<td>225.0</td>
<td>1.1</td>
</tr>
<tr>
<td>Ca</td>
<td>Mg</td>
</tr>
<tr>
<td>1000.0</td>
<td>22.0</td>
</tr>
<tr>
<td>1000.0</td>
<td>6.7</td>
</tr>
<tr>
<td>1000.0</td>
<td>8.4</td>
</tr>
<tr>
<td>1000.0</td>
<td>10.1</td>
</tr>
<tr>
<td>1000.0</td>
<td>11.8</td>
</tr>
<tr>
<td>1000.0</td>
<td>13.5</td>
</tr>
<tr>
<td>1000.0</td>
<td>5.0</td>
</tr>
<tr>
<td>Cl</td>
<td>HCO3</td>
</tr>
<tr>
<td>125.0</td>
<td>125.0</td>
</tr>
<tr>
<td>269.9</td>
<td>136.77</td>
</tr>
<tr>
<td>253.8</td>
<td>137.24</td>
</tr>
<tr>
<td>237.7</td>
<td>135.71</td>
</tr>
<tr>
<td>221.6</td>
<td>134.18</td>
</tr>
<tr>
<td>265.5</td>
<td>132.65</td>
</tr>
<tr>
<td>286.0</td>
<td>140.3</td>
</tr>
<tr>
<td>SO4</td>
<td>Options</td>
</tr>
<tr>
<td>550.0</td>
<td>0.0</td>
</tr>
<tr>
<td>233.47</td>
<td>0.0</td>
</tr>
<tr>
<td>258.64</td>
<td>0.0</td>
</tr>
<tr>
<td>303.81</td>
<td>0.0</td>
</tr>
<tr>
<td>338.98</td>
<td>0.0</td>
</tr>
<tr>
<td>374.15</td>
<td>0.0</td>
</tr>
<tr>
<td>198.3</td>
<td>0.0</td>
</tr>
</tbody>
</table>

The concentrations of each parameter in the first column are the concentrations for Solution 1. The concentrations of each parameter in the second column are the concentrations for a mixture of 0.1 parts Solution 1 with 0.9 parts Solution 2. The concentrations of each
parameter in the third column are the concentrations for a mixture of 0.2 parts Solution 1 with 0.8 parts Solution 2, and so forth for the remaining columns.

Optimize Mode
In addition to simple mixing of two samples, AquaChem also allows you to determine the optimal mixing ratio of the two selected samples that most closely matches a target sample from the database. When you select the Optimize mode, you will see the following options (in the lower half of the Report options dialogue):

This mixing mode requires you to select a sample that you would like to match. AquaChem will mix the two initial samples in 2% increments until the Euclidean distance between the calculated mixture and specified resulting sample is minimized.

The Optimize mode can be used in a situation where you have three samples (ex. groundwater, seawater and freshwater) and you suspect that the groundwater is a mixture of the freshwater and the seawater. The Optimize mode can be used to estimate the percentage of freshwater and the percentage of seawater required to obtain the groundwater composition of selected parameters.

To generate a report with Optimize mode, select a sample from your database, and click [OK].

5.6 Water Quality Standards

The Water Quality Standards report provides a list of all parameters which exceed at least one of the established Guideline/Tolerance levels for the selected sample. If your sample contains no exceedences, then this Report will be blank.

When you select this report, a Water Quality window similar to the one below will appear:
Each line of the report contains the Parameter, corresponding Unit, actual measured Value and guideline values (e.g. Maximum Contaminant level (MCL), Goal contaminant level (GCL), Aesthetic Objectives (AO)). Depending on the Guideline used, you may see one, two, or three guideline levels. The example above shows three levels, a maximum concentration limit, a tolerated concentration limit and a concentration goal. AquaChem allows the definition of multiple standards; the active standard used for detecting exceedences in this report is defined in the Preferences dialogue available under the File menu.

The scroll arrows in the lower left corner of the Report window can be used to produce a report for other samples in your database.

5.7 Hardness Dependent Standards

The United States Environmental Protection Agency (EPA) has established standards for metals where toxicity is a function of hardness. The water quality criteria for metals can be expressed as "total recoverable" or "dissolved" for acute and chronic concentrations. The total recoverable also includes the sorbed concentration on particles. Acute standards offer protection from toxic effects from chemical concentrations during a shorter term exposure. Chronic standards offer protection from toxic effects from a chemical during long-term exposure.

EPA Freshwater standards are mainly used for hardness dependent standards, however similar standards can be found in different countries. The demo_basic database provided with AquaChem only includes the EPA Freshwater Standards, however you may create your own standards.

When you select this report, a Freshwater Standards window will appear (shown below):
The Standards Tab displays the non-hardness dependent standards, along with the acute and chronic standards for metals, according to the specified Hardness (mg/L CaCO₃). When a new value is entered in the Hardness field, the acute and chronic values are automatically calculated and displayed in the table below for all metals that are hardness dependent.

The Exceedences tab shows a table with the measured hardness and measured parameter along with respective calculated standards based upon sample hardness for each sample in the active samples list.

Exceedences will be highlighted with different colors if acute or chronic standards are exceeded.

The Function tab shows the metal standards as a function of hardness value varying from 1-400 mg/L CaCO₃.

Creating a New Standard
By default, AquaChem provides the EPA Freshwater standard. However, if this standard is not suitable for your project, you may modify the standard or create a new standard from scratch.

To create a new hardness dependent standard, select the Options button, located in the bottom-right corner of the Fresh Water Standards dialog. The Hardness Dependent Standards dialog will appear on your screen.
Information for the current standard will be shown in the Hardness Dependent Standard dialog. To create a new standard, click the New button.

Specify a Name, Description and Units for the new standard in the respective text fields.

Specify the desired Hardness interval (mg/L CaCO3). AquaChem will display the metal standards as a function of each hardness value within the specified range in the Function tab (of the Fresh Water Standards Dialog).

**Adding Parameters to the Standard**

Click the button, and then type the name of the parameter in the Parameter field. Select the desired type from the Type combo box. Choose Constant or Hardness Dependent (formula).
Constant
The Constant option allows you to define a constant value for both the acute and chronic concentrations. In other words, these values will not change with changes in hardness.

The chronic concentration, also referred to as Criteria Continuous Concentration (CCC), is an estimate of the highest concentration of a material in surface water to which an aquatic community can be exposed briefly without resulting in an unacceptable effect. The acute concentration, also referred to as Criteria Maximum Concentration (CMC), is an estimate of the highest concentration of a material in surface water to which an aquatic community can be exposed briefly without resulting in an unacceptable effect.

You may also specify the conversion factor for both CCC and CMC. The term "Conversion Factor" is the recommended conversion factor for converting a metal criterion expressed as the total recoverable fraction in the water column to a criterion expressed as dissolved fraction in the water column.

Hardness Dependent (Formula)
This option allows you to express the freshwater criterion for the metal as a function of hardness (mg/L) in the water column. The hardness level may be specified in the main Fresh Water Standards dialog, in the Standards tab (shown below).

When the Hardness Dependent (Formula) option is selected, the following options will appear:
The criteria values for CMC and CCC are calculated using the following formulas:

\[
\text{CMC} = \exp\{m_A \ln(\text{hardness}) + b_A\} \\
\text{CCC} = \exp\{m_C \ln(\text{hardness}) + b_C\}
\]

Where \(m_A, b_A, m_C\) and \(b_C\) are empirical coefficients for the metal.

To express the metal criterion as dissolved fraction in the water column, a conversion factor is applied to the above formulas. The following formulas are used to define the conversion factor as a function of hardness.

\[
\text{CF(CMC)} = a - \ln(\text{hardness}) \times b \\
\text{CF(CCC)} = c - \ln(\text{hardness}) \times d
\]

To view a table of parameters used for calculating freshwater dissolved metals criteria that are hardness-dependent, please refer to the "National Recommended Water Quality Criteria" document by the United States Environmental Protection Agency, available on-line at the following website:

http://epa.gov/ost/criteria/wqctable/

**Saving Standards**

To save the changes made to your hardness dependent standard, click the [Save] button located at the bottom of the dialog.

**Duplicating Standards**

You may wish to create a duplicate of an existing standard to use as a template, for creating new standards. To create a duplicate, click the [Duplicate] button located at the bottom of the dialog.

### 5.8 Rock Source Deduction

The Rock Source Deduction report allows you to gain insight into the possible origin of the water sample. The results are a general overview based on ion ratios found in a sample which are compared to ratios of the respective ions in reactive minerals. If results do not meet expectations, the result should be confirmed with more detailed study based on multiple samples, aquifer mineralogy analysis, modeling and with the use of plots.

When you select this report, the following Rock Source Deduction window will appear:
The following table provides a summary of the criterion for the Rock Source Deduction Report.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Attention Value</th>
<th>Conclusion</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>SiO2 (mmol/L)</td>
<td>&gt;0.5</td>
<td>Volcanic glass or hydrothermal water possible</td>
<td>The solubility of quartz at 20° is X mg/L.</td>
</tr>
<tr>
<td>HCO3-/SiO2</td>
<td>&gt;10</td>
<td>Carbonate weathering</td>
<td>Low carbonate SiO2 ratios indicate that these ions are released from silicate minerals, especially if TDS is low.</td>
</tr>
<tr>
<td></td>
<td>&gt;5 and &lt;10</td>
<td>Ambiguous</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;5</td>
<td>Silicate weathering</td>
<td></td>
</tr>
<tr>
<td>SiO2/(Na+K-Cl)</td>
<td>&lt;1</td>
<td>Cation exchange</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&gt;1 and &lt;2</td>
<td>Albite weathering</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&gt;2</td>
<td>Ferromagnesian minerals</td>
<td></td>
</tr>
<tr>
<td>(Na+K-Cl)/(Na+K-Cl+Ca)</td>
<td>&gt;0.2 and &lt;0.8</td>
<td>Plagioklas weathering possible</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;0.2 or &gt;0.8</td>
<td>Plagioklas weathering unlikely</td>
<td></td>
</tr>
<tr>
<td>Na/(Na+Cl)</td>
<td>&gt;0.5</td>
<td>Sodium source other than halite - albite, ion exchange</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;0.5</td>
<td>Halite solution</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;0.5 TDS &gt;500</td>
<td>Reverse Softening, seawater</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;0.5 TDS &lt;500 and &gt;50</td>
<td>Analysis Error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;0.5 TDS &lt;50</td>
<td>Rainwater</td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Criteria</td>
<td>Interpretation</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>----------</td>
<td>----------------</td>
<td></td>
</tr>
<tr>
<td>Mg/ (Ca+Mg)</td>
<td>=0.5 and (HCO3/Si)&gt;10 &lt;0.5 &gt;0.5 &lt;0.5 and (HCO3/Si)&lt;5 &gt;0.5</td>
<td>Dolomite Weathering Limestone-Dolomite Weathering Dolomite Dissolution, calcite precipitation, or seawater Ferromagnesian Minerals Granitic weathering</td>
<td></td>
</tr>
<tr>
<td>Ca/ (Ca+SO4)</td>
<td>=0.5 &lt;0.5 and pH&lt;5.5 &lt;0.5 and pH neutral &gt;0.5</td>
<td>Gypsum dissolution Pyrite oxidation Calcium removal - ion exchange or calcite precipitation Calcium source other than gypsum - carbonate or silicates</td>
<td></td>
</tr>
<tr>
<td>TDS</td>
<td>&gt;500 &lt;500</td>
<td>Carbonate weathering or brine or seawater Silicate weathering</td>
<td></td>
</tr>
<tr>
<td>Cl/Sum Anions</td>
<td>&gt;0.8 and TDS&gt;500 &gt;0.8 and TDS&lt;100 &lt;0.8</td>
<td>Seawater or brine or evaporites Rainwater Rock weathering</td>
<td></td>
</tr>
<tr>
<td>HCO3/ Sum Anions</td>
<td>&gt;0.8 &gt;0.8 and SO4 &gt;20meq/L &lt;0.8 and sulfate low</td>
<td>Silicate or carbonate weathering Gypsum dissolution Seawater or brine</td>
<td></td>
</tr>
<tr>
<td>Calcite Saturation Index</td>
<td>&gt;0 =0 &lt;0</td>
<td>Oversaturated with respect to Calcite Saturated with respect to Calcite Undersaturated with respect to Calcite</td>
<td></td>
</tr>
</tbody>
</table>

The report will complete the Parameter analysis, check the Attention Values, and produce a result value and Conclusion on the rock source. If the report values shows “n/a”, it means that no data is available and the calculation could not be performed.

The scroll arrows in the lower right corner of the Rock Source Deduction Report window can be used to produce a report for other samples in your database. For more details please see the reference below:


### 5.9 Statistics

AquaChem comprises most of the commonly used statistical methods and techniques for the analysis of water samples:

**Summary Statistics**
Correlation Matrix
Trend Analysis
Outlier tests

These analyses are available under Reports>Statistics and are discussed in detail below. The statistics used in AquaChem were developed in accordance with USEPA guidelines outlined in the following document:

5.9.1 Summary Statistics

The Summary Statistics report calculates basic statistics for all active samples in your database. When you select Reports from the main menu, then Statistics, and, finally, Summary Statistics from the sub-menu, the following Statistics options dialogue will appear:

The above dialogue allows you to customize your summary statistics report using the available tabs. At the top of this dialogue is a combo box which allows you to choose a previously saved combination of settings.
In the first tab, Parameters, you must specify the parameters for which the summary statistics are to be calculated. Click the button to produce a standard parameter selection dialogue and choose the desired parameters by highlighting them and clicking
When finished with parameter selection click [Close]. You can change the order of the chosen parameters by clicking the [Add] and [Remove] buttons. Delete any parameter by clicking the [Remove] button.

Next, click on the Statistics tab.

Use this dialogue to select the statistics for your data. Click the [Add] button to produce the following dialogue:
Scroll through the available list of statistics to select the desired ones. Click [Select] to add a chosen statistic. When finished, click [Close]. The statistic abbreviation will be listed in the Function column of the statistic list. The Title column lists the full statistic names and these names will appear as headers on the output. You can modify these entries by double-clicking in the cell and entering a new Title. You can change the order of the chosen statistics by clicking the and buttons. Delete any parameter by clicking the button.

Once the statistics are chosen, you can modify some of their options in the Summary Statistics dialogue. To access statistic options simply highlight it in the list, and available options will be displayed in the bottom portion of the dialogue:
AquaChem allows you to decide how to deal with censored data. The Censored Data combo box allows you to select the method used to manage non-detects. The options are Auto, Ignore, Multiply, Constant, Trimmed, Winsorize. Depending on the method chosen you may have to enter additional data (e.g. if you chose Multiply, you will have to enter the Factor to multiply by). Choosing Auto will subject the censored data to the method specified under File / Preferences (for more details see ”QC Metadata” option).

The following is a description of each Statistical Analysis available for this report:

- **MIN** (minimum): lowest recorded value for the parameter
- **MAX** (maximum): highest recorded value for the parameter
- **RAN** (range): maximum minus minimum
- **IQR** (interquartile range): Q75 minus Q25
- **MEAN** (Arithmetic mean): average value for the parameter
- **STD** (Standard Deviation): square root of the variance

\[ s = \sqrt{s^2} \]

**QUANT** (non parametric quantile): The Quantile is a data value, that is greater than or equal to a given fraction of the data values. If \( x \) is the \( p \) quantile, then at least the fraction \( p \) of the value set lie at or below \( x \), at least \( 1-p \) of the value lie at or above \( x \). For the non parametric quantile calculation no assumption is made for the underlying data set. The data is ranked from the lowest to the highest value. The quantile \( p \) is then calculated depending as follows if number of points is odd:
\[ \tilde{X} = X_{\lfloor n/2 \rfloor} \]

if number of points is even:

\[ \tilde{X} = \frac{X_{\lfloor n/2 \rfloor} + X_{\lceil n/2 \rceil + 1}}{2} \]

CI (confidence interval): The confidence interval gives an estimated range of values which is likely to include the sample mean. The estimated range is calculated from a given set of sample data. Confidence intervals are usually calculated so that this percentage is 95%, but AquaChem can produce 90%, 99%, 99.9% (or any other) confidence intervals for the mean. The confidence range is calculated as the upper minus the lower confidence interval

\[ \left( \bar{x} + t_{1-\alpha/2} \cdot \frac{s}{\sqrt{n}} \right) - \left( \bar{x} - t_{1-\alpha/2} \cdot \frac{s}{\sqrt{n}} \right) \]

**NOTE**: If the result calculated for the Confidence Intervals comes back as 1.#INF or -1.#INF this means that infinity was calculated likely due to invalid parameters. Please re-check your data and your settings.

DEV_COEF (Deviation Coefficient): Coefficient of Variance calculated using the formula below.

\[ CV = \frac{s}{\bar{x}} \cdot 100\% \]

SKEW (skewness): skewness is calculated according to the following formula:

\[ skew = \frac{n}{(n-1)(n-2)} \sum \left( \frac{x_i - \bar{x}}{s} \right)^3 \]

KURT (kurtosis): kurtosis is calculated according to the following formula:

\[ kurt = \frac{\sum (x_i - \bar{x})^4}{n \cdot s^4} - 3 \]

N (number of samples): number of samples that have a measured value for the selected parameter.

N_ND (number of non-detects): number of samples that list the value for the selected parameter as a non-detect.

PERC_ND (percent of non-detects): number of non-detects divided by the total number of samples and multiplied by one hundred.

VAR (Variance): average square distance from points to sample mean

\[ s^2 = \frac{1}{n-1} \sum_{i=1}^{n} (y_i - \bar{y})^2 \]

QUANT_PAR (parametric quantile): For the parametric quantile calculation the data is assumed to be normally distributed. A 0.25 quantile thus corresponds to the Z value of the normal distribution for a probability of 0.25.

N_EXC (number of exceedences): number of samples that have exceedences for the selected parameter.
PERC_EXC (percent of exceedences): number of exceedences for the parameter divided by the total number of samples and multiplied by one hundred

N_D (number of detects): number of samples for which the selected parameter could be detected

PERC_D (percent of detects): number of detects for the parameter divided by the total number of samples and multiplied by one hundred

N_DBS (number of detects below standard): number of values below standard for the selected parameter

PERC_DBS (percent of detects below standard): number of detects below standard divided by the total number of samples and multiplied by one hundred

N_DAS (number of detects above standard): number of values above standard for the selected parameter

PERC_DAS (percent of detects above standard): number of values above standard for the selected parameter divided by the total number and multiplied by one hundred

TSTAT (t-statistic): calculates t-statistic for the parameter

LCL (lower confidence limit): calculates lower confidence limit

\[ \bar{x} - t_{1-\alpha, n-1} \cdot \frac{s}{\sqrt{n}} \]

UCL (upper confidence limit): calculates upper confidence limit

\[ \bar{x} + t_{1-\alpha, n-1} \cdot \frac{s}{\sqrt{n}} \]

TI (tolerance interval): The tolerance interval is a way of determining a range that (with a certain confidence level) will contain a certain percentage of the population

LTI (lower tolerance limit): calculates lower tolerance limit

UTI (upper tolerance limit): calculates upper tolerance limit

MKS (Mann Kendall Statistic): indicates increasing or decreasing trend

MKZ (Mann Kendall Statistic): approximates Z value for calculating probability

GEOMEAN (Geometric Mean): the mean of n numbers expressed as the n-th root of their product.

P_EXC: Probability of exceeding a given value. This function assumes that the data is normally distributed. It calculates the standard deviation and average for a given parameter, and then calculates the probability that the specified threshold is exceeded. Typically the threshold is defined as the water standard for the given parameter. The P_EXC function then returns the probability that exceeding values will be encountered.

LPR/UPL: The prediction interval estimates future values based on present or past background samples. Prediction intervals tend to be applied in detection monitoring in two main ways. They can be used to compare compliance wells with background wells, or they can be used for intrawell comparisons of monitoring wells. When comparing compliance wells to a background well, if the compliance wells come from the same uncontaminated water source, the upper prediction limit should be greater than or equal to the data collected from compliance wells. Compliance data greater than upper prediction limits is indicative of contamination. For intrawell comparisons, a range of values is determined which future values collected from the same well should fall within. Any data collected in the future which does not fall within that specified range is an indication that a once uncontaminated water supply is now contaminated. Below is the formula for calculating lower and upper prediction limits:

\[ \bar{x} \pm ts \sqrt{\frac{1 + \frac{1}{n}}{n}} \]

where,
x = mean
\[ t(n-1,\alpha) = \text{t-statistics value (function of confidence and number of points)} \]
s = standard deviation
n = number of data points

The next tab allows you to specify the output settings:

The Parameter as combo box allows you to set the parameter orientation. When Rows is selected, the parameters will be displayed in rows and statistics in columns. When Columns is selected, the orientations are reversed with parameters displayed in columns and statistics in rows.

AquaChem allows you to break the Summary Statistics output by symbol. When this option is selected, the statistics will be calculated and displayed for every symbol. Thus, if you have a symbol assigned to every sample, all samples with the same symbols will be grouped and statistics performed on those groups.

The Data tab provides you with a preview of data of the selected parameters:
If you are satisfied with the settings for the Summary Statistics report, before generating it, you may wish to save these settings by clicking [Save] button. The following Save dialogue will be loaded:

Type in a new name, or select an already existing name if you wish to update the settings. This dialogue also allows you to delete the settings that are no longer needed. Simply select the name of the settings you wish to delete and click the [Delete] button. Click [OK] to save the settings.
Click [OK] to generate the report.
An example of a finished report is displayed below:
5.9.2 Correlation Matrix

The Correlation Matrix Report shows a simple correlation matrix of the parameters for the samples in your database. This allows you to quickly determine the similarities or differences between your samples. When you select Reports from the main menu and then Statistics>Correlation Matrix, the following dialogue will appear:

The Correlation Matrix Report requires you to specify parameters which will be used in the correlation analysis. To add new parameters, press the button and select a parameter from the available list. You can also include parameter ratios, sums or differences (e.g. Na/Cl, Ca+Mg, Cl-SO4) in the Parameters field; simply type these values in manually in the parameter field. To remove parameters from the list, press the button.

When the Use Selected samples only option is enabled, only the samples which are selected in the active list will be used. If this option is disabled, then all samples in the active list will be used.

The Unit field beside every parameter contains a combo box listing the available concentration units for the correlation of the chemical parameters. Units of mol/l are often more suitable for correlating than mg/L, because it gives you an idea as to which minerals have been dissolved.

Once you have specified the required options, press [OK] and the report will be generated as shown in the figure below:
The Correlation Matrix report generates a correlation matrix for a specified number of sample parameters that are common to all samples. A linear regression routine calculates the regression coefficient (r), and the slope and intercept of the regression line.
The figure below shows the correlation of Ca against SO4 for three different scenarios.

\[ r = \frac{\sum_{i=1}^{n} x_i y_i - \frac{\sum_{i=1}^{n} x_i \sum_{i=1}^{n} y_i}{n}}{\sqrt{\left(\sum_{i=1}^{n} x_i^2 - \frac{(\sum_{i=1}^{n} x_i)^2}{n}\right)\left(\sum_{i=1}^{n} y_i^2 - \frac{(\sum_{i=1}^{n} y_i)^2}{n}\right)}} \]

The correlation of Ca and SO4 in three samples above is as follows:
(A) high positive correlation
(B) low positive correlation
(C) high negative correlation

It is often useful to check the correlation results graphically in a scatter plot to easily identify outliers which might influence the correlation result. The Scatter plot is available as one of the plot types, under the Plots menu. In the Scatter plot options, access the Edit Lines option under the Symbols tab. In this dialogue, you can calculate the regression curve. For more details, see Scatter Plot in the Plots section.

The Correlation Matrix also includes the Spearman Rank Correlation coefficient. This value is calculated using the assigned rank, rather than exact values. This coefficient is useful when it is not economically feasible to obtain the exact values. Spearman Rank Correlation coefficient is a good indicator of a relationship between two variables, in case this relationship is not linear.

5.9.3 Trend Analysis

The Trend Analysis option estimates a potential positive or negative trend that may be present in the data. A trend analysis may be interesting for three types of problems:

When detecting an increasing trend becomes important to show that the contaminants in the down gradient wells increase with time and may eventually exceed its water quality standards.

For compliance monitoring projects, the success of groundwater cleanup and remediation works can be verified by testing if the contaminant shows a decreasing trend.
Finally, if a dataset is to be used in a test assumption of independent data, trend analysis can be used in order to ensure that this data does not include any trend at all.

When you select Reports / Statistics / Trend Analysis, the following dialogue will appear:

![Trend Test dialog](image)

The Trend Test dialog consists of three tabs: Stations & Parameters, Options and Results. Each tab is described below.

**Stations & Parameters**
This tab allows you to specify which stations and parameters to include in the trend analysis.

**Adding Stations**
To add one or more stations, select the ![button](image) button, located beside the Show combo box.
The Stations dialog will appear on your screen. The stations dialog lists all stations currently displayed in the Active Stations list. Note: If your database consists of many stations, it may be desirable to perform a query (see "Find") such that only those stations required for the trend analysis are displayed in the Active Stations list.
Select the desired stations from the Stations dialog, and then select the [Select] button. Click the [Close] button to close the dialog. The selected stations will then be added to the Stations list, in the Trend Test dialog.

**Adding Parameters**

The AquaChem trend analysis report allows you to analyze any combination of stations and parameters in a single run.

To add one or more parameters to the analysis, select the button, located below the Parameters list.
The Parameters dialog will appear on your screen where you can select one or more parameters for the analysis. Please note that the list of parameters in the dataset may be very extensive, and you may not want to include parameters which have not been analyzed in any of the samples in the current selection of stations. Select the subcategory filter "Analyzed parameters only" to show only those parameters that have been analyze.
Select the desired parameters, and then select the [Select] button. Click the Close button to close the dialog.

**Exploring the Dataset**
Before you run the actual trend analysis, with potentially hundreds of stations and parameters, you should first explore the dataset and check whether there are stations or parameters which should be excluded from the analysis due to insufficient data.

Use the Show combo box, to display various information in the adjacent display area about the selected station and parameter.
The show combo box provides the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw Data</td>
<td>Shows all data points including samples marked as outliers. Note that outliers will not appear in other previews, e.g., in plots</td>
</tr>
<tr>
<td>Statistics</td>
<td>Provides a short summary of statistics for specified dataset.</td>
</tr>
<tr>
<td>Aggregated Data</td>
<td>Shows the average measurement in each aggregation interval. For example, if you aggregate over 12 months, you will see a yearly averaged sample. Please note that the concentration as well as the time is averaged. If all measurements were taken in Q4, the averaged point will also plot in Q4, not in the middle of the year.</td>
</tr>
<tr>
<td>Trend Test</td>
<td>Summarizes the trend test results for the current parameter and station selection. The information of each of the 5 tests are shown: Man Kendall, seasonal Mann Kendall, Sen Test, Linear Regression and Spearman Correlation. Please note that the linear regression coefficient detects linear relations only and is sensitive to outliers. The Spearman's rank correlation coefficient detects any monotonic trend and is not limited to linear.</td>
</tr>
<tr>
<td>Time Series Plots</td>
<td>Generates a time series diagram including the Sen slope, the linear regression and the water standard for the active parameter. The data points are shown as raw data and averaged data points if this option has been selected.</td>
</tr>
<tr>
<td>Station Summary</td>
<td>Displays a summary of each station in the database that has an analyzed parameter value, including the Min, Max, Count, date of the First Sample and date of the Last sample.</td>
</tr>
<tr>
<td>Parameter Summary</td>
<td>Displays a list of stations that contain data for the selected parameter, including the Min, Max, Count, date of the First Sample and date of the Last sample.</td>
</tr>
</tbody>
</table>

**Options**
The options tab allows you to configure the various input and output options for the trend analysis. Once you have specified the desired options, you can save the configuration by selecting the [Save] button from the row of buttons along the bottom of the dialog.

<table>
<thead>
<tr>
<th>Title</th>
<th>The title of the trend test configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>A description of the trend test configuration</td>
</tr>
<tr>
<td>Time Axis Start</td>
<td>Start data for trend test analysis. Samples before this date will be ignored in the analysis. Format: MM/DD/YYYY</td>
</tr>
<tr>
<td>Time Axis End</td>
<td>End data for trend test analysis. Samples after this date will be ignored in the analysis. Format: MM/DD/YYYY</td>
</tr>
<tr>
<td>ND Method</td>
<td>Method for handling non detect values</td>
</tr>
<tr>
<td>ND Factor</td>
<td>The factor by which all non detect concentration are multiplied or the constant value that is assigned to all non detect concentrations.</td>
</tr>
<tr>
<td>Maximum Percentage ND</td>
<td>The maximum percentage of non detects allowed in dataset. If this threshold is exceeded, no test will be performed.</td>
</tr>
<tr>
<td>Maximum Ratio ND/min ND</td>
<td>High ND values will be ignored, if the ratio between the minimum ND and the ND value is higher than this threshold.</td>
</tr>
<tr>
<td>Minimum Number of Years</td>
<td>The minimum number of years with at least 1 sample in the test interval. If this threshold is not reached, no test will be performed.</td>
</tr>
<tr>
<td>Minimum Number of Samples</td>
<td>The minimum number of points allowed in the dataset. If this threshold is not reached, a test will not be performed.</td>
</tr>
<tr>
<td>Confidence for Trend Test</td>
<td>Confidence for trend tests.</td>
</tr>
<tr>
<td>---------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>Run Test on averaged data</td>
<td>Choose the desired time interval for averaging data or disable averaging.</td>
</tr>
<tr>
<td>Average data by</td>
<td>Select the desired averaging method that will be used to average data within the specified time interval.</td>
</tr>
<tr>
<td>Average method</td>
<td>Only display rows where the data quality criteria have been matched. This is useful for tests with a large number of stations and parameters where many records do not reach the data quality criteria, e.g., there are not enough points to too many non detects.</td>
</tr>
<tr>
<td>Show Analyzed Rows only</td>
<td>Show/hide the results of the Mann Kendall test</td>
</tr>
<tr>
<td>Calc. Mann Kendall</td>
<td>Show/hide the results of the Seasonal Mann Kendall test</td>
</tr>
<tr>
<td>Calc Mann Kendall Seasonal</td>
<td>Show/hide the results of the Sen test</td>
</tr>
<tr>
<td>Mann Kendall season length</td>
<td>Show/hide the results of the linear regression</td>
</tr>
<tr>
<td>Calc. Sen’ Test</td>
<td>Show/hide the results of the Spearman Rank correlation</td>
</tr>
<tr>
<td>Extrapolate Value (years)</td>
<td>Define a prediction year in number of years after the end date for test data.</td>
</tr>
<tr>
<td>Standard</td>
<td>Specify the standard that will display in the results table</td>
</tr>
<tr>
<td>Show standard value</td>
<td>Show/hide the water quality standard in the table results.</td>
</tr>
<tr>
<td>Show standard line</td>
<td>Select whether you want to display the water quality standard as a line on the time series diagrams.</td>
</tr>
<tr>
<td>Save test result</td>
<td>Specify the test result that is saved to the aquachem database or select none if the results should not be saved to the database. This option requires that a meta data parameter has previously been defined to hold the test result. If this option is selected, a value of 1 will be stored for every parameter/station combination where a statistical trend was detected. This can be useful if you would later query for test results to detect patterns that may explain the occurrence of outliers.</td>
</tr>
<tr>
<td>Save result in DB field</td>
<td>Select which parameter meta data field should be used to store the information. If you do not find an appropriate field, you may create it in the File &gt; Database utility.</td>
</tr>
<tr>
<td>Raw data symbol</td>
<td>Define the desired symbology for the raw data points on the time series plots.</td>
</tr>
<tr>
<td>Aggregated data symbol</td>
<td>Define the desired symbology for the aggregated data points on the time series plot.</td>
</tr>
</tbody>
</table>
## Results

Once you have specified the Stations & Parameters and have configured the input and output Options, you can run the trend analysis. To run the trend analysis, click the [Run] button located along the bottom of the Trend Test dialog.

Depending on how many parameters and stations are included in the test, this may take a few minutes to complete. The results will display in the Results tab.

![Trend Test Results Table](image)

The first 10 rows of the results table display a summary of the input options used for the trend analysis. These are defined under the Options tab. The rows below contain the results of the trend analysis. In the first section, it contains the station and parameter as well as the checks for data completeness. Following this section are the various tests depending on whether they are selected in the output options. The complete set of tests include:

- Mann Kendall
- Seasonal Mann Kendall
- Sen's test
- Linear Regression
- Spearman's Rank Correlation

Significant increasing and decreasing trends are highlighted with a yellow background. If you would like to check the statistical test results, double click the respective row and you will be deferred to the Station & Parameter tab, where the station and parameter are automatically selected for you. Here you can select Trend Results from the Show combo box to view the statistical test results.

### Creating Plots

Trend analysis plots can be quickly generated for each station and parameter combination in the results tab. In the results tab, scroll across to the end of the results table, so that the last
column is visible. This column will contain a selectable box in each cell. Select the desired rows to be plotted.

NOTE: The Select combo box, located at the bottom-right corner of the dialog, provides various options for automatically selecting multiple rows for plotting. For example, the Select All option will select all rows in the results table. The Select accepted MK option will only select those rows that meet the criteria for Mann Kendall analysis. Furthermore, you can filter the result list by parameter name (using the Parameter combo box) or station name (using the Station combo box).

Once the desired rows are selected, click the [Plot] button, located along the bottom of the Trend Test dialog. A time series plot displaying the linear regression and the Sen line will display for each selected row.
Please Note: The Y intercept is based on the Plot X axis beginning at January 1, 1900.

**Saving the Results**
To Save the trend analysis results, select the Export button, located at the bottom of the dialog box. You may choose from three file formats.

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comma Separated Values (*.CSV)</td>
<td>This format is useful when your table is very large (&gt;65,000 rows) and you do not want to use the database format</td>
</tr>
<tr>
<td>Microsoft Excel (*.XLS)</td>
<td>This is the preferred format if you simply want to create a table for your report.</td>
</tr>
<tr>
<td>Microsoft Access (*.MDB)</td>
<td>This will create a new table in a specified database. This will allow you to query out specific results within the MS Access environment, e.g., if you want to know the percentage of insufficient data for a given parameter, the number of increasing versus decreasing trends etc.</td>
</tr>
</tbody>
</table>

**5.9.4 Outlier Tests**

Outliers are measurements that are extremely large or small relative to the rest of the data and, therefore, are suspected of misrepresenting the population from which they were collected. Outliers may result from transcription errors, data-coding errors, or measurement errors.
system problems such as instrument breakdown. However, outliers may also represent true extreme values of a distribution (for instance, hot spots) and indicate more variability in the population than expected. Not removing true outliers and removing false outliers both lead to a distortion of estimates of population parameters. (Office of Environmental Information, U.S. Environmental Protection Agency, 2000).

AquaChem allows you to run outlier tests for multiple stations and parameters simultaneously.

Selecting this option from the Statistics sub-menu launches the following dialogue:

The workflow for performing batch outlier tests is similar to that of performing trend analysis test. Start by specifying the stations and which parameters to include in the outlier tests. This process is described on "Stations & Parameters".

**Exploring the Data**
Before you run the actual outlier tests with potentially hundreds of stations and parameters, you should first explore the dataset and check whether there are stations or parameters which should be excluded from the analysis due to insufficient data.

Use the Show combo box, to display various information in the adjacent display area about the selected station and parameter.

The show combo box provides the following options:

<table>
<thead>
<tr>
<th>Raw Data</th>
<th>Shows all data points including analysis marked as outliers. Note that outliers will not appear in other previews, e.g., in plots</th>
</tr>
</thead>
<tbody>
<tr>
<td>Statistics</td>
<td>Provides a short summary of statistics</td>
</tr>
<tr>
<td>Trend Test</td>
<td>Summarizes the outlier results for the current combination of parameters and stations. The information of each normality tests are shown: Dixon</td>
</tr>
</tbody>
</table>
test, Discordance test, Rosner test, Walsh test. A description of the tests together with directives for the calculations can be found in the USEPA report QA/G-9 Guidance for Data Quality Assessment.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Histogram Plot</td>
<td>Displays a time series plot for the selected parameter and station</td>
</tr>
<tr>
<td>Station Summary</td>
<td>Displays a summary of each station in the database that has an analyzed parameter value, including the Min, Max, Count, date of the First Sample and date of the Last sample.</td>
</tr>
<tr>
<td>Parameter Summary</td>
<td>Displays a list of stations that contain data for the selected parameter, and associated information including the Min, Max, Count, date of the First Sample and date of the Last sample.</td>
</tr>
</tbody>
</table>

**Options**
The options tab allows you to configure the various input and output options for the outlier test. Once you have specified the desired options, you can save the configuration by selecting the [Save] button from the row of buttons along the bottom of the dialog.

The options allow you to configure various input/output parameters for the Outlier tests. Each option is described briefly below:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Title of outlier test configuration</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the outlier test configuration</td>
</tr>
<tr>
<td>ND Method</td>
<td>The method for handling non detect values</td>
</tr>
<tr>
<td>ND Factor</td>
<td>The factor by which all non detect concentrations are multiplied or constant value that is assigned to all non detect concentrations</td>
</tr>
</tbody>
</table>
### Reports 270

© 2017 Waterloo Hydrogeologic.

<table>
<thead>
<tr>
<th>Min Points</th>
<th>The minimum number of points - if this threshold is not reached no test will be performed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outlier Test Confidence</td>
<td>Confidence limit for all outlier tests</td>
</tr>
<tr>
<td>Test for Normality (&lt;= 50 points)</td>
<td>Parametric outlier test requires that the underlying data is normally distributed. For each dataset, a normality test is run, and parametric tests are only run if the data is normally distributed. Chose the desired test for normality when the number of points is less than or equal to 50</td>
</tr>
<tr>
<td>Test for Normality (&gt;50 points)</td>
<td>Parametric outlier test requires that the underlying data is normally distributed. For each dataset, a normality test is run, and parametric tests are only run if the data is normally distributed. Chose the desired test for normality when the number of points is greater than 50</td>
</tr>
<tr>
<td>Normality Test Confidence</td>
<td>The confidence limit for the normality test</td>
</tr>
<tr>
<td>Flag Outlier Method</td>
<td>Statistical method for automatically flagging detected outliers. It is recommended to visually verify automatically flagged data.</td>
</tr>
<tr>
<td>Code for low outlier</td>
<td>Define a code which will be used for detected high outliers</td>
</tr>
<tr>
<td>Code for high outlier</td>
<td>Define a code which will be used for detected low outliers</td>
</tr>
<tr>
<td>Show control interval</td>
<td>Show the upper and lower control interval lines</td>
</tr>
<tr>
<td>Probability for control interval</td>
<td>Probability used for each control interval line</td>
</tr>
<tr>
<td>Show Dixon Test Results</td>
<td>Show/hide the results of the Dixon Test in the result table</td>
</tr>
<tr>
<td>Show Discordance test results</td>
<td>Show/hide the results of the Discordance Test in the result table</td>
</tr>
<tr>
<td>Show Rosner test results</td>
<td>Show/hide the results of the Rosner Test in the result table</td>
</tr>
<tr>
<td>Show Walsh test results</td>
<td>Show/hide the results of the Walsh Test in the result table</td>
</tr>
<tr>
<td>Data Symbol</td>
<td>Define settings for the symbol representing data in the time series plot</td>
</tr>
<tr>
<td>Time axis start</td>
<td>Start of x-axis on time series plot</td>
</tr>
<tr>
<td>Time axis end</td>
<td>End of x-axis on time series plot</td>
</tr>
<tr>
<td>Show labels</td>
<td>Define a field in the analysis table to label the plotted data or select none to show no labels.</td>
</tr>
<tr>
<td>Duplicate Samples Symbol</td>
<td>Select the symbol shown to represent duplicate samples</td>
</tr>
</tbody>
</table>

**Results**

Once you have specified the stations and parameters as well as configuring the options, you can run the outlier tests. To run the outlier tests, click the [Run] button located along the bottom of the Outlier Test dialog.
Depending on how many parameters and stations are included in the test, this may take a few minutes to complete. The results will display in the Results tab.

The first 9 rows of the results table display a summary of the input options used for the outlier test. These options are defined under the Options tab. The rows below contain the results of the outlier tests. In the first section, it contains the station and parameter as well as the checks for data completeness. Following this section are the various tests depending on whether they are selected in the output options. The complete set of tests include:
- Dixon's Extreme Value Test
- Discordance Test
- Rosner's Test
- Walsh's Test

A description of these tests together with directives for the calculations can be found in the USEPA report QA/G-9> Guidance for Data Quality Assessment.

If you would like to check the statistical test results, double click the respective row and you will be directed to the Station & Parameter tab, where the station and parameter are automatically selected for you. Here you can select Outlier Results from the Show combo box to view the statistical test results.

### Creating Plots

Outlier test plots can be quickly generated for each station and parameter combination in the results tab. The procedure for creating plots for outlier tests is similar to creating plots for trend analysis tests. For more information, please refer to “Creating Plots”.

### Saving the Results

To save the outlier test results, select the Export button, located at the bottom of the dialog box. You may choose from three file formats. For more information on the available options, please refer to "Saving the Results".

### 5.10 Sample Summary

The Sample Summary report is formatted differently from the other reports described up to this point. This report was designed using the Report Designer; as such, you have the option of modifying the appearance of this report, including the layout, available fields, and printing
template. For more details on how to modify this report template, please see the Report Designer section at the end of this chapter.

The Sample Summary report provides a general overview of a single sample including major ions, hydrochemical facies (e.g. Na-Cl), calculated hardness, ion balance, ion ratios, etc. The parameter values are read directly from the Sample Details window for each sample; this report shows both measured and calculated values.

When you select the Reports from the main menu and then Sample Summary, the following Sample Summary report window will appear:

The report window for user-defined reports (as shown in the figure above) has a few more options available at the top and bottom of the report window:

The Scroll arrows are only available when you have a report that contains multiple pages. The page count shows the current page number, out of the total number of pages available.

The Zoom (magnifying) button allows you to change the zoom size of the window. When you press the down arrow beside the magnifying glass, you will see several window size options. Simply choose the desired zoom size and the preview window should be automatically refreshed.
The Print button sends the reports for all selected samples to the printer.

The Show fields option is only available if the Report is linked to a printing template (done using the Report Designer). To enable this option, place a check mark in this box. You will then see the following dialogue appear in the middle of your display, to the left of the preview window:

In these fields, you can enter the appropriate descriptive information that should appear in the template. As the information is entered, the report preview window should be automatically updated.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Project Description........</td>
</tr>
<tr>
<td>DATE</td>
<td>Report Date.................</td>
</tr>
<tr>
<td>CLIENT</td>
<td>Client Info..................</td>
</tr>
<tr>
<td>PROJECT NO</td>
<td>Project Number Info........</td>
</tr>
</tbody>
</table>

The Scroll arrows on the bottom of the report window are only available when only one sample is selected. They allow you to scroll through the entire dataset.

NOTE: You may generate single-page and multi-page reports. Selecting multiple samples and generating a Sample Summary report will generate an individual report for each selected sample, allowing you to scroll through them using the scroll buttons at the TOP of the report window. Printing the report at this stage will print a report for ALL selected samples. Alternately, if you generate the Sample Summary report while only one sample is selected, the report will be created for that sample and you will be able to scroll through all samples in the project using the green scroll buttons at the BOTTOM of the report window. Printing the report will produce a printout of this sample ONLY.

Clicking the [Close] button closes the report. This report will be edited in Report Designer.
NOTE: When you save user-defined reports, the report template information will not be saved; only the report contents are saved to a file.

5.11 Report Designer

As mentioned earlier in this chapter, AquaChem allows you to create two types of reports:
- The pre-defined (hardwired) reports, and
- The user-defined reports

The hardwired reports cannot be modified, nor can their layout be changed. These reports include: Compare Sample, Mix Samples, Water Quality Standards, Reliability Check, Compare Duplicates, Rock Source Deduction, Summary Statistics, and Correlation Matrix.

The user-defined reports (eg. Sample Summary) can be modified using the Report Designer.

Using the Report Designer you may design and customize up to 10 new reports for your own project needs. The report may include any combination of database parameters and function (calculation) results. Once a new report has been created, it can be selected from the Reports menu, below the Isotopes report.

General Features
When you select Report Designer from the Reports menu, the following dialogue will appear. The Report Designer dialogue is separated into three tabs: Reports, Edit, and Preview.
Reports
Provides a list of the reports available in the current database template, and general information on each report (Description, Selected Printing template, report size, and selected font).

Edit
Provides options for designing the report layout.

Preview
This tab provides you with a preview of the selected report.
You will also find the following buttons in the Report Designer dialogue:

- The up-arrow button allows you to change the order of the selected reports upwards as they appear in the Reports menu (in the main menu).
- The down-arrow button allows you to change the order of the selected reports downwards as they appear in the Reports menu (in the main menu).
- The Duplicate button clones the selected report. This allows you to quickly modify an existing report, without having to create a new one from scratch.
- The Add button creates a new report.
- The Delete button deletes the selected report.

The [Save] button at the bottom of the dialogue saves the current report information.

The [Close] button closes the Report Designer dialogue.
5.11.2 Designing a New Report

Before customizing a report you should create a spreadsheet-style layout of this report using a program such as Excel. Decide what fields you want to use, their placement, and how wide the cells need to be. This will speed-up the process when using the Report Designer in AquaChem. Below is the layout that will be used for this simple example report.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>General Report</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Sample ID</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Sampling Date</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Location</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Major Ions</td>
<td>mg/L</td>
<td>mg/L</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Ca</td>
<td>CL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Mg</td>
<td>SO4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Na</td>
<td>HCO3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Sum Anions</td>
<td>Sum Cations</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Ion Balance</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Ratio</td>
<td>mg/L</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>NA/CL</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To create a new report, follow the steps as described below.
If you have not already done so, load the Report Designer from the Reports menu. Ensure you are viewing the Reports tab (the first tab).
Select the button to create a new report. A new line will be added below the Isotopes Report, with the name: #New Report.

Double Click #NewReport and enter a name for this new report.

- type: Example
- Select Enter (on your keyboard)
- In the lower half of this dialogue:
  - type: An Example Report (in the Description field)
  - Select ‘none’ for the Template
  - type: 20 (the Number of Rows for this report)
  - type: 5 (the Number of Columns for this report)
  - Select button to change the Default Font for this report
  - Select Times New Roman / Regular / 10 font size
  - Select [OK]
  - Select [Save] (in the lower right corner of the dialogue) to save this report.

You can now proceed to add fields to this report.

Select Edit tab (from the top of the dialogue).
This will present you with a blank grid (spreadsheet), containing 20 rows and 5 columns as shown below.
You will see that the rows are numbered and the columns are lettered (similar to MSEexcel) to allow you to quickly locate cell locations in the grid. At this point you may begin to add values to the cells. You may fill cells with text, database parameters, or with a function (calculation).

Double-click on the cell in the upper-left corner (Cell A1) and the Cell dialogue (as shown below) will appear:
This dialogue allows you to control the contents of the selected cell. Cell contents must be assigned one cell at a time.
Below are the options available for each cell:

**Type**
Click on the button and you may choose from the following cell types:
- Text: Enter the desired text for the cell
- Sample Description: choose from a list of Sample Description parameters
- Station Description: choose from a list of Station Description parameters
- Measured/Modeled Value: choose from a list of Measured or Modeled parameter values.
- Ratio: choose two parameters to show as a ratio
- Function Value: choose from a list of available calculations
- Range Name: select from a list of available Ranges
- Thermometers: select from a list of Geothermometers

**Span next**
This option is useful for headings and titles, where the text may not fit into one cell. If the cell to the right of the selected cell is empty, you may span several cells into one. Simply enter a cell number in this field (ex. Span 2 cells).

**Alignment**
Choose from the following justification options:
- Left
- Center
- Right
The three fields described above are common to all data types listed. Below, all data types are listed along with the descriptions of the other fields that go with them.

**Text**
Enter the text you wish to appear in this cell. Used for captions that do not change (e.g. "Station ID")

**Sample Description**
Sample Parameter - Use the combo box to select a sample parameter. The value of this cell will change depending on what sample is loaded into the report.

**Station Description**
Station Parameter - Use the combo box to select a station parameter. The value of this cell will change as you move between samples that are assigned to different stations.

**Measured/Modeled Parameter**
- Parameter - Use the combo box to select a measured or a modeled parameter. The cell will reflect the value of this parameter for the sample that is loaded into the report.
- Unit - Use the combo box to select a unit for the parameter (becomes inactive if the chosen parameter is unitless - e.g. pH).
- Format - Use the combo box to select the numeric format for the parameter value.

**Ratio**
- Numerator - Use the combo box to select the parameter to serve as the numerator of the ratio.
- Denominator - Use the combo box to select the parameter to serve as the denominator of the ratio.
- Units - Use the combo box to select the units for the parameters used as the numerator and the denominator. The ratio may change depending on the chosen units (e.g. the ratio of the parameter values in g/l will be different from the ratio of the parameter values in mol/l)
- Format - Use the combo box to select the numeric format for the ratio.

**Function Value**
- Function - Use the combo box to select a function, the result of which will be displayed in the cell. The functions are defined in the Calculations tab of the Database.
- Unit - Use the combo box to select the unit for the parameters used in the function. The result of the calculations may be different depending on the units used.
- Format - Use the combo box to select the format for the result value.

**Range Name**
Parameter - The combo box lists the parameters that have the range(s) defined. The cell will display the name of the range that contains the value of the specified parameter for the current sample (e.g. Natural aquifer range).

**Thermometer**
Thermometer - Use the combo box to select the thermometer function. The thermometer calculations are defined in the thermometers tab of the Database.

**Now lets continue to "Design a New Report"**
You will now enter a Report Title for cell A1: Select Text (from the list beside the Type field)
type: 1 in the Span next ... cells field
Select Left justify, for the cell alignment
type: General Report (beside the Text field)
Select [OK]

You should now see an entry under the Edit tab for Cell A1. You may switch to the Preview tab to see a preview of how the report will appear.
As you can see, the words take up two lines in the cell. To have the words fit on one line you
can span this cell into the adjacent one.

Switch back to the Edit tab
Double-click on the cell A1 to produce the Cell dialogue
type: 2 in the Span the next … cells

Switch to the Preview tab again. Now it should look similar the picture below (use the
magnifying glass menu to adjust the view size):
The text colors of the cells in the Edit dialogue are representative of the cell types. The following summary provides a list of what each cell color indicates of the cell type:

- **Black**: Text cells
- **Green**: Sample and Station Description parameters
- **Blue**: Measured and Modeled parameters, and Parameter Ratios
- **Grey**: Function (Calculated) values, Thermometers, and Ranges
- **Red**: Guideline Levels

If you want to change the column widths, simply drag the column to the desired width in the spreadsheet. Alternatively, you can select the column then right-click the highlighted column and select Set Column Width.

Enter the precise value of the column width in the pop-up dialogue and press [OK]. Then load the Preview window to see the refreshed report.

The font for the report may be customized in two places:

In the Reports tab, the Default Font for the entire report is defined; all items on the report will use this font, size and style.

A default font may also be assigned on a per row basis. To do so, select an entire row and right-mouse click on it and select Font. Select the desired Font from the dialogue that appears, and click [OK]. This font will be applied to an entire row. This is practical for assigning fonts to column headings in the report.

You can also insert and delete any selected row, column, or cell by highlighting the desired element, right-clicking on it, and choosing the appropriate action.

You will now proceed to define the remaining cells in the report, as per the pre-designed layout:

Double Click Cell A3
Select Text from Type field
type: Sample ID
Select[OK]

Double Click Cell A4
Select Text from Type field
type: Sampling Date
Select [OK]

Double Click Cell A5
Select Text from Type field
type: Location
Select [OK]

Using the same procedure, fill in the remaining text fields as per the layout above, in the appropriate cell locations:

<table>
<thead>
<tr>
<th>Cell</th>
<th>Text Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>A7</td>
<td>Major Ions</td>
</tr>
<tr>
<td>A9</td>
<td>Ca</td>
</tr>
<tr>
<td>A10</td>
<td>Mg</td>
</tr>
<tr>
<td>A11</td>
<td>Na</td>
</tr>
<tr>
<td>A13</td>
<td>Sum Anions</td>
</tr>
<tr>
<td>A14</td>
<td>Ion Balance</td>
</tr>
<tr>
<td>A16</td>
<td>Ratio</td>
</tr>
<tr>
<td>A18</td>
<td>Na/Cl</td>
</tr>
<tr>
<td>B8</td>
<td>mg/L</td>
</tr>
<tr>
<td>B16</td>
<td>mg/L</td>
</tr>
<tr>
<td>C9</td>
<td>Cl</td>
</tr>
<tr>
<td>C10</td>
<td>SO4</td>
</tr>
<tr>
<td>C11</td>
<td>HCO3</td>
</tr>
<tr>
<td>C13</td>
<td>Sum Cations</td>
</tr>
<tr>
<td>D8</td>
<td>mg/L</td>
</tr>
</tbody>
</table>

Click on the Preview tab to see if any caption is too big for its cell. Go back to the Edit tab and if there were such captions, resize the column they are in so that they only take up one line. Do not worry if some parameter names (such as "SAMPLE_DATE") take up a lot of space - gauge the length of the value.

Once you are finished you should save the changes that have been made so far.

Select [Save] in the lower-right corner of the Report Designer dialogue, to save the report design changes up to this point.

You can now add in the parameter value cells and function values.

Double Click Cell B3
Select Sample Description from the combo box beside cell Type
Select SAMPLEID from the combo box beside Sample Parameter field
Select [OK]

Double Click Cell B4
Select Sample Description from the combo box beside cell Type
Select SAMPLE_DATE from the combo box beside Sample Parameter field
Select [OK]

Double Click Cell B5
Select Station Description from the combo box beside cell Type
Select LOCATION from the combo box beside Station Parameter
Select [OK]
Notice the color of the cells under the Edit tab in the Report Designer dialogue for these new cells; green cells indicate that these cells contain Station/Sample Description parameters.

Double Click Cell B9
Select Measured/Modeled Value from the combo box beside cell Type
Select Ca from the combo box beside Parameter
Select mg/l from the Unit field
Select [OK]

Double Click Cell B10
Select Measured Modeled Value from the combo box beside cell Type
Select Mg from the combo box beside Parameter
Select mg/l from the Unit field
Select [OK]

Double Click Cell B11
Select Measured Modeled Value from the combo box beside cell Type
Select Na from the combo box beside Parameter
Select mg/l from the Unit field
Select [OK]

Notice the color of the cells in the Edit dialogue; blue cells indicate that these cells contain Measured values.
Repeat this step for the remaining ions by choosing the appropriate parameter and placing this in the cell immediately beside the text cell for that parameter.

<table>
<thead>
<tr>
<th>Cell</th>
<th>Measured Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>D9</td>
<td>Cl</td>
</tr>
<tr>
<td>D10</td>
<td>SO4</td>
</tr>
<tr>
<td>D11</td>
<td>HCO3</td>
</tr>
</tbody>
</table>

Once you have finished this step, your display should be similar to the one shown below:
Select [Save] in the lower-right corner of the Report Designer dialogue to save the report design changes up to this point.
You will now add function values for the Sum Anions, Sum Cations, and Ion Balance.

Double Click Cell B13
Select Function Value from the combo box beside cell Type
Select Left Justify from the Alignment field
Select Sum of Anions from the combo box beside Function
Select [OK]

Double Click Cell D13
Select Function Value from the combo box beside cell Type
Select Left Justify from the Alignment field
Select Sum of Cations from the combo box beside Function
Select [OK]

Double Click Cell B14
Select Function Value from the combo box beside cell Type
Select Left Justify from the Alignment field
Select E. N. (Electroneutrality) from the combo box beside Function
Select [OK]
Notice the color of the cells in the Edit dialogue; grey cells indicate that these cells contain Function (Calculated) Values. Finally, you will add a Ratio to Cell B18 showing a parameter ratio of Na / Cl.

Double Click Cell B18
Select Select Ratio, from the combo box beside cell Type
Select Na for the first parameter
Select Cl for the second (right) parameter
Select mg/l for the units
Select [OK]

Notice the color of the cells in the Edit dialogue; blue cells indicate that this cell contains a Parameter Ratio.
Select [Save] in the lower-right corner of the report designer dialogue to save all changes to this report.
Once you have designed the report, click on the Preview tab to see a page preview.
This concludes the steps required to design a report. Feel free to add new cell values, functions, parameters, etc. in order to see the full capabilities of the Report Designer.

Once you are finished in the Report Designer, press [Close] to return to the main window of AquaChem. The newly created "Example Report" will now be available under Reports in the AquaChem main menu.
6 **Tools**

The Tools menu provides access to the AquaChem data analysis tools, including Converters, Calculators, LookUp Tables, and access to the PHREEQC modeling interface.

The following Calculators and Converters are available:
- Aggregate Samples
- AquaChem Function
- Calculate facies
- Corrosion & Scaling
- Decay Calculator
- Find Missing Major Ion
- Formula Weight Calculator
- Oxygen Solubility
- Volume Concentration Converter
- Retardation
- Special Conversions
- Species Converter
- Unit Calculator
- UTM Conversion

The following QA/QC checks are available:
- Compare Duplicates
- Control Intervals
- Highlight Duplicates
- Highlight Outliers
- Holding Times
- Manage Duplicates
- Method Detection Limit
- Reliability Check
- Total/Dissolved Comparison

The following LookUp Tables are available:
- Degradation Rates
- PHREEQC Phases
- Periodic Table
- Water Standards
- Time Series
- Browse Database

Finally, under the Modeling options you may:
- Calculate Saturation Indices and Activities
- Calculate pH
- Calculate Eh
- Alk > HCO3, CO3
- Equilibrate with Minerals
- Run a PHREEQC (Basic) Simulation
- Run a PHREEQC (Advanced) Simulation
6.1 Calculators and Converters

AquaChem Function
This tool allows you to quickly calculate any of the AquaChem built-in functions. Calculations can be performed without having to add/remove individual functions to the options of the Sample Details window.

To use this tool, first select a sample from your Active Samples list. Then select Calculators > AquaChem Function from the Tools menu, and a dialogue will appear as shown to the right side. In this dialogue, you can see a Description of the function and the function units. By clicking on the down-arrow key, choose a function and then Format, and you will see the resulting value displayed in the Result field.

Use the arrows to move through the samples.

The calculations can be customized in the Calculations section of the Preferences options dialogue under the File menu. In here, you may select which calculations should appear in the AquaChem functions (calculations) lists.

Decay Calculator
The Decay Calculator allows you to calculate the concentration of a contaminant at a particular point in time following a specified rate of decay, or the time to reach a specified concentration based, again, on that decay rate. AquaChem also allows you to calculate the decay rate of a chemical based on two or more concentration-time pairs. Degradation rate of a contaminant is usually given as a "half-life", which is the time required for the substance to be reduced to half of the initial mass. This tool can be applied only to organic chemical parameters in your database. The formula for the rate of decay is as follows:

\[
\frac{C_0}{C_1} = e^{-kt}
\]

Where,

- \( t \) = time
- \( C_0 \) = initial concentration
- \( C_1 \) = concentration after time \( t \)

When you access this tool, the following Decay Calculator dialogue will appear. The components of this dialogue are described below.
Sample
At the top of this dialogue under the Sample field, click on button and then double-click in Pick a sample list to select a sample for which you would like to run a degradation analysis. Selecting a sample from the sample list copies the concentration value for the current parameter to the initial concentration field C(t=0).

Parameter
In the Parameter field, click on the button and select the organic parameter you would like to analyze (please ensure that your sample contains a value for this organic parameter). Note that the parameter list contains all database parameters, which have a corresponding record in the Degradation Rates table (available under Tools > LookUp Tables).

Half-Life
After selecting a parameter, the Half-Life field will be automatically filled in with the appropriate value. The combo box to the right of the Half-Life field provides options for the Half-Life environments (Soil, Air, Groundwater, and Surface water) for which degradation rates are specified in the database. If all rates are known for these environments the list will contain a high, low, and average half-life values for each environment. Effects such as dilution, transport or adsorption etc. are not taken into account with this tool.

AquaChem includes values for 335 organic chemicals. These are taken from the following Reference:
This tool may also be used as a simple degradation calculator, without selecting samples or parameters. Simply enter a Half-life value manually, choose your Problem Type, enter an initial concentration, target concentration or time period and press Calculate. AquaChem also allows you to estimate a chemical's half-life based on two or more time-concentration pairs.

Time Unit
Half-life values in the AquaChem database are saved as hours, however, you may convert these to days or years by selecting the appropriate Time Unit from the combo box.

Concentration Unit
Allows you to select the concentration units that will be used in the half-life calculations.

Problem Type
In the next line, you must specify the Problem Type for the degradation calculator. The Decay Calculator has three problem types available:

Type 1: Time to reach a specified concentration
Type 2: Concentration after a specified amount of time
Type 3: Estimate half life from given concentration values

NOTE: If problem type 1 is selected, and the current contaminant has an assigned guideline level in your AquaChem database, a combo box with available guideline levels will appear to the right of the target concentration field. You have the option to choose the desired guideline level, and the C1 value will be automatically filled in for you.

A summary of the required data input is as follows:

Problem Type 1
In Problem Type 1 you can determine the time required for a contaminant to decay to a specified concentration.
C(t=0): initial concentration
C1: target concentration

Press [Calculate] and the t(C1) (time to reach target concentration) will be calculated.

Problem Type 2
In Problem Type 2 you can determine the concentration after a specified amount of time.
C(t=0): initial concentration
t1: target time

Press [Calculate] and the C(t1) (concentration after a specified time) will be calculated. This calculator accounts only for degradation effect, using the following equation:

C(t) = C1*e^{-kt}

where,
k = residence time

Problem Type 3
In Problem Type 3 you can estimate half life from given concentration values.
Set the Parameter to "Custom"
Time: time of sampling
Conc.: concentration at sample time
Click [Calculate] to calculate the half-life as the slope of the regression line through the specified points. For every specified point, the estimated concentration by means of the linear regression line is displayed to verify the quality of the calculated values. At the left hand side of the screen, the estimated initial concentration, half-life, and the regression coefficient are displayed.
You can edit the concentration-time pairs at any time by double-clicking in the cell that contains the value you wish to edit. To remove the concentration-time pair highlight any cell in that pair and click the button.

Find Missing Major Ion
If information for one of the major anions or cations (Na, Ca, Mg, Cl, HCO₃, SO₄) is missing from a sample, you can use this tool to estimate the concentration of the missing major ion. The concentration of the missing ion is calculated using the assumption that the total concentration of cations in meq/l is equal to the sum of anions. The entire difference of charges is assigned to the missing parameter.

NOTE: This tool is only available when you have a Sample Details window open and active.

Open a sample, and select Tools > Calculators > Find Missing Major Ion > Na (for the example shown below).

After you have selected the desired missing parameter, AquaChem will calculate the missing value and display a confirmation message as shown on the right. Click [Yes] to accept the calculated value, or click [No] to reject the calculated value.
This tool does not work if more than one of the major cations or anions is missing in the analysis. In order to calculate the missing values for one of the major ions, each of the remaining major ions must be present.
If there is an over-abundance of the missing ion’s charge (e.g. Cl concentration is missing, the sample has already an anion excess) the following message will be displayed:

© 2017 Waterloo Hydrogeologic.
Formula Weight Calculator
This tool allows you to quickly calculate formula weights for a user-specified chemical formula.

When you access this tool, the Calculate Formula Weight dialogue will appear. Simply enter the desired formula, and press [Calculate].

Note that the Formula is case sensitive; therefore, ensure that you enter two-letter elements such as Silicon as Si and not SI.

In addition, only one level of parentheses is taken into account. So, in case of a formula with two levels of parenthesis such as ((XY2)3)3AC, it will not be calculated correctly. In the standard display, simply the weight of the specified formula is calculated.

When checking the Extended checkbox, more options become available to convert different types of concentrations. This is convenient for converting PHREEQC results, expressed as mol/kg into mg/l. To do so, first enter the formula of the chemical. Then copy the PHREEQC molality value into the respective field, check the radio button and press the calculate button. The radio button tells the system that this field has been entered manually, and that all other concentration fields should be recalculated based on this value, the formula weight of the chemical, the density of the solution and the activity coefficient. This option may also be used to convert mg/L concentrations into ppm, provided that the density of the solution is known.

Aggregate Samples
The aggregate samples tool allows you to create a new sample by aggregating existing samples. Parameters can be aggregated using various aggregation methods, including Minimum, Maximum, Median, Geometric Mean, Quantile and Custom.

When this option is selected from Tools > Calculators > Aggregate Samples, the Aggregate Samples dialog will appear on your screen.
The Aggregate Samples dialog consists of two tabs: Aggregation and Options. Under the Aggregation tab, each sample currently displayed in the Active Samples list is displayed in a table, along with the values for each analyzed parameter. The very last row in the table contains the aggregation value for each parameter.

The aggregation method can be selected from the Aggregation combobox, located directly above the table. When you select a new aggregation method, be sure to also select the [Refresh] button to repopulate the table with the new aggregation values.

The Options tab provides options for configuring a customized aggregation method. This tab is only applicable when the Custom option is selected under the Aggregation tab. The custom aggregation method allows you to mix two aggregation types. For example, average for major ions and geometric mean for trace methods. Choose the desired methods from the Method 1 and Method 2 combo boxes, and then associate each parameter with a aggregation method in the table below.

Once the desired aggregation method is selected, click the [Save] button, and chose whether to create a new sample, or to overwrite an existing sample with the aggregated values. Please note that overwriting an existing sample with aggregated values cannot be undone.

**Volume Concentration Converter**

This converter allows you to quickly convert volume concentrations into mass concentrations for gas species, which are frequently reported in either of the two units.
When you access this tool, the Volume Concentration Converter dialogue will appear. Simply choose the observed ambient Temperature (0, 20, or 25°C), enter a Formula for an organic chemical, and enter the concentration. You may enter the concentration in either the ppmV or the mg/m3 field. Press [Calculate] and the missing concentration will be calculated.

In the vapor phase, one ppm by volume (ppmV) is on a volume per volume bases. For example, one ppmV of Benzene in the air means one part volume of benzene in one million parts volume of air space. To convert the ppmV into mass concentration units (mg/m3), the following formula can be used:

\[ 1 \text{ ppmV} = \frac{\text{FMW}}{K} \]

where,
\[ \text{FMW} = \text{Formula Weight (g/mol)} \]
\[ K = \text{a temperature dependant coefficient (molar gas volume).} \]
\[ K = 22.4 \text{ l/mol at 0°C,} \]
\[ K = 24.05 \text{ l/mol at 20°C, and} \]
\[ K = 24.5 \text{ l/mol at 25°C.} \]

Example:
To convert 1 ppmV Benzene to mg/m3 at 20°C:
Mass Benzene mg/m3 = 1 ppmV Benzene * (78 g/mol) / (24.05 l/mol)
= 3.24 g/L
= 3.24 mg/m3

**NOTE:** The formula is case sensitive, therefore, ensure that you enter two-letter elements such as Silicon as Si and not SI. In addition, only one level of parentheses is taken into account (i.e. a formula such as ((XY2)3)3AC will not be calculated correctly).

**Special Conversions**
This tool provides conversions for numerous non-linear geochemical calculations. You may convert values from one measurement unit to another for measurement units such as pe - Eh, Alkalinity - HCO₃, and Conductivity (us) - Resistivity (Ohm/cm).

When you access this tool, the Special Conversions dialogue will appear. Click on the button and choose a category from the list, enter the start value, and any other required variables (temperature, density), and press to convert the value.

The available conversion categories include:

Conductivity  Resistivity
where,
Cond = 1/(Resistivity/1E+6)

Electrical conductivity at a different temperature: Cond(T1) → Cond(T2).
It requires you to enter a conversion temperature. The conductivity is always normalized to a specific temperature which is dependant on the probe. If you want to enter conductivity data to your database, and the temperature for the probe is different (e.g. 25°C) from the one in the database (20°C) then the data has to be converted before being adding to the database. This calculation is done in two steps:
First, calculate the conductivity at standard temperature,
Second, calculate the conductivity at the specified temperature (Temp2).

Examples:
Conductivity
Cond(25) = Cond(Temp1) / (1 + 0.0198 * (Temp1 - 25))
Cond(Temp2) = Cond(25) * (1 + 0.0198 * (Temp2 - 25))

Redox potential
pe → Eh
It requires you to enter an observation temperature.
pe(Eh): pe = Eh * F / 2.303 / R / T
Eh(pe): Eh = pe * 2.303 * RT / F
where,
R = 8.314 (Gas constant)
F = 96485 (Faraday constant)

Alkalinity calculations
Convert between:
mg/L HCO3,
meq/L,
Alkalinity (f*), where * means French degrees,
Alkalinity (g*), where * means German degrees
mg/L CaCO3.

Other conversions
ppm → mg/L: Requires you to enter a density.
mg/L = ppm / Density
mg/L → ppm: Requires you to enter a density
ppm = mg/L * Density

Species Converter
This tool allows you to convert any aqueous species into a different form.
When you access this tool, the Species Converter dialogue will appear as shown below:

- Select a Master Element (Parameter) in which you are interested (common examples include nitrogen, phosphorus, silica, etc.).
- Type in a Source Species.
- Type in a Target Species.
- Enter a concentration of the source species in the lower left corner of the dialogue.
- The Conversion Factor is calculated based on the formula weights of the two species: the Target species divided by the Source Species.
- Press Calculate and the concentration for the target species will be calculated.

This tool is practical for expressing a measured amount of a parameter as different aqueous species when expressed in mg/L. For example, you may receive your Silica results as mg/L Si, and your database requires mg/L SiO2 or H2SiO3. For this you need to calculate the amount of SiO2 that holds the same amount of Silica as given in the lab analysis. Nitrogen species such as nitrate and nitrite may are commonly expressed as N or as their actual formula (NO3 or NO3) and constitute another good example where the above calculation may be useful.

The data entered in the Species Converter dialogue (shown above) depicts an example for converting Si species.

**NOTE:** The Formula is case sensitive; therefore, ensure that you enter two-letter elements such as Silicon as Si and not SI. In addition, only one level of brackets is taken into account (i.e. a formula such as ((XY2)3)3AC will not be calculated correctly).

**Unit Calculator**

This tool performs basic unit conversions for length, time, volume, density, mass, etc. When you access this tool, the Unit Calculator dialogue will appear as shown below.
Tools

Click on the button and select the desired category from the combo box at the top of the dialogue, enter the value and units in the fields below, and the new value will be automatically calculated.

In addition, you can modify the existing conversion factors, or create new ones. Press the Options button, and the following dialogue will be loaded.

The following dialogue allows you to chose the algorithm to be used in the calculation and the field where the calculated value will be placed:

Select the Unit Type from the combo list (at the top), or press the button to load a list of available unit types, and options to create a new unit type. The list below will now show all conversions available for this unit type, and the conversion factor associated with each. You may enter or edit all factors, or create new conversions using the button. Then enter the appropriate conversion type and factor for this new conversion.

Once you are finished, press Save to save any changes you made to the conversions. Press Close to return to the Unit Calculator tool.

Calculate Facies

This command calculates the Watertype (water facies) expression for all highlighted samples. The following dialogue allows you to chose the algorithm to be used in the calculation and the field where the calculated value will be placed:
The Mode lets the user select whether he wants to use the long facies name, which is based on the ions that contribute more than 10% (e.g. Ca-Mg-Cl-SO4), or the short mode, listing just the most frequent anion and cation.

The Fill calculated watertypes into field combo box allows you to specify the target field where the value should be stored. Every sample must contain a field which contains the watertype and which is automatically recalculated if any changes to chemical concentrations occur, however the user may specify a second field, holding the water type in short notation. This can be useful when creating symbols based on watertypes. To implement this, use the Calculate facies command and select the Short version in the Mode combo box. Then, specify a field other than the official water facies field (where you want to keep the more precise long notation). Next, go to Symbols and Lines dialogue and create a new symbol group called Water type. Use the automatic function based on the short watertype field to create a new symbol for every distinct value of water facies (Ca-HCO3, Ca-SO4, Na-Cl et.c)

In most cases the procedure of calculating the long water facies is not necessary since the facies expression is calculated automatically when importing data or when entering or modifying data in the Sample Details window.

However, in some cases the chemical composition of a sample might change without having this change reflected by the water facies. For example, the facies expression is not updated for all samples entered or modified in the Table View. Additionally there are a few commands allowing to change the chemistry of a sample without passing by the sample screen, such as using the Replace/Multiply function, marking extreme values as outliers using the Outlier Tests, or calculating the HCO3 and CO3 concentrations from the measured alkalinity. For these cases, the water facies may be synchronized manually with the chemical composition using the Calculate facies command.

Recalculation of the water facies expression may be necessary, after modifying the way for calculating the water facies expression.

**Corrosion & Scaling**

Corrosion and scaling of well equipment count among the most common concerns in water management. Various methods have been developed to predict the tendency of the ground or surface water to precipitate minerals or to corrode metal pipes. The most commonly used method is the Langelier Saturation Index LSI. The Ryznar Stability Index RSI is closely related to the LSI. Both indexes are based on the following parameters: Temperature, pH, TDS, alkalinity and calcium. Various ranges and associated risks of scaling or corrosion have been suggested and AquaChem follows the ranges outlined below in table 1 and 2. Ranges and comments associated with the ranges may be changed in the File>Database>Ranges section.

<table>
<thead>
<tr>
<th>Value</th>
<th>Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 5</td>
<td>Heavy scaling</td>
</tr>
<tr>
<td>5 - 6</td>
<td>Mild scaling</td>
</tr>
<tr>
<td>6 - 7</td>
<td>Little scale or corrosion</td>
</tr>
<tr>
<td>7 - 7.5</td>
<td>Corrosion significant</td>
</tr>
<tr>
<td>7.5 - 9</td>
<td>Heavy Corrosion</td>
</tr>
</tbody>
</table>
Corrosion intolerable

Table 2: Langelier Saturation Index

<table>
<thead>
<tr>
<th>Value</th>
<th>Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;-2</td>
<td>Serious corrosion, CaCO3 dissolution</td>
</tr>
<tr>
<td>-0.5 - -2</td>
<td>Slightly corrosive but non-scale forming</td>
</tr>
<tr>
<td>-0.5 - 0.5</td>
<td>Balanced but pitting corrosion possible</td>
</tr>
<tr>
<td>0.5 - 2</td>
<td>Slightly scale forming and corrosive</td>
</tr>
<tr>
<td>&gt;2</td>
<td>Scale forming but non corrosive</td>
</tr>
</tbody>
</table>

LSI and RSI are empirical methods based on a limited number of parameters and taking into account the precipitation of calcite only. They are useful in that they can be easily calculated and interpreted by means of tables such as table 1 and 2 and cover the most common scaling thread (calcite). However we suggest using the scaling and corrosion calculator only for a preliminary overview and base corrosion and scaling predictions on a PHREEQC simulation. PHREEQC will provide more reliable results in that it is based on a thermodynamic dataset and includes more corrosion/scaling relevant minerals and parameters such as Eh, Mn, Fe, iron hydroxides, etc.

If you want to calculate the corrosion and scaling indexes of a sample in the database, select the sample first, then select Tools>Calculators>Corrosion and Scaling menu command. The calculator will display as shown, and will be initialized with the values for this sample. If you launch the calculator without selecting a sample first, then the screen will open with empty fields which you must fill. When the fields are ready, press the [Calculate] button. You may test how the LSI and RSI react to changes of one or several parameter (e.g. for rising temperature) by changing the field values.

Note that for if the calculator has been initialized from a existing database sample and the Calcite saturation index has been calculated. This value will be displayed at the bottom of the screen, which may help to interpret the RSI and LSI. If there is a major discrepancy between the empirical indices and the modeled saturation index, you should proceed with a PHREEQC simulation on this sample. The PHREEQC Calcite saturation index value reflects the sample stored in the database. The comparison of calcite scaling indices such as Langelier and Ryznar to the PHREEQC saturation indices should only be verified as long as the original input parameters (temperature, alkalinity, calcium etc.) have not been changed. Once these values are modified, the corrosion and scaling indices will be...
re-calculated based on the new input whereas the PHREEQC saturation index will still be based on the initial conditions.

**Oxygen Solubility**

This function allows you to calculate the oxygen solubility of a given sample as a function of elevation and temperature.

It is accessed from the main menu via Tools > Calculators > Oxygen Solubility

Dissolved oxygen saturation values are calculated using the American Society of Civil Engineers’ formula (American Society of Civil Engineering Committee on Sanitary Engineering Research, 1960):

$$DO_{sat} = 14.652 - 0.41022T + 0.00799107T^2 - 0.000077774T^3$$

where $DO_{sat}$ = dissolved oxygen saturation concentration, mg/L

$T$ = water temperature, degrees Celsius

This formula represents saturation values for distilled water at sea level pressure. The dissolved oxygen saturation concentrations generated by the formula must be corrected for elevation above mean sea level due to differences in air pressure, as well as differences caused by air temperature changes. The correction factor is calculated by the Oxygen Solubility Calculator using the following:

$$f = 2116.8 - (0.08 - 0.000115A)E$$


**UTM Conversion**

This function allows you to calculate geographic coordinates from projected (UTM) coordinates, and vice versa, for stations in your database. Geographic and UTM station coordinates are stored in separate columns in the aquachem database and can be included in exported station data, e.g., .KML, .SHP etc.

To use this tool, select Tools > Calculators > UTM Calculator from the main menu. The UTM Conversion dialog will appear on your screen.
Select the desired conversion type from the Mode combo box. If you wish to calculate UTM coordinates from Geographic coordinates, select the Geographic to UTM option. If you wish to calculate Geographic coordinates from UTM coordinates, select the UTM to Lat/Long option.

**Geographic to UTM**
When this option is selected, you must also specify the associated datum of the existing geographic coordinates.

**UTM to Lat/Long**
When this option is selected you must also specify the associated UTM direction and zone of the coordinates.

Click the Calculate button to calculate the coordinates. Please note that any existing coordinates will be overwritten with the new values.

**Retardation**
Retardation factor (Rf) for a particular chemical species is the ratio of solution velocity and species velocity or the ratio between the rate of groundwater movement and the rate of contaminant movement. Rf is a required input for transport modules.
6.2 QA/QC

Reliability Check
This Reliability Check report helps you confirm the validity of the measured sample data.
When you select this report, the following Reliability Check window will appear:

\[
\text{Retardation Factor} = 1 + \left( \frac{\rho_b}{\Theta} \right)(K_d)
\]

Where:
- \(\rho_b\) = dry bulk mass density of the soil, gm/cc
- \(\Theta\) = Porosity
- \(K_d\) = distribution coefficient for the solute with the soil, ml/g
- \(C\) = Concentration of solute
- \(C^*\) = Concentration of solute on solid
This report provides a number of checks which can lend insight as to the reliability of the water sample analysis. If the analysis value passes the test, then a Pass will be displayed in the Result column; if not, then a Fail will be displayed. Each analysis is explained in the table below:

### Available Tests in the Reliability Check Report

<table>
<thead>
<tr>
<th>Test</th>
<th>Attention Value</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Balance ((C-A)/(C+A)\times 100)</td>
<td>&lt;5%</td>
<td>The solution must be electrically neutral or within ±5%: sum of cations = sum of anions.</td>
</tr>
<tr>
<td>TDS: ([\text{Entered-calculated}]/\text{Entered}] \times 100)</td>
<td>&lt;5%</td>
<td>Calculated TDS = sum ions (mg/L) + SiO2 must be similar to measured dry residue.</td>
</tr>
<tr>
<td>TDS: ([\text{Entered-TDS180o calculated}]/\text{Entered}] \times 100)</td>
<td>&lt;5%</td>
<td>Calculated TDS = sum ions (mg/L) + SiO2 - 0.5082 * bicarbonate. Must be similar to measured dry residue at 180°.</td>
</tr>
<tr>
<td>TDS Entered/Conductivity</td>
<td>(0.55 &lt; x &lt; 0.75)</td>
<td>There is a linear relationship between TDS and conductivity within a range of 0.55 to 0.75.</td>
</tr>
<tr>
<td>Conductivity/Sum MEQ Cations</td>
<td>(90 &lt; x &lt; 110)</td>
<td>There is a linear relationship between conductivity and Sum of Cations within a range</td>
</tr>
<tr>
<td>Parameter</td>
<td>Range</td>
<td>Note</td>
</tr>
<tr>
<td>-----------</td>
<td>-------</td>
<td>------</td>
</tr>
<tr>
<td>K+/[Na++ K+] meq/l</td>
<td>&lt;20%</td>
<td>Mg is mainly provided by the dissolution of dolomite resulting in a Ca/Mg ratio of 1:1. However calcium has various additional sources such as the dissolution of gypsum or carbonate.</td>
</tr>
<tr>
<td>Mg++/[Ca++ + Mg++] meq/l</td>
<td>&lt;40%</td>
<td>Most SO4 concentration can be attributed to the dissolution of gypsum. Therefore the Ca/SO4 ratio must be 1:1 or lower, if some Ca is also provided by the dissolution of carbonate.</td>
</tr>
<tr>
<td>Ca++/[Ca+++SO4--)</td>
<td>&gt;50%</td>
<td>Chloride is mainly provided by the dissolution of Halite (NaCl). Therefore the ratio Na/Cl is 1 or higher, if some Sodium is added to the solution by the solution of silicates or by ion exchange.</td>
</tr>
<tr>
<td>Na+/(Na+ +Cl-)</td>
<td>&gt;50%</td>
<td>In a normal groundwater, the saturation index of rock forming and reactive minerals may be assumed to be close to 0 (saturation) or below. Any supersaturation, indicated by SI&gt;0, will be rapidly compensated by the precipitation of the respective mineral. A significant calculated supersaturation of calcite normally indicates an error in pH measurement or postsampling addition of calcium due to dissolution of carbonate particles in the sampling vessel.</td>
</tr>
<tr>
<td>SI Calcite</td>
<td>&lt;0.2</td>
<td>The solubility of a chemical parameter may be defined in the database dialogue. If a measured result exceeds the theoretical solubility, the respective concentration should be checked</td>
</tr>
<tr>
<td>Test for results &gt; solubility</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Test for results outside natural occurrence range</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** Some attention values are displayed as "acceptable ranges". This means that the Analysis value must be within this range. The analysis (calculated) values can be positive or negative. If the analysis values are outside this range (either positively or negatively) then the value will not "pass" this check, and the report will display a "Fail", indicating that the sample did not pass this analysis check.

If the calculated values are not within the attention values (i.e. the Result is Fail), then this does not necessarily signify an error; it does mean however that there should be an explanation for the value. For example, if Na/Cl< 1 then the explanation could be that some Na has been removed from the solution by Na > Ca exchange; this should be confirmed by a suitable aquifer geology (exchange friendly minerals such as Ca-rich clay). A ratio of Ca/SO4...
< 1 can be explained by the dissolution of ferrous minerals such as pyrite. This effect is often observed in mine tailings. However, normal groundwater samples should fulfill all the criteria mentioned above.

The scroll arrows in the lower right corner of the **Reliability Check** window can be used to produce a report for other samples in your database.

For more details please see the reference below:

**Compare Duplicates**
Field duplicates are a common quality control method for water quality data. A field duplicate is a duplicate sample, collected by the same team or by another sampler or team at the same place at the same time. It is used to estimate sampling and laboratory analysis precision.

In order to compare duplicates, duplicate samples must have an assigned duplicate code using the Manage Duplicates utility ("Manage Duplicates").

Once duplicates have been assigned duplicate codes they can be selected by selecting **Tools / QAQC / Highlight Duplicates**.

Then to compare duplicates, select **Tools > QAQC > Compare Duplicates**, from the main menu. The following dialog will appear on your screen.
Selecting Parameters

To specify which parameters to include in the comparison, select the bottom button. A list of parameters will appear displaying all measured parameters. Select the desired parameters for comparison and then click the [Select] button.

Several options for the comparison are available by selecting the Options tab.
In the Duplicates dialog, select the [OK] button to generate the report. A report will appear on your screen with a sample comparison, including the relative percent difference value.
Manage Duplicates
The Manage Duplicates utility allows you to find duplicate samples and assign duplicate codes:

Choose one or more parameters from the list of available parameters by placing a check mark in the appropriate box(es). Only Sample Description and Station Description parameters are available. To select all parameters, place a checkmark beside Match all Parameters. Then click the [Find] button.

AquaChem will then run a query on the samples in the Active Samples list and locate all samples for which the values of the set of specified parameters are identical. Common parameters for this utility are sampleID and date.

The results will then be shown in the lower half of this dialogue.

Assigning Duplicate Codes
In order to compare duplicate samples using relative percent difference (RPD) analysis and reporting (see "Compare Duplicates"), each duplicate sample must be assigned a duplicate code. The duplicate code is stored in the Duplicate_ID field for each sample.
**Note:** Samples that have not been assigned a duplicate code will not be available for sample comparison using RPD analysis.

To assign a duplicate code to samples:
- Select the desired samples from the Duplicate Samples list (located at the bottom of the Find Duplicates dialog.)
- Select the Assign Selected button to assign the duplicate code to each selected samples.

To assign a duplicate code to all samples in the duplicate samples list, select the Assign All button.

The primary sample to which duplicates will be compared will be marked with a P (Primary) in the Dup Type field.

**Highlight Nondetects**
Selecting this option will load the following dialogue:

![Highlight Nondetects](image1)

Selecting the appropriate parameter and clicking [OK] will highlight all samples that have non-detect value for that parameter.

**Highlight Outliers**
Selecting this option will load the following dialogue:

![Highlight Outliers](image2)

Selecting the appropriate parameter and clicking [OK] will highlight all samples that have that parameter marked as an outlier.

**Highlight Duplicates**
Selecting this option will highlight all samples that have a Duplicate_ID value entered. The Duplicate_ID is entered in the top portion of the Sample Details window.

### 6.3 LookUp Tables
The Look-Up Tables menu displays the available AquaChem tables containing useful hydrochemical information.

The following tables are used by AquaChem for internal calculations, and can not be modified or removed:
Degradation Rates
PHREEQC Phases
Periodic Table
Water Standards
Time Series

Additionally there is an option to Browse Database which allows you to view any table within the AquaChem database.

Degradation Rates
This table provides a list of Degradation Rates for organic compounds. Half-life values are available for various phases (Soil, Air, Surface water, and Groundwater). All half-life values are displayed in hours. The data from this table is used for the Decay Calculator. These degradation rates are from the following reference:

PHREEQC Phases
The minerals list is read from the PHREEQC thermodynamic database file. If no valid thermodynamic database is specified, the List of Minerals will be empty. This table displays PHREEQC phase names, formula, and molecular weights.

Periodic Table
This table provides information for all elements in the Periodic Table. This includes: Name, Formula, Mass, Valence, CAS #, and Group Name.

Water Standards
This table contains all of the water quality standards and guidelines defined in the project database. Use the comboboxes located at the top of the window to show specific guidelines, levels and parameters.
Time Series
This table contains all imported time series data. Use the combo box at the top to select the desired time series to show in the table below. You may add and delete records from the table using the Add and Delete button, located in the bottom-left corner of the dialog.

6.4 Modeling

The Modeling option under the Tools menu provides links to the PHREEQC geochemical modeling utilities.

PHREEQC provides six options for geochemical calculations:
Option 1: Calculation of the aqueous equilibrium (activities and saturation indices) based on a sample analysis
Option 2: Calculate pH based on a sample analysis
Option 3: Calculate Eh based on a sample analysis
Option 4: Calculate bicarbonate and carbonate concentration based on the measured total alkalinity and pH
Option 5: Equilibrate with minerals present in the sample
Option 6: Basic forward modeling, such as mixing samples, adding minerals or chemicals to a solution, or raising temperature
Option 7: Advanced modeling such as transport calculations, inverse modeling, etc.
Option 1: Calculate Saturation Indices and Activities
AquaChem allows you to quickly calculate saturation indices and activities for the modeled parameters listed in your database; the results are automatically saved back to your database, provided that the fields exist in the database. For example, to read back the calcite saturation index calculation, you need a field SI_Calcite specified in the Database Options, Modeled Parameters section.

Option 2: Calculate pH
AquaChem allows you to use PHREEQC to calculate a pH value for your sample. This can be used in an instance where you do not have a pH value for your sample, or you would like to compare to a theoretical pH if the sample was exactly in equilibrium with a specified carbonate mineral (e.g. calcite or dolomite).

Option 3: Calculate Eh
AquaChem allows you to use PHREEQC to calculate the Eh value for your sample. The calculation is based on the available redox couples for the selected sample. The sample must include concentrations for at least 1 redox couple, e.g. Fe2+/Fe3+, Mn2+/Mn3+, etc.

Option 4: Alk > HCO3, CO3
AquaChem allows you to calculate the concentrations of the carbonate species HCO3-, CO32- as well as OH- (if defined as a parameter in AquaChem) based on the alkalinity measurement. Note that this option is only active, if "Measured Alkalinity" has been matched to a database parameter in the File \ Preferences \ Aliases dialogue.

Option 5: Equilibrate with Minerals
This option allows you to simulate how much mineral would dissolve or precipitate, if a given solution was brought into equilibrium with one or several minerals. You may change the temperature to simulate heating or cooling of the solution and you may also simulate evaporation. The following examples illustrate two classic applications:
Calcite saturated water is pumped and its temperature raises from 12 to 25 degrees in the piping system. How much precipitated calcite can be expected if equilibrium is maintained?
An initial solution evaporates in a pond. How much gypsum precipitates if the residual water is one tenth of the original volume?

Option 6: PHREEQC (Basic)
AquaChem also allows you to do basic modeling with the PHREEQC interface included with AquaChem. To do so, you must use the PHREEQC (Basic) option. This option allows you to create input files, and run simulations which include basic forward modeling, such as mixing samples, adding minerals or chemicals to a solution, etc. PHREEQC input files may contain samples from your AquaChem database or a Pure Water solution. Before creating a PHREEQC Input file, it is recommended that you have some basic knowledge about PHREEQC.

Option 7: PHREEQC (Advanced)
For a more advanced simulation, AquaChem provides links to the two versions of PHREEQC which are distributed by the USGS: PHREEQC-I and PHREEQC for Windows. These versions offer the full features of PHREEQC, including transport, inverse modeling, and kinetics. In order to do advanced modeling, and exploit all the features of PHREEQC, it is encouraged that you use one of these versions of PHREEQC. Please review the USGS PHREEQC website to find the latest installations for these versions: http://wwwbrr.cr.usgs.gov/projects/GWC_coupled/phreeqc/

You may link either one of the mentioned programs to AquaChem in the File \ Preferences \ PHREEQC dialog and launch this program through the Tools \ Modeling \ PHREEQC (Advanced) menu option.
When this program is launched, an input file will be created automatically, and will contain any selected sample(s) from your AquaChem active samples list.

Other options:

- PHREEQC Interactive
- PHREEQC for Windows
- Generate PHT3D Input

6.4.1 Calculate Saturation Indices and Activities

When you select this item from the Tools \ Modeling menu, PHREEQC will run for each selected sample, and calculate saturation indices and activities for all modeled parameters which are defined in the current database structure. The results of the simulation will be automatically written back to the database for each selected sample, provided that the fields exist in the database. For example, to read back the calcite saturation index calculation, you need a field SI_Calcite specified in the Database Options, Modeled Parameters section.

If you would like to calculate Saturation Indices (SI) or activities for one sample in your database, simply load the appropriate Sample Details window, then click on the Modeled Parameters tab. Once you have done this, click on the button, which is located in the lower left corner of this window (as circled below):
PHREEQC will then run in the background, and the modeled results will be saved automatically back to your database. There is no need to create and define input files.

If you would like to quickly calculate Saturation Indices (SI) or activities for multiple samples in your database, then you should use the Calculate Sat. Indices and Activities menu option.

To add additional modeled parameters to your database structure, you must load the Database options, under File / Preferences / Database Parameters. Then, select the Modeled Parameters from the combo box, and add the desired Saturation Indices and Activities to your database (as shown in the dialogue below).
An example of how to Calculate Saturation Indices and Activities is provided below:

**Example**

To model a sample from the Demo.AQC database:

Select any sample from your Active Samples List.
Select Calculate Saturation Indices and Activities from the Tools > Modeling menu.

You will then see a PHREEQC DOS window run in the background. Once this is finished, load the Sample Details window for this sample, then

Select Modeled Parameters tab

In this window, you will see the modeled values for the available parameters. An example is shown in the figure below:
You may now do further processing and analysis with these parameter values, such as plotting, reporting, and querying.

**Note:** In addition to using the Tools > Modeling > Calculate Sat. Indices option, you can also use the Tools > Modeling > PHREEQC Basic option to calculate saturation indices for multiple samples. From the PHREEQC Basic window, click on the Solutions branch of the tree (left side), then select the samples of interest and ADD them to your solutions list using the "Green Plus button". Then, click on the Simulation branch of the tree (left side), and click the Selected Output tab. Choose the equilibrium phases (minerals) you are interested in, then RUN the PHREEQC program. Once the run is finished, click on the Spreadsheet Tab, and you can find the Saturation Indices. These can be saved from PHREEQC basic, or simply Copied and Pasted into another program.

### 6.4.2 Calculate pH
This tool can be used to estimate a missing pH value for an individual sample. The pH is calculated, based on the assumption that the groundwater comes from a carbonaceous aquifer and is in equilibrium with calcite. Usually a saturation index (SI) of 0 is thus specified. If a different SI is known to be typical for samples in the region, a different value can be specified.

Alternately, if a pH value was measured, and again the groundwater is assumed to be in close equilibrium with calcite, this tool can be used to validate the measured pH value. If the estimated theoretical pH is close to the measured pH, the pH measurement is probably true.

Example
To model the pH for a sample from the Demo_Basic.AQC database:

Select any sample from your Active Samples List.
Select Calculate pH from the Tools / Modeling menu.

You will then see the following dialogue:

```
Calculate pH
Sample: 0W-2.95
Measured pH: 7.3
Adjust pH of the solution in order to reach a specified saturation with the mineral below:
Mineral: Dolomite
Saturation Index: 0
Result: 7.76496
```

The Sample and Measured pH will be filled in automatically.

Select a Mineral from the combo box, usually calcite or dolomite.
Enter a value for the Saturation Index for this Mineral. This may be from a previous simulation, or other known values.
Select the Calculate button.

You will then see a PHREEQC DOS window run in the background. Once this is finished, a calculated pH value will appear in the Result field.

To accept this calculated pH value,
Select the Save button.
Otherwise, select the Close button to return to the main window.

6.4.3 Calculate Eh

In some cases, it may be very difficult to obtain meaningful Eh values by direct measurements. Several authors have recommended to calculate the Eh by means of the redox speciation with the Nernst
Equation. Each Redox couple, e.g. Fe$^{2+}$/Fe$^{3+}$, Mn$^{2+}$/Mn$^{3+}$ gives an individual Eh value, which in cases of equilibrium conditions, should be reasonable. The Calculate Eh menu item launches PHREEQC to search the selected sample for available redox couples and to calculate pe and Eh values for each couple. A sample of the dialog is shown below:

![Calculate Eh dialog]

The calculated Eh value may be compared to your measured Eh value.

In order to use this modeling utility, you must have data entered for a minimum of 1 redox couple (ex. Fe$^{2+}$ / Fe$^{3+}$), in the sample details window, Measured parameters tab.

### 6.4.4 Equilibrate with Minerals

This option allows you to evaporate a solution while staying in equilibrium with one or several minerals. For additional information on this option please see "Modeling" and "Equilibrate with Minerals". When this option is selected, the following dialog will load:

![Equilibrate with Minerals dialog]

This dialog consists of three tabs: Sample, Minerals and Results. Each is described below.
Sample
Sample information is shown in the top grid, i.e., station, sample date, sample_id etc. and its corresponding parameter information is shown below, in the left grid. In the adjacent right grid, you can enter values for Evaporate (%), Pump rate (m3/h) and Duration (days).
If the evaporation value is 0, the calculator will predict the mass of the precipitated minerals, based on the pumping rate and duration.

Minerals
This tab allows you to specify the minerals to equilibrate the solution with.

Simply click the green button to add a new record in the minerals table. Click in the mineral field (highlighted in the image above) and then select the desired mineral from the combobox.
Click the Calculate button to generated the output values. These can be viewed in the Results tab.

Results
This tab displays the output results which include the chemistry of the remaining sample as well as the amount of mineral that was precipitated or dissolved (Prec/Diss).
If a pumping rate and duration was specified in the Sample tab, the results are also expressed as total prec/diss during the pumping interval.

If you specified multiple minerals in the Mineral tab, you can recalculate the output with respect to different mineral by selecting the mineral from the Mineral combobox and clicking [Calculate].

6.4.5 PHREEQC (Basic)

This option loads the PHREEQC (Basic) Input file dialogue as shown below.
This graphical environment facilitates rapid development of simple PHREEQC simulations. Only the basic features of PHREEQC are supported; to take advantage of the more advanced features (Inverse Modeling, Transport, and Kinetics), you may utilize one of the USGS’s PHREEQC versions, as explained below.

AquaChem provides direct access to your AquaChem project database samples for selecting solutions and building the input files. New solutions can be easily defined as needed, or existing solutions from previous simulations can be conveniently selected.

AquaChem also supports the use of flexible units for the various chemicals in solution.

Several simulations can be defined in one input file and processed in a single run. Reactions such as heating, evaporating, dissolving, or precipitating minerals can be conveniently simulated in step wise simulations, with all model parameters calculated for each step.

Once the PHREEQC input files have been prepared, the simulation can be launched directly from AquaChem. When the PHREEQC simulation is completed, you can copy the results from the spreadsheet view, and paste these into the Sample Details window for each individual sample. This will allow you to do further processing and analysis, such as plotting, reporting, and querying.
NOTE: Before using PHREEQC, you must ensure that you have defined the location of the PHREEQC.exe (executable), and PHREEQC.dat files. This can be done in the PHREEQC Preferences dialogue, available in the File menu.

For more details on designing a PHREEQC input file, please refer to Chapter 7: Geochemical Modeling with PHREEQC (Basic).

6.4.6 PHREEQC (Advanced)

PHREEQC (Advanced)
This option allows you to run advanced PHREEQC simulations, using either PHREEQC-Interactive or PHREEQC for Windows. The PHREEQC version that is loaded will be dependent upon the .exe file which is specified in the Preferences dialogue, as shown below:

In the third line, you will see a field where you can specify the location of the PHREEQC executable file. If you are using PHREEQC-I, the file is called phreeqci.exe. If you are using PHREEQC for Windows, the file is called phreeqc.exe. Please point this to the appropriate folder on your system where the respective installation resides.

6.4.7 PHREEQC Interactive

When you select the PHREEQC (Advanced) option from the Tools > Modeling menu, this will load the USGS’s PHREEQC- Interactive Windows Interface, provided that this component was successfully installed during your AquaChem installation. An example of the PHREEQC-I window is shown below:
You may select individual or multiple samples in your active samples list. Any sample(s) which is (are) selected will be used as initial solution(s) when you load the PHREEQC-I program. You may then use the full features that PHREEQC-I has to offer. Once a PHREEQC-I simulation is completed, you must manually insert the results back into AquaChem by copy-and-paste, or by manually typing in the values.

**NOTE:** Before using PHREEQC-I, you must ensure that you have defined the location of the PHREEQC-I.exe (executable). This can be done in the Preferences>PHREEQC dialogue, available in the File menu. If you did not install PHREEQC during your AquaChem installation, you may install this using the installation files located in the PHREEQC folder of your AquaChem CD-ROM. The installation file is named: Phreeqc-2.12.1-669.exe.

For more details on PHREEQC-I, please refer to the user's manual "manual.pdf" which can be found in the 'Doc' folder, in your PHREEQC-I installation directory. Or, you may access the PHREEQC-I On-Line help, from within PHREEQC-I (in the Help menu).

### 6.4.8 PHREEQC for Windows

PHREEQC for Windows is a 32-bit Windows version of the geochemical model PHREEQC. PHREEQC for Windows contains the full functionality of PHREEQC v.2. The input files for the program are backward compatible with the normal version of PHREEQC. This means that you can use any file created with the normal version in PHREEQC for Windows. However, some options that are available in PHREEQC for Windows are not available in the standard version. The PHREEQC for Windows is developed by Vincent E.A. Post.
PHREEQC for Windows is not included with the AquaChem installation. PHREEQC for Windows is a public domain product, and may be downloaded from the web site below:


Once you have installed PHREEQC for Windows, you must define the location of the PHREEQC.exe (executable), in the PHREEQC Preferences dialogue, available in the File menu. Then, this executable will be launched when you select PHREEQC (Advanced) from the Tools > Modeling menu option.

An example of the input window for PHREEQC for Windows is shown below:

Similar to the PHREEQC-I, any sample(s) which is (are) selected in your active list will be used as initial solutions when you load the PHREEQC for Windows program. You may select individual or multiple samples in your active samples list. You may then use the full features that PHREEQC for Windows has to offer. Once a simulation is completed, you must manually insert the results back into AquaChem by copy-and-paste, or by manually typing in the values.

For more details on PHREEQC for Windows, please refer to the user's manual "ManualW.pdf", which can be found in your PHREEQC for Windows installation folder. Or, you may access the On-Line help, from within PHREEQC for Windows (in the Help menu).
6.4.9 Generate PHT3D Input

AquaChem can produce PHT3D input files for use with PHT3D in Visual MODFLOW versions 4.2 or higher.

Visual MODFLOW incorporates the reactive multi-component engine PHT3D. PHT3D couples the transport simulator MT3DMS and the geochemical package PHREEQC-2. Through the flexible, generic nature of PHREEQC-2, PHT3D can handle a broad range of equilibrium and kinetic reactive processes, including aqueous complexation, mineral precipitation/dissolution and (multi-site) ion exchange. In the current version 4.2, Visual MODFLOW data entry is based on the same user interface used for the transport engines such as MT3DMS and RT3D. This has the following drawbacks: typically when using PHT3D, your model will be comprised of many more species than was the case with the former transport engines. Also, PHT3D only accepts special units, and solutions require special conditions such as perfect ion balance, total inorganic carbon entry instead of alkalinity, etc. Therefore laboratory results have to be transformed before the data may be used in PHT3D. To facilitate an efficient workflow, Visual MODFLOW includes an import feature, which allows the user to import solutions, minerals, gas composition and exchanger composition into a selected set of cells. AquaChem, in turn, allows for export of the information stored in its database into the format that can be imported into Visual MODFLOW.

Typically a PHT3D model is comprised of the following elements:
- initial composition of water in the aquifer
- composition of inflowing, infiltrating or injected water
- properties of the aquifer: mineralogical composition, amount and initial composition of exchanger places and gas composition

The operations described below are required to transform laboratory results into PHT3D ready input.

Solutions
All units must be expressed in mol/l, plus there must be a perfect ion balance between anions and cations. This is achieved by first running a PHREEQC simulation and allowing an automatic charge adjustment, typically on an element which is sufficiently abundant to achieve a balance and which is not considered important for the type of reactions studied through this model. In many cases chloride is a good candidate. Further, PHT3D requires total inorganic carbon as input as opposed to alkalinity which is usually reported in lab results. Again, this requires that the original solution is run and total inorganic carbon is read back from the simulation output file.

Minerals
Typically, the laboratory results are provided in ppm or percentage mineral related to 1kg of aquifer material. PHT3D requires the number of mols of mineral related to the mass of aquifer material in contact with 1 liter of pore water. This requires knowledge about the porosity and density of the aquifer material. For example, an aquifer having porosity of 20% and density of 2.7 g/cm3 will have a volume of 4 liter of rock around every liter of pore water resulting in a mass of 10.8 kg of rock material. If this rock comprises 10% of calcite, the mols of calcite is calculated as 10.8 * 0.1 * FMW(calcite, 0.1 kg) 10.08 mols. This calculation needs to be repeated for each mineral.

Exchangers
PHT3D requires the amount of exchange places and the initial occupation of these places with various available ions, e.g. NaX, CaX2, MgX2, KX, etc. As in the previous case, the concentrations refer to 1 liter of pore water, though in reality, these values are rarely available. Values provided by the laboratory normally include the CEC (cation exchange capacity, which may be transformed into exchange places per liter of pore water in a similar way as discussed for the minerals. More often, the CEC itself has to be
estimated based on the amount and type of clay minerals and presence of organic material. A formula that is often applied in this respect is given by Appelo and Postma, 1993:

\[ \text{CEC} = 3.7 \times \% \text{clay} + 3.5 \times \% \text{organic C} \]

If the type of the dominant clay material is known, then the CEC can also be estimated by multiplying the average CEC of this clay material with the percentage reported in the studied aquifer material.

All above methods only provide the places available for ion exchange, but do not indicate the initial occupation of these places. If an exchanger material assumed to be in equilibrium with a given solution, e.g. fresh water or sea water, then PHREEQC allows calculating this initial composition using the so-called implicit option for the exchange simulation. As for the solution, the PHREEQC output can then be used as input for PHT3D.

**Create Input Files**

For models comprised of many species, data entry and associated conversion and transformation may turn out to be very tedious. AquaChem, therefore, includes an option to facilitate this data entry as explained below.

Requirements:
A VMOD project must exist, since AquaChem reads information from the *.vmf file.
A VMOD installation must exist on the local computer or network, since AquaChem needs to have access to the vmod.xml file in order to find the thermodynamic database.

To create a PHT3D input file:
Select Generate PHT3D Input from the Tools > Modeling menu, and the screen depicted in figure below will appear.
Each tab is described in detail below:

**General Tab**
The VMOD Program Folder field allows you to select the VMOD installation folder (where the vmod.xml file is located).
Click the button beside the VMOD Program Folder field, in the top right corner and navigate to the VMOD installation folder. Select the folder and click [OK].

The VMOD Project field allows the user to specify the folders where the project .VMF file is located. AquaChem reads all required information from the XML file and displays it in the grid.

Click the button beside the VMOD project field and navigate to the VMOD installation folder. Select the file and click [OK].
The remaining tabs, i.e., solution, aquifer and preview, provide an interface to define the composition that will be importable in PHT3D (solutions, minerals, gas composition, exchanger composition).
The first tab allows you to format the entry for one or several solutions. The solutions must have been previously entered in AquaChem using standard units. Another important precondition for assigning AquaChem concentrations to PHREEQC master species is that the master species are matched to AquaChem database parameters in the currently active thermodynamic database.

**Solutions tab**
The Solutions tab allows converting AquaChem solutions into PHT3D importable solutions including charge balance calculations and conversions to mol/L. When this tab is displayed, the grid below is shown. It lists all master species of the current thermodynamic database for the active VMOD project variant. The active compounds are marked in the third column by the internal concentration name, i.e., conc0001, conc0002, etc.

Click the [Select] button to open the Station List dialog (shown below).
Select a sample from the station list, and click the [Assign] button and then Close.

All available concentrations from the selected sample will be copied to the "Conc" column in their original format.

The Charge Balance combo box allows you to select an element that will be used for calculating the charge balance. Please note that only the active PHT3D components will be used for the PHREEQC simulation. Therefore an AquaChem sample, that is perfectly balanced, but includes species which are not active in PHT3D, still needs to be balanced.

All available active PHT3D species will be written to a PHREEQC input file and the charge balance is calculated as well as redox species, e.g., Fe(2), Fe(3) from total Fe. All results are read back in mols/L column in the grid immediately (shown below). You may edit the concentration column manually however you will need to click the [Run] button to launch the PHREEQC simulation manually. When changing the element used to calculate the ion balance, the simulation is launched automatically.
Use the format combo box to specify the appropriate format for the generated input file. You can choose from initial concentration or recharge concentration.

For more information on recharge concentration format, see “Preview Tab”

Aquifer tab

The Aquifer tab allows you to define the mineral composition of the aquifer. Note that PHT3D uses concentrations per liter of bulk aquifer material rather than per liter of porewater used by PHREEQC.

First, define the bulk density by entering the value in the Bulk Density text field. This value can be calculated based on the porosity and the density of grains. Most rock forming minerals have a density of 2.6-2.75 g/cc. Porosity can vary more widely from a few percent up to 60% for clays.

Click the button to access the AquaChem bulk density calculator (shown below).
Enter a Porosity and Density value and then click the [Calculate] button to generate the Bulk Density value. Click [Close] and enter the generated value into the Bulk Density text field in the Aquifer tab.

**Minerals**

In the Phase Assembly (Minerals) frame, enter the estimated or measured percentages for each listed mineral in the % column. The respective mols/L of aquifer bulk material will be calculated in the last column (shown below).

**Exchanger Sites**

The definition of an exchanger assemblage requires two basic inputs: the amount of total available sites and the initial distribution of these sites among the active PHT3D exchanger components. Because these values are not always directly measured, you can use the AquaChem calculator to generate estimated values.

The first step of calculating an exchanger composition consists of estimating the amount of exchanger sites in the aquifer material that is in contact with 1 liter for pore-water. Click the button and the screen shown below will be shown.
Under the General tab, calculate the Bulk Density by entering grain density and porosity values or simply enter the bulk density if the value is already known. Next click on the Exchange Capacity tab.

For this example the exchange places are to be estimated based on a known percentage of 10% clay and 5% organic matter. Enter these percentage values in the first two text boxes. Click the CEC estimated radio button. Once the [Calculate] button is clicked, the CEC in meq/100g soil will be calculated and multiplied by the mass of grains calculated on the first tab.
Copy the calculated value to the clipboard (highlight value, right-click and select copy) and then paste the value into the Exchanger sites field of the Minerals tab.

There are two ways of entering the distribution of sites among Exchanger species: Explicit requires that you distribute the sites manually among the species, based on laboratory results or estimation. The Implicit method allows selecting a solution, equilibrates the exchanger assemblage with this solution, and then reads the results back to the grid. Both methods are described in more detail in the following sections.

**Explicit**
If the distribution of specific exchange places (Ca\(\text{X}\), Na\(\text{X}\), K\(\text{X}\), etc.) is known, enter the percent values manually in the grid below for each exchanger.

**Implicit**
Alternatively you may assume that the exchanger is in equilibrium with a solution. Typically for exchange reaction simulations, the aquifer including its exchangers is in equilibrium with an initial solution. This system is then flushed with a solution of a different composition (e.g. saltwater if the initial solution was freshwater or vice versa). The first solution can be used to calculate the distribution of individual exchange species (Ca\(\text{X}\), Na\(\text{X}\), K\(\text{X}\), etc.).

Select the Implicit option, then press the button and select the required sample from the Station List dialog (shown below).
Once selected, click the [Assign] button.

This will automatically generate a PHREEQC simulation, equilibrating an exchanger having the specified number of exchange places with this solution. The calculated exchange species are then extracted from the PHREEQC output file and inserted into the grid.

**Preview Tab**

The preview tab provides a summary of the prepared data for PHT3D import. Three different entries are created: initial concentration, mineral composition and exchanger composition. Each grid contains a [Save] button which allows you to export the grid data to an importable text file (indicated in the image below).
Exchanger and mineral composition can only be defined under the initial concentrations format. The respective datafiles are time independent. Solutions may also be bound to time dependant boundary conditions such as recharge and point sources. Among those, only the creation of recharge concentrations is supported for the time being.

To create recharge concentrations, simply select Recharge concentrations from the Format combo box in the General tab.

The preview grid for solutions will now be filled with multiple records (shown below). The number of time steps and the simulation duration is read directly from the project.vmf file and is also displayed in the project setting grid on the General tab. For the time being, the composition of every step is kept
constant. This grid is editable; you may add or delete rows and change the start/stop values for every row. For example, if the solution includes a parameter for temperature, you can manually change this value for every time step, while the composition of the water remains constant.

<table>
<thead>
<tr>
<th>Species</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start Time</strong></td>
</tr>
<tr>
<td>0</td>
</tr>
<tr>
<td>365</td>
</tr>
<tr>
<td>730</td>
</tr>
<tr>
<td>1095</td>
</tr>
<tr>
<td>1460</td>
</tr>
</tbody>
</table>

Once the grid data has been saved in imported text files, they can be imported into VMOD/PHT3D.
Geochemical Modeling with PHREEQC (Basic)

This chapter presents an overview of the modeling capabilities of PHREEQC and an introduction on how to create PHREEQC Input files using the basic version of PHREEQC included within the AquaChem interface.

Here you will find an introduction to the AquaChem Interface to PHREEQC, PHREEQC Window Layout, Creating PHREEQC Input Files, and Running PHREEQC Simulation.

AquaChem uses the batch version of PHREEQC, which allows to integrate this model seamlessly into AquaChem. For details on the Graphical User Interfaces PHREEQC-I, or PHREEQC for Windows, please refer to the User's Manuals included with these programs. These programs are available from the USGS PHREEQC website:

7.1 AquaChem Interface to PHREEQC

PHREEQC is a computer program for speciation, batch-reaction, one-dimensional transport, inverse geochemical calculations, and much more. For more than twenty years, the USGS's PHREEQC has been the proven standard for aqueous geochemical modeling. PHREEQC is derived from the FORTRAN program PHREEQE. As the name implies, the original FORTRAN code has been entirely rewritten in the C programming language and this new version has eliminated many of the deficiencies and limitations of earlier version of PHREEQE, while adding many new powerful analytical capabilities.

In the past years the authors of PHREEQC have not only added many more powerful features to the program, they have also implemented two very easy-to-use interfaces for writing input files and analyzing output files for the PHREEQC program. The respective programs PHREEQC-I and PHREEQC for Windows are available from the USGS PHREEQC website:
You may link your AquaChem samples in your database to either one of these programs, provided that these programs are installed, and linked in the File / Preferences / PHREEQC dialogue. These interfaces may be called from within AquaChem, and this will allow you to run advanced PHREEQC simulations using your AquaChem samples. For more details, please refer to Chapter 6.

The PHREEQC (Basic) option provides a GUI to the basic features of PHREEQC. You may run simple simulations based on analysis stored in the AquaChem database; this option also allows you to create PHREEQC input files, can be later opened with more sophisticated graphical user interfaces such as PHREEQCI or PHREEQC for Windows versions of PHREEQC.

Although this chapter describes how to create PHREEQC input files with the PHREEQC (Basic) version, the concept of hydrochemical modeling and the PHREEQC program will not be discussed in detail. It is recommended that you read the PHREEQC user's manual before performing any complex hydrochemical simulations. For your reference, the PHREEQC user's manual and source code may be downloaded from the following web site:

7.1.1 Preferences for PHREEQC

The instructions in this section will be based on the assumption that you are using the PHREEQC executable file. By default, the PHREEQC batch executable file is installed in the program folder of
AquChem. While the PHREEQC thermodynamic database files are installed in My Documents\AquaChem\PHREEQC.

If you have installed AquaChem in a directory other than the default installation directory, or if aquachem is not yet linked to PHREEQC, the Tools/Modeling/PHREEQC (Advanced) option will be inactive (greyed out) on your computer, and you will need to manually set up the link between AquaChem and the PHREEQC thermodynamic database and executable files.

To do so, select File from the main menu and then select Preferences and then PHREEQC to find the following options:

Press \(\text{button}\) beside the Thermodynamic Database field and select the path and filename from the PHREEQC Thermodynamic Database dialogue. From this dialogue, select either phreeqc.dat, pitzer.dat, Wateq4f.dat, Minteq.dat or Minteq.v4.dat.

In addition, in the PHREEQC Executable field select the path and filename for the phreeqc.exe file (this is installed within the AquaChem Installation folder and is used for the PHREEQC (Basic) option).

Finally, specify the path and filename for the USGS PHREEQC Executable file (which is used in the PHREEQC (Advanced) option).
If the default path and filename are incorrect, you can browse the directory by clicking on the button and select the filename. You can find the most up to date versions of the PHREEQC Graphical User Interface from the USGS website by selecting the PHREEQC Website button.

By default, all PHREEQC input and output files will be saved in your AquaChem installation folder (default is C:\Program Files\AquaChem). Once you are finished, click [Save] then [Close]. You are now ready to run PHREEQC.

7.1.2 The PHREEQC Thermodynamic Database Link

One of the biggest advantages of the AquaChem PHREEQC interface is the direct link between the two databases of these programs. The link allows you to use samples from the AquaChem database and read them into the PHREEQC input data file.

In order to let AquaChem know which database parameter matches which PHREEQC element, some minor modifications have been made to each of the thermodynamic databases included with AquaChem. The link between AquaChem and the thermodynamic databases is established by adding the AquaChem parameter name as a comment for each matching parameter in the Masterspecies section of the database file. Each comment is preceded by a `#` character to flag the AquaChem parameter descriptor.

For example, the following lines are taken from the Masterspecies section of the phreeqc.dat file:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Symbol</th>
<th>Charge</th>
<th>Value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ca</td>
<td>Ca+2</td>
<td>0.0</td>
<td>Ca</td>
<td>40.08</td>
</tr>
<tr>
<td>Mg</td>
<td>Mg+2</td>
<td>0.0</td>
<td>Mg</td>
<td>24.312</td>
</tr>
<tr>
<td>Na</td>
<td>Na+</td>
<td>0.0</td>
<td>Na</td>
<td>22.9898</td>
</tr>
<tr>
<td>K</td>
<td>K+</td>
<td>0.0</td>
<td>K</td>
<td>39.102</td>
</tr>
<tr>
<td>Fe</td>
<td>Fe+2</td>
<td>0.0</td>
<td>Fe</td>
<td>55.847</td>
</tr>
<tr>
<td>Fe(+2)</td>
<td>Fe+2</td>
<td>0.0</td>
<td>Fe</td>
<td></td>
</tr>
<tr>
<td>Fe(+3)</td>
<td>Fe+3</td>
<td>-2.0</td>
<td>Fe</td>
<td></td>
</tr>
<tr>
<td>Mn</td>
<td>Mn+2</td>
<td>0.0</td>
<td>Mn</td>
<td>54.938</td>
</tr>
</tbody>
</table>

These modifications have already been defined for each of the thermodynamic database files provided with AquaChem. You have to redefine this only if you change the thermodynamic database. Please be aware that if you find it necessary to make adjustments to the thermodynamic databases we recommend that you save them with a new name. This will avoid your changes being overwritten if you ever find it necessary to re-install AquaChem. Please ensure that if you save the thermodynamic database files with new names you go through the procedure described above to set the new database file as the one to be used by PHREEQC under File/Preferences/PHREEQC.

7.2 PHREEQC Window Layout

To access the PHREEQC input dialogue, select Tools from the main menu of AquaChem and Modeling and then PHREEQC (Basic). This will load the PHREEQC (Basic) Input dialogue as shown in the following figure.
The PHREEQC Input dialogue consists of several options and settings that apply to the entire PHREEQC simulation. The left side of the dialogue includes a Navigator Tree, allowing you to quickly add and modify the reaction options for the current simulation. Along the lower part of the PHREEQC Input dialogue there are four tabs: Simulation This allows you to define the simulation options (main input dialogue). Input File This provides a view of the PHREEQC input file, in text format. Output File This provides a view of the complete PHREEQC output file, in text format. Spreadsheet This provides a spreadsheet preview of selected parameters from the PHREEQC output file in a spreadsheet format. The bottom of the PHREEQC Input dialogue contains several buttons: Save The save button allows you to save the contents of the input or output file. If the Input File tab is selected, the [Save] button will allow you to save the input file as a .PQI file. If desired, this file may be loaded into PHREEQC-I, and the simulation may be run using this version. If the Output File tab is selected, the Save button will allow you to save the output file as a .PQO file. Clear The [Clear] button clears the contents of the input file, and allows you to create a clean, new input file. Calculator The [Calculator] button loads the Aquifer Properties Conversion dialogue and allows you to calculate and convert various aquifer properties you require for some of the PHREEQC simulations. Run The [Run] button runs PHREEQC using the current simulation options. This button loads the PHREEQC input file and executes the PHREEQC simulation. The [Run] button should only be used after you have specified all of the required run options and you are ready to start the PHREEQC simulation. It is recommended that you verify the input file before running the simulation. Close The [Close] button closes the PHREEQC input dialogue.
There are four tabs associated with the [Calculator] button: General, Surface Complexation, Exchange Capacity, and Mineral Assemblage. These are shown and described below:

**General**
Since PHREEQC always assumes a solution volume of 1.0 liters, the General calculator allows you to easily calculate the Volume of rock (liters) per liter of porewater and Mass of grains (kg) per liter of porewater for the aquifer based on a solution containing 1.0 liters of porewater. Simply enter the input parameters (Porosity, Density), and press the [Calculate] button. This provides the necessary values for all calculations shown below.

**Surface Complexation**
The moles of surface places (sites) depends on the content of hydrous ferric oxides in the aquifer (Sites/mol ferrous iron). Fe is generally a measured parameter but you must estimate the percentage of iron (Weight % Fe) that is in the form of hydrous iron (% hydrous ferric oxides of total iron). Since PHREEQC always asks for mols, you also need a formula weight value for your iron minerals. Hydrous iron is a mixture of several minerals, so a suggested Gram formula weight for oxides is 89 which is used as a default value.
The Cation Exchange Capacity (CEC) is normally expressed as meq/100g of soil. PHREEQC however uses meq/l of porewater. There are several ways of estimating the number of exchangeable sites and express it in the unit used by PHREEQC.

If you know the CEC value you may directly enter it and calculate the exchange places (Sites) within the given aquifer volume. Otherwise you need to estimate the CEC. The first option lets you select a clay mineral from a list and will use an average CEC value. Choose this option if you know the dominant clay mineral of your aquifer. If you know only the percentage but not the mineralogy of your clay minerals you may use a formula derived by Appelo (1993) to estimate the CEC:

$$\text{CEC} = 0.7 \times \text{clay}\% + 3.5 \times \text{org material}\%.$$
Mineral Assemblage
The Mineral Assemblage option lets you convert an analysis usually expressed as weight percent to mol of mineral per liter of porewater. Simply select a mineral from the combo box, and specify a Weight %. Press [Calculate] and the amount of mols will be calculated.

There are three tabs associated with the Simulation tab which are shown and described below:

**General**
The General tab contains a summary of the steps defined for the current simulation.
Reaction Temperature
This tab provides options to specify the reaction temperature, or step-wise changes in the reaction temperature. The Reaction Temperature options can be seen in the dialogue shown below.

The Reaction Temperature tab provides options for specifying the desired temperature settings during a modeled reaction. Normally the temperature of the selected sample stays Constant (default setting) during a reaction and it will use the solution temperature as entered in the Solutions option selected from Navigator tree. However, PHREEQC provides you the options to change the temperature linearly (Linear change from...to...in...Steps) from a starting temperature to an ending temperature in a specified number of steps or in steps during the course of a simulation. The List of Steps option allows you to specify the exact temperature at specific steps during the reaction and the temperatures will be applied in the order they are listed.

Output
The Output tab allows you to access the various output details to include in the standard PHREEQC results output file (.PQO file extension) or to save simulations directly back to the database. PHREEQC will generate an output file every time you run a simulation. However, this file is very detailed and may contain more information than you need to solve a particular problem. Its format is also not suited for plotting or presenting simulated data. This tab lets you extract individual parameters from the detailed output file and write them into a spreadsheet.

The options available under the Selected Output dialogue are shown in the figure below:
Selected Output

With the selected output option, you may extract specified activities, saturation indices, gas phases, etc. into a spreadsheet type file. Simply choose the parameters you want to save to the tabular output file. By default the parameters pH, pe, Temperature and Ionic Strength are included in the output.

Totals Total amount of a masterspecies, this value should be equal to the entered concentrations
Activities Amount of aqueous species that is available for reactions.
Molalities Concentrations of aqueous species
Saturation indices Saturation state of minerals
Equilibrium phases: Amount of minerals present in the system
Gas phases: Amount of gas phases present in the system

When you have successfully run the simulation, AquaChem allows you to save the output file. To do so, press the **Save** button, and enter a filename.

Prepare simulated output for storage in database

If the database is selected as the target output, then the simulated results for created samples will be saved as new sample records. This option is only applicable if a simulation creates a new solution, e.g. when mixing several existing samples, when equilibrating an existing sample with minerals, or when adding chemicals. Since every sample needs to have an assigned station, you should create one or several dummy simulation stations, to which you may assign your simulated samples in order to easily distinguish them from real samples. If the sample comment field exists and is identified and mapped in the File>Database>Aliases section, then the type of simulation will be written automatically to the sample.

Simulated samples do not necessarily belong to a station, e.g. when saving the mixture between 2 samples, the saved simulated composition would belong to no specific station. However, AquaChem
needs a station to be assigned to every sample, therefore the Save simulated solution output to database option requires you to define the station for the new samples to be created. You may create a dummy station names, such as "PHREEQC Simulation" that may be used for this purpose.

Save Options
The PHREEQC input and output files are saved by Aquachem under default filenames which will be overwritten with every new PHREEQC run. Using the "Save Solution as" option in the step frames, allows you to save the current simulation under a defined name. You may afterwards use this file for your documentation or continue to model with one of the USGS GUIs that provide more advanced coverage of the PHREEQC features.

7.3 Creating PHREEQC Input Files

7.3.1 Simulation - Steps
A PHREEQC simulation may consist of several steps (e.g. you may define and mix 2 samples in the first step and equilibrate the mixing result in a second step).
Under the General tab, you will see a list of Steps (if multiple steps have been defined).
In order to add a simulation step you may right click on Simulation - the top item of the Navigation tree - and select the Add Step. Or click the button below the Steps frame.

You can enter a name for the Step in the Description field, and choose the step properties. Click button under the Add and choose an item from the list, and press the button. After a new step has been added, double click on it or click on the Step in the Navigator tree to produce the Step description dialogue:
This new item will now appear in the Navigator tree on the left side of your display. To activate the properties for this item, expand the Navigator tree and click once on this item.

To modify the Step properties, you have two options:
1. Double click on the Step name from the main dialogue
2. Select "Step" from the Navigator tree on the left side of your display.

Options for the reaction steps can also be created and modified as needed. These include:
Add Initial Conditions and Forward Modeling

These options are described in detail in the following sections.

**Add Initial Conditions**
Add Equilibrium Phase
Add Exchange Assemblage
Add Gas Phase Assemblage
Add Solution
Add Surface

**Add Forward Model**
Add Mix
Add Reaction

### 7.3.2 Equilibrium Phases
Adding Equilibrium mineral phases is similar to adding reactions. With the Add Reaction options (described below) you add a specified amount of a phase, but with the Add Equilibrium Phase options the amount of mineral phase added is limited by a specified saturation index.

To specify an equilibration of your solution with Mineral Phases, right click on the Steps options and select Add Initial Conditions from the pop-up menu and then select Add Equilibrium Phases.

Equilibrium Assemblage
Each mineral phase assemblage is identified by a unique Phase assemblage Number and a Description. You may enter multiple phases by specifying a phase number from # to # (ex. Number 1 to 2). The assemblage number is only important if you intend to use the input file later for transport modeling using PHREEQCI or PHREEQC for Windows.

Select Equilibrium Phases and an Equilibrium Phases dialogue will appear as shown below.

For each mineral phase you choose, you can specify the following properties:

SI: This is the Saturation Index of the selected mineral phase (degree of saturation, default value 0).

\[ SI = \log(\text{IAP}/KT) \]

where,

- IAP = the ion activity product for the given material and
- KT = the reaction constant at the given temperature

If SI > 0, then the solution is super-saturated with respect to the mineral phase;
If SI < 0, then the solution is below saturation of the specified mineral phase.
If SI = 0, then the solution is in equilibrium with the specified mineral phase.

For Gas phases the SI corresponds to the log of the partial pressure.

Mols: Mols describes the maximum amount of mineral phase that can be added or dissolved to reach the specified saturation. The default value is 10 mols. The constraint on available amount of mols is important if you want to translate measured concentrations of minerals in an aquifer in a PHREEQC...
transport model. You may also set the amount of available mols to 0, making sure that the respective mineral can only be precipitated but not dissolved from the aquifer.

Alternative phase: The alternative phase is added or removed until the first mineral is in equilibrium with specified saturation index. For example, gypsum may be added or removed to the solution until an equilibrium with the primary mineral calcite is reached. An amount must be specified for the alternative mineral phase (default amount of the alternative phase is 10 moles as specified by PHREEQC). The solutions equilibration with calcite will be terminated if the amount specified for the alternative mineral phase is consumed prior to equilibration with calcite. It should be noted that if the alternative phase is specified, the amount of the mineral phase is ignored. Otherwise the system would be overdetermined. Below the grid, select the solution with which the mineral phase will be equilibrated. If you do not choose a solution, the specified assemblage is equilibrated with the first solution defined in the current simulation.

The equilibration of a solution with minerals will result in a new composition of the solution. The Save Solution as allows you to save this composition as a new solution. These new 'elements' can then be used as input data for subsequent PHREEQC simulations. Each of these new elements must be identified by a unique number that is not already in use. If you specify a number that is currently in use, the new element will overwrite the old element.

7.3.3 Exchange Assemblage

Ion exchange involves the replacement of one chemical in the solution with another on a solid surface. Intrusion of fresh water into marine sediments or seawater into coastal fresh water aquifers are probably the best known examples for this mechanism. Fresh water typically is dominated by Ca\(^{2+}\) and HCO\(_3^-\) ions due to the presence of dissolved calcite, whereas in seawater, Na\(^+\) and Cl\(^-\) are the dominant ions. Sediment in contact with sea water will often have large concentrations of Na\(^+\).

When seawater intrudes in a coastal fresh water aquifer an exchange of cations takes place:

\[ 2\text{Na}^+ + \text{Ca}-X_2 \rightarrow (2\text{Na}-X + \text{Ca}^{2+}) \]

where X indicates the soil exchanger.

Sodium is taken up by the exchanger and Ca\(^{2+}\) is then released. The composition of the solution and the exchanger is modified by this reaction.

A sample of the Exchange Assemblage options dialogue is seen below:
PHREEQC lets you define the initial composition of an Exchange Assemblage in two ways:

1. Explicitly by selecting the composition of the Exchange Assemblage. This approach is chosen if the mineralogy and the exchange sites for these minerals are well known.

2. Implicitly by specifying that the Exchange Assemblage is in equilibrium with a solution of a fixed composition. This approach is chosen if the type of water in the aquifer is known. E.g. to model an aquifer in contact with seawater make sure that your model contains a seawater sample and specify this sample within the "Exchange assemblage is defined to be in equilibrium with solution" option.

**Option 1**

AquaChem provides a list of available exchanger ions to choose from and allows you to easily add several ions to the Exchange Assemblage.

To add an ion(s) to the Exchange Assemblage:

Click + to add a new line to the grid.

Under the Exchanger field, double-click in the first empty cell and a combo box with a ✗ button will appear listing the available items.

Select the ion you need, and press <Enter> (on your keyboard). The ion will appear in the grid.

Enter the Amount (in Mols) for each ion in the Exchanger column. In order to estimate the amount of exchangeable cations, you may use the Aquifer Properties Calculator described above.

To remove an ion from the Exchange Assemblage, click-on the ion you would like to remove, and then press the ✗ button.

**Option 2**

You may specify that the Exchange assemblage is defined to be in equilibrium with a solution. For example, if you consider that the exchange takes place on a marine clay, define seawater as a solution and select this solution in the Implicit option as the water the exchange material is in equilibrium with.

Simply enter a solution number in the appropriate field.

Once you have defined the Exchange Assemblage, you must select the solution with which you wish to equilibrate. If you do not select a solution from the list, you can save the Exchange Assemblage to equilibrate in a later simulation step (e.g. during a transport problem).
Each Exchange Assemblage is identified by a unique Number and a Description so they can be easily recognized in the Input / Output files, and reused in later simulations. The Save Solution field allows you to save the composition of a simulation by creating a new exchange assemblage. These new 'elements' can then be used as input data for subsequent PHREEQC simulations. Each of these new elements must be identified by a unique number that is not already in use. If you specify a number that is currently in use, the new element will overwrite the old element.

### 7.3.4 Gas Phase Assemblage

The Gas Phase is used to equilibrate a solution with a finite volume of gas. This simulation is not applicable if fixed partial pressures of the gas components are desired (for this case use the Mineral Phase option instead and fix a gas with a partial pressure that has an infinite volume of gas phase). An example of the Gas Phase Assemblage dialogue is shown below:

The Gas Phase option will equilibrate the solution with only those gases which are defined in the simulation. However, gases may be specified with a partial pressure equal to zero at the start of the simulation. In this case, no moles of that component will be present initially, but some gases may evolve during a reaction simulation such as oxidation of organic material. As a result, the partial pressure of all gases included in the gas phase stays constant and the excess gas is removed from the solution as the gas bubbles.

Pressure calculations are computed using the ideal gas law,

\[ PV = nRT \]

where,

- \( P \) = defined pressure
- \( V \) = volume
- \( n \) = number of moles of the gas
- \( R \) = universal gas constant
- \( T \) = temperature

AquaChem provides a list of available gases to choose from and allows you to easily add multiple gases to the Gas Phase Assemblage.

To add a gas phase assemblage to the simulation:
Click + to add a new line to the grid.

Under the Gas Phase field, double-click in the first empty cell and a combo box with a button will appear listing the available items.
Select the gas you need, and press <Enter> (on your keyboard). The gas will appear in the grid.
Enter a partial pressure value for each gas under the Part. Press column.

If you wish to add air to the solution, click on button and the major components of air will be automatically added to the list, with their partial pressures at 1 bar.

To remove a gas from the Gas Phase Assemblage table, select the gas to remove and then press the button.

The Critical Pressure, Initial Volume and Temperature information is required for each Gas Phase assemblage in order to calculate the weights of each gas component.

The default values are:
Critical Pressure: 1.1 atm. This is equal to the pressure, at which the dissolved gas will start to create bubbles
Initial Volume: 1.0 liters: amount of gas initially in the system
Temperature: 25°C

Finally, you can select the solution with which you would like to equilibrate the gas phase assemblage. If you do not select a solution from the list, you can save the gas phase to equilibrate in a later simulation step. Each Gas Phase Assemblage is identified by a unique number and can be reused in later simulations.

The Save Solution as allows you to save the composition of a simulation by creating a new gas phase assemblage. These new ‘elements’ can then be used as input data for subsequent PHREEQC simulations. Each of these new elements must be identified by a unique number that is not already in use. If you specify a number that is currently in use, the new element will overwrite the old element.

7.3.5 Adding Solutions
In PHREEQC, a “solution” is a set of analyses for a single water sample. AquaChem automatically creates a PHREEQC input file from the sample details pertaining to your AquaChem database, or from a pure water sample.

To access the solutions options, expand the items in the Navigator tree by pressing the + beside Step. Then select Solutions and the solutions frame should appear, similar to the one below.
You must specify at least one solution for every PHREEQC simulation file. AquaChem allows you to select from two types of solutions:

1. Samples from your AquaChem database
2. Pure Water

These options are described in detail in the following sections.

Using Samples from your AquaChem Database
To add a sample from your database as a solution, select the sample from the list at the top, and press the button. The sample will then be added to the Solutions frame in the lower half of the dialogue; in addition, the new solution will show up as a new line in the Navigation tree, under Solutions.

To add multiple samples from your database, use the <Shift> and <Ctrl> keys with the mouse to select the samples you need, then click the button. This is useful if you want to speciate a large number of samples simultaneously. Each complete sample should have pH, alkalinity, and temperature values specified.

The AquaChem database index Number for the selected sample will be used as the Solution number. The Description field is used to identify the solutions. The solution description will appear in the PHREEQC input file.

After you have added a solution, you can verify that it has been added to the PHREEQC input file. To do so, click the Input File tab at the bottom of the screen and you should see the added solution and any corresponding concentrations.
Adding Pure Water

To add pure water as a solution, press the button below the list of AquaChem active solutions. For certain simulations it might be useful to have pure water as a base solution. For example, you can simulate a groundwater by saturating pure water with calcite and adding a specified CO2 pressure.

Solution Properties
Once you have added a solution, you may want to modify the Solution properties.

To do so, you have two options:

In the Solutions frame, double click on the appropriate solution from the main dialogue, OR Select the appropriate Solution #, from the Navigator tree on the left side of your display.

The Solutions properties frame should appear as shown below.

The upper part of this dialogue lists the solution Description and Number. As discussed above, the Number is AquaChem database index number for the selected sample which will be used as the Solution number. The Description field is used to identify the solutions.

The remaining options in this frame are separated into two tabs; General, and Concentrations. The options associated with these tabs are described in detail in the following section.

General
Under the General tab, you can specify options for pH and Redox during the simulation.
You can choose a Constant during reaction value for these parameters, or allow the values to be determined as a result of equilibration with a mineral phase (Determined by equilibration with phase).

In addition, at the bottom of the frame, you can enter a default Temperature and Density values for the solution. The sample density is only needed when concentration values are entered in ppm or ppb.

**Concentrations**

This tab lists the concentrations of the dissolved elements in solution.

<table>
<thead>
<tr>
<th>Element</th>
<th>M. Spec.</th>
<th>Conc.</th>
<th>Unit</th>
<th>Phase</th>
<th>Sat.</th>
</tr>
</thead>
<tbody>
<tr>
<td>H</td>
<td>H+</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H(0)</td>
<td>H2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H(1)</td>
<td>H+</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>O</td>
<td>O2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>O(2)</td>
<td>H2O</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ca</td>
<td>Ca+2</td>
<td>256</td>
<td>mg/l</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mg</td>
<td>Mg+2</td>
<td>13</td>
<td>mg/l</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Na</td>
<td>Na+</td>
<td>50</td>
<td>mg/l</td>
<td></td>
<td></td>
</tr>
<tr>
<td>K</td>
<td>K+</td>
<td>2</td>
<td>mg/l</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fe</td>
<td>Fe+2</td>
<td>0.3</td>
<td>mg/l</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fe[+2]</td>
<td>Fe+2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fe[+3]</td>
<td>Fe+3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mn</td>
<td>Mn+2</td>
<td>0.29</td>
<td>mg/l</td>
<td></td>
<td></td>
</tr>
<tr>
<td>H(2)</td>
<td>H+</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The first column of the grid contains the Element name, while the second column describes the PHREEQC Masterspecies (M. Spec.) name.

The parameter values are read from the database; if necessary you may add or remove concentrations (Conc.), or edit the existing values. You may also define a concentration as controlled by a mineral solubility, or for gases, by a defined pressure. For example, a calcium concentration is overridden in the simulation by a calculated value that will result in a calcite equilibrium state (Saturation index = 0).

Once you have entered element values for the pure water solution, the Default Unit may not be changed. However, you can change the unit individually for each entered value by clicking the button in the Unit column. Please note that it is not possible to freely mix units (i.e. you may not enter some values as mg/L and others as mmol/L). You may only mix units within a “unit family” such as g/L, mg/L ug/L.

**Example**

The following example will demonstrate how to use a sample from the Demo database, as a solution in a PHREEQC simulation:
To add the MW-1-92 sample from the DEMO.AQC database to a PHREEQC input file, proceed as follows:

Tools from the main menu, then select Modeling and then PHREEQC (Basic) from the main menu.
Click + beside Step (in the Navigator tree) and you will see Solutions
Select Solutions
Select the MW-1-92 sample (ID = 1) at the top of the list of Active solutions in database frame
Click \( \text{button and the sample will now appear in the Solutions frame in the bottom section of the dialogue.} \)

To view the solution properties, double click on this Solutions, or expand the Navigator tree, and select the Solution from here. This will load a Solution properties dialogue.

Click on the Concentrations tab to confirm that the concentrations are identical to those entered for that sample in the AquaChem database.

To verify that this data is saved to the PHREEQC input file, you can view the input file by clicking the Input File tab at the bottom of the dialogue.

### 7.3.6 Surface Assemblage

While ions are exchanged during an exchange process, surface processes involve only the absorption of material on mineral surfaces. This process typically can be observed on hydroxides and is driven by electrostatic processes.

An example of the Surface options dialogue is seen below:
PHREEQC lets you define the initial composition of a Surface Assemblage in two ways:

1. Explicitly by specifying the parameter values for Surface Assemblage; or
2. Implicitly by specifying that the Surface Assemblage is in equilibrium with a solution of a fixed composition.

Option 1 (Explicit)

To define a Surface Assemblage:

Click \( + \) to add a new line to the grid.
Under the Binding Site field, double-click in the first empty cell and a combo box with a \( \square \) button will appear listing the available items.
Select a Binding site, and press <Enter> (on your keyboard).
Overwrite the default values for Specific Area (600 m2) and Weight (89 g) if required. Weight is defined as mass of solid for calculation of surface area in grams. Surface area is mass times specific area per gram.
Specify the total number of Sites (in mols) for each binding and make any appropriate changes to the default values for Specific Area and Weight.
Choose the appropriate diffuse layer model for the surface reaction (please see the PHREEQC manual for information on selecting the appropriate Diffuse Layer Options for your surface reactions).

To remove a binding site from the Surface Assemblage, select the Binding Site you would like to remove and press the \( \times \) button.

Option 2 (Implicit)
You may specify that the Surface Assemblage is defined to be in equilibrium with a solution. Simply enter a solution number in the appropriate field.

Once you have defined the Surface Assemblage, you must select the solution with which you wish to equilibrate. Each Surface Assemblage is identified by a unique Number and a Description so they can be easily recognized and reused in later simulations.

The Save Solution as allows you to save the composition of a simulation by creating a new surface assemblage. These new ‘elements’ can then be used as input data for subsequent PHREEQC simulations. Each of these new elements must be identified by a unique number that is not already in use. If you specify a number that is currently in use, the new element will overwrite the old element.

7.3.7 Mix Solutions
The Mix Solutions allows you to simulate the mixing of multiple solutions together with different proportions of each solution added to the mixture. An example of the Mix options dialogue is seen below:

To simulate mixing multiple samples together, you must first specify at least two solutions for the PHREEQC simulation.

To add a solution to the mixture:

Click to add a new line to the grid under the Solution header.

Type in a Solution number in the same cell.

Click-on the first line in the grid under the Part header and type the proportion of the solution you would like to add to the mixture (e.g. 3 parts of Solution 1 and 4 parts of Solution 2)

The solutions will be automatically added to the input file. Note that if you want to simulate several mixing proportions between two samples, each mix must be conducted in a separate simulation step as otherwise only the first mix definition will be executed.

Each mixed solution has a unique Mix number and Description. To re-use the simulated mixed sample in a later step, simply enter a solution number beside the Save Solution as field.

7.3.8 Reactions
The Reactions simulation options are used to dissolve or precipitate a specified amount of a mineral or formula. To access these options, you need to add a Reaction as a Step and then access the Reactions options. Below is an example of the Reaction dialogue:
AquaChem provides a comprehensive list of available reactant species and phases to choose from. To select from the list of available reactants:

Specify to show Phases or Species

Click to add a new Phase or Species. A new line will be added to the grid.

Under the Phase or Formula field, double-click in the first empty cell and a combo box with a button will appear listing the available reactants.

Select the reactant you need, and press <Enter> (on your keyboard). The reactant will appear in the grid. Enter the stoichiometric factor in the Stoichio field beside the reactant. The stoichiometric factor defines whether the reactants are added (SF>0) or removed (SF<0) from the solution. The stoichiometric factor is multiplied by the Mols of reaction added in order to calculate the total amount of the respective reactant added (default value is 1).

Type the number of Moles of reactant added, the Number of steps for the reaction, and Add reaction to solution number. The reaction path is revealed when you simulate the reaction in multiple steps. By default the reaction is added to the first solution in the simulation. Note that you are not required to add the reaction immediately to a solution if you only wish to use the reaction in later simulation step(s).

To add additional reactions, you must add additional Reaction steps. To do this, select Reactions from the Navigator tree. Then, under the Reactions frame, click to add a new Reaction. A new line will be added to the navigator tree. Select this new item, and the options will be loaded for this new reaction.

The Save Solution as allows you to save the composition of a simulation by creating a new reaction. These new 'elements' can then be used as input data for subsequent PHREEQC simulations. Each of
these new elements must be identified by a unique number that is not already in use. If you specify a number that is currently in use, the new element will overwrite the old element.

The reaction will be added automatically to the input file. To verify this, click the Input File tab at the bottom of the dialogue.

NOTE: The add reaction option does not calculate an equilibrium status. It will only dissolve the specified amount of chemicals in the given solution. Therefore you may enter any valid chemical formula into the phase or formula grid

Example - how to add a reaction
Follow the steps listed below to specify the following reaction:

Dissolve 0.1 moles Calcite and 2.0 moles Halite (NaCl) in pure water.

Select Tools from the main menu, then Modeling and then PHREEQC (Basic) from the main menu.

The PHREEQC Input dialogue will appear, and the General tab will be active.

Click + beside Step (in the Navigator tree) and you will see Solutions
Select Solutions
Add pure water as a solution by clicking Add pure Water below the active solutions frame
Click Step from the Navigator tree and right click on it
Select Add Forward Model and then select Add Reaction to add the First Reaction step.
Reactions a new item Reaction1 will now appear in the Navigator tree.

Under the Reaction options (in the Navigator tree):
Select Reaction1 in the Navigator tree
Phases radio button, under the Reaction options frame
Click to add a new Phase or Species. A new line will be added to the grid.
Under the Phase or Formula field, double-click in the first empty cell and a combo box with a button will appear listing the available reactants.
Select Calcite, overwrite the default value of 1.0 with 0.1. Press <Enter> on your keyboard.
This reaction will be automatically added to the input file. To verify this, click the Input File tab at the bottom of the dialogue.
To add a reaction for Halite:

Click to add a new Phase or Species. A new line will be added to the grid.
Under the Phase or Formula field, double-click in the first empty cell and a combo box with a button will appear listing the available reactants.
Select Halite, and a default value of 1.0 will show. Press <Enter> on your keyboard.
type: 1 in the Mols of reaction added field (located below the grid)
Select the field labeled Add reaction to solution.
Type 1 in this field.
Once you have added this reaction, your dialogue should appear similar to the one shown below:
To verify the input file, click on the Input File tab at the bottom of this dialogue. The contents of the input file should be similar to that shown in the figure below:

<table>
<thead>
<tr>
<th>Phase or Formula</th>
<th>Stoichi</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calcite</td>
<td>0.1</td>
</tr>
<tr>
<td>Halite</td>
<td>2</td>
</tr>
</tbody>
</table>

- Reaction
  - Description: (Enter Reaction description)
  - Number: 1
  - Phase or Formula | Stoichi
    | Calcite | 0.1     |
    | Halite  | 2       |
  - Mols of reaction added: 0.1
  - Number of steps: 1
  - Add reaction to solution: 1
  - Save Solution: [ ]

© 2017 Waterloo Hydrogeologic.
You may now run PHREEQC with these reaction and solution options.

### 7.4 Running PHREEQC Simulation

Once you have specified the necessary Solutions and Reaction Steps, you are ready to run the simulation. Before doing so, it is recommended that you verify the contents of the input file. Once this is finished, click the [Run] button to run the simulation.

The PHREEQC simulation will run in the background as a DOS application inside a DOS window. Once the simulation is finished, you can verify the results by clicking the Output File tab (at the bottom of the main PHREEQC dialogue) and scan this for any error messages. The output from the PHREEQC run can be viewed by clicking on the Output File tab, or on the Spreadsheet tab.
8 Appendices

The following Appendices are available for your reference:

Appendix A: Troubleshooting and FAQ
Appendix B: Using HydroGeo Analyst and AquaChem Together
Appendix C: Trend Analysis Tests
Appendix D: Calculating Alert Levels
Appendix E: References

8.1 Appendix A: Troubleshooting and FAQ

The following list provides answers to some of the most common problems encountered by users of AquaChem. Please review this list of frequently asked questions before contacting Technical Support for assistance with your project.

Q 1: My sample symbols do not show up on the plot.
A1. Check that you have assigned symbols to that sample(s).
A2. Ensure the symbol group is active for the plots. This can be set in the Plots > Define Symbol or Line dialogue.
A3. Ensure that you have entered data for each parameter required by that plot.

Q 2: My symbols show up on the plot colored in red, even though I have assigned another color to this symbol.
A. The red colored symbols correspond to the samples which are selected in the active list. This indicates you are using the Identify Samples option in the Define Symbol or Line dialogue. Disable this option and the symbols will no longer be identified.

Q 3. After I import data, the data does not appear correctly or does not appear at all.
A1. Check that you have a value for each sample for each parameter in your source file.
A2. Ensure that you have selected the correct Delimiter during the import routine.
A3. Check your data source file to ensure that there are no extra spaces between columns or rows of data.

Q 4: During data import, I get an error “Column must be assigned to CAS Registry #.”
A1. Ensure that you have specified the correct import format. For this warning, you should typically try the Samples as Rows in the Format field.
A2. If your data source file does not contain CAS Registry #s, ensure that this option is disabled during the data import.

Q 5: During data import, I get error “Column must be assigned to SampleID or StationID.”
A1. Ensure that you have specified the correct import format. For this warning, you should typically try the Samples as Rows in the Format field.
A2. Ensure that you have mapped at least one of your text fields as the StationID and SampleID.

Q 6: Some of my samples or stations no longer appear in the active list.
A. Since samples and stations are actively linked in the database, when you temporarily omit a station, the corresponding samples will be removed from the active list. Likewise, when you remove all samples assigned to a given station, this station will be temporarily removed from
the active list. To restore all samples or stations press the Show all button in the active samples list dialogue, or select Filter from the main menu and then Show all option.

Q 7: In the print options window, part of the plot is cut off by the print template.
A. Be sure to select the print template first, then load the plot on top of the template. This will ensure the page margins are set correctly, and will not cut off sections of the plot.

Q 8: After I enter a value for a measured parameter, the 0 after the decimal place is cut off (for example, 7.20 in entered, however AquaChem displays this as 7.2).
A. This can be corrected by modifying the parameter format. Go to File > Preferences > Database Parameters. Select the appropriate measured parameter, and modify the format. Disable the Auto option, and increase the number of decimal places to the desired value.

Q 9: Is it possible to create two unique Piper plots showing two different sample groups?
A. AquaChem will not allow for multiple Piper plot windows showing two distinct sample groups, at the same time. Since plots are created from information based on the active samples list, any changes that are made in the active list will immediately impact any open plot windows. The plots must be created individually.

8.2 Appendix B: Using HydroGeo Analyst and AquaChem Together

With AquaChem 2012.1 and later you can run the program completely on a Hydro GeoAnalyst (HGA) SQL database. This workflow begins in HGA with an HGA project. In order to use the AquaChem (Water Quality Analysis) feature in HGA, you must first have AquaChem 2012.1 or later installed on the local machine. When you select Modules / AquaChem (or select the icon from the toolbar) HGA will search for the installation, however, if it can not be found you will be prompted to browse to the location of your AquaChem executable (aquachem.exe).

Then it will check the current project database to see if the Geochemistry Extension has been added - if this has not been added you will be prompted to add this extension.

Adding the Geochemistry Extension will allow Hydro GeoAnalyst and AquaChem to seamlessly work together. This extension requires updates to the Hydro GeoAnalyst database. Making a backup of your project database is recommended before starting.

It is always a good idea to make a backup of our database before adding this extension.
The Geochemistry Extension will add several tables and fields required to allow AquaChem to run on the HGA SQL database.

Once the Geochemistry Extension has been added to the project database AquaChem will launch. The next time you open the HGA project and select Modules / AquaChem it will simply launch AquaChem. Alternatively you can open the HGA project file (project.vbh) within AquaChem without needing to launch HGA, simply select the project.vbh file when prompted to open a database.

When using AquaChem with HGA, keep in mind that AquaChem is intended only for its presentation and calculation features. Data entry and maintenance operations should be performed centrally through the HGA interface and not the AquaChem interface. The operations that must be performed in HGA include:

- Importing data
- Creating new samples
- Creating new stations

Please keep in mind that there are specific table and field requirements in the HGA project database in order to allow the Geochemistry Extension to be properly added to your project database. The following tables and fields are required:

**Station**

- ID
- Name
- X
- Y
- Elevation
- TOC
- Depth

**Parameter Sample**

- sample_id
- lab_id
- sample_date
- comment
- watertype

**Parameter Result**

- sample_id
- chemical_name
- result_value
- result_unit
- reporting_detection_limit
- sampling_precision
- analysis_method
- qualifier
- outlier
- comment
- analysis_date
These tables and fields are all included in the current Environmental (metric or imperial) versions of the Database Templates provided with the installation of HGA. You are free to change the View Settings for these tables and fields (for instance to change them to a local term or another language) however, the database settings must remain.

**A note on Chemical Names**

To be able to see your results that are stored in HGA within AquaChem you must ensure that the Chemical Names used within HGA are recognized by AquaChem. Therefore review the names of the Measured Parameters in AquaChem by opening the Demo_Basic project and selecting File / Preferences and selecting Database Parameters. Under the Measured Parameters you will find the list. Ensure that the names used within HGA are the same as those used for the Internal Key, Form Label or Description fields within AquaChem (as it will try and map the names based on these fields.

**Limitations:**

**X and Y coordinates**

When using an HGA project with projected coordinates, the X and Y coordinates in the database are stored as latitude and longitude (WGS 1984) in decimal degrees. When linking with AquaChem this information will be shown in the Coord_Long and Coord_Lat fields within AquaChem. While working in AquaChem these can be converted back to UTM and shown in the X and Y fields by using the UTM Conversion tool (found under Tools/Calculators menu). The X and Y fields will then NOT be dynamically linked to the HGA X and Y fields. Therefore when needing to make changes to the coordinates you must make the change in HGA and then re-run the UTM conversion in AquaChem.

When using an HGA project with local coordinates, the X and Y coordinates are stored as is in the database. Therefore when linking with AquaChem this information will be shown in the X and Y fields of AquaChem (and no further conversion is required).

---

**8.3 Appendix C: Trend Analysis Tests**

**Linear Regression**

The linear regression simply calculates a regression line on the time/value plot. A positive slope of the regression line indicates a trend towards increasing values, a negative slope a trend to decreasing values. However the result of this test should only be used qualitatively and should be confirmed by more sophisticated tests such as Sen's and Mann-Kendall. The calculated line is drawn on the time series plot.
Sen's Test

Sen (1968) developed a simple nonparametric estimator of trend which is particularly useful for groundwater monitoring applications. The method is robust to outliers, missing data and non-detects. To compute the Sen's trend estimator $S$, the individual slopes for any succeeding points are calculated. The trend estimator corresponds to the median of all calculated slopes. To calculate the confidence limits, an estimate of the variance of $S$ is required which may be calculated using the following formula:

$$\text{var}(S) = \frac{1}{18} n(n-1)(2n+5) - \sum_{i=1}^{q} t_p (t_p - 1)(2t_p + 5)$$

where $q$ is the number of values for which there are ties and $t_p$ is the number of tied measurements for a particular value. The lower and upper confidence limit $M_1$ and $M_2$ can be calculated as follows:

$$M_1 = \frac{N^2 - Z_{1-\alpha} \sqrt{\text{var}(S)}}{2}$$

$$M_2 = \frac{N^2 + Z_{1-\alpha} \sqrt{\text{var}(S)}}{2}$$

The calculated ranks $M_1$ and $M_2$ are projected on the ranked slope data. If the respective interval contains the zero value, the Null Hypothesis of non trend is accepted. The Output of Aquachem includes the Median slope, the variance $S$, $M_1$, $M_2$ as well as their respective slopes. Both Hypothesis, "Increasing trend" and "Decreasing trend" are tested according to the specified probability and the result reported in the result table shown below.
For more details on the Sen’s test please see the reference below:

**Mann-Kendall Test**

The Mann-Kendall test is a trend estimator that can be used to prove if contaminant concentrations are significantly diminishing or rising over time. For this test, there are no distributional assumptions, and missing data (non-detects) or irregularly spaced measurement periods are allowed. Non-detects are assigned a value smaller than the smallest measured value.

The version of the Mann-Kendall Test used in AquaChem can be applied for virtually any groundwater parameter. The Mann Kendall test provides two values; S value and Z value. The test procedure is as follows:

First, order the data by sampling date \(x_1, x_2, \ldots, x_n\) where \(x_i\) is the measured value on occasion \(i\).

Second, record the signs of each of the \(N'\) possible differences \(x_i' - x_i\) where \(i' > i\). For example, let \(\text{sgn}(x_i' - x_i) = 1\) if \(x_i' - x_i > 0\)

\[= 0 \text{ if } x_i' - x_i = 0\]

\[= -1 \text{ if } x_i' - x_i < 0\]

The Mann-Kendall statistic (S) is then computed as:
\[ S = \sum_{i=1}^{n-1} \sum_{i' = k+1} \text{sgn}(x_{i'} - x_i) \]

which is the number of positive differences minus the number of negative differences.

If \( S = 0 \), then there is no increasing or decreasing trend in the data.
If \( S < 0 \), then there is a decreasing trend, indicating concentration is decreasing over the time interval.
If \( S > 0 \), then there is an increasing trend, indicating concentration is increasing over the time interval.

A two-sided test (for either increasing or decreasing trend) can also be obtained, using probability values. For \( n > 10 \), then the normal approximation (\( Z \)) is calculated as follows:

If \( S > 0 \), then
\[ Z = \frac{S - 1}{\sqrt{\text{var}(S)}} \]
If \( S = 0 \), then \( Z = 0 \)
If \( S < 0 \), then
\[ Z = \frac{S + 1}{\sqrt{\text{var}(S)}} \]

Where \( \text{var}(S) \) is calculated according to the formula used for the Sen's slope estimator. The quantity \( Z \) can be compared to standard normal cumulative distribution probabilities to test the null hypothesis of no trend.

In the Statistics Report window, the \( S \) value is displayed as \( S(M-K) \), and the \( Z \) value is displayed as \( Z(M-K) \).

For more details on the Mann-Kendall test please see the reference below:

After you have selected a test to use in trend calculation, select the parameter for which you wish to calculate the trend.
All stations will be displayed in the Data tab, sorted by date in ascending order. At this point you can de-select any samples you do not wish to use in the analysis. Simply un-check the box beside the sample to remove it from calculations.
Once you are satisfied with the data selection, move on to the Plot tab. This tab offers a graphical representation of the selected data.
The graphical representation of the data is very helpful because it allows you to see if there are any outliers that may potentially distort the analysis.

Once you are satisfied with the view click the [Calculate] button, and the trend will be calculated and displayed in the result tab.
Depending on the chosen test, different results will be displayed, however one common entry is the Result line at the bottom of the list of calculated parameters. The result can be:
- increasing trend accepted/rejected
- decreasing trend accepted/rejected

To see the calculations for another method and/or parameter simply change these options in their respective combo boxes and click [Calculate] again.

8.4 Appendix D: Calculating Alert Levels

Tolerance Interval Method

The tolerance interval method is one statistical method used in AquaChem to calculate upper and lower tolerance limits for groundwater constituents. Tolerance limits, or alert levels, are derived from historical compliance groundwater monitoring data. They may be useful for comparing with future monitoring data for detecting potential groundwater contamination. Please note that this method assumes that the historical data is of normal distribution.

Depending on the number of non-detects present in the historical dataset, one of three formulas are used to determine the appropriate alert levels: Basic Tolerance Interval Method, Cohen's Method or Aitchison's Method. The latter two methods are intended to handle datasets with a larger percentage of non-detects. The algorithm for determining which method to use is presented graphically below. All acronyms are described at the end of the appendix.
The formulas for each method is described on the following page.

AL Calc 1 : Basic Tolerance Interval Method

\[ AL = \bar{x} + Ka \]

\[ \bar{x} = \text{Mean} = \frac{\sum x_i}{n} \]

K = Tolerance factor

\[ a = \text{std. dev.} = \sqrt{\frac{\sum_{i=1}^{n} (x_i - \bar{x})^2 n_i}{n-1}} \]

n = total number of quantifiable samples

AL Calc 2 : Cohen's Method
\[ AL = \bar{x}_{corr} + K \sigma_{corr} \]

\[ x = \text{mean} = \text{as in AL Calc1 (see above)} \]

\[ K = \text{tolerance factor from table 1} \]

\[ a = \text{std. dev} = \text{as in AL Calc1 (see above)} \]

\[ n = \text{total number of quantifiable samples} \]

\[ m = \text{total number of samples} \]

\[ m - n = \text{total number of non detects} \]

\[ h = \frac{(m-n)}{m} = \text{corr. factor 1} \]

\[ g = \frac{a^2}{(\bar{x} - PQL)^2} = \text{corr. factor 2} \]

Obtain \( e \) from Correction for Non-detects table

\[ \bar{x}_{corr} = \bar{x} - e(\bar{x} - PQL) \]

\[ a_{corr} = \sqrt{a^2 + e(\bar{x} - PQL)^2} \]

Description of Acronyms

AL - Alert Level: an early warning indicator of a potential violation of a water quality standard at the applicable point of compliance.

AQL - Aquifer Quality Limit: a maximum concentration of a constituent allowed in an aquifer at the point of compliance. Synonymous with AWQS.

AWQS - Aquifer Water Quality Standards: numeric water quality standards

MCL - Maximum Contaminant Level: the maximum permissible level of a contaminant in water

MDL - Method Detection Limit: the minimum concentration of a constituent that can be measured and reported with a 99 percent confidence that the true value is greater than zero in a given matrix containing the analyte.

PQL - Practical Quantitation Limit: the lowest level that can be reliably achieved within specified limits of precision and accuracy during routine laboratory operating conditions.


8.5 Appendix E: References


McCulloh (Eds.), Thermal History of Sedimentary Basins; Methods and Case Histories, Springer Verlag, pp. 99-117.


Index

- E -
Exchange Assemblage 347
Export
  To ESRI Shapefile 63

- F -
File
  Close 45
  Import 46
  New 42
  Save Database Template 46
  Save Database 46
Filter Menu 135

- H -
Hardness Dependent Standards 239

- L -
LookUp Tables 310

- O -
Options 262

- P -
Parameters 257
Plots
  Configurations 169
  Options 158

- R -
Report Designer 274
Reports 152
  Compare Samples 233
  Mix Samples 236

Options 230
  Rock Source Deduction 243
  Sample Summary 271
  Water Quality Standards 238

Results 265

- S -
Save as Template 46
Stations 257

- T -
Table View 128
Tools 153
  Modeling 312
Trend Test 257, 262, 265

© 2017 Waterloo Hydrogeologic.